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FuelsManager Defense

Using This Manual

The FuelsManager Defense Administrator manual explains not only the
configuration and maintenance of the FuelsManager System, but also explains
how to use the FuelsManager applications: Draw, Report, Configuration, and
Operate.

Before reading this guide, you should become familiar with the operation of
Microsoft Windows. This manual has been supplied for system administrators,
managers, engineers, and other top-level management. The operator and other
personnel can use this guide, but a separate guide entitled FuelsManager
Defense User manual is available for operators.

This manual includes step-by-step instructions for both the Standard and
Professional editions of FuelsManager.

It is assumed that the FuelsManager System has already been installed and
commissioned. If there is any doubt of the state of the system, contact an
Administrator or Supervisor before continuing.

Windows Terminology

FuelsManager operator interface is based upon the Microsoft Windows Graphical
User Interface (GUI) standard and is SAA-compliant (System Application
Architecture standard for open systems). All top-level menus, dialog boxes and
mouse-driven interfaces adhere to the published standards for Microsoft
Windows. This manual uses the terms described in the table below when
describing operator actions and windows elements for step-by-step instructions.

Actions in Windows

Actions Description

Point To move the mouse pointer until it rests on the item of choice

Click To quickly, press and release the mouse button once

Double-click To quickly, press and release the mouse button twice in
succession

Drag To hold down the mouse button while moving an object
across the computer screen

Release To quit holding down the mouse button after dragging an item

Select To pick an item on a menu, button or to highlight text or
graphics usually via a single click). Selecting does not initiate
an action

Choose To pick an item to carry out an action. Often needed to select

an item before choosing it (usually via a double-click).
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Window Elements

Elements

Program Icon

Title Bar

Menu Bar

Menu

Dialog Box

Window

Window Title

Close Button

Maximize Button

Minimize Button

Restore Button

Window Border
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Description

Provides a pop-up menu, which allows window modification

Shows the title of the application, document or FuelsManager
graphic screen

Lists of available menus. Most applications have a File menu,
Edit menu, and a Help menu, as well as menus unique to the
application

A menu contains a list of commands or actions performed by
the operator. Also referred to as a pop-up/drop-down menu.

A movable window that is displayed on screen in response to
the user selecting a menu option. It provides the current
status and available options for a particular feature in the
application

A scrollable viewing area on screen. May refer to the entire
application in a window

The Window title can be the name of an application,
document, group, directory or file depending on the type of
window in which it appears

Use this button to close the window or application.

Use this button to enlarge the application window so that it
fills the entire desktop

Use this button to reduce the application window to an icon at
the bottom of the screen.

This button can restore an application window to its previous
size and location

The Window border is the outside edge of a window. The
user can change the window size by dragging the border in
or out on each side of a window
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Note! If FuelsManager has not
been configured, the Administrator
should perform the all the
procedures in this chapter.

Before You Begin

This section describes how to install FuelsManager. This chapter also provides an
overview of how a system could be networked.

In most cases, FuelsManager is installed and pre-configured on the computers
before they arrive on site. Further information on how to use the Operate user
interface to interact with the facility during run-time is provided in the user manual.
When and if other database components need to be edited or changed, refer to
Databases Chapter in this manual.

Once FuelsManager has been installed, the user should then refer to the Setting
System Parameters chapter which addresses the configuration procedures to
provide complete functionality of this software.

Before you begin installation make sure:
« The computer meets the minimum requirements listed in the Hardware
Requirements section

e The installation is to a Windows NTFS file system. If one does not exist, you
must create and format an NTFS partition. See Windows documentation for
further information

* You log into Windows 2000/XP as Administrator to install FuelsManager. The
system administrator has complete authority for installing FuelsManager,
setting up Windows users, and defining FuelsManager users

 You close all other applications before installing
What'’s in the Box
The items delivered as part of this installation include:
* Install CD-ROM
» Hardware Key
« Keyboard Template
* Mouse Pad
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FuelsManager install CD-ROM

This CD contains the files necessary to run FuelsManager. If you are upgrading
an existing version of FuelsManager, the installation program will not overwrite
existing data unless indicated and will offer the opportunity to backup the existing
project.

The FuelsManager installation CD will automatically run when inserted into the
PC. If your PC does not support this function, refer to ‘Installing the Software.’

Optional features and communication drivers

By default, the FuelsManager installation program will install all optional features
and communications drivers available at the time of purchase. However,
depending on the FuelsManager licence you purchased (Standard or
Professional), some of these features may not be available.

You may want to only install features you have purchased (or the ones you intend
to use) without all the optional drivers. To do this, simply select Custom during the
installation process and deselect the options you do not want to install.
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Licensing Options

The FuelsManager software suite is available as a licensed product with various
levels of functionality. Each edition is available pre-installed on a PC or as a
software license only.

The FuelsManager license pre-installed onto a PC includes the following
deliverables:

« PC with minimum required features for workstation or server editions
 Electronic copies of the user and operator manuals

« CD with files necessary to install the FuelsManager and ViewRTU software
» Software protection key

« Windows 2000/XP license

Professional Edition

FuelsManager Professional is intended for medium to large sized networks where
the customer needs to be able to customize the operator interface and show data
over a network. Each FuelsManager workstation on the network has its own
licensing key. The FuelsManager Professional Edition can also act as a data
server and provide inventory data to other FuelsManager Professional or Standard
Editions.

Standard Edition

FuelsManager Standard is intended for standalone systems or as a client to a
Professional Edition. FuelsManager Standard Edition supports predefined
graphics and reports, but does not allow these standards to be modified; custom
graphics or reports cannot be created. FuelsManager Standard Edition cannot
serve data to other FuelsManager stations and/or be used with the optional
Product Movement Package. FuelsManager Standard and does not support
Inventory Management functionality.

Edition Features

The features and abilities of the Standard and Professional editions are detailed in
the following table. For more information, contact Varec at 1-866-MY-VAREC

Standard Professional
Edition Edition
Predefined tank templates, tabular and v v
graphical tank groups
Select industry standard volume correction v v
methods, including API, ATSM, IP, JIS,
Polynomial and others
All measured and calculated storage tank v v
parameters are displayed in the engineering
units you specify
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Standard
Edition
All parameters can be controlled online through v
the industry standard Windows® dialog boxes
and user interface
Allows seamless communications to various v
manufacturers’ tank gauges via the RTU 8130
or TankGate interfaces
Comprehensive real-time alarm and event v
management
Print or save standard reports of your daily v
operations, including alarm, events, historical
data and others
An OPC client/server interface allows seamless v

integration of data to and from OPC equipped
systems

Inventory Management functionality, such as
pump and valve control, allows you to control
and monitor your facility

User configurable tank detail templates,
displays and reports can be modified for your
specific business operations

Additional communications drivers are provided
to allow direct connectivity to tank gauging
devices, PLCs, DCS and other 1/O systems

Provide data to multiple FuelsManager Defense
Standard Edition workstations

Integrated movement system designed to track
bulk product transfer to and from your facility or
from tank to tank within your facility

Periodic or triggered logging of user specified
data to CSV, HTML or XML data files

Integrated statistical analysis of historical data
designed to detect possible leaks from
underground storage tanks

Offline analysis of historical data provides
throughput calculations to assist with EPA Title
V permitting

Manage inventories throughout the office or
across the enterprise using an intuitive web
based user interface.
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Caution! Turn off your computer to
avoid possible shock.

Left - USB Key

Right - Parallel Key

Installing the hardware key

Each FuelsManager workstation requires a hardware key in order for the software
to run. This device plugs into either the parallel port or USB of the CPU without
disrupting normal operations, and should be inserted as indicated in the
installation program. Along with the physical key, there is a driver called Sentinel
that is automatically configured during the software installation.

To install the FuelsManager parallel hardware key, perform the following steps:

Step-by-Step
« If the computer has a local printer, detach the printer cable from the rear of
the computer.
¢ Attach the hardware key to the printer port.
 If the computer has a local printer, attach the printer cable to the hardware
key.

USB keys should not be installed until after FuelsManager has been successfully
installed. See the Installing USB Hardware Key section for instructions.
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Installing FuelsManager

FuelsManager
installation wizard

FuelsManager Defense ¥6.0 - InstallShield Wizard N

Welcome to the Installation Wizard for
FuelsManager Defense ¥6.0

The Installation ‘wizard will install Fuelstanager Defense
WE.0 on your computer. To continue, click Mest.

Cancel

< Back
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Step-by-Step
« Insert the Install CD-ROM into the CD-ROM drive
 If the CD does not autorun, perform the following:
From the Windows 2000/XP desktop, click the Start menu and select Run.
Type ‘E:\SETUP ‘(substitute the “E” with the appropriate CD drive letter)

¢ The Install Wizard will start, and a message appears regarding the need to
obtain a new hardware key, for this version of FuelsManager to function. If
you have a new hardware key, click OK

« Another message appears regarding the USB key type. If your key is USB,
remove the key from the port and click OK

e The Welcome Screen will appear, select Next

* The License Agreement will appear. Review text, then select the appropriate
option

e The Customer Information screen will appear. Review information and
change if appropriate

« For the “Install this application for...” option, make sure the ‘radio button’
next to the “Anyone...(All Users)” is selected, select Next

« The Setup Type screen appears, providing “Complete” or “Custom”
installation options. Leave the selection set to “Complete,” select Next

e The wizard confirms that you are now ready to set Program Options. Click
Next

¢ The next screen prompts you to enter the default units FuelsManager will
use for adding new tank points. Select either English (FT-IN-16) or Metric
and click Next

* The next screen prompts you to select the language the software will use.
Select from the list and click Next

« The next screen prompts you to select the database type you will be using.
Select either Microsoft Access or Microsoft SQL Server and click Next

* The next screen asks if you want to install the demo database. Selected the
required option and click Next

« The wizard confirms that it is ready to begin installation. Click Install

¢ The install wizard begins to install FuelsManager Defense. This may take
several minutes to complete

< After completion, the Installation Wizard Complete screen appears. Click
Finish

* The wizard will close and give the option to restart your system. Click Yes if
you want to restart at this time. If using a USB key, you can insert the key
after rebooting
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Installing USB hardware key

To install a USB Hardware Key, perform the following steps:
Step-by-Step

» Attach the USB hardware key to an available USB port

« If Windows prompts you to install drivers for the key, follow the on-screen
instructions

Uninstalling FuelsManager

You can uninstall FuelsManager by running the SETUP program from the CD-
ROM, following the Installation Wizard and selecting Remove.

You can also uninstall FuelsManager from Windows’ Add or Remove Programs
tool in the Control Panel. Scroll down and select FuelsManager Defense V6.0 and
click Remove.

Modifying Installation

FuelsManager Defense automatically installs all available features drivers.
However, you can uninstall or re-install features by running the Install program
and selecting Modify install.

FuelsManager Defense ¥6.0 - InstallShield Wizard i f, |

FuelsManager”

Select the features you want ta install, and deselect the features you do nat want to install.

Select Features

— Disscind
=] Inventary M anagement o ezcrption

T Integrated systems cavering all

- aspects of bulk liquid
] Movement System management and provides
[w] Leak Detection complete integration.
v Automated Data Output
[w] Throughput Calculator
v ¥iewR TU Configuration Tool
: [l Communic.ation Dirivers
B FCC
D- Dispatch LI
0.00 ME of space required on the C drive
28562.01 MEB of space available on the C drive
IrratallShield

< Back I Mest » I Cancel |

You can select or deselect options as needed and continue the installation.
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Left - User Interface
menu from the
FuelsManager

Configuration
application

Right - Draw menu,
File, Batch Run Files
sub-menu

Upgrading from FuelsManager 4.3

As with all previous versions of FuelsManager, upgrades are only supported from
the immediately preceding version, in this case FuelsManager version 4.3.

Install FuelsManager. Follow the steps for a new install, but select “Yes” when
offered the opportunity to back up the existing project. The install wizard will create
a folder entitled ‘c:\FMProject<CurrentDate>.

Regenerating user Graphics and Symbols
To complete the upgrade from FuelsManager v4.3 you must ‘regenerate’ all user

defined graphics and symbols from the FuelsManager Configuration application. If
you don't do this you will not be able to view graphics created on the previous
system.

Step-by-Step
* From the FuelsManager Configuration Menu bar, click User Interface, and
then click Draw Graphics command.

e The Draw Application opens

* Click on the File menu, and select Batch Run Files, from the sub-menu
select the Symbols command

« The Batch Compile dialog box appears (see opposite), select the Build All
option

¢ A confirmation dialog box appears - select OK

* When operation finishes select Cancel to close the dialog box

« To regenerate Graphics, click on the File menu, and select Batch Run Files,
from the sub-menu select the Graphics command

« The Batch Compile dialog box appears, select the Build All option
« A confirmation dialog box appears - select OK
* When operation finishes select Cancel to close the dialog box

User Interface

Operate
Drraw Graphics
Create Reports

Merge File

Detail Mode
Detail Data 2

Graphics
Exit Draw _,w
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Batch Compile dialo
Batch Compile FE box P 9

Attered Symbol Files:
BATCH RUN GENERATICHN |

File;
Select &ll

Command;

Status: Unzelect Al

‘ Build &1 Help

Regenerating reports

After upgrading from the previous version of FuelsManager the user must
‘regenerate’ all reports. Failure to do so will result in the inability to view any
reports created on the earlier system.

Step-by-Step

* From the FuelsManager Configuration Menu bar, click User Interface, and
select Create Reports command

* The Report application will start

¢ Click on the File menu and select Batch Run Files command

« The Batch Compile dialog box appears, select the Build All option

< A confirmation dialog box appears, select OK

» Select Cancel to close the Batch Compile dialog box

Regenerating Tank Details and other graphic files

FuelsManager ships with regenerated Tank Detail displays. However, if you want
to continue using an existing v4.3 custom detail, you will need to ‘regenerate’ the
custom tank detail.
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Left - Detail Mode is
‘Checked’ on the File
menu

Right - Open Graphic
File dialog box

Step-by-Step

* From the FuelsManager Configuration menu bar, click User Interface, and

then click Draw Graphics command

The Draw Application opens

Click on the File menu and select Open command
The Open Graphic File dialog box appears

Select the required Tank Detail file (*.grf) from the list
The selected graphic file is displayed

Click on the File menu and select Detail Mode

Click on the File menu and select Generate Run Files
The graphic file has now been regenerated

Click on the File menu and select Exit to return to FuelsManager
Configuration

File Open Graphic File
Mew 3 .
B File Name :
Save Directory: |z:%. Mmprojectyaraphics
SavEfs..
Purge... File Mame : File Type :
Merge File FeceiptT anks. GRF
—_—— ShipmentT anks. GRF :
M SiteOverview GRF f* Graphic
Detail Data 3
et -
[renerate Hum Files.. Ll
Batch Run Files... 3
Exit Draw

| Cancel
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Networking

Networking

Operator

- | DataManager |—>1 ReportManager | 2 Printer
1 {
Alarm & { Format = '—l—’—ﬁ‘
Event Logs Data g Manager ODBC Data Source |
Crlculations

‘P_‘

CommManager
| L/ Drivar I | L/Q Driver | I /O Drivar I ’
Instruments | | ELCs | RTUs |

The above figure illustrates a typical FuelsManager System setup. This example
is only one of many configurations, but it provides a general understanding of how
an FuelsManager System is configured.

Network Installation

FuelsManager can be set up a variety of ways to accommodate the needs of any
given site. A typical FuelsManager network setup has all computers reading data
from one source, and is a good reference point to use to describe network
installation.

A typical network installation would require FuelsManager to be installed on the
system designated as the server, and also on each workstation or client machine.
(During the install, the local system should be specified for the program and
project path, as FuelsManager may need access to program indexes as well as
graphic and/or tank group files.)

The Server system does not need to be a Windows Server, as FuelsManager
looks to the system registry for the server location. The system registry on each
individual installation also retains the system name, as well as location of custom
graphics and tank groups.

ADMO03GVAE1005
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Step-by-Step

« Install FuelsManager on the system that will be used as the server

« Install FuelsManager on all ‘client’ machines. Place both the application and
the project on the local machine, as indexes and application files are
necessary

« Once installed, the server may be specified in each client systems registry.
This can be done using the Windows registry editing tool, and changing the
value in the server key to reflect the desired Server machine. The registry
key: HKEY_LOCAL_MACHINE\SOFTWARE\FuelsManagenServer
contains this value. Refer to Windows documentation for further information
on editing the registry

With this sort of setup flexibility, a number of possible configurations can be
utilized. The server may contain all the resources used by the workstations. In this
case, there must be a network connection to the appropriate folders on the server
for the workstations to have access. These folders may be changed in
FuelsManager either by editing the system registry or changing the settings in the
System Control Options dialog box.

The Project, Detail, Graphics, and Reports folders displayed in the System Control
Options dialog box are listed in the System Registry, along with the server name.
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Printers

Printers are used to print Alarm/Event reports and Log File Browser reports that
were created in Report. The available printers and reports are listed in the
ReportManager dialog box in Operate.

FuelsManager will recognize all local printers, and allow the user to choose
between them under the ReportManager. If the Windows default print device is
also a local printer, FuelsManager will use that as its default printer. If the
Windows default printer is a network printer, or if the desired print device(s) are
network printers, additional steps must be taken to ensure FuelsManager can
utilize the device.

Using a Network Printer

In all but a few cases, FuelsManager will be set up to run as a service under
Windows 2000 or XP. Any application that runs as a service, however, is unable to
enumerate network printers because printers ' belong' to users and not to the
system.

In order for FuelsManager to be able to see a network print device, the printer
must be set up to be accessed as a local port. To accomplish this, create a local
printer (on the local system) that is mapped to the printer to the remote system.
Consult your Microsoft Windows documentation for further information.

ADMO03GVAE1005
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This dialog box can be
obtained by double-
clicking on the
Services icon in the
Control Panel window.

Startup

The user does not “start up” FuelsManager, it launches automatically upon start-
up of the Windows operating system. This system must start before any other
FuelsManager subprogram. The FuelsManager system can run regardless of
whether a User is logged onto the system. As long as the computer is on,
FuelsManager can run in the background.

During installation, the FuelsManager system was configured to run as a service
and placed in Automatic mode. The following Services dialog box lists all Windows
services.

*4 Services

File  Action  Miew Help

W ERR @ o= w

1By Services (Local) %, Services (Local) I
FMSystemManager Mame J Description | Status | Startup Tvpe | Log On As \ B
% Distributed Link Tra.,. Maintains ...  Started Autornatic Lacal System
%;%;Rig:’:ﬁm 8y Distribured Transac...  Coordinate, . Marual Metwork ...
S %DNS Client Resolvesa,.. Started Autornatic Metwork 5...
%Errur Reporting Ser...  Allows erra,.,  Started Autornatic Lacal System
Event Log Enables ev...  Started Automatic Local System
%Fast User Switching... Provides m... Manual Local System
Fax Enables yo... Autornatic Lacal System
4 FMarchiveManager Manual Local System
4 FMCommManager Manual Local System
%FMDataManager Manual Lacal System
8 FMLogServer Manual Local System
4 FMR eportManager Manual Local Syskem
% ger Started  Automatic T
84 FTP Publishing Provides F.., Started  Automatic Local System
%Fu:&\sMaTager Gur, [ M LocalSystem

*\ Extended 4 Standard

After loading and initializing shared system resources, FMSystemManager starts
up subsystems such as FMDataManager, FMCommManager, and
FMReportManager. The selection of subsystems depends on the local
FuelsManager configuration. Refer to the Setting Subsystem Run Modes.
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Stopping FuelsManager

Under some circumstances, your Varec representative may request that you stop
FuelsManager. You can stop the FuelsManager service from the Services item in
the Control Panel.

.

Step-By-Step

From Windows, click the Start button. The Start menu displays
Select Control Panel. The Control Panel dialog box appears
Double-click the Administrative Tools icon

Double-click the Services icon in the Administrative Tools dialog box. The
Services dialog box appears

Select FMSystemManager
Select Stop from the Actions menu bar

ADMO03GVAE1005
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Additional Configuration

Once a new install is completed, the Administrator must then configure the
database and security for the following items
» Confirm system and network setup

« Configure the database: Create and define Tank, Input, Output, and Triggered
points, assigning alarms to database points

» Define system resources such as products, tank sizes, and string names
» Create connections between the database and field devices

« Configure communications interfaces and field devices

» Create graphics to be displayed in Operate

» Create reports to be displayed in Operate and printed to hard copy

» Configure security: Define Users and assign to Groups, create and assign
Alarms and Tag
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What is FuelsManager software?

FuelsManager is an advanced Inventory Management software product for tank
farms, terminals, pipelines and other management facilities. This system runs
under either the Microsoft Windows 2000 or XP operating systems. These multi-
tasking 32-bit operating systems allow for complete Client/Server applications.
FuelsManager operates on a single PC, or as part of a network, and is available in
Workstation or Server configurations.

FuelsManager enables users to integrate all major types of tank level and mass
measurement instruments, including float, radar, servo, hydrostatic, intelligent,
magnetostrictive and hybrid tank gauges, into one system. Storage tank
parameters such as level, temperature, gross and net standard volumes are
displayed at the local operator workstation. In addition, FuelsManager can be
networked with other PC or Host Computer systems.

FuelsManager enables the operator to view the facility using real-time Graphic

Displays.

Faruelsmtanager - Dperate - [Tank Detad ; \SUTCLINELE ST a0k 5T skiPoint]

S|

D isplay_Alarm Pork Tools Trond Window Help =18] %]
Tank [EeH.TankiS TankPolne | E F El M ge
informa Description | KIS ueistianager
Tank information — Description
Product =« | [oNE
=tdansar e ik e e
- Loval el N-m-16ith Tank Comimand Moda Sot _
Data field T/28/000 33437 Transfar Moda PR nective]
PPN 41915 Ginment Tank Mode [ Innctive |
Measured values Watar Lavel £ fioin- 1Bt Curront Transfor Status. | Inactive |
712712000 4:20:31 Transfer Shutdown | 000 |
ity Pl o P Advisory Setpolnt | R
7280000 93503 Transforred Volume T
SET button P o B Time Remaining ]
Standard Density AP R _ A (US)
[t Yok e
Total Obswrvad Volums - TOV — gal (US)
Watar Valama. - FW. N LU 56.00.00 |
CromsViluine G0V =~ Ly — o]
|:Calculated values tot Standard votume - sy [ I - o
Povailalshe Product — gal (LIS
Famating o TN
wmaining Capaity sl (US) )
" 732024
Alarm tool bar i it
| UnAck Alams 0|

Above - A typical Tank
Detail graphic display
shown in Operate

With FuelsManager, the operator can control and view all activities and product
movements using windows that display the status of the facility with continuous
data (real-time data). The system can be used as a total management software
system for monitoring and controlling of all pumps, valves, motors, mixers and

other equipment for product receipt, storage and dispensing.

The system contains fuels management-specific functionality and can support
most major manufacturers’ tank gauging systems and other terminal automation
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equipment. The system can monitor levels, temperatures, alarms, volumes, flow,
and other variables for up to 2000 tanks.

Real-Time Database

FuelsManager maintains a real-time memory-resident database consisting of
input values, calculated values and operator-entered values. The system supplied
is completely pre configured to fully support the required functions. Refer to the
Database chapter for procedures on editing the database.

The FuelsManager Real-Time database offers the following features:

* Volume Calculations

e Multiple Users

* Multiple databases

* On-Line Configuration

e Alarms

» Events and Event logging

e Trends

« On-Line help
Volume Calculations
FuelsManager performs automatic database calculations (specified engineering
units) based on changes to database point values. Changes may be due to

receipt of new input data from external sources, other database calculations, or
timed events.

FuelsManager includes a comprehensive set of tank volume calculations for
storage tank data. To review correctional methods used to calculate tank data,
refer to the Tank Calculations chapter.

Multiple Users
FuelsManager supports simultaneous access to configuration data for multiple

users. It maintains database integrity by locking database points that are currently
selected for modification.

Multiple Databases
Each machine has its own database and data management system (called

FMDataManager). No more than one database can be created on a single
machine, but users can access databases from other network machines.

On-Line Configuration
FuelsManager also allows users with the correct privileges to configure local or

networked DataManagers. The user can configure the database while
FMDataManager is active and fully operational, as On-line Configuration does not
interfere with normal real-time database functions.

Alarms
Alarms can be set in FuelsManager that essentially compare a current database

value against preset conditions. If an Alarm is defined for a database value, the
comparison will be made each time the value changes. Each Alarm has an

associated priority that may be indicated by a distinctive audible tone and color,
and user access to alarm groups may be restricted through the Security setup.

All alarms, returns to normal, and acknowledgements are automatically logged to
a daily alarm and event log disk file and the system can be configured to
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automatically generate a printout. Refer to chapters on FuelsManager
Configuration and Reports for further Alarm and Security information.

Events And Event Logging
Events are based on changes to a database value by a defined amount or by

operator command. All Events are automatically logged to a daily alarm and event
log disk file and can be configured to automatically generate a printout to a
specified printer.

Trends
Trends present data in a time-versus-magnitude format simulating a conventional
strip chart recorder.

On-line Help

Several forms of Help are provided to maximize operator proficiency. User-defined
Help files may be created and then linked to graphics displays and alarms. Refer
to the chapter on Administrative Operations for more information.
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FuelsManager System Architecture

The FuelsManager System consists of an integrated client/server architecture of
applications and services that interact using the Windows 2000 or XP operating
systems. This section describes the functions provided by each of these programs
as well as the interaction between them.

The FuelsManager server architecture services include
* FMSystemManager
* FMDataManager
« FMCommManager
* FMReportManager
* FMArchiveManager

The Client applications include

« FuelsManager Configuration Note! refer to the following

« Operate sections for illustrations of the
p Client applications

* Report

e Draw
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FuelsManager Services
FMSystemManager

FMSystemManager performs master initialization and scheduling for the
FuelsManager System. It starts up the previously mentioned server programs on
its local machine. In addition, it provides shared system resources (Coded
Variables, Maodifiers, Engineering Units Strings, Products, Graphic File Names,
Help File Names, and up to 16 sets of User Defined String tables) and services
that are used by all FuelsManager programs.

Each machine contains FMSystemManager, which must be started before any
other FuelsManager program. FuelsManager can be set up to start
FMSystemManager manually or as a service. When started as a service,
FMSystemManager automatically starts when Windows opens. It also executes
under the SYSTEM account, so it is not necessary for a user to be logged into the
system for FMSystemManager to execute.

System Start-up
After loading and initializing the shared system resources, FMSystemManager

then starts up programs such as FMDataManager, FMCommManager,
ArchiveManager, and ReportManager. The selection of programs depends on the
local FuelsManager configuration. The startup mode of each program can be
configured using the FuelsManager Configuration application.

System Shutdown
Shutting down FMSystemManager closes all FuelsManager programs such as the
FMDataManager, FMCommManager, ArchiveManager, and the ReportManager.

System Resources

As mentioned previously, FMSystemManager manages certain system resources
that are maintained in files. These files may be managed independently on each
computer or cooperatively for a network of computers. The SERVER value under
HKEY_LOCAL_MACHINE\Software\FuelsManager in the registry controls this
functionality. System Manager accomplishes this by using either Independent
system files or Master system files.

Independent System Files

By default, the local computer independently maintains all system resource files.
The SERVER registry key contains the local computer system name.
Configuration changes are applied to the local files and are not visible to other
FuelsManager stations on a Local Area Network (LAN).

The default ‘Independent’ method is normally used for single computer
FuelsManager systems. This method is also used when interconnected systems
are using different languages or when the client computer is connected to the
main FuelsManager system using low-speed serial communications.

Master System Files
Under this method, a master server maintains multiple computer systems. The

SERVER registry key contains the master server’s computer name. All
configuration changes to shared resources are directed to the master server
instead of the local system.

During start-up, the FMSystemManager on each FuelsManager computer loads
system files. If the registry designates another computer as the server, a link to
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the server is established so that all changes to the system shared resources are
updated on the local computer. If the local computer is the master system server,
additional functions are used to transmit changes to all Client computers.
Maintaining local disk images of shared resources ensures that a viable image of
all shared resources is available even if the designated server is temporarily
unavailable. Any changes to shared resources are automatically updated to local
storage when the server is available.

DataManager

The FMDataManager service maintains real-time process data and provides
highly efficient, event-driven communications with other FuelsManager programs
for data acquisition.

DataManager functions
« Provides security functions to limit user interaction with the database based

on Windows 2000/XP and FuelsManager Configuration Accounts
« Provides the means to create and modify the system database

» Updates data values upon requests from the FMCommManager or the user
interface programs

» Performs functions to detect and report alarms and events related to changes
in the database

« Performs database calculations based on changes to the database.

» Performs Server functions to provide process data upon request from the
user interface programs and FMCommManager. Real-time data can be
provided to other FuelsManager or third party programs using industry
standard protocols

Database storage

Process data is stored in a real-time data array. Each real-time data value entry
includes the current value, time stamp, and status. Each process data item is
associated with a point and each point within the database is assigned a unique
name of up to four fields.

Database time

For data received from an FMCommManager, the time stamp is established when
data is received from the field device. For values calculated in the database, the
database time stamp is based on the latest calculation. The format is expressed in
seconds and milliseconds and is stored in Greenwich Mean Time. This time is
available for assignments in graphics and reports and is also viewed in the
Operate program. All displays and reports correct to local time.

CommManager

This program controls communications with all field instrumentation and provides
updated process data to the FMDataManager. The CommManager acquires data
from remote devices and communicates this data to FMDataManager. The
CommManager also loads, initializes, and supervises individual device interface
modules.

CommManager Functions
 Allocates hardware ports to devices based on system configuration

» Loads and manages interfaces based on configured field devices
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» Performs hardware configuration, protocol translation and data conversion
functions required to support the device. These functions may also include
downloads and uploads from the field device

« Converts device data from all field devices for transmission to the
FMDataManager. The CommManager may poll the field devices or accept
unsolicited data from the devices based on device capabilities Translation
may include simple data type conversion, engineering units’ conversion, or
more complex calculations such as tank calculations

* Relays information from the device to the FMDataManager upon changes to
device dynamic data

« Transmits data to field devices by processing output requests from the
FMDataManager

ReportManager

This program controls the scheduling of reports according to the print times
specified when each report is created. Alarm/Event reports are categorized into
Alarm Groups. Each Alarm Group is scheduled to print at a specific time and
interval. If no alarms or events occurred within the interval, a report will still be
printed indicating that no alarms or events occurred during the interval.

ArchiveManager

This program controls the extraction of information from FMDataManager and
stores it to an alternate data source, usually a third party ODBC compliant
relational database.
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The FuelsManager
Configuration
application appears as
a window containing a
menu bar:

FuelsManager Applications

FuelsManager can be configured and maintained through several Windows-based
user applications: FuelsManager Configuration, Operate, Draw and Report.

FuelsManager Configuration

The FuelsManager Configuration application is used to configure, maintain, and
administrate all FuelsManager specifications such as real-time database
configuration and device communications.

The FuelsManager Configuration application is for top-level users such as
administrators and maintenance personnel, and is used for administration of the
FuelsManager application suite.

The user can define start-up options, access, define resources, configure the
database points and alarms, configure or maintain the FMDataManager and
CommManager. Security can be accessed to set up users and groups, and control
data access. FuelsManager Configuration also provides access to the Operate,
Report, and Draw applications from the User Interface menu.

£ FuelsManager Configuration T
Systern  Resources Database Communications User Interface Movement Help

Fuelsl“lflnflggEr;E -

Operate

The FuelsManager Operate application allows an operator to track and monitor
and/or control all activity and product movements.

The Operate program is intended for operations personnel, and can be configured
with a login script to start automatically upon user log. The Operate program lets
the operator interact with the facility during run-time. It provides dynamic
interaction with the FuelsManager database. In Operate, the operator can monitor
and control equipment through the use of real-time graphics, reports, and other
windows.

The operator can also manage alarms and view trends. Other functions may
include monitoring database points and responding to data by issuing commands.
Refer to the Operate chapter for more information.
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Draw

Graphics are color graphic images that show the dynamic status of the system.
The Draw application lets users create new graphics and symbols or edit existing
graphics and symbols for use with the The Operate program.

Your FuelsManager system package contains several predefined graphics used to
monitor and control the facility.

FuelsManager includes a program called Draw. With Draw users can create and
modify graphics. When opened in the Operate program, these graphics display
the real-time data of the selected points. Refer to the Using the Draw application
chapter for more information.

Select Operation
NEEEEEREEEETB 0

Rep (0] I’t The Draw application

. . _ . Ib
FuelsManager provides the Report program, which controls all printing functions. toolbar

The Report program lets users define new reports or edit existing reports that
display real-time values or events.

Reports may be configured to print on demand, at a specific time or periodically. In
the Operate program, the user can view, print, and save these on-screen reports.

Your FuelsManager package may contain several predefined reports. Refer to the
Report chapter for more information.
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System Name
selection

Select FuelsManager
System dialog

Selecting remote FuelsManager systems

The FuelsManager interface allows the user to select other available
FuelsManager databases on the network. This gives the ability to remotely

configure systems over a network.

This can be done from many different dialogs within FuelsManager. Whenever
you see a System button, or a Select button within a System or System Name

group, you can select a different database.

Select. .

Systemn Mame

Lo

Select FuelsManager System

System: [WTESTWETS

FuelsManager Systems

VHELPDESK-XP-2
WIFLA,

MEMART

WTAS
WTESTWWETS
ALINDERM

Dizplay Options
¥ Show LAN Servers

[~ Show TCPAP Servers

Select | Cancel
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Note! It is important to note that all
FuelsManager users must be
defined as Windows users on the
system running the application. If
Users are not already set up, refer
to Windows 2000 or XP
documentation.

The security dialog box
has three menu
options when it is
open: Actions, View
and W&M
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Microsoft Windows and FuelsManager security

FuelsManager security extends the Microsoft Windows security model by
providing additional security privileges specific to the process of fuels
management. FuelsManager security lets you:

Create users and user groups

Assign appropriate security privileges to user groups

Create alarm categories to manage which alarms get annunciated to which
groups of users

Create tag categories to manage which database points are accessible to
which groups of users

Set up an optional audit trail to assist in monitoring configuration changes
made by users.

Security. [EJ

Actions  Yiew  WEaM

=] Mame |
[# Categories

-+ & Groups

ﬂ Uszers

iy Auit

Opening the Security Window
Step-by-Step
* From the FuelsManager Defense Configuration window, click the System

menu.

» Select Security. The Security window opens.
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ADD

DELETE

RENAME

PROPERTIES

CLOSE

View Menu

LARGE
ICONS

SMALL
ICONS

LIST

DETAILS
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Actions
Add
Delete
Renarme
Froperties

Claze

Actions Menu

The Add command allows the administrator to add a user,
group, tag, or an alarm according to what section is selected in
the security dialog box

The Delete command allows the administrator to delete a user,
group, tag, or an alarm according to what section is selected in
the security dialog box

The Rename command allows the administrator to rename a
user, group, tag, or an alarm according to what section is
selected in the security dialog box

The Properties command allows the administrator to define the
properties of a user, group, or an alarm category according to
what section is selected in the security dialog box

The Close command will close the Security dialog box
completely

[iew
Large |cons
Small lcons
Ligt
v Details

The Large Icons command will make all of the icons in the right
hand window appear large

The Small Icons command will make all of the icons in the right
hand window appear small

The List command will arranges the elements, in a column, in the
right hand window. Small Icons will be shown next to each
element and no details will be displayed

The Details command will arranges the elements, in a column, in
the right hand window. Small Icons will be shown next to each
element along with any applicable details

The Actions menu
includes the options to
add, delete, rename,
properties or close

The View menu allows
the users to change
the way elements are
displayed in the
security dialog box
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Note! The process of defining
which database points are in which
alarm / tag category takes places
as part of database configuration
and is detailed in the Database
section.
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Categories

FuelsManager provides two types of categories, alarms and tags.

Alarm categories allow the administrator to designate which alarms a particular
user group will be notified of. In addition, the administrator can designate which
printer alarms of a particular category should be printed to. For larger systems it is
important to categorize alarms such that only the users with responsibility for a
particular area of the facility are notified of alarms for that area. Without this
categorization users would be consistently bothered by ‘nuisance’ alarms for
areas over which they have no control.

Tag categories allow the administrator to further segregate the FuelsManager
system by defining which database points a particular user groups can see. In this
manner the administrator can deploy a system with a central database containing
all tanks for the entire facility, but then segregate the tanks based on logical areas
of plant (i.e. West Tank Farm, East Tank Farm and Docks).

FuelsManager allows the creation of up to 32 alarm and 32 tag categories. Once
defined alarm and tag categories are assigned to a user group, under the Access
branch, and only users in those groups have access to the tags in the categories.
Categories can be assigned to more than one group, allowing an overlapping of
alarm and tag categories. From our example above, we created categories for
West Tank Farm, East Tank Farm and Docks — typically these might be assigned
to user groups of the same name. We could then create another user group called
Managers and assign all three categories to this group. In this way the Managers
user group would be able to see all tanks across the entire facility.

Working with Alarm Categories
Alarms can have a defined report manager, printer, start time, print interval, and
the choice to enable the print.

Creating, Deleting or Renaming Alarm Categories
In this example we will Create an alarm, but you can also follow the instructions to
delete or rename an alarm.

Step-By-Step
» Click to expand the Categories tree
¢ Select Alarm under the Categories
¢ From the Actions menu select the Add command
¢ Enter the name of the alarm
* Close the Security dialog box
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Security.
Actions  Miew  WEM

X

Security
=] ﬁ Categories
4:E Alarm
) Tag
# & Groups
ﬂ Uszers
g At

[ame ] Report Manager I Printer I Start Time i |
FEDefaut 0000 I
3 00:00 [

£

%
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The security dialog box
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Alarm Properties
dialog box can be used
to create delete or
rename Security Alarm
settings

Defining Alarm Category Properties
The properties of the alarm category define which server will be used to print
alarms for this category and printer settings, such as print time and print intervals.

Step-By-Step

Click to expand the Categories tree

Select Alarm under Categories and click on the category name from the
right window to define its properties

From the Actions menu select the Properties command
The properties dialog box appears

Enter in the name of the server or click on the button next to the Report
Manager box to browse for servers

Select a printer via drop down box or by typing in the name of printer

In the Start Time field, enter the time of day that the alarms in this category
should print. Or in the Print Interval field, enter the number of minutes
between periodic printings of alarms in this category

Select Print Enabled to activate alarm printing
Click OK or Apply to have the properties stored for the alarm
Close the Security dialog box

Use the Start time Field in conjunction with the Print Interval field to synchronize
what time periodic print outs will occur. For example, set Start Time to 00:10 and
print interval to 60 minutes to have alarms for the category printed

Alarm Properties - Security;Categories ;Alarm;NewalarmCa...

General
Report Manager : || _J
Prirter : | ﬂ
Start Time : ’W hb:mim
Frint Interval : IU— minutes

Print Enabled: H

ok | Cancel
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Creating, Deleting or Renaming Tag Categories

In this example we will Delete a Tag Category, but you can also follow the
instructions to Create or rename a Tag.

Step-By-Step
» Click on + next to Categories to expand the tree structure
¢ Select Tag under the Categories
» Click on the tag name that is to be deleted from the Tag listing
e From the Actions menu select the Delete command
¢ Close the Security dialog box

Security. [gj

Actions  Yiew  WEM

= ‘a\ﬁgcurﬂy Maime |
= Categoties Diefautt
4:[5 Alarm s
1 Tag
[+ & Groups
ﬂ Users
e At
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The security dialog box
can be used to create
delete or rename
Security Tag settings
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Note! Users are only allowed to
belong to one user group.

Note! To be added to
FuelsManager the user must also
exist as a Windows user — the
particular Windows user group and
permissions assigned to that group
do not matter.

Note! A complete list of system
and tag permissions is provided
later in this section.
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Users and Groups

FuelsManager follows the typical user and user group security model. The system
administrator creates user groups and assigns privileges to these groups that
restrict the specific FuelsManager features that the group is allowed to access.
The administrator then assigns users to these groups. Users assigned to a user
group can access the FuelsManager features defined for the group.

By default FuelsManager provides two preconfigured user groups: Operator and
Administrator. It is possible to create new user groups to build a security model
that matches the needs of the particular facility.

In addition to defining which categories the user group can access (see above),
the administrator can control the specific system features a user group has access
to. These privileges are divided into two sections:

« System permissions — these apply to the overall FuelsManager system and
control general access to features like configuring the database or deleting
database points.

« Tag permissions — these apply to previously defined tag categories and
control access to features specific to a database point like setting the level
high-high alarm limit or executing a gauge command.

Creating and Editing Users

User accounts can be created in the Security dialog box. Once the FuelsManager
user account is created, the user can then be added to a User Group.
Furthermore, the administrator can delete, rename or define properties for the
user.

Administrator Manual



Users and Groups

Creating, Deleting or Renaming a User
Step-By-Step
¢ Click on the Users icon to display a list of users in the right side window

¢ This list contains all the FuelsManager users and their corresponding
groups. FuelsManager is capable of supporting fifty (50) different users.

¢ From the Actions menu select the Add command
« Enter the case-sensitive user name, as it appears in Windows

¢ Close the Security dialog box

S : = Note! To select multiple users to
ECurity = delete simultaneously use the

Wiew WM <Ctrl> key in conjunction with the
add mouse to highlight all users
% Name Full Name | Description | Group | desired to be deleted.
Renam dories i Administrator Administrator
Properties P i§3 sizemare Administrator
k=3

Close t

The security dialog
box: Action menu
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Note! The properties that are
defined within the FuelsManager
program are not linked to any of
the user information defined in the
system. Refer to your Windows
documentation for further
instruction.

Note! When a new group is
created, the permissions default to
Operator group rights.

Note! The groups within
FuelsManager are Not linked to
the groups in Windows XP or
2000.
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Defining User Properties
Further details for each individual user can be added through the Properties

dialog. This allows the entry of the user’s full name and other details to help
describe the user.

Step-By-Step
» Click on the Users icon to display a list of users in the right side window
¢ Select the user you wish to modify from the User list
* From the Actions menu select the Properties command
« The User Properties dialog box appears
« Type in the user’s Full Name and Details in the corresponding fields
» Click OK or APPLY to apply changes.

Creating and Editing User Groups

Creating, Deleting or Renaming a Group

Once a group has been created; users, permissions, alarms, and tags can be
modified for the group along with deleting and renaming the group. In this example
we will Rename a Group, but you can also follow the instructions to Create or
Delete a Group.

Step-By-Step
¢ Click on Groups icon
* Click on the group name that is to be renamed in the Groups listing
¢ From the Actions menu select the Rename command
¢ Enter a new name for the Group
¢ Close the Security dialog box
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The security dialog box
can be used to create
delete or rename
Security Group

Security I Name I Description I settings
0 Categaries & Operator
EfE Groups 3 Administrator
Oper.a?or & e Groupr]
Administratar
N e Group
o EE Users
] At

Adding Users to a Group )
A user can be added to a group once the group exists. A user does not have Note! The user can only belong to

already exist under the Users option in order to be added to a group. When the one group.
user is added to a group, the user name will automatically by added to the list
under Users.

Steps-By-Steps

» Click on the + next to the Groups icon to expand the tree structure
Click on the group name that the user will be added to
From the Actions menu select the Add command

* Enter a name for the new user
Close the Security dialog box

ADMO03GVAE1005 41



FuelsManager Defense

42

Access

Alarm and Tag Selection
In this example we will Assign alarm categories to a Group, but you can also
follow the instructions to Assign Tag categories to a Group.

Step-By-Step

Click on the + next to the Groups icon to expand the tree structure
Click on the + next to the group name under the Groups icon
Click on the + next to Access under the group name

Click on the Alarm icon under the Access expanded tree structure

In the right side window click in the check box next to the alarm categories
that the group will have access to

A check next to the alarm name indicates that there is access to the alarm. If
there is not a check mark next to the alarm, the group will not have any
access to the alarm

Close the Security dialog box

Permissions

System and Tag Permissions
In this example we will modify the System permissions for a Group, but you can
also follow these steps to modify Tag permissions for a Group.

Step-By-Step

Click on the + next to the Groups icon to expand the tree structure
Click on the + next to the group name under the Groups icon
Click on the + next to Permissions under the group name

Click on the System icon under the Permissions expanded tree

In the right window, check or uncheck the permissions as required
Close the Security dialog box
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Permissions
System Permission

CONFIGURE DATABASE

CONFIGURE ALARMS

CONFIGURE
ARCHIVEMANAGER

CONFIGURE
COMMUNICATIONS

CONFIGURE SYSTEM
RESOURCES

CONFIGURE SECURITY

CONFIGURE AUDITING

CONFIGURE ALARM
CATEGORIES

CONFIGURE STARTUP
OPTIONS

CONFIGURE GRAPHICS*
CONFIGURE REPORTS*
CONFIGURE GROUPS*

CONFIGURE GROUPS
FORMAT

CONFIGURE
MOVEMENTS*

COMMUNICATIONS
MAINTENANCE*
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Description

Configure the database while running
FuelsManager. These changes are instantly
configured into the database

Configure global alarm definitions in
FMDataManager

Configure Archive Manager for start times,
intervals, and historical periods for data to be
archived

Configure the CommManager only for the
interface device, description, and communication
port

Configure the products, strings, coded variables,
modifiers, graphic file names, and help file names
resources

Configure the tag category and the access
selection for alarms and tags of groups. Configure
the system and tag permissions. Configure Users
and Groups. Configure alarm category and audit
are not available under this option

Configure Audit permissions

Configure Alarm category within security.

Configure Startup Options for the system like what
sub-systems are active, standby, or shutdown

Configure any graphics
Configure any reports

Configure the tank groups within Operate. It is
possible to create a new tank group template

Modify the format of existing tank group displays
(add, delete, insert and modify columns; select
column units; set column headings; add tanks;
remove tanks; set tank data)

Configure new product movement paths via the
Operate program. Without this user right all new
movement paths must be configure via the
FuelsManager Configuration application

Configure the communications maintenance
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System Permission

GRAPHICS ACCESS*

OVERRIDE DATABASE
VALUE

ACKNOWLEDGE LOCAL
ALARMS*

ACKNOWLEDGEREMOTE
ALARMS*

GLOBAL SILENCE
AUDIBLE*

CONFIGURE HISTORICAL
TREND*

CONFIGURE REALTIME
TREND*

PRINT DISPLAY*
CONFIGURE MACROS*
EXECUTE MACROS*
ADD DATABASE POINTS
EDIT DATABASE POINTS

COPY DATABASE POINTS

RENAME DATABASE
POINTS

DELETE DATABASE
POINTS
IMPORT/EXPORT

BROWSE DATABASE*

SETUP MOVEMENTS*

CONFIGURE START
DEFINITIONS

Description

Allow Operate program to open up different
graphics to display

Bypass the database and enter database values
online

Respond to alarm activity in the Operate program
from a local machine

Respond to alarm activity in the Operate program
from the remote server

Silence all alarms in Operate

Configure the historical trend data for the graphical
display of the trend and of what points to graph

Configure the real-time trend data for the graphical
display of the trend and what points to graph

Configure the capabilities to print the display
Record/Delete new macros in Operate
Execute existing macros in Operate
Capable to add database points

Capable to edit database points from original
content

Capable to copy database points

Capable to rename database points

Capable to delete database points

Capable to Import/Export alarm groups from
different data-bases

Browse the point database in Operate to define,
open, or restore any point variable to monitor.
(Defines whether can access the Point menu bar
option)

Configure new product movement paths via the
Operate program. Without this user right all new
movement paths must be configure via the
FuelsManager Configuration application

Configure start definitions within the resources
menu to de-fine functions to run at the start
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System Permission

EXECUTE START
DEFINITIONS

CONFIGURE MOVEMENT
VIEW

CONFIGURE LEAK
DETECTION

RUN LEAK DETECTION
TESTS

*Permissions that are set to
Tag permissions

Actions  Yiew WaM

Description

Execute start definitions in Operate under the

Tools menu

Modify the format of the existing summary. (add,
delete, insert and modify columns; select column

units; set column headings)

Configure the Leak Detection operations in

FuelsManager Configuration

Run Leak Detection tests on your tanks using the

settings that exist in the Configuration

the default for the operator group

= E\E Security

Mame |

+ ﬁ Categories
= & Groups

+ Operstar
= Aciminiztratar
E= @ Access
4:!5 Alarm
D Tay
E= %‘ Permizsions
gﬂ System
= @ Tag
o
@ e TagCategr
ﬂ Users
A Auit

Y
v

[F1%5 volume Correction Data
@ Process Connection Data
A% operations Data

[F1%5 Engineering Data

A% Level HHilLoLo Limit
#1557 Lewvel HighiLowy Limit
A% Tempersture HiHiLoLo Limit
1% Temperature High/Low Limit
145 Density HighiLow Limit
AT Flow HighLow Limit
[F1%5 Lewel Rate HighaLow Limit
A% Pressure HighlLow Limit
175 Movement Deadband
A% Movement Holdott

A% Reverse Flow Holdoft
#1457 Mo Flows Haldoff

M7 Level

[ Temperature

A% vensity

T wemw

#1757 standard Density

A% solicts Level
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The security dialog box
showing a list of
permissions
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User Privilege

Volume Correction Data
Process Connection Data
Operations Data
Engineering Data

Level HiHi/LoLo Limit

Level High/Low Limit*
Temperature HiHi/LoLo Limit
Temperature High/Low Limit*
Density High/Low Limit

Flow High/Low Limit*

Level Rate High/Low Limit*
Pressure High/Low Limit

Movement Deadband*

46

%BSW* Movement Holdoff*
Standard Density* Reverse Flow Holdoff*
Solids Level* No Flow Holdoff*
Water Level* Level

Density Temperature Temperature

Gas Density* Density*

Correction Factors Volumes

Ambient Temperature* Mass

Vapor Temperature Rates

Vapor Pressure Gauge Status/Alarm
Gauge Command* Tank/Transfer Status
Tank Mode* Transfer*

Configure Tank Product

*Permissions that are set to the default for the operator group
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Audit

The FuelsManager audit feature allows the administrator to track when and by
whom configuration changes are made. Once enabled, changes made to the

audited parameters are logged to the Windows Event log under a FuelsManager

specific log called FM Audit. The audit log is useful in tracking down what
parameters have been changed when diagnosing a problem. FuelsManager
provides the ability to turn audit logging on and off for six areas of configuration

data.

Reviewing the Event Log

Step-By-Step

* Select Event Viewer
¢ Select FM Audit

Audit Categories

CHANGES TO TAG
CONFIGURATION

CHANGES TO GROUP
PERMISSIONS

CHANGES TO USERS

CHANGES TO GROUPS

CHANGES TO W&M
CALIBRATION SEALS

CHANGES TO W&M
MODULE SEALS

ADMO03GVAE1005

* Open the Windows Control Panel from the Settings menu

» Select Administrative Tools

» Select Computer Management

¢ Click on the + next to System Tools to expand the tree structure

Monitor and record any changes made to the
configurations of any tag

Monitor and record any changes made to the
permissions of any group

Monitor and record any changes made to the list
of Users

Monitor and record any changes made to the list
of Groups

Monitor and record any changes made to the
W&M Calibration Seals

Monitor and record any changes made to the
W&M Module Seals

Note! It is recommended that the
audit log only be enabled after
FuelsManager configuration is
complete. Enabling this feature
during configuration will result in
many useless log entries.
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The FuelsManager
Configuration
application appears as
a window containing a
menu bar

Working with Configuration

Top-level users such as administrators, system engineers, and maintenance
personnel use the Configuration application to configure and control the
FuelsManager system.

Configuration and control features include defining start-up options,
FuelsManager users, system resources, and configuring database points, alarms,
and field device interfaces. Other features include maintaining field
communications and accessing the Operate, Report, and Draw applications.
Opening Configuration

Step-by-Step

¢ From Windows, click Start and select Programs

» Select FuelsManager folder

» Select Configuration

« The FuelsManager Configuration application window appears

2 FuelsManager Configuration

System Resources Database Communications User Inkerface  Mowvement  Help

Exiting Configuration
Step-by-Step
¢ From the System menu select the Exit command
¢ The Configuration dialog box closes
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Setting subsystem run modes

This section lets you start and stop the different FuelsManager services. It also
lets you set which of these services should automatically start when

FMSystemManager starts.

System Control Options
— System Mame

LYoo

Select Subsystem

Mame Status

Select...

Startup

—System Serial Mumber

300-055-3520

Project Directary

Shutdown i
Shutdown Io

Archivelanacger
Commbdanager
Dtz SEr

Reporthanager

Mol
Shutdown Ilo

Datatanager
Current Mode
7 Shutdown  © Standby o At
Auto Start Mode
% Mone i Standby " Act

]

i | CProgram Files'FuelzhanagerFl

ne
ne Defautt Tank Detail
ne

| C:\Program Files\FuelsManager'Fl Browwse...

Graphics Directory

e | CProgram Files\FuelsManager'Fl Brovwse...

Reports Directory

e Browse...

EE L

| CProgram Files'FuelshManagerFl

Cancel ‘

System Selection

FuelsManager Configuration can be used to configure the local FuelsManager

application or a remote Fue

IsManager on the LAN or WAN. Nearly all

FuelsManager Configuration dialogs contain a System Name field and a Select or
Browse button that allows you to pick which FuelsManager system is to be

configured. In this case, the

user can select a different server on the network by

clicking Select, which opens the Select FuelsManager System dialog. Then

choose a different system a

Select FuelsManager System

System: [WESTWS15

FuelsManager Systems

nd click Select.

X

WHELPDESK-XP-2
WFLA

WEMART

WTAS
WIESTWS15
WAUNDERM

Dizplay Cptions
¥ Show LAN Servers
[~ Show TCPAP Servers

Select |

Cancel
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Note! Setting subsystem run
modes must be done after a new
installation. The system defaults
everything to shutdown and none.

Note! The Select FuelsManager
System dialog only displays active
FuelsManager installations. If your
system is not listed, make sure the
appropriate ‘manager’ is active.

Select FuelsManager
System dialog box
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Note! You can also select the
directories the system uses to
store and access FuelsManager
files. These selections are
described in the Setting Up
FuelsManager File Directories.
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Current Mode

The Current Mode options let the user change the current operating mode.
Selecting Shutdown, Standby or Active immediately changes that subsystem’s

mode
Auto Start Mode

The Auto Start Mode option allows the user to select an automatic startup mode
for each of the subsystems. The user can select None, Standby or Active. For
example, suppose Active is selected for the FMDataManager. If FuelsManager
shuts down and then restarts, the FMDataManager starts up in the Active mode.

If a remote system is selected, the Startup Options dialog box displays the defined
attributes of that system. Selecting a different system only allows the user to set
the system options; this does not change the local FuelsManager Configuration

application.

Shutdown
Mode

ARCHIVEMANA
GER

DATAMANAGER

COMMMANAGE
R

REPORTMANAG
ER

Standby Mode

Effect

The system is not archiving data into the ArchiveManager
database

User cannot configure the system database

User cannot configure the communication interface. Any
associated 1/O points are not available for data transfer to or
from the database

Reports cannot be opened in Operate program. Report is still
enabled for creating and editing reports

Effect

ARCHIVEMANA The system is not archiving data into the ArchiveManager

GER database, just like Shutdown Mode

DATAMANAGER Database is available for configuration. Cannot configure for
real-time data

COMMMANAGE CommManager and all of its interfaces are available for

R configuration. All interfaces are forced into this mode.
Cannot configure for field data

REPORTMANAG Reports are available for configuration. Reports can be

ER opened in Operate program

Active Mode Effect

ARCHIVEMANAGER The system archives data into the ArchiveManager

database
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Active Mode

DATAMANAGER

COMMMANAGER

REPORTMANAGER

ADMO03GVAE1005

Effect

Real-time data is available to all subprograms and
subsystems

Data passes between the configured database point
variables and the field device(s)

Reports are available for configuration. Reports can
be opened in Operate program
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Note! The RTU, Strap, CSV
support subfolders are not
automatically created by
FuelsManager. These folders are
created by your Varec project
engineer.
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FuelsManager file directories

The selected hard drive, subdirectories, and file contents vary according to your
facility requirements.

Program directory (\Program Files\FuelsManager\)

The FuelsManager directory, which is not displayed in the System Control Options
dialog box, contains all the FuelsManager system files. The FuelsManager
directory is always separate from the project directory and it is where the program
was installed.

FM Project (\Program Files\FuelsManager\FMProject)

The FMProject directory is the main directory that stores all the project-specific
files such as CommManager data, database definitions, strapping tables, and
alarm definitions. This directory also contains the Graphic, Report, and other
subdirectories.

Subdirectory Description

Archives Contains Archival and Movement databases when using
MS Access database type

CM_Data Contains communication interface definitions

Csv Contains exported configuration files

Detail Contains all standard and custom tank detail graphics

Graphics Contains all saved and generated graphic and seasonal
files

Log Contains all Alarm and Event logs

Reports Contains all saved and generated report files

RTU Contains RTU Configuration and DVR files

Strap Contains all exported tank strapping tables

Support Contains various other files used to configure your
FuelsManager database

Templates Contains template files for Bitmaps, Databases, example
projects, Graphics, Reports and Symbols

FMTools
The FMTools subdirectory contains FuelsManager applications used to assist in
the configuration of your database.

File Description
Dmp.exe Application used to create a diagnostic file detailing the

FuelsManager application files and the installation
environment
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File Description

FMBakRes.exe Application used to back up the FuelsManager
configuration to a zip file or restore a configuration from a
zip file. This requires Winzip to be installed on the machine

FMSim.exe An OPC client application that can be used to simulate
changing tank values--useful for testing and demonstrating
purposes

FMSysConfig.exe  Used to rename a FuelsManager project that was
developed on one machine name but needs to be
transferred to a PC with a different name

FMSysUpdate An offline utility used to upgrade FuelsManager database
from previous versions to the current version

ViewRTU
The ViewRTU directory in FuelsManager serves as the installation directory of the

ViewRTU software. It includes all ViewRTU system files, drivers and bitmaps.
Setting up file directories
Step-by-Step
« From the Configuration dialog box, select System and click Startup Options
» Click the appropriate Browse button and navigate to the appropriate
directory
* Repeat the previous step until all the fields contain the correct directory path
details, then click OK

ADMO03GVAE1005

Note! Unless absolutely
necessary, it is recommended that
you keep the default file
directories. This will assist Varec
support staff in diagnosing any
problems.
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Product Configuration
dialog box
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Defining system resources

Resources utilized by FuelsManager are defined in the system resources within
the FuelsManager Configuration application. Resources that can be defined are:

e Products

 Strings

» Coded Variables

* Modifiers

» Graphic File Names
» Help File Names
 Start Definitions

Products

Product specifications are created, saved, edited and deleted using the resources
command in the FuelsManager Configuration application. They are saved in the
Product Index which can be accessed during database edit and then assigned to

Tank points.

Creating a new product definition

Step-by-Step

box appears

Product Configuration

Ok

Cancel

Product Server WSIZEMORE Mumber of Entries: B
Product Code Product Description

CRUDE Crude Cil

DERY Diezel Fuel

GAS Gazoling

HOIL Heating Cil

JET Jet A Fuel

TRAMNS Pipeline Transmix

Impott

Export

il

« In the Configuration dialog box, select, select the Products command from
the resources menu. The Product Configuration dialog box appears

» Click Add to create a new a product code. The Edit Product Definition dialog

¢ Enter in the name of the product, description of the product, assignment
options, correction method (if any), and temperature alarms (if any). The
product name can be up to twenty alphanumeric characters and the
description can be up to thirty alphanumeric characters

« Enter any appropriate Assignment Options for the product definition.

¢ Click OK to save the product definition
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> Edit Product Definition
Edit Product Definition @ dialog box

Product Aszsignment Options
Mame (20 chars) Jv Use Correction Method
CRUDE
[T Use Standard Density
Description (30 chars)
| Crude Oil [T Use Temperature Limits
Correction Method Temperature Alarms
Type Specific
| i v [Tabe sasa =]
Standard Temperature Correction Factors
B = W
Standard Density
=ap| ,7
OK | Cancel |

Assignment Options (Product)
In addition to the Name and Description of the Product Definitions, you can also

set the product to use a Correction Method, Standard Density, and Temperature
Limits. You can have different options for each Product.

Assignment Options
[v =ze Correction Method

| Usze Standard Density

[ Usze Tempersture Limits

Selecting one or more of the options above ensures that when a Product is Product Assignment
assigned to a tank point, the corresponding parameters are automatically applied Options - Edit Product
to the tank Definitions dialog

Use Correction Method
Select the Correction Method checkbox when you want to use Correction

Methods. This enables the Type and Specific list boxes. Select the Type of
Correction Method you want to use, then select the Specific method. You may be
required to enter additional data in the Correction Factors fields.

Use Standard Density
Standard Density lets you set the specific density that will be used for the Product.

This enables the Standard Density field so you can enter the appropriate figure.
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Edit Product Definition
- Standard Density
options enabled

Edit Product Definition
- Temperature Limits
options enabled
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Edit Product Definition

Product
Mamme (20 chars)

CRUDE

Description (30 chars)

| crude oi

Correction Method

Specific

Type

Standard Tempersture
MLA&.

Standard Density

]0—' 4P|

Correction Factors

]7
|4
3

o]

Cancel ‘

X

Aszsignment Options

¥ Use Standard Density

[~ Use Temperature Limits

Temperature Alarms

,“7
,+.
‘—' !

Edit Product Definition

Product
Mame (20 chars)

CRUDE

Description (30 chars)

Use Temperature Limits
Temperature Limits let you set specific temperature parameters. You can enter the

specific temperature alarms that you want tied to the product.

| crude oi

Correction Method
Type

Specific

Standard Temperature
MLA&.

Standard Density

[ cam

Correction Factors

Aszsignment Options
[~ Use Correction Method

[ Use Standard Density

¥ Use Temperature Limits

Temperature Alarms

]:J—‘ High-High
]07 High
’07 Loy
’07 Loww-Low
]0— Hald Off
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Importing/exporting product definitions
Product definitions can be imported or exported. Importing allows the use of

product definitions previously defined, while exporting provides a backup of the
product definitions. All files for importing and exporting are comma-delimited text

files (*.csv).

Step-by-Step

¢ In the Product Configuration dialog box, select Import or Export to import/
export a product definition file

« The Choose a File to Import dialog box appears or Export Products dialog
box appears

« Import: Select the file to import in the corresponding directory, and then click
Open

« Export: Select the path to save the file to. Type in a name for the file and
click Save

Strings

User-defined strings are messages that may be used in the Operate program.
These strings, or messages, can be used to instruct an operator to perform a
specific task. FuelsManager provides the user the ability to create User-defined
string types that may be assigned to Input and Output points.

For example, if an alarm becomes active, a message may be displayed instructing
the operator to close a valve. User-defined strings can also be used to display
advisory messages concerning equipment status. For example, a User-defined
string may be used to display Client Names, Client Document Numbers, and
Destinations.

The string appears as a data format type in the database. The User-defined
strings are added to the bottom of the data format list. In the list, the first string
type label is “USEROQ”. Each additional string type is labeled “USER1", “USER2",
etc. The string type name appears next to the label.

There are no standard FuelsManager strings. All strings are user-defined.
FuelsManager allows up to 16 unique User-defined string types.

ADMO03GVAE1005
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Creating strings

Step-by-Step

« In the Configuration dialog box, select the Strings command from the
Resources menu. From the Strings sub-menu select Add Type. The String
Configuration dialog box appears

« Enter the name of the user-defined type. Type in the maximum length of
each string in the Maximum Length dialog box and click Apply. This sets the
maximum number of characters used in each string, which can be no
greater than 80 characters and no less than 1 character

¢ Type the string in the Edit String dialog box

» Click Append to add the string to the list. The string is added to the bottom of
the current list

* Repeat the above steps to add more strings to the list. When all strings have
been entered, click OK

String Configuration
dialog box

String Configuration

User Defined Type

[Matme: |QA Strings
Maximum Length: | 25 Apply

Edit String

Cancel

Remove

Append

@& Department String

Strings: 1 Ertries
1. Q& Department String

HASHEHE.

ImportExport Functions

* Header © Strings Import Export

Deleting or editing a string
Once a String has been defined it will appear in the Strings sub-menu under the

Add Type command.

Step-by-Step

« In the Configuration dialog box, select the Strings command from the
Resources menu. From the Strings sub-menu select the user-defined string
to be modified

¢ The String Configuration dialog box appears

* Use the action buttons within the dialog box to modify the string

String configuration dialog box

APPEND Adds the string in the Edit String text box to the end of the
string list.
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String configuration dialog box

EDIT Allows any of text of the current string selection in the Edit
String text box to be modified.

REPLACE Replace the current string selection with the text in the
Edit String text box.

INSERT Insert a new blank string above the selected string.

CLEAR Clear the current string selection of any text.

DELETE Delete the current string selection from the list
completely.

Importing/exporting string information
User-defined strings can be imported or exported using comma-delimited text files
(*.csv). The header and strings have to be imported/exported separately.

Importing strings

Step-by-Step

< In the Configuration dialog box, select the Strings command from the
Resources menu. From the Strings sub-menu select Add Type. The String
Configuration dialog box appears

¢ Select either Header or String option button. The Header options button
import header information (user-defined name and maximum length). The
String option button imports the string (the list of strings for the user-defined
type)

¢ Click Import

e The Import User String Header or the User String table appears

« Select the file to import and click Open

¢ The String Configuration dialog box displays the Header or String
information imported

Coded variables

Coded Variables are used for input and output processing as well as alarm
processing. Coded Variables can be used to build alarms and to display process
or equipment status on graphics and reports.

FuelsManager allocates the first 512 Coded Variables. These standard Coded
Variables are used for FuelsManager processes and cannot be modified. The
predefined variables include most common process control states including
equipment status, alarm states, months of the year, and equipment commands.

If the list is not sufficient, the user has the ability to create new Coded Variables.
Once created, the Coded Variables are available for assignment in the database.
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Coded Variables
Configuration dialog
box

Note! Standard Coded Variables
cannot be deleted
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Creating a new coded variable

Step-by-Step

« From the Resources menu in the Configuration dialog box, select the Coded
Variables command, the Coded Variables Configuration dialog box appears

« Type in a coded variable name. The name can be up to 15 characters
including any embedded spaces entered, then click Add

* The name appears in the list, click OK
* The Coded Variable is now available for database point assignment

Coded Yariables Configuration @

Coded Yariables List:

Wariable 26 Standard: 337 Custom: 0
Cancel

2 K|

=
AHB Master
AB Slave
Abort

AC Impart
Acknowledged

Active o

e [ e

Coded Variables Configuration dialog box

The Coded Variables Configuration dialog box lists all the variables found in the
system - standard and custom Coded Variables - and the quantity of each type.
The user is able to add or delete custom Coded Variables. Each Coded Variable is
identified by a variable index number as indicated in the Coded Variables
Configuration dialog box.

Deleting a coded variable

Step-by-Step
« In the Coded Variables Configuration dialog box, select the variable to be
deleted from the scroll box so that it appears in the edit box

¢ Click Delete. The coded variable is no longer a part of the list
Importing coded variables ) _
Custom coded variables are the only variables that can be imported or exported.
Step-by-Step
* From the Configuration dialog box, select Resources and click Coded
Variables. The Coded Variables Configuration dialog box appears

¢ Click Import

¢ The Import Coded Variables dialog box appears

e Select the import file and click Open

¢ The system imports the file and returns to the Coded Variable Configuration

dialog box
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Modifiers

Modifiers are a collection of Coded Variables. Modifiers are used to group
commands issued in the Operate application. For example, the “OPEN” and
“CLOSE” command combination is one type of modifier.

The FuelsManager system contains a list of predefined modifiers. FuelsManager
reserves the first 18 modifiers for standard use. Standard modifiers cannot be
edited or deleted by the user, but the user can create custom modifiers. The user
is able to define up to eight commands for a modifier. These commands appear as
selections when the operator issues a command.

Modifiers Configuration dialog box
Modifiers can be created, edited, imported, exported, deleted inserted or replaced
using the action buttons in the Modifiers Configuration dialog box.

Creating a modifier

Step-by-Step

* From the Resources menu in the Configuration dialog box, select the
Modifiers command, the Modifiers Configuration dialog box appears

* Type in the name of the custom modifier and click New

» Select a coded variable from the coded variables selection list and click
Add. Repeat until all coded variables for the custom modifier has been
added to the Contents List

» Click OK to save the changes

Modifiers Configuration Dialog

Standard Modifier
Coded Yariahles Selection List:

Activednactive = B

Mame:

=
AB Master

AB Slave

Ahort

A

Acknowledged

Active

Achy High

Ay Lowy

Aclvizory NG

Ok | Cancel| Impart | t | | I ‘ i |

Graphic file names

Entering a graphic file name as a system resource makes the existing graphic file
available for assignment to Input and Output points in the database. Sometimes
the user may want a particular graphic to appear when the associated database
point alarm becomes active.

Contents List:

Active
Inactive

In the Operate program, the operator selects the graphic button in the Alarm
toolbar or Alarm Summary to display the graphic. This graphic could be a facility
overview or a group of field devices.

Saved and generated graphic files originate from the Draw application. These
graphics are stored in the Graphic Index. The user can view the Graphic Index by
selecting Master and clicking Graphic Index in the Draw application.
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Modifiers Configuration
dialog box
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Graphic Files dialog
box

Graphic Files dialog box
Graphic Files can be added, edited, deleted or replaced using the action buttons

in the Graphic files dialog box.

Graphics Files Configuration

Adding a graphic file name

Step-by-Step

¢ From the Resources menu in the Configuration dialog box, select the
Graphic File Names command, the Graphic Files Configuration dialog box
appears

« Type in the graphic’s file name as it appears in the Graphic Index of the
Draw application. The graphic must have been saved and generated for it to
be available for assignment

e Click Add. The graphic file name is added to the list

¢ Click OK. The file is now available for assignment

Help file names

Entering a help file name as a system resource makes the existing help file
available for different purposes. There are two types of Help files that are
supported: Text Help and Windows Help Format. Help file entries can be assigned
to:

« Input and Output points, in the database, in the Operate program

» Buttons in the Draw application
Input and output points in the database
Sometimes the user may want a particular help file to appear in the Operate
program when the associated database point alarm becomes active. The operator
selects the HELP button in the Alarm toolbar or Alarm Summary to display the
help file. This help file could be used to instruct the operator to perform a
sequence of steps in response to the alarm.

Buttons in the Draw application

Sometimes the user may want a particular help file to appear when the operator
selects a button in a graphic. When creating a graphic in the Draw application, the
user can create buttons or Appends that displays a help file when selected in
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Operate. The user has the option of creating a graphic button as well as a help file
button.

Text help file

This type of help utilizes a user defined text file with the HTX extension. These
files may be created with any text editor such as DOS EDIT or Window Notepad.
These files should not be created with a word processor, since embedded
formatting is not supported. The text file should consist of no more than 80
characters on each line. The length of the file should not exceed 64,000
characters, including spaces.

When the Help Append is selected in Operate, a Help Window will be displayed
with the designated *.HTX file. If the complete file is too large for the window,
scroll bars are provided.

Windows help format
If the Windows Help Format check box in the Select Help File dialog box is
selected, all files with the HLP extension are shown in the File list box.

These files must be created with tools supplied with the Microsoft Software
Development Kit (SDK) or from other vendors. Operate displays these files by
calling the Windows Help program (Winhelp.exe). All features of the Windows
Help system may be included in the user defined *.HLP file.

If you enter a number in the Context text box, the help file will be called with the
designated context number. This context number must be defined in the [MAPS]
section of the project file for the HLP file. Using context numbers allows a single
help (HLP) file for an entire project with different topics assigned unique context
numbers. If the context number is zero, the help file will be called to display the
top-level “Contents” page of the help file. (Refer to your help development system
documentation for details on creating a Windows Help file)

Help Files Configuration dialog box
Graphic Files can be added, edited, deleted or replaced using the action buttons
in the Help Files Configuration dialog box.

Help Files Configuration @

Ediit
QK

Mame : |Strings

Windovws Format: [~ Context: Cancel
Mames Format Contexdt humber
=hone=
Graphics Standard o000 :
Products Standard Qo000
Strings Standard 0ooo0
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Help Files
Configuration dialog
box
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Adding a help file

Step-by-Step
« From the Resources menu in the Configuration dialog box, select the Help
File Names command, the Help Files Configuration dialog box appears

« Type in the Help file name in the edit box
¢ Click Add. The help file name is added to the list
» Click OK. The file is now available for assignment

Start definitions

Start Definitions provides access to other programs through the Operate program.
This allows the Operate program to always be running while users need to use
other programs. For example, you can run Windows Calculator, Excel for
spreadsheet editing, or Notepad for shift logs.

Start Definitions dialol
box g Start Definitions @

Dizplay Mame | Application Definition
Simulator CProgram Files'\FuelsManager FMTools\FMSim exe
Throughput Calcs CProgram Files\FuelsManageriTanks exe
£ >
Al Delete | Upcdzte: |
Display Mame: | Adabe Acrobat Reader
Application: | C:'Program Filesiadobelscrobat 5 0\Acrobatitorobat exe Browse...
Initial Path: |
Parameters: |
OK | Cancel

Start Definitions dialog box

DISPLAY NAME Name of the defined application to be seen in the
Operate program.

APPLICATION Name of the application to run when the display name is
selected in the Operate program.

INITIAL PATH Beginning path of the application.

PARAMETERS Parameters to be passed into the application.
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Creating a start definition
Step-by-Step
* From the Resources menu in the Configuration dialog box, select the Start
Definitions command. The Start Definitions dialog box appears
« Enter the display name, application, initial path, and parameters. Clicking
browse next to Application allows you to locate the application.

¢ Click Add. The new program is then added to the display name list
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Operate application
toolbar includes the
Alarm line

Operate application
includes a complete
Alarm Summary

Alarms

The purpose of Alarms is to notify operators of a significant inventory occurrences
that may require immediate attention. These occurrences are recognized by
datamanager monitoring points and situations that are set to be monitored for
alarms. Administrators can set up criteria for an alarm such as a significant
temperature or level change. When one of those situations occurs, the operator
will be notified of the alarm.

In the Operate program, the operator is notified of an alarm by audible alarms or
flashing, color-coded visuals at the bottom of the Operate window. Alarm Priorities
determine the severity of the alarm and consequently the color and sound
notifications.

‘ Indicator box ‘ ‘ Buttons ‘ ‘Alarm Mode button ‘ ‘ Operator infor ‘

I
A

Dote & Time

ANE2004 auge Tank 14 Level
ANEZ0A (5. [Gouge Tank 14 Level
A1 62004 3 Tanks.Tankd.Gauge Tank 1 Level
Af16R004

A/IE[2004 6:

Af6jzona

A/IG/2004 6

ANEJ2004

4/16/2004 anks. T auge Tank 12 Level

ANG2004 Tankd.Gauge Tank 4 Level

226003 Pump 9 HIHI Temp ALARM HIHI Temperature Alamm Pro
Temp ALARM HIHI Temperature Alarm Pro.

Events

Events are changes to a database point value that are not associated with an
alarm definition but are important enough to be recorded. Examples of events are:

« Operator commands — such as opening a valve or raising a tank gauge

« Value Change (operator) — such as the operator entering a new manual value
for water level or changing a high level alarm setpoint

« Value Change (system) — such as a communication request from another
system, via OPC or a CommManager driver, to change the density value or
issue a command to reset a tank gauge

Alarm & Event Logs

All Alarms and Events are recorded to the same log file and can be viewed via the
FuelsManager Log File Browser feature. FuelsManager creates one alarm and
event file per day. By default this file is written to the following folder:

\Program Files\FuelsManager\FMProject\Log. Alarms and events can be printed
manually, or at specified times depending on the configuration of the Alarm
Category to which the alarms belong (see Security Section)

It is possible to reduce the number of events logged to the event log, by disabling
the logging of events from OPC data sources.
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Step-by-Step

¢ Create the DWORD value ‘LogOPCcommands’ under the following registry
key: HKEY_LOCAL_MACHINE\SOFTWARE\FuelsManager\DataManager

¢ Set the value to one (1) to allow the logging of events from OPC data
sources

_Or_

« Set the value to zero (0) to disable the logging of events from OPC data
sources

Pre-configured alarms

Tank points contain pre-configured alarms that are integrated in the tank point edit
dialog box. Alarm definition includes “enabling” the alarm and entering a value.
Pre-configured alarms are available for certain parameters.

¢ Tank Level « ETA

* Temperature e *Leak Rate

« Density » *Leak Data

¢ Tank Flow ¢ Vapor Pressure

¢ Level Rate ¢ Unauthorized Movement
¢ Tank Mode * Reverse Flow

¢ No Flow

*Applicable to systems using the optional Leak Detection feature

Operate application
provides graphical
representation to the
user for alarms - the
example shows level
alarms

User Defined alarms

If your system requires alarms for additional tank parameters that do not have pre-
configured alarms, the user has the option of creating them. For example, the
water level parameter does not contain an alarm. To compensate, the user first
defines an Input point for water level, and then defines the alarm.

ADMO03GVAE1005
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Alarms for Input and Output points are not pre-configured. The user must create
and define these alarms. User-defined alarms can be one of three forms: Alarm
Templates, Global Alarms or Local Alarms.

Form

ALARM
TEMPLATES

GLOBAL ALARMS

LOCAL ALARMS

Description

Multiple database points requiring alarm limits of the
percentage value, regardless of the minimum and
maximum (i.e., High = 95%, Low = 5%). When applied to a
particular database point, the percentage limits are
translated into actual Alarm setpoints.

Multiple database points requiring alarms based on the
same setpoint.

A database point requiring a unique alarm configuration.
Local alarms are “on the spot” configurations.

Configuring alarms

The Database menu in the FuelsManager Configuration application can be used
to configure alarms. Alarm Templates and Global Alarms are created and edited
using the Alarms menu option. Your system contains several predefined Alarm
Templates and Global Alarms, which are listed below. These alarms cannot be
removed from FuelsManager.

Alarm

ANALOG ALARM

LEAK ALARM

RTU
COMMUNICATION

RTU STATUS

TANK DIGITAL

TANK GAUGE

TANK MODE
ALARM

Description

Alarm Template. Contents include the High-High, High,
Low, Low-Low, Advisory High and Advisory Low alarm
limits.

Alarm Template. Contents include High & Low alarm limits
for use with the optional Leak Detection feature.

Global Alarm. Contents include port one communications
error, port two communications error, communications are
off line or there is complete failure in communications.

Global Alarm. Contents include verifying the database is
not empty and the RTU is programmed.

Global Alarm. Contents include scan failure, gauge failure,
and overfill error alarms.

Global Alarm. Contents include database configuration
error, tank calculation error, and strapping error alarms.

Global Alarm. Contents include a movement, reverse flow,
and no flow alarms.
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Define Global Alarm @

Alarm Mame

Description

| Analog Alarm
Data Format

Select... |  Undefined

Edit Test Condition

| Template for Standard Analog

— Global Process Type
{+ Global Defintion

i Template

i

,_ Build ...

Alarm Reset Holdoff
v Use Hysterisis

Display Style
{+ Decimal &

Help

Reset Holdoff | 0.00

els}

el

The Tank Gauge, Tank Digital, and Tank Mode Global Alarms are tied to Tank
points. Tank points have predefined alarms--meaning the user does not have to

build the alarm process. The user only has to enable the alarm and enter a value.

Note that in the above dialog box, if the predefined tank gauge alarm doesn’t
match the need of your system, a new global alarm can be defined and
associated with the relevant tank point. You can use these Global Alarms as a
reference for building other alarms. The RTU Comm. and RTU Status global
alarms are tied to the RTU connected to your system.

DATA FORMAT

USE
HYSTERESIS

RESET
HOLDOFF

ADMO03GVAE1005

Define Global Alarm dialog box

This parameter defines the type of data value this alarm can
be applied to--Values, Word, Float, Double, Coded, etc.

This checkbox is used to determine when the alarm can
change status. It is helpful for values such as level and
temperature that may fluctuate by small amounts around
the alarm limit, thereby causing the alarm to activate again
and again.

This field is used to enter in a value for the hysteresis to
determine if the alarm should be on or off. For example,
suppose “0.1” is entered for the Reset Holdoff. If the High-
High alarm becomes active, the alarm will not clear until the
value falls by 0.1 or greater.

Define Global Alarms
dialog box
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Global Alarms
definitions dialog box

Define Global Alarm dialog box

DISPLAY STYLE this option determines how values are displayed in this
dialog box. Available options vary with the selected data

format.

BUILD This feature allows the user to create the actual alarm limit,
tests, and results. Refer to Build An Alarm Process for more
details.

ADD This feature will add the test condition to the conditions list

for the alarm.

REPLACE This feature allows test conditions to be replaced by the
new test condition defined in the Edit Test Condition dialog
box.

EDIT This feature allows an already existing test condition to be
modified.

DELETE This feature allows the selected test condition to be deleted

for the alarm.

In the Used column, “template” indicates an Alarm Template. A number appearing
in the Used column identifies the number of database points using the Global
Alarm.

When a user edits a Global Alarm, the changes affect all assigned database
points. Editing involves changing the name, description, data format and alarm
limits. Editing an Alarm Template does not affect those points that have already
used the template.

Global Alarm Definitions
Databaze MSIZEMORE Select...
Alarm Mame Description Drata Format Used
Analog Slarm Template for Standard Snalog Flost template
Leak Alarm Standard Leak Detection Alarms Flost template
RTU Comm. RTU Communication Coded o
RTU Status RTU Status irel 1}
Tank Digital Standard Tank Digital Alarms Word 27
Tank Gauge Default Tank Gauge Alarms ‘Wiord 27
Tank Mode Alarm Standard Tank Movement Alarms viard 27

Ediit... Import | Export | Done |
Mew... I

Delete | Help |

The Global Alarms Definitions dialog box lists all the Global Alarms and Alarm
Templates found in the system. The user can create, delete or edit a selected
Alarm Template or Global Alarm. When assigning alarms to a Global Alarm or
Alarm Template, the Alarm Name is used. A Data Format is assigned to each
Global Alarm or Alarm Template. Only database points of the selected format can
use the selected Global Alarm or Alarm Template.
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Creating global, local alarms and templates

From the Define Global Alarm dialog box, the user can create a Global Alarm or
Alarm Template by entering a name and description, selecting its attributes, and
entering alarm limits.

Step-by-Step
* From the FuelsManager Configuration application Database menu select
the Alarms command, the Global Alarm Definitions dialog box appears

* Click New, the Define Global Alarm dialog box appears

* Type the alarm name and description. The nhame and description appear in
the Global Alarm Definitions dialog box

¢ Select either the Global Definition option to create a Global Alarm or the
Template option to create and Alarm Template

¢ Select the point data format

« Type in a test condition by entering the Test Type, the Test Value, and the
Result or use the Build feature. In the Print edit box, type in a priority (0-
Lowest through 3-Highest)

< Enter the attributes such as Use Hysteresis and Reset Holdoff value, and a
Display Style selection. The Display Style section applies to the Define
Global Alarm dialog and controls how the test values are displayed

¢ Click Add to enter the test condition into the condition list

¢ Click OK when all test conditions are entered

Global alarm definition ) )
The new Global Alarm or Alarm Template is ready for alarm assignment. The user

can assign these alarms during database configuration.

Creating and modifying global alarms from the Points menu

Global Alarms can also be created and modified using the Points menu. The
disadvantage of using this menu option is that the user cannot view all the
system'’s Global Alarms. Only the Global Alarms related to the selected data
format appears. The advantage is that the user can edit or create a Global Alarm
“on the fly.” Local Alarms are unique to the point to which it is assigned.

Step-by-Step
« From the FuelsManager Configuration application Database menu select
the Points command, the Database Edit dialog box appears

¢ Select the input or output point that the alarm is to be defined. Select Edit.
The Edit Point dialog box appears

¢ Select the Details tab in the Edit Point dialog box

¢ Click Alarm Defined option button in the Edit Point dialog box
¢ Click the Edit Alarm button

e The Alarm Assignments dialog box will appear

ADMO03GVAE1005

Note! If the Global Alarms dialog
box is opened during database
edit, only the Global Alarms or
templates matching the selected
point’s data format are displayed.

Note! When building an alarm limit
for an Alarm Template, the Test
Value must be entered as a
percentage from 0.00 to 1.00.

Note! Tank points have predefined
alarms, so this procedure does not

apply.
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Alarms Assignments
dialog box

Alarm Assignments dialog box

In the Alarm Assignments dialog box, the user can select the alarm type, select a
graphic file, and select a help file to accompany the alarm, select an alarm/event
category or select an event definition. The user can edit existing alarms and
control the status of each alarm limit. The user can also configure the point for
Event Processing at the bottom of the dialog box.

Alarm Assignments @

Alarm Limits Alarm Limit Enable

(" Local Alarm Edit... Template Limit Statusz
" Global Alarm t ‘

Alarm Mame

Alarm Graphic

Select...

Alarm Help

Select..

AlarmiEvent Category

| Defautt ﬂ

Event Defintion

[ Event Enabled [ Ok | Cancel

-

Help ‘

Local Alarm limits

Local alarms are unique to the point to which they are assigned. The creation
process involves only building the alarm limits. Templates can be used to
construct a local alarm for a numerical database point.

Step-by-Step

* From the steps above with the Alarm Assignments dialog box open, select
the option Local Alarm to create a local alarm

* To create or edit the conditions of the alarm, click Edit. The Define Alarm
Process dialog box appears

« Type in a test condition by entering the Test Type, the Test Value, and the
Result or use the Build feature. In the Pri edit box, type in a priority (O-
Lowest through 3-Highest)

« Enter the attributes such as Use Hysteresis and Reset Holdoff value, The
attributes have the functionality and purpose as defined in the Defined
Global Alarm dialog box

 Click Add to enter the test condition into the condition list

* Repeat the build and add process until all alarm test conditions have been
added

¢ Click OK when all test conditions are entered
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Alarm limit enable

This list box displays the codes of each alarm test. This box allows the user to
disable and enable individual alarm tests. Once the alarm tests have been
created, they appear in the Alarm Limit Enable list box.

Alarm template

Alarm Templates apply only to Local alarms and can only be created for numerical
database point values. Once an alarm template has been selected, its attributes
are copied to the new local alarm.

Step-by-Step

* From the steps above with the Alarm Assignments dialog box open, select
the Local Alarm option button

» Select Template to apply a predefined alarm template for the selected
database point. The Global Alarm Definitions dialog box will appear. Only
templates that match the point data format are displayed

¢ Select the desired template and click Done. The Define Alarm Process
dialog box appears. The attributes of the selected template appear in the
dialog box

« Modify any of the desired test conditions for the template then click OK

Sharing global alarms

Many points can share global alarms. Once a Global Alarm is created, it becomes
available for assignment. Not only does this save time in the creation process, but
also when editing the alarm. When a Global alarm is edited, the changes apply to
all assigned points.

Step-by-Step

* From the steps above with the Alarm Assignments dialog box open, select
the Global Alarm option button

¢ Click Select Global. The Global Alarm Definitions dialog box will appear.
Only alarms that match the point data format are displayed

¢ Select the desired alarm and click Done. The Alarm Assignments dialog box
appears

¢ The desired alarm will appear in the Alarm Name box under Global Alarm
option button

Alarm graphic and alarm help

You can set up your alarms to make help graphics and help files available that can
assist the operator when dealing with an alarm. There may be specific reasons for
certain alarms and specific tasks the operator must perform as a result.

The user can select from a number of standard graphics that he or she wants to
display in event of a specific alarm. Similarly, help files (.hlp or .htx) can be
included that give the operator more information and instructions regarding the
alarm.

All alarm graphic and help files must be properly assigned and entered into
FuelsManager with the Graphics Files Configuration feature and the Help Files
Configuration feature respectively (See Defining System Resources).
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Build Alarm Limit
dialog box

Assigning an alarm graphic

Step-by-Step

» Click Select in the Alarm Graphic frame in the Alarm Assignments dialog
box. The Graphic Files Configuration dialog box appears

* Type in the name of the graphic file created by Draw Graphics in the Edit
dialog box and click Add. Or select a file from the list of Graphics files
defined in the Setting System Parameters section

« Select the name of the graphic file to assign to the alarm and click OK. The
Alarm Assignments dialog box appears with the graphic file listed in the
Alarm Graphic dialog box

Alarm/event category
Users can assign alarms to alarm categories (see the Security section). Alarm

categories filter alarms so that only users with permissions to view the category
are notified of alarms assigned to the category. This eliminates users having to
address alarms outside of their control.

Event definition
The user can select a numerical or non-numerical point value for event processing

as well as the advisory option that notifies an Operator of a change.

At the bottom of the dialog box, a section specifically for enabling Events is
displayed.

The user can type in a deadband value to compare to the current value. If the
numerical point value changes by that amount, it will be recorded as an event.
This capability also applies to non-numerical values. For example, if a database
point value changes from “On” to “Off” it will be recorded as an event. Selecting
the Advise on Event option causes a message box to be displayed.

Build An alarm process
The test condition specifies the test limits to be performed on a point’s value. An

Alarm Definition may be assigned to each database point with up to 16 alarm tests
to be performed on the associated database value. Four parameters must be
defined for the test condition, whether the user types in the test condition or uses
the Build button for a semi-automated process

Build Alarm Limit @

Test Type... Select Limit Test Type

Test Walue... Select Limit Yalue

il

Result Code ... Select Limit Result VWalue

Help ‘ Cancel ‘ Ok ‘
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Alarm Test Parameter

TEST TYPE Type of comparison to be performed

TEST VALUE Comparison Value (Same format as database variable)

RESULT Alarm Result if Comparison is True. Stored as a coded
variable

PRIORITY Alarm Priority (0-3) for logging, audible alarms and

summary functions

An example limit entry is as follows:

Type Value then Result Priority
.EQU. 103.5 then HIGH Pri 3

Build an alarm test
Step-by-Step
¢ Click Build in the Define Global Alarm or Define Alarm Process dialog box

« Select Test Type to select a test code. The Alarm Test Codes dialog box
appears

* Select the desired code and click OK
* Select Test Value

» Select the desired test value in the Select Coded Variable dialog box and
click OK

¢ Click the Result Code to select the result in the Select Coded Variable
dialog box

¢ Select the desired coded variable and click OK

e Type in a priority number from 0 to 3 (0-Lowest, 3-Highest). Click Add when
complete

* Repeat procedure for additional tests up to the limit of 16 defined tests
» Click OK to save changes to the Alarm Definition

Select Coded Variable @

TAY Master Transttional Uncler
WAY Slave Trip Unelr
K Master Tripped Unlogs
op True Unlact
rans Adv SetPt TSU Slave Unlocl
rans SO SetPt Tuesday Up

ransfer uR Uploa
vansier In Uracknawisdgsd Uplaa
ransier Out Unauthorized Upper
ransferring

< >
Cancel
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Select Coded Variable
dialog box
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Alarm test value
* |f the data format is numeric, the Test Value button will be disabled. Test
Values have to be typed in manually in the edit box

« |f the data format is a coded variable, the Test Value button will be enabled to
choose a test value from the Select Coded Variable dialog box

« If the data format is a user-defined string type, the Test Value button will be
enabled to configure the string in the String Configuration dialog box. This
dialog box lists the attributes of the selected user-defined string type. The
user selects the appropriate string found in the list box

« If the data format is Time and Date, the time and date must be typed in for the

Result Code, which is set to the system default time and date
Alarm Test Codes

dialog box Alarm Test Codes @

Code Description

MEQ. - Mat Ecjual Limit

LES. - Less than Limit

JGRT. - Greater than Limit

LEG. - Less than or Eqgual Limit

JGEQ. - Grester than or Egqual Limit N

Help | Cancel Ok

Test Conditions

.EQU. Database Value equal to Test Value

.NEQ. Database Value not equal to Test Value

.LES. Database Value less than Test Value

.LEQ. Database Value less than or equal to Test Value

.GRT. Database Value greater than Test Value

.GEQ. Database Value greater than or equal to Test Value

.BIT. Bit Set in Database Value which matches Bit in Test Value

.MASK. Anly Bit(s) Set in Database Value matches any Bits in Test
Value
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Edit alarm test

Step-by-Step

« In the Define Global Alarm or the Alarm Process dialog box select the
desired test

¢ Click Delete to delete the test or click Edit to change the test. Edit the
information in the Edit Condition box or by selecting Build

* Once changes have been made, select Replace to have the conditions set
for the test

< To disregard any changes made in the Define Alarm Process and the Define
Global Alarm dialog boxes, click Cancel

Importing and exporting global alarms

Global Alarms can be imported or exported as a comma-delimited text file with
the.csv extension. This is useful if alarms are defined for another database that
you want to define within the separate database.
Import global alarm
Step-by-Step
* From the FuelsManager Configuration application Database menu select
the Alarms command, the Global Alarm Definitions dialog box appears

» Click Import, the Import Alarm Definition File dialog box appears
» Select the comma-delimited text file you want to import and click OK

The system imports the alarms and displays them in the Global Alarms Definitions
dialog box.
Export global alarm

Step-by-Step
« From the FuelsManager Configuration application Database menu select
the Alarms command, the Global Alarm Definitions dialog box appears

» Click Export to export all alarms or select the global alarm to export
« The Export Alarm Definition File dialog box appears
« Enter an export file name and click OK

The system saves the global alarm(s) in a comma-delimited text file with the .csv
extension.
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Note! The FuelsManager
Configuration application contains
most of the configuration
processes you use to configure a
FuelsManager database.

Database menu Points
Command

Database Edit dialog
box

84

Introduction to databases

The FuelsManager database is an arrangement of data files that work together to
retain real-time and calculated data. This data is represented by elements called
Points, and are arranged in a tree-like structure with up to four levels. The levels
are arranged from broad (Level X) to specific (Level 0) - the default is three levels.

On each execution cycle, the controlling system called the DataManager performs
tank calculations, database calculations, and alarm detection, data conversion
and/or reporting based on a points value change.

Configuring a database involves creating points. Alarms and events can be
assigned to these points. Once the point is defined, it becomes available to the
FuelsManager subprograms and subsystems.

The database is mainly accessed through the FuelsManager Configuration
application, but depending upon your user privileges the database can also be
edited from several other areas of the application.

Step-by-Step
» To access the database, start the FuelsManager Configuration application
and from the Database menu select the Points command

e The Database Edit dialog box appears
¢ In order to edit a local or remote database, confirm the following:
*User has permission to access the target machine
*Machine is currently running FuelsManager
eDataManager on target machine is active
*Also, if database resides on a remote system, confirm Network connection
exists between the user’s machine and remote machine

» Follow the instructions later in this chapter for creating and editing database
points

Database

Alarms... [!

Source Assignments

Database Edit E|

Current Database System
Database..

WSIZEMORE Active Levels: 3

Foirt ams
| Meters -a00 Density

m
£

i Eclit
ArchiveManager.. S Meters M-400 —> FlowRate 4

E ETems e

EX L “alume ok
Rename
Delete:

Export

Import

<< Prev Level

Select I Close
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Point Types

» Tank E
* Input =
« Output =
o Triggered _—
Tank Point

A Tank point includes predefined variables specifically designed for tank gauging
applications. The behavior of the tank point is configured via the tank configuration
dialog boxes. A tank variable is any component of the tank such as tank level,
flow, and temperature. Each tank provides process values, or tank variables,
which may be entered manually, received from a field device or internally
calculated. These process variables are listed in the Glossary.

Input Point

Input points are used to receive data from generic field equipment, database
calculations or manual input. Typically these points are used to hold data for
equipment that is not tank specific (i.e. pumps, values or motors). However, they
can also be used to store tank information not covered by the FuelsManager Tank
Point.

Output Point

Output points are used to transmit data from the database to field equipment.
Typically outputs are derived from an operator issuing commands, however, they
can also be derived from an internal calculation process.

Output points may be configured to update the local process value immediately
from the command value or to update the database point value based on inputs
from the field equipment.

Triggered Point

Triggered points are used as an intermediary between points. FuelsManager uses
a triggered point to monitor another point. When it sees a change in the point, the
point gets sent to another point in the database.

Triggered points are typically used to monitor database input from a gauge. Once
the point changes, the triggered point sends it to another point such as an output
point for an OPC server or a PLC.
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Point attributes

When creating FuelsManager database points the user must define certain point
attributes. These attributes define how the data is stored; the source of the data;
the range and type of data; any alarm or event processing and who can access
the data.

Engineering units

Engineering units can be configured for all point types. These engineering units
are used to calculate the value and used to represent the value in graphics and
reports. If engineering units are changed, the user is given the option of
automatically recalculating the scale limits.

Scale limits

Scale limits can be defined for all point types. They are only available for numeric
process variables such as level, temperature, volume, density, standard density,
mass and flow.

Scale limits are defined for a couple of reasons. One, they define the ranges used
for bar graphs and trend plots. Second, they define the ranges used by Operator
Commands. Inside the Operate Command dialog box is a scroll bar that is used to
manually set a new value. Scale limits determine the minimum and maximum
values of the scroll bar.

Data source

Each point must be assigned a data source. As the name implies, the data source
defines how data is received in order to update the point’s current value. Input
points are assigned one source: the source of incoming data. Output points are
assigned two sources: one for the source of incoming data and the other for the
output destination. Each process variable in a Tank point is assigned a source.
The available source selections include the following:

Select Data Source - Water Volume E|
Source Type Selection

Current Type  Calculated

Manual Camm Cal OPC

Bitfield Properties

Start Bit: Number of Bits: Start Data Source Bit

Data Type

Translation: |<hones - Source Units: Undefined .

Data Source

System

Device/Point Description

Ok Cancel
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Manual input
The Manual data source is used when the operator needs to change the value

manually. This task is accomplished by issuing Operator Commands in the
Operate program where the operator can type in new data or select a command.
When this data source is selected, a SET button appears next to the database
point variable (for example, level) in the Tank Detail. In the Point Monitor display, a
modify button appears.

Entering an Operator Command sends the command directly to the
FMDataManager. FMDataManager immediately processes an Operator command
and issues the command to the appropriate destination based on point
configuration.

Operator Command requests are checked against the permissions assigned to
the User Group. If the command cannot be completed due to security or other
reasons, the system displays an operator message window describing why the
command is disallowed.

CommManager

The Comm option enables the user to connect to an external field device.
Depending on the point data format and variable type, only some points can be
assigned to the 1/0O connections. After selecting the Comm option, the
Communications Interface Configuration dialog box appears. This dialog box lists
all the interfaces available on the selected system.

Once an interface is selected, the user clicks I/0O Point to view the 1/O
connections. Only 1/O connections compatible with the point data format and
engineering units configuration are displayed.

For more details on Comm connections, see the Communications section of this
manual.

Calculated value

This option defines that FuelsManager should calculate this value. This option is
only available for tank point variables that can be calculated (i.e. volume, mass
etc.).It is not available for variables that must be measured or manually entered
(i.e. Level or Temperature).

Local input
This data source option defines the value to be connected to another database
point and is only available for the Tank Point variable - Ambient Temperature.

OoPC

The OPC option also allows the user to connect to an external field device, via a
Varec or third-party OPC server. The Hierarchy of tags available depends on the
OPC server selected. After selecting the OPC option, the OPC Server Source
select Dialog box appears.
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OPC Server Source
Select dialog

Note! You must configure the data
format correctly for the range of
data expected. Attempting to write
a value that it too large for the data
format defined will result in
truncation of and possible
misinterpretation of the data.

Note! For a list of the available
formats, refer to the Glossary
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OPC Server Source Select E|

System  [MSIFEMORE [

Selected OPC Server ArchiveManager.1

Selected Tag |

Scan Time | 1000 mSec (100 - 10000)

ArchiveManager 1
Datatanager.1

=1
-2
=I Tark Farm
= Tank
Tank 4

| Cancel |

Within this dialog box, the System and Selected Servers are displayed in non-
editable fields. Below these, the Scan Time may be entered to set the update rate
and the version of OPC can be selected. Below these, a list containing available
OPC servers is displayed. When a server is selected from this list, the system
displays a tree view of the different OPC tags associated with the OPC server
selected. For step-by-step instructions on how to Select an OPC server data
source refer to ‘Process Data Information’.

Data format

FuelsManager supports several data formats for storage of data. Selecting a data
format only applies to Input and Output points. Tank points have a predefined
formats.

Each numerical data format has a default minimum and maximum value as listed
in the Glossary. These values become the limits used for bar graphs, trends, and
Operator Command entries. Refer to the Scale Limits section for more
information.

If the data format is Coded Variable, a command modifier may be assigned to the
point. For more information on Modifiers, refer to the Modifier Assignment section.

Modifier assignment

If the Coded Variable type is selected during configuration, the user is able to
assign modifiers to the point. Modifiers are sets of coded variables grouped
together to be used as commands issued by the operator. The On/Off and Open/
Close modifiers are examples. The FuelsManager System contains a list of
predefined modifiers, a list of these modifiers can be found in the Glossary.

Alarms and events

An Alarm Process defines the alarm limits of a point's value. If the value exceeds
or falls below these defined alarm limits, an alarm occurs in the database. The
alarm is then displayed in the Operate program.
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Event Processes occur if the point’'s numeric value changes by a specified
amount or if a command is issued. Refer to the Administering Alarms section.

Tag category
Each database point can be assigned Tag Category, which works with the

Security module to determine the level of access for the viewing and changing of
database point values.

The Tag Category can be set to determine which database points may be viewed
or modified by a user or operator. When setting up the Security module, all
FuelsManager users are placed into an appropriate User Group (operators,
administrator, etc.) and each User Group is assigned a Tag Category. Refer to the
Security documentation for further information.
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OPC server support

OPC server support in FuelsManager provides:

» Collection of field data from remote I/O, PLC, and other devices via Varec or
3rd party OPC servers

» Access to measured and calculated tank data via LAN

« An interface to host systems (DCS), which provide an OPC client

« Easy configuration of interchanged data using one dialog box

What is OPC?

OPC (OLE for Process Control) is an open technical specification that defines a
set of standard interfaces based on Microsoft's OLE/COM technology. The
standards are defined and maintained by the OPC Foundation — an industry group
with over 300 members from around the world, including nearly all of the world's
major providers of control systems, instrumentation, and process control systems.
The open OPC standard and the participation of the majority of the world’s key
automation and control providers makes OPC a powerful option in the inter
operability field devices, automation systems and business / office applications.

OPC Data Access
FuelsManager implements the OPC Data Access specification used to move real-

time data from PLC'’s, DCS’s, and other control devices to HMI's and other display
clients. FuelsManager currently support the following OPC specifications.

* OPC Data Access v1.0 (OPC DA 1.0)
* OPC Data Access v2.05a (OPC DA 2.05a)

The OPC DA specification defines interfaces for both OPC clients and OPC
servers. Typically clients are HMI or other data gathering / display programs, client
applications can browse OPC servers and allow the user to select which OPC
tags the client will read. OPC servers typically provide communications to/from
devices further down the system hierarchy. OPC servers encapsulate the specific
details of talking to the device(s) and provide a well defined set of OPC tags that
the client can connect to. FuelsManager can operate simultaneously as both an
OPC client and OPC server. FuelsManager can be an OPC client and
communicate with OPC server for Tank Gauges, PLC’s and other remote I/O to
gather data from the field. At the same time FuelsManager can be providing data
to DCS’s and other business systems via its OPC server interface.

Administrator Manual



OPC server support

Office Systems

| m Tt
| OFC E@g Systems
Clients =
SCADA Systems
OPC Server
FuelsManager DataManager
L)
OPC Client
'y
o FPLCs
OFC  Lyg 4—— Tank gauges
Servers Remote /O

OPC Server Tags
FuelsManager’s OPC server exposes all database points created in the

FuelsManager real time database to OPC clients. The exact structure of the OPC
tags will depend on the database structure defined for your project. Also, the
method for browsing and selecting the tags will depend on the OPC client
software being used. The dialog below shows the OPC tag structure as seen via
the industry standard Matrikon OPC explorer client.

Matrikon OPC Tag
Studio dialog

iz Matrikon OPC Tag Studio - Matrikon OPC Explorer (FuelsManager Group)
File FEdit View Help

% |8 x| @ g B

TagEntry | Tags To Be Added:

s Fi TarkFarm Tank 1.Tank.Level
M8 ttem D: [TonkFarm Tank 1TankVolme
DataType: [Epty/Default +| W Create Active
Access Path: &
5 o P
Fiter: [[evel Data TypeFiter: [Empty/Default  +

¥ Write Access [ Read Access [ Branches [ Items

Available Items in Server ‘Endress+Hauser.DataManager. 1's

=3 TankFarm ~
=3 Tank 1
4 Tank
a2 Tank 2 X
(0] Tank 3 Tag: TankFarm. Tank 1.Tank.Level
- Tank 4 Access Path:
) Availsble Tags ~ Validated: No
@@ Vol, Strap - Cor Exp Dt Tysse: EmptyDefadt
i ol, Strap - H20 Create Active: Yes
o Readable: 777
D Yolume Available Net i w‘:‘::eable: e
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FuelsManager Supported client and server interface
* OPC Data Access (DA) v1.0
* OPC Data Access (DA) v.2.05a

The OPC standard also supports an interface designed to browse and select
database tags for which data is exchanged. This function allows developers of
OPC clients to provide an interface to browse and select point variables from the
in FuelsManager database.
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Creating database points

The following section defines the procedure necessary to create any type of
database point. This procedure is common to all point types, for specific
information about input & output points, triggered, or tank points refer to the
following sections.

Step-by-Step

* From the FuelsManager Configuration application Database menu select
the Points command, the Database Edit dialog box appears

« In the Database Edit dialog box, click New to create a new point, the Add
Point to Database dialog box appears

« Enter the level(s) names used to define the new point. Depending on which
level you selected, the higher levels appear in the dialog box. Each point
must be unique within the system.

« Under Point Type, select either Tank, Input, Output, or Triggered

¢ Click Add

* The Database Edit dialog box appears if you selected a Tank point, follow
the appropriate procedure to create a Tank point. For a description of the
Add Point to Database and Database Edit dialog box refer to the tables on
the following pages

« The Edit Point dialog box appears if you selected an Input or Output point.
Follow the appropriate procedure to create an Input and Output point

« The Edit point dialog box appears if you selected a Triggered Point. Follow
the appropriate procedure to create Triggered point
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Top - Add Point to

Database dialog box Database Edit X
. Current Database System
Bottom - Datapase edit o e Database
dialog box
Point Mame:
Eclit
[ valves v-110 Status
Eclit
I#valves v-110 > Command
ey

Copy

Delete
Export

Import

LRl lEE

== Prev Level

|| =]

RE %)

Add Point to Database on System WSIZE

| Active TagLevels = 3

Mew Point Name

Level 2 Lewel 1 Level0

| valves | w10 [l
-~ Point Type

B & ot

I#  Ouput l

1 ¢ Triggered
B C Tenk
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CURRENT
DATABASE
SYSTEM

DATABASE
BUTTON

POINT NAME

PREV LEVEL
AND NEXT
LEVEL

SELECT

CLOSE
EDIT

NEW

COPY

DELETE
EXPORT

IMPORT
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ACTIVE LEVELS

AND POINT LIST

Database Edit dialog box

The Current Database System displays the system database
on which the Database Point list is based

The Active Levels field displays the number of database tag
levels for the selected database

The Database button allows the user to select an alternate
FuelsManager database to configure

The Point Name and the Point List display the tagname for
the currently selected database point. The icon at the left of
the point list defines the type of point.

Users can search for known database point names by typing
in the tagname in the Point Name field

The Prev Level and Next Level buttons allow the user to
navigate up and down through the FuelsManager database
tree. The user can also move down to the next level by
double-clicking on the point in the point list

The Select button picks the current point and closes the
Database Edit dialog box. This option is only applicable
when the Database Edit dialog is opened from Operate or
CommManager

The Close button closes the Database Edit dialog box

The Edit button opens the Edit Point dialog box for the
selected point. The format of the Edit point dialog box differs
depending on the type of point selected

The New button opens the Add Point dialog box, allowing
the user to select the type of database point to be created

The Copy button opens the Point Copy / Rename dialog box,
allowing the user to either make a copy of the selected point
or rename the selected point

The Delete button deletes the selected point

The Export button opens the Import / Export Data Type
dialog box, allowing the user to select which particular data
is to be exported to a CSV formatted file

The Import button opens the Import / Export Data Type
dialog box, allowing the user to select which particular data
is to be import from a CSV formatted file
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Add Point to Database dialog box

DIALOG BOX
TITLE

ACTIVE TAG
LEVELS

LEVEL2,1,0

POINT TYPE

The title of the dialog box displays the Current Database
System to which the point will be added

The Active Levels field displays the number of database tag
levels for the selected database

The Level 2, Level 1 and Level 1 fields allow the user to
enter the database tagname for the point to be created.
Levels 2 or 1 will default to the database level already
selected in the Database Edit dialog box (if any)

Note! The example dialog box shows a three level database, an alternate
dialog box exists for four level databases. For databases with less than three
levels the Level 2 or Level 1 fields will be disabled.

The point type group allows the user to select the type of
point to be created. refer to the previous descriptions of the
different types points
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Creating input and output points

An Input Point contains data received from field equipment, database calculations
or another FuelsManager database. Both types of points require an input source
but, the user only selects an output destination for the Output point.
Note! You must first select a point

format before the other attributes
Step-by-Step can be addressed. Once selected,

« Continued from the previous Step-by Step instructions, Creating Database f,gefudeesfig;?;?'{:ma,\;iiimﬁ";ﬂ

Points Maximum Value edit boxes if the

« In the Edit Point dialog box the user selects a data format, data source(s), format s numeric.
engineering units, and other parameters. For a description of these
attributes, refer to the Edit Point dialog box - key field explanations table at
the end of this section, the brief instructions below, or the specific section
relating to that topic
« From the Edit Point dialog box - Type in the Description of the point

* From the Edit Point dialog box - Select a Tag Category, if applicable and
select whether you want to display quality data with the point

« If necessary, enter applicable Variable Format, Details, and Input Source
information. See sections below and the Edit Point dialog box table for more
information

Edit Point dialog box

Edit Point -» WSIZEMORE Walves,V-110,Status 3] (input/Output)

Deseription I~ Disabled

Tag Category | Defautt - [ Display Quality Data

“ariable Farmet ]Delans | Input Source |

Codsdd - Coded Vrisbls

I™ Bitfield Data

|

Modifier... | Undefined

Min Value: Max Value:

2k N
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Left - Select Data
Storage Format dialog
box

Right - Select
Engineering Units
Dialog box

Entering Variable Format information for an input or output point

« From the Edit Point dialog box, Variable Format tab - Click Format to select
the data storage format. The Select Data Storage Format dialog box

appears

* Make the Data Storage format selection and click OK to return to the Edit

Point dialog

e The user can select to use Bitfield Data for the point

¢ Or click the Units button to display the Select Engineering Units dialog to
use for the point. Just select the appropriate type, unit, and click OK to

return to the Edit Point dialog

Select Data Storage Format E|

Fuelshanager Data Formsts

- Signed  Shit (-125t0127) ~
- Unzigned & hbit (0to 255)

- Signed 16 hit (-f+ 32767)

E: bit { 0to B5535 )
e

it (-t 2,147 483548
- Unsigned 32 bit (0to 4,204 957 295)

Fioat - Floating Poirt (3.4E +£-38 [7 digits])
Double - Long Flnat Pairt (1 7E +-308 [15 digit
TDATE - Time & Date

Diate - Date Only

Titme - Time Only b

o | ]

Select Engineering Units

Select Unit Type:

Select Engineering Unit:

B

All Units # | |cubic certimeters ~
Temperature cubic meters

Time liters

Length cubic inches

Area

Mass
Pressure
Flow - Yalume b

Impetial Gallon
Barrel (il)

Ok ‘ Cancel |

Clear

« If needed, the user can select a modifier by clicking the Modifier button
« Select the appropriate Modifier and click OK to return to the Edit Point dialog

« If you are using a numeric format, the user can set the minimum and
maximum value by entering the parameters in the Min. Value and Max.

Value fields
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Creating input and output points

Entering Details for an input/output point

Yatiahle Format  Details llnpu‘t Source ]

Alarm # Event Configuration

[~ &larm Defined Edit &larm ...

Input Tranglation Table: | <Mone: w| ...

Edit

From the Edit Point dialog box, select the Details tab

The user can make Alarm/Event Configurations for the input/output point
here by clicking Edit Alarm and setting up alarms for the point. See
Administering Alarms section for more details.

Click OK to return to the Edit Point dialog

The user can select an Input Translation Table by making a selection in the
list. The user can also view and edit translation tables by clicking the browse
button

Translations. @

Scaling Functions

Import. Export Apply Close:
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Details tab - Input/
Output point

Translation dialog
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Entering Input Sources for an input/output point

Input Source tab - ‘ariable Format ] Detailz  Input Source ]

Input/output point
I |

Description Syztem Type
Endress+Hauser Databanager 1%Mete.. ‘WSIZE..  OFPC

« From the Edit Point dialog box - select the Input Source tab

e The user can add input sources from a specific data source (Manual,
Comm, or OPC)

« Click Add to display the Select Data Source dialog and select any data
source

* When finished, click OK to return to the Edit Point dialog

Note! Changes made to the Data
Source settings or the Alarm
Definition cannot be discarded by
the Cancel button, they have
already been saved.
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Creating and editing triggered points

A Triggered Point serves as a monitor that views a single database point (such as

an input point from a gauge). You can set the trigger point to send to an output
point, OPC server or PLC when it observes a change in the point its monitoring.

Step-by-Step

Continued from the previous Step-by Step instructions, Creating Database
Points

In the Edit Point dialog box the user selects a data format, data source(s),
engineering units, and other parameters. For a description of these
attributes, refer to the Edit Point dialog box - key field explanations table at
the end of this section, the brief instructions below, or the specific section
relating to that topic

From the Edit Point dialog box - Type in the Description of the point

From the Edit Point dialog box - Select a Tag Category, if applicable and
select whether you want to display quality data with the point

If necessary, enter applicable Variable Format, Details, Output Destinations,
and Input Source information. See sections below and the Edit Point dialog
box table for more information

Description J [ Dizabled
Tag Category | Default - [ Display Quality Data
Wariable Format }Detans ] Output Destinations | Input Source
Undefined
=
Units... Undefined
Maodifier.
IinValug: Max Yalue:
Help oK Cancel
ADMO03GVAE1005

Note! You must first select a point
format before the other attributes
can be addressed. Once selected,
the default minimum and maximum
values appear in the Minimum and
Maximum Value edit boxes if the
format is numeric.

Edit Point dialog box
(Triggered)
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Entering Variable Format information for a triggered point

« From the Edit Point dialog box, Variable Format tab - Click Format to select
the data storage format. The Select Data Storage Format dialog box
appears

* Make the Data Storage format selection and click OK to return to the Edit
Point dialog

e The user can select to use Bitfield Data for the point

¢ Or click the Units button to display the Select Engineering Units dialog to
use for the point. Just select the appropriate type, unit, and click OK to
return to the Edit Point (triggered) dialog

« If needed, the user can select a modifier by clicking the Modifier button

« Select the appropriate Modifier and click OK to return to the Edit Point dialog

« If you are using a numeric format, the user can set the minimum and
maximum value by entering the parameters in the Min. Value and Max.
Value fields

Entering Details for a triggered point

Details - triggered point watiable Format  Details | Output Destinstions | Input Source ]

Trigger Setup

] Minimum Repeat Interval [Secs)
1] Maximum Fepeat Interval [Secz)]

Input Tramslation Table: | <Mones- | ..
Output Tramslation Table: | <Monex -

From the Edit Point dialog box, select the Details tab

The user can make Alarm/Event configurations for the input/output point
here by clicking Edit Alarm and setting up alarms for the point. Click OK to
return to the Edit Point dialog

In the Trigger Setup, the user can set how frequently the triggered point
checks the input source

The input source and the output source can be set to different translation
tables. Select the Input Translation Table and the Output Translation Table
from the lists. The user can also view and edit translation tables by clicking
the browse button next to the input list
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Entering Output Destinations for a triggered point
For triggered points, the output destinations are the points that get populated as a

result of the input source changing.

Output destinations -

Variskle Format | Details  Output Destinations |Input Source |
triggered point

Add

Description System Type

« From the Edit Point dialog box - select the Output Destinations tab

¢ Click Add to display the Select Data Source dialog and select any data
source as an output destination. The user can add output destinations of up
32 to a specific data source destinations (Comm or OPC)

* When finished selecting Data Source distinctions, click OK to return to the
Edit Point dialog
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Entering Input Source for a triggered point
For triggered points, the input source is the point that the trigger point will monitor.

Input Source - Variable Format | Details | Output Destinations  Inaut Source |
triggered point
Add |

Description Spstem Type

« From the Edit Point dialog box - select the Input Source tab

e The user can add input sources from a specific data source (Manual,
Comm, or OPC)

« Click Add to display the Select Data Source dialog and select any data
source

* When finished, click OK to return to the Edit Point dialog
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Edit Point Dialog box

Edit Point dialog box (Input/Output and Triggered Point)

DESCRIPTION Define a descriptive name to be use for the point. This
name can be displayed on user graphics and reports, in
addition, it forms part of the alarm entry if an alarm
condition should occur

DISABLED Disable the processing of a particular input / output point.
The default is unchecked i.e. the point is processed.

TAG CATEGORY  Each database point can be assigned a Tag Category,
which works with the Security module to determine the
level of access for the viewing and changing of database
point values

FORMAT Configure the data format for the input / output point (for a
list of possible data formats refer to the Glossary).
If the data Storage format is a Coded Variable, the Modifier
button becomes available within the Edit Point dialog box.
For all other options (except for Time and Date
combinations), the Units button becomes available

BITFIELD DATA Enable or disable FuelsManager processing of individual
bits with this point

UNITS Configure the engineering units for the input / output point
(for a list of possible engineering units refer to the
Glossary)

MODIFIER Configure the command modifier to be assigned to the

input / output point (for a list of standard modifiers refer to
the Glossary). The Modifier button on only available for the
Coded data type

MIN VALUE / MAX Configure the minimum and maximum scaling limits for the

VALUE input / output point
DISPLAY QUALITY Enable or disable the display of FuelsManager quality
DATA information (text superscripts displayed in graphic and

reports that define from where the data was derived). The
default setting is unchecked i.e. quality data is not
displayed

ALARM EVENT Alarm Defined - Open the Alarm Assignments dialog box

CONFIGURATION allowing you to define and assign alarm processes to the
input / output point. (see Administering Alarms).
Edit Alarm - re-open the Alarm Assignments dialog box
allowing you to edit previously defined alarm processes for
the input / output point. (see Administering Alarms). The
Edit Alarm button is disabled if not alarms have been
defined for this point
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Edit Point dialog box (Input/Output and Triggered Point)

TRIGGER SETUP
(Triggered only)

INPUT
TRANSLATION
TABLE

OUTPUT
TRANSLATION
TABLE
(Triggered only)

OUTPUT
DESTINATIONS
(Triggered only)

INPUT SOURCE

The minimum repeat interval defines the fastest period that
any changes in the monitored value will be sent to the
defined destination.

The maximum repeat interval defines the period of which
the monitored value will be sent to the destination,
regardless of whether the value has changed.

Setting either the minimum or maximum repeat intervals to
zero disables the associated functionality

The translation table FuelsManager uses to decipher the
data coming in from the input point

The translation table FuelsManager uses before sending
point data to an output destination

A table listing the data sources that serve as the
destinations for triggered points. The user can add, edit
and remove the source by clicking the appropriate button.
Adding or editing the source opens the Select Data Source
dialog box, allowing you to define the sources of your data
output point

A table listing the data source for the input point. The user
can add, edit and remove the input source bay clicking the
appropriate button.

Adding or editing the source opens the Select Data Source
dialog box, allowing you to define the source of data for the
input / output point. Input points have only one Select
button, whereas Output points have two Select buttons,
one to define the destination for the output and one for the
input source
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Creating and editing tank points

A Tank point includes predefined variables specifically designed for tank gauging
applications, such as tank level, flow, and temperature. The Edit Tank Data dialog
box allows for specification of the Tank point attributes.

Step-by-Step
« Continued from the previous Step-by Step instructions, Creating Database
Points

« To configure each parameter for a tank point, work through the following

sections that correspond to the tab fields within the Edit Tank Data dialog
box

General information
Follow the steps below to fill out the General tab

Step-by-Step

« Enter a description for the tank point

¢ Leave the Detail field empty if you want to use FuelsManager's default tank
detail display, however, if you require an alternate tank detail display for this
tank, enter the name of the tank detail

¢ Select the required engineering units for all variable types
« If required, enter the minimum and maximum scaling limits for all variable
types

Note! FuelsManager will give you
the option to automatically re-scale
Edit Tank Data -> WSIZEMORE \TankFarm. Tank 4. Tank ® the minimum/maximum, alarm,

General | Volume | Process Data | Alams | Vassel 1| Vessel 2| WM | Strap /Water Table | Leak Detection | strapplr)g tables and all other
values if you change the
engineering units.

Description |Tank 4 Tag Category |Default -
Detail [DetaiMCR_StdDn I Display Quaty Data Edit Tank Data dialog
box - General tab

Variable Type | Minimum | Maximum Engineering Units |
Level 40-00-00 ftAnchi16th
Tempersture 0.00 30000 Degrees Fahrenheit
Valume 0.00 1,200,00000 US. Gallan
Mass 0.00 10,000,000.00 Pound
Denstty 0.00 100,00 Degrees AP
Standard Densty 0.00 100.00 Degrees AP|
Flow: -1,000.00 1,000.00 U5, Gallon £ min
Pressure Units 0.00 30.00 pouncl/sg in (P31
Level Change Rate -1000 1000 feet per minLte
Mass Flow -3,000.00 3,000.00 pounds per hour
WaporiGas Density 0.00 10000 pounds { cu. foot
Leak Rate -1000 10.00 U5, Gallan £ hour

Cancel
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DISPLAY QUALITY
DATA

DETAIL

VARIABLE TYPE
COLUMN

MINIMUM /
MAXIMUM
COLUMNS

ENGINEERING
UNITS COLUMN
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Edit Tank Data dialog box - General tab

Enter a descriptive name to be used for the point. This
name can be displayed on user graphics and reports, in
addition, it forms part of the alarm entry if an alarm
condition should occur.

Each database point can be assigned a Tag Category,
which works with the Security module to determine the
level of access for the viewing and changing of database
point values.

Enable or disable the display of FuelsManager quality
information (text superscripts displayed in graphic and
reports that define from where the data was derived). The
default setting is unchecked i.e. quality data is displayed.

Enter the name of the tank detail template (without the file
extension) to be used for this tank. If this entry is left blank
the default tank detail as defined in the registry will be
used.

This column displays the types of tank point variables
available. This data is for display purposes only.

Edit the minimum and maximum scaling ranges for each
of the variable types. The scaling ranges are used for bar
graphs and trend plots and to define the ranges used by
Operator Commands.

To edit the units, click on the cell containing the units you
want to change, the drop down list presented displays
only units applicable to the variable type selected.
Following a change in engineering units, FuelsManager
will ask the user if the scaling limit and alarm limits should
be automatically modified to reflect the new units.
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Volume information

Step-by-Step

» To select a product, Click on the Product button

« Highlight a product from the Select A Product dialog box and then click
Select. Refer to the Adding Products section for further information on
creating a product list

« If the selected product does not define the correction method to be used,
select the required correction type and any optional correction techniques
as required in the Special Rounding and Calculation Option sections

* As required, enter the Samples, Sample Time, and Deadband for the Flow,
Level Rate, Mass Flow and Net Flow. There is no set formula to determine
these values. The user must consider the tank geometry, pipeline sizes and
other factors before entering these parameters

Edit Tank Data -> WSIZEMORE ¥TankFarm. Tank 4. Tank 3
Genersl Wolume | Frocess Data | Alsms | Vassel 1| Vessel 2| WM | Shap # water Table | Leak Detection |
Canestion Method Averaging Fiter
Conestion Type sepiplingn Sec
Flow
Fiter b
Deadband |15.00
g Level Rate
Std. Temp F e 7
Deadband [0.00
Special Fiounding
Mass Flow
VCF Fiter
Level =] Deadband [1.00000
Temperavee [in <] Hatblon =
B eien e Deadband |15.00
Waler
VoW [NotGobiantes =]
Mole Constant
Mass/weight [hass =]
ok Cancel

PRODUCT

CORRECTION
TYPE
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Edit Tank Data dialog box - Volume tab

The Product button opens the Select A Product dialog box,
allowing the user to pick the tank product from a list of pre-
defined products, or add additional products

These controls allow you to select of the correction algorithm
to be used in the calculation of corrected volume for this
tank. The selection of the major correction type (in the upper
list box), restricts the minor correction types available (in the
lower list box). In addition, if your system administrator
associated a correction method with the product, the
correction type is selection is made automatically based on
the product chosen

Edit Tank Data dialog
box - Volume tab
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Edit Tank Data dialog box - Volume tab

SPECIAL
ROUNDING
GROUP

CALCULATION

OPTIONS
GROUP

AVERAGING

FILTER GROUP

These parameters are only available when a Japanese
volume correction method is selected in the correction type
lists. These options allow you to define specific data
rounding methods to be used in the volume correction
calculation for VCF, Level and Temperature variables

These parameters are only available when a Japanese
volume correction method is selected in the correction type
lists. These options allow you to define specific options as to
when the water volume and volume due t0%BSW are
subtracted from product volume during the volume
correction calculation. In addition the Mass/Weight option
allows you to define the method to be used for the
calculation of product mass

This group defines the number of samples, time between
samples and the value below which changes in data are
ignored. The parameters entered control how FuelsManager
calculates the Flow, Level Rate, Mass Flow and Net Flow
process variables

FuelsManager calculates flow by sampling the tank’s volume and then calculating
a rate of change volume (i.e., Gal / hr.). Users can tune how FuelsManager
calculates this flow rate by the Sample Rate, Sample Size, and deadband
parameters on the General tab.

FuelsManager will sample the volume at the rate defined by the sample time
parameter, calculate a flow rate based on this volume change, then average the
individual flow rates over the number of sample defined by the Samples

parameter.
; 4 . .
Volume Samples to Avg. =6
Gals Sample Time = 30 sees
Nl _-l—\- |
1
-
>
Time (secs)
Valume values (Gals)
12345 12305 12345 12332 13176 13093 11p62
Caleulated Flow values (gal/sec) Average over 6 samples
-2.10833 gals/sec
4133 200 D43 186 270 433 2.10833 gals/sec
(12305 - 12 ‘l.//'
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Creating and editing tank points

If FuelsManager calculates an individual flow rate that is below the deadband
parameter, the value will be treated as zero for the purposes of averaging the flow
rate. Users should tune the deadband parameter such that normal gauge
movements caused by product surface ripples or wind movement will not be
considered in the flow average calculation.
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Edit Tank Data dialog
box - Process Data tab

VARIABLE COLUMN

SOURCE COLUMN

112

Process data information

Step-by-Step
» Click on the appropriate button under the Source column to select the Data
Source as required

e The Select Data Source dialog box appears

¢ Click one of the buttons, Clear, Manual, Comm, Calc, Local or OPC in order
to set the required data source

* Repeat to change the source for any other variable as required

Edit Tank Data -> WSIZEMORE \TankFanm. Tank 4.Tank

&

General | Volume Process Data | alams | Vessel1 | Vessal 2| Wi | Strap /water Table | Leak Detection |

Variable

Source

-~

Level
Temperature

Densty

water Level

BB

olums Gross
“olume Net

“olume Remaining et
“olums Available Het
Standeard Densty
Mass

Solits Level

Flow

Water Vallme

Gauge Postion
Density Temperature
Salids Volume

Transter Mode

Manual Entry

Manual Entry

Calculated

Manual Entry:

Manual Entry:

Calculated

Calculated

Calculated

Calculated

Manual Entry

Calculated

Marual Entry:

Calculated

Calculated

Hot Assigned

Hot Assigned

Calculated

Manual Entrv

Cancel

Edit Tank Data dialog box - Process Data tab

This column displays the tank point process variable name. This column is for

display only.

This column displays the current Data Source for the particular tank process
variable. Clicking on a particular Source opens the Select Data Source dialog box,
where the source can be changed.
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Select Data Source - Water Yolume

Source Type Selection

Current Type  Calculated

Clear I hdanual CUI’I‘II’I‘Il Calc I ] OPC

Bitfield Properties

Start Bit: Mumber of Bits: Start Data Source Bit:

Data Type

Translation: |=Mone= | .. .| Source Units: Undefined -

Data Source

System

Device/Poirt Description

QK Cancel

When a new Tank Point is created, FuelsManager sets the default Data Source's
to the most common settings, however, the Data Sources for Level and
Temperature are left unassigned. This means that you will have to assign data

Select Data Source
dialog box

sources for level and temperature, but will not have to modify all the data sources

for the tank point.
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Note! In addition to the Level
alarms defined on the Edit Tank
Data - Alarms tab, FuelsManager
supports a Minimum and Maximum
Operating level alarm. Selecting
the 'User Defined' option for the
Minimum and Maximum fill
parameter on the Edit Tank Data -
Vessel tab, enables these alarms.

Edit Tank Data dialog
box - Alarms tab

114

Alarm information

Step-by-Step
» Click the Gauge Alarm button to set a Global Alarm Definition to be used for
the tank point

¢ Global Alarm Definitions dialog box appears

¢ In the Global Alarm Definitions dialog box either select an existing alarm
definition or click New to create a new alarm definition. Typically the
required alarm definitions have already been created - see Building an
Alarm Process for more information

« In the Edit Tank Data dialog box, enter the required alarm setpoints for the

tank point
Edit Tank Data -> WSIZEMORE VTankFarm, Tank 4. Tank 3
General | Volume | Process Data Alams | Vessel 1| Vessel 2| WiM | Stiap / water Table | Leak Detection |

Gauge Alam Tank Gaugs Alam/Event Category  [Default -
Alarm State | WighHigh |  High Low | Low-Low | Holdoff |

Level Enabled f26-00-00] 34-00-00 6-00-00 2-00-00 0-04-13

Temperature  |Mone

Density Mone

Flow Mone

Level Rate Mone

apor Press  |Mone

Movement Dizabled 0-00-00 0.00

Reverse Flow | Disabled 0.00

o Flowy Digabled 0.00

Test Made Digabled

ETA Disahled

Leak Rate Disablecd 9.50

Leak Data Disablec

Min> 340000 Max<=400000  Engr Units = ftin-16th

Cancel

Edit Tank Data dialog box - Alarms tab

GAUGE ALARMS This button opens the Global Alarm Definitions dialog box,
allowing selection of the alarm definition to be associated
with the tank point

ALARM/EVENT
CATEGORY

ALARM COLUMN

The Alarm Event category selection box allows selection of
the appropriate pre-defined alarm security category

This column displays the available tank alarms. This
column is for display only
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STATE COLUMN

HIGH-HIGH
COLUMN

HIGH COLUMN

LOW COLUMN

LOW-LOW
COLUMN

HOLDOFF
COLUMN

ADMO03GVAE1005

Edit Tank Data dialog box - Alarms tab

This column displays the current status of all available tank
alarms. In addition by clicking on the appropriate cell in this
column the user can change the state of the alarms.
Available states are:

Disabled - Alarm limits are not cleared but no alarms of this
type will be activated.

Enabled - Alarm limits are shown and alarms are processed
by FuelsManager.

None - Alarm limits are cleared and no alarms of this type
will be activated

This column displays the current High-High alarm limit. In
addition, by clicking on the appropriate cell in this column
the user can change the High-High alarm limit. High-High
alarm limits are available for Level and Temperature
process variables only

This column displays the current High alarm limit. In
addition, by clicking on the appropriate cell in this column
the user can change the High alarm limit. High alarm limits
are available for Level, Temperature, Density, Flow, Level
Rate, and Vapor Pressure process variables. Also the High
limit is available for the Movement alarm, in this case the
High limit value defines how much the tank level / volume
has to move before an illegal movement alarm is activated

This column displays the current Low alarm limit. In
addition, by clicking on the appropriate cell in this column
the user can change the Low alarm limit. Low alarm limits
are available for Level, Temperature, Density, Flow, Level
Rate, and Vapor Pressure process variables

This column displays the current Low-Low alarm limit. In
addition, by clicking on the appropriate cell in this column
the user can change the Low-Low alarm limit. Low-Low
alarm limits are available for Level and Temperature
process variables only

This column displays the current alarm hold off value
(sometimes called deadband or hysteresis). In addition, by
clicking on the appropriate cell in this column the user can
change the Hold off alarm value. This value defines the
amount by which the alarm limit must be cleared before the
alarm is deactivated. For example, if the High level alarm
setpoint is 10 and the level alarm hold off is 1, the level
must return to a value of 9 before the High level alarm is
deactivated. Hold off parameters are available for Level,
Temperature, Density, Flow, Level Rate, and Vapor
Pressure process variables. Also, a time hold off value is
available for the Movement, Reverse Flow and No Flow
alarms
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In order to assist the user when entering alarm limit information, the Edit Tank
Data - Alarm dialog box displays the minimum and maximum available values for
each alarm limit, along with the applicable engineering units.In addition, when a
new tank point is created the Level Alarms are automatically enabled and the
alarm limits are set to 95%, 90%, 10% and 5%.
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Other alarm types

Several additional alarms exist for each tank however these are not configured
from the Alarms Page. These alarms are defined in the Tank Digital Global Alarm
Definition. The default Tank Digital Alarms include:

» Database Configuration

» Tank Calculation Error
 Strap table Error

» API Correction Error

« Critical Zone

« Transfer Advisory Setpoint

« Transfer Advisory Shutdown
» Specialized alarms

These can be edited and applied to all tanks in the system. However you cannot
edit these alarms on a tank by tank basis.

Specialized alarms

The following tank alarms have special meaning, that may not be as easy to
understand as the simple level, temperature or process alarms. For this reason a
brief description of their functionality is given in the following table, for more
information please refer to the Glossary.

Edit Tank Data dialog box - Alarm tab - Specialized Alarms

MOVEMENT When the Tank Mode is set to Stopped, a Stop Level is
established at the current tank level. If the tank level
deviates from the Stop Level by the High Setpoint, a
Movement Alarm is generated

REVERSE FLOW When the Tank Mode is Fill and the Flow is negative or the
Tank Mode is Empty and the Flow is positive, a Reverse
Flow Alarm is generated

NO FLOW When the Tank Mode is set to Fill, Empty or Run, a Timer is
started. If the time exceeds the value configured under the
No Flow Alarm Hold off parameter and the flow is still zero,
a no Flow alarm is generated. The time is reset whenever
the flow value is not zero

TEST MODE When the Tank Mode is set to Testing, the Test Mode alarm
is generated.

ETA (ESTIMATED For each level alarm limit, and ETA is calculated. Whenever

TIME OF the ETA is less than the Transfer Advisory Setpoint, the

ARRIVAL) corresponding ETA alarm is generated. ETA alarms are
suppressed when the ETA time is 0
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Edit Tank Data dialog
box - Vessel 1 tab

118

Vessel information (Vessel 1 & Vessel 2 tabs)

The point information concerning the vessel is divided among two tabs--Vessel 1
& Vessel 2. Vessel 1 keeps the physical statistics of a tank along with gauging,
pressure, and other information to ensure accurate use in FuelsManager. Vessel 2
contains transfer limit settings, gauge assignments, and float characteristics.

Edit Tank Data -> WSIZEMORE YTankFarm. Tank 4. Tank 3

Eenera\] Volume} Process Dala} Mlarms  Wesssl 1 l\/esselﬂ ihd I Strap /‘WaterTab\e} Leak Delectlun}

Characteristics

Landed Height [BEIER ftin1Eth
Floating Height W ft-in-16th
RoofMass[487.00 b
Roof Type [Roof Massin Swap =]
Tark Geometiy [Vert Cynder =]
TankVolume [000 gal(US)
Tank Height [0-0000 fin16th
Tark Radius [00000  fein16th
Shell Thickness [00000 fin16th
Lining Material ’7
Date Installed | 51872008 = |
Tank Matsrial [inknawn -
Ewplocff0
Instal Temp 0 F

Optional Protsction Tank Shel Correction
Cathodic Protection [ || [ Enable
Overfill Pratection [~ I
Spil Protection [~ || AreaCoet [T
Gauging Setup
& Tradtional  © Hpdrostatic ¢ Hybrid

Pressure Transmitter Setup
Offget PSI
LI

™ Midde [ [cooon
Boftom [ | CET

Minimum Level ftin-16th
Density Deadband APl

In [ wses
Elevation [0 &
Latde [0 [0 [0 DMs
LevelOffset [ 70000 ftinTBth

Height ft-in-16th

Cancel
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Entering Vessel 1 information

Step-by-Step

¢ Click the Vessel 1 tab

« Enter information about the basic physical Characteristics--Landed Height,
Floating Height, Roof Mass, Roof Type, Tank Geometry, Tank Volume, Tank
Height, Tank Radius, Shell Thickness, Lining Material, Date Installed, Tank
Material, ExpCoef, and Install Temperature

« Under Optional Protection, indicate any Cathodic, Overfill, or Spill protection
that is used with the tank

* Under Tank Shell Correction, the user can enable and indicate any Shell
Insulation and area coefficient (if applicable)

* Under Gauging Setup, you can set whether your gauging system uses
Traditional, Hydrostatic or Hybrid setups

« If using either the Hydrostatic or Hybrid gauging setup, the user must enter
the bottom Pressure Transmitter Setup (Offset PSI & Height). You can also
enable and enter the Top and Middle transmitter settings

- If using Hydrostatic or Hybrid gauging setup, you can enter the Minimum 33&?&52[.2"5%3:3'1?3 using
Level and Density Deadband calculations, see the Calculation
« The user can select whether to use Local Gravity settings. Just check the Methods chapter

Use Local Gravity check box and enter the m/Sec?

* You can also enter the Elevation in feet, and Latitude in Degrees, Minutes
and Seconds. You can only enter Latitude if you are not using Local Gravity

* Enter the Level Offset

Edit Tank Data dialog box - Vessel 1 tab

MAXIMUM FILL  This field allows the user to configure the maximum safe
level to which the tank can be filled. FuelsManager uses this
value in the calculation of remaining and available
volume(s). The maximum fill level can be:

User Defined - user can enter any value

High - Maximum fill level is the same as the high level alarm
limit

High-High - Maximum fill level is the same as the high-high
level alarm limit

Note! Selecting the 'User Defined' option also enables the Maximum

Operating limit level alarm. This alarm functions independently of the High and
High-High alarms and is intended to give an additional stage of level alarm

monitoring.
LANDED This field allows configuration of the height at which the
HEIGHT floating roof is fully landed on it legs. FuelsManager only

uses this parameter if the list item ‘Roof Mass not in Strap’ is
selected, otherwise this parameter is ignored
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Edit Tank Data dialog box - Vessel 1 tab

FLOATING
HEIGHT

ROOF MASS

ROOF TYPE

TANK
GEOMETRY

TANK VOLUME

TANK HEIGHT

TANK RADIUS

This field allows the user to configure the height at which the
floating roof is fully floating on the product. FuelsManager
only uses this parameter if the list item ‘Roof Mass not in
Strap’ is selected, otherwise this parameter is ignored

This field allows the user to configure the weight of the
floating roof. This value is used together with the Roof Type
selection and the current density and strapping density
values to calculate the volumetric effect of the floating roof

This field allows the user to configure the type of floating
roof, possible values are:

No Tank Roof - No floating roof correction

Fixed Roof - No floating roof correction

Roof Mass in Strap - Roof mass is accounted for in the tank
strapping table.

Roof Mass not in Strap - Roof mass has not been included in
the tank strapping table

Kaiji-Kentei-Kyyokai - See the Tank Calculations chapter for
more details. Only available if a '‘Japan' Correction Type is
selected on the Edit Tank Data Volume tab
Sin-Nihon-Kentei-Kyyoukail - See the Tank Calculations
chapter for more details Only available if a 'Japan' Correction
Type is selected on the Edit Tank Data Volume tab
Sin-Nihon-Kentei-Kyyoukai2 - See the Tank Calculations
chapter for more details Only available if a 'Japan' Correction
Type is selected on the Edit Tank Data Volume tab
Sin-Nihon-Kentei-Kyyoukai3 - See the Tank Calculations
chapter for more details Only available if a 'Japan’ Correction
Type is selected on the Edit Tank Data Volume tab

This field allows the user to configure the shape of the tank.
FuelsManager uses this value to determine how to
interpolate between strapping table points, possible values
are: Vert. Cylinder; Horizontal Cylinder - End Caps;
Horizontal Cylinder - Flat Ends; Standard Sphere; and
Polynomial Sphere. Selecting Polynomial Sphere causes the
strapping table tab of the tank configuration dialog box to
change to 'Polynomial Sphere'

This field allows the user to configure the total internal
volume of the spherical tank.
Used in the LPG calculation method

This field allows the user to configure the total height of the
sphere at the point at which the automatic tank gauge is
installed. Used in the LPG calculation method

This field allows the user to configure the radius of the
sphere. Used in the LPG calculation method
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Edit Tank Data dialog box - Vessel 1 tab

SHELL
THICKNESS

LINING
MATERIAL

DATE
INSTALLED

TANK MATERIAL

EXP COEF

INSTALL TEMP

CATHODIC
PROTECTION

OVERFILL
PROTECTION

SPILL
PROTECTION

ENABLE (TANK
SHELL
CORRECTION)

SHELL
INSULATION

AREACOEF

GAUGING
SETUP -
TRADITIONAL

GAUGING
SETUP -
HYDROSTATIC
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This field allows the user to configure the thickness of the
sphere's shell. Used in the LPG calculation method

This field allows the configuration of the type of tank lining
material. For reporting and information only

This field allows the configuration of the date the tank was
installed or build. For reporting and information only

This field allows the user to configure the material from
which the tank shell is constructed. This field is only
available if the Enable Correction option is checked. Used in
tank shell correction calculation

This field allows the user to configure the material expansion
coefficient used in the tank shell correction calculations.
Manual entry of this value is not allowed except when the
Tank Material is set to 'Other.” Used in tank shell correction
calculation

This field allows the configuration of the ambient
temperature when the tank was installed or built

This field denotes that the tank is fitted with cathodic
protection. Used for reporting and information only

This field denotes that the tank is fitted with overfill
protection. Used for reporting and information only

This field denotes that the tank is fitted with spill protection.
Used for reporting and information only

This field allows the user to enable the compensation of the
Net Std. volume for the thermal expansion effects of the tank
shell

This field allows the user to configure the tank shell
correction method to use the insulated tank correction
equation. This field is only available if the Enable Correction
option is checked

This field allows the user to configure the shell area
expansion coefficient used in the tank shell correction
calculations. Manual entry of this value is not allowed except
when the Tank Material is set to 'Other’

This option configures the tank to use traditional level tank
gauging techniques

This option configures the tank to use Hydrostatic tank
gauging techniques
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Edit Tank Data dialog box - Vessel 1 tab

GAUGING This option configures the tank to use Hybrid tank gauging
SETUP - HYBRID techniques

PRESSURE These parameters define the position and offset for the Top
TRANSMITTER  pressure transmitter in Hydrostatic/Hybrid tank calculations
SETUP - TOP

PRESSURE These parameters define the position and offset for the

TRANSMITTER  Middle pressure transmitter in Hydrostatic/Hybrid tank
SETUP - MIDDLE calculations

PRESSURE These parameters define the position and offset for the
TRANSMITTER  Bottom pressure transmitter in Hydrostatic/Hybrid tank
SETUP - calculations

BOTTOM

MINIMUM LEVEL This parameter defines the lowest level of which Hydrostatic/
Hybrid tank calculations can be performed

DENSITY This parameter defines the minimum change in density that

DEADBAND will cause the Hydrostatic/Hybrid tank calculations to be
executed

USE LOCAL Enable the entry of the Earth’s gravity, in m/sec?, at the

GRAVITY tank’s specification. Used in Hydrostatic/Hybrid calculations

ELEVATION Defines the elevation above sea level at the tanks specific

location, used in Hydrostatic/Hybrid calculations

LATITUDE Defines the Latitude (in deg, mins, & sec) at the tanks
specific location, used in Hydrostatic/Hybrid calculations

LEVEL OFFSET Defines the offset value to be applied to the Level calculation
as part of the Hydrostatic calculations
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Entering Vessel 2 information

Edit Tank Data - > WSIZEMORE 11, 2. Tank 4 3

Eenera\] Vo\ume] Process Data} Alarmsl Vessel1 Wesselz |W&M ] Strap fWaterTab\e] Leak. Dete:l\on}

Transter Limits

Gauge

LPG Float Characteristics

" High-High
asimum Fill ftire16th ((i High
User Defined
" LowLow

Minirum Empty fin-16th * Low

" User Defined

Gauge Type |Undefined =

Modifier Undefined

Float Mass g
Float Density APl
Float Diameter ftire16th

Cancel

Step-by-Step

Click the Vessel 2 tab

Under Transfer Limits, you can set the Maximum Fill volume for the tank.
You can select from the pre-set amounts of High-High or High, or select
User Defined and enter the appropriate amount

Also under Transfer Limits you can set the Maximum Empty volume for the
tank. You can select from the pre-set amounts of Low-Low and Low, or
select User Defined and enter the appropriate amount

Under Gauge, you can select from the standard Gauge Type list and enter
the appropriate commands available from the gauge by clicking the Modifier
button and selecting from the list

Under LPG Float Characteristics, you can enter the Float Mass, Float
Density and Float Diameter so FuelsManager can compensate for the size
of the LPG float. These fields are only available when the LPG volume
correction method is selected on the Volume tab
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Edit Tank Data dialog
box - Vessel 1 tab
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Edit Tank Data dialog box - Vessel 2 tab

MAXIMUM FILL

MINIMUM
EMPTY

GAUGE TYPE

MODIFIER

FLOAT MASS

FLOAT DENSITY

FLOAT
DIAMETER

This field allows the user to configure the maximum safe
level to which the tank can be filled. FuelsManager uses this
value in the calculation of remaining and available
volume(s). The maximum fill level can be:

User Defined - user can enter any value.

High - Maximum fill level is the same as the high level alarm
limit

High-High - Maximum fill level is the same as the high-high
level alarm limit.

Note! Selecting the 'User Defined' option also enables the Maximum
Operating limit level alarm. This alarm functions independently of the High and

High-High alarms and is intended to give an additional stage of level alarm
monitoring.

This field allows the user to configure the minimum safe level
to which the tank can be drained. FuelsManager uses this
value in the calculation of remaining and available
volume(s). The minimum empty level can be:

User Defined - User can enter any value.

Low - Minimum empty level is the same as the low level
alarm limit.

Low-Low - Minimum empty level is the same as the low-low
level alarm limit.

Note! Selecting the 'User Defined' option also enables the Minimum
Operating limit level alarm. This alarm functions independently of the Low and
Low- algrms and is intended to give an additional stage of level alarm
monitoring.

This field allows the user to configure the type of automatic
tank gauge used by this tank. FuelsManager uses this
parameter for display only.

This field allows the user to configure the commands
available to the operator for a particular automatic tank
gauge. For example, Raise / Lower.

This field allows the user to configure the mass of the float,
FuelsManager uses this to compensate the level value
reported by the tank gauge. Used when LPG volume
calculation method is selected

This field allows the user to configure the density of the float.
FuelsManager uses this to compensate the level value
reported by the tank gauge. Used when LPG volume
calculation method is selected

This field allows the user to configure the diameter of the
float. FuelsManager uses this to compensate the level value
reported by the tank gauge. Used when LPG volume
calculation method is selected
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Polynomial sphere information

The Polynomial Sphere tab replaces the Strapping table tab when the user selects

the Tank Geometry option - Polynomial Sphere.

Step-by-Step

¢ Review the Level/Constant grid values
« Enter the required Correction Level and P Constant

Equation Constants

Edit Tank Data -» WSIZEMORE YTankFarm. TankTP-200. Tank @
Gieneral | Volume | Process Data | Alams | Vessel 1 | Vessel 2| Wik | Loak Detection Polynomial Sphere |
Level ‘ Q Constant ‘ R Constant | S Constant |
1 0-00-00 0.00e+000 0.00e+000 0.00e+000
2 0-00-00 0.00e+000 0.00e+000 0.00e+000
3 |0-00-00 0.008+000 0.00e+000 0.00e+000
4 |0-00-00 0.00g+000 0.00e+000 0.00e+000
s 0-00-00 0.00e+000 0.00e+000 0.00e+000
& 0-00-00 0.00e+000 0.00e+000 0.00e+000
7 |0-00-00 0.00=+000 0.00&+000 0.00e+000
& |0-00-00 0.008+000 0.00e+000 0.00e+000

Comection Level |0-00-00 ft-in-16th Deensity {3000 “API
P Conistant |0 Temperature |50.00 °F

LEVEL &
CONSTANT
COLUMNS

CORRECTION
LEVEL

P CONSTANT

DENSITY

TEMPERATURE
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Edit Tank Data dialog box - Polynomial Sphere tab

These columns display the volumetric constants to be
applied between the specified level ranges. The level
column reflects the current engineering units for the tank.

This field allows the user to enter the level offset to be used
to correct the level process variable for the measurement
error due to the low temperatures in tanks containing liquid
hydrocarbons

This field allows the user to enter the volumetric constant to
be applied to all level gauge values, for more details please
refer to the Tank Calculations chapter

This field allows the user to edit the density at which
polynomial sphere constants apply. This value is used in
FuelsManager volume calculations.

This field allows the user to edit the temperature at which
polynomial sphere constants apply. This value is used in
FuelsManager volume calculations.

Note! For detailed calculation
method used, see the Polynomial
Sphere section of the Tank
Calculations section

Edit Tank Data dialog

box - Polynomial
Sphere tab
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Note! Each time the weights and
measures Tank Seal Data is
changed, the Seal ID is increased.
This allows the weights and
measures authority to know if
seals have been removed and
subsequently reapplied.

Edit Tank Data dialog
box - Weights &
Measures tab

Note! For more information about
weight and measure functions, see
the Weight and Measure section of
this manual.
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Weights & measures information

FuelsManager allows the user to apply a software seal to a particular tank point.
This provides a method of verifying the data associated with the tank point is
weights and measures approved.

The W&M property tab in the Edit Tank Data dialog box provides a list of
Calibration Seals for a particular tank point variable. A check box indicates the
state for the Tank Seal and each input Process Variable Seal.

Step by Step
« To change the desired Seal State, click in the Seal check box with the left
mouse button

¢ The checkbooks is ticked
¢ Click the Update button

« If any Seal State changes are checked, the prompt is for entry of the
Weights & Measures Password. The Weights & Measures Password must
be properly entered to effect setting Tag Seals

¢ Alternately the prompt is simply for confirmation

Edit Tank Data -> WSIZEMORE \TankFanm. Tank 4.Tank ®
Genelal} \f’o\ume] Process Data] A\alms} Weszel1 ] Wessel2 WM | Strap ﬂ‘WaterTabIe} Leak Detecl\on}
Calibration Seals
O Tank ~
v
SeallD: O et |

Selecting the Tank parameter prevents modifications to any tank parameters that
can effect the calculated volumes.

Selecting an individual parameter prevents modification to the data source for that
particular variable.
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Strapping/water table information

FuelsManager allows each tank point to be configured with both a Product
Strapping Table and a Water Table. Follow the steps below to fill out the Strap/
Water Table information

Step-by-Step

» Select the Add or Insert button to enter the tank strapping table directly into
the grid, or use the Import button to import strapping table data from a
FuelsManager formatted strapping table text file (*.TST)

* Choose either Strap Table or Water Table. The table grid display will adjust
to either choice

« Enter the strapping table density and temperature in the Density and
Temperature fields.

« Select the strapping table type (innage or outage) in the Strap table Type

group
Edit Tank Data -> WSIZEMORE YTankFarm. Tank 4. Tank ®
General | Yolume | Process Data | Alams | Wessel 1| Vessel 2| Wit Shap / Water Table ]Leak Detection |
Strap | ft-in-16th | gal (US) |
1 0-00-00 0.00
2 40-00-00 1,200,000.00 @ Stap (" Water (" Hydio Def.
Densily (KT B
Temperature |50.00 F
Strap Table Type
& '
Strap / Water Table Mode
[ (5
Number Of Table Entries: 2
Add Ewpot | mpor |

Edit Tank Data dialog box - Strap/Water Table tab

STRAPPING These columns display the current tank strapping table

TABLE GRID information; in addition, the user can edit any particular

COLUMNS entry by clicking on and editing the appropriate cell. The
column headings reflect the current level and volume
engineering units for the tank

STRAP TABLE, This selection allows choice of the table type, and alters the

WATER TABLE, table grid display to list either the Strap, Water, or Hydro

HYDRO DEF definition tables. Selection of Water and Hydro Def tables

will disable the Strap table Type fields
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Note! The Product Strapping Table
can be configured in the registry to
include or exclude the Water
Volume.

Note! The Polynomial Sphere tab
replaces the Strapping Table tab
when the user selects the Tank
Geometry option - Polynomial
Sphere.

Edit Tank Data dialog
box - Strap/Water table
tab
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Edit Tank Data dialog box - Strap/Water Table tab

DENSITY

TEMPERATURE

ADD

DELETE

INSERT

EXPORT

IMPORT

STRAP TABLE
TYPE

INNAGE

This field allows the user to edit the strapping table density.
This value is the density at which the strapping table was
created and is used in FuelsManager volume calculations

This field allows the user to edit the strapping table
temperature. This value is the temperature at which the
strapping table was created and is used in FuelsManager
volume calculations

This button allows the user to add a new entry at the end of
the strapping table

This button removes the currently selected entry from the
strapping table

This button allows the user to add a new entry at the
currently selected position in the strapping table

This button allows the user to export the tank strapping
table to a proprietary formatted text file. This allows the user
to edit the information offline using 3rd party tools like
Notepad

This button allows the user to import a previously exported
tank strapping table

This group allows the user to configure the type of strapping
table to be used, either Innage or Outage. A tank may be
converted from Innage to Outage by simply changing the
selection in the Strap table Type. The system calculates the
new Outage Strap table based on the Innage table and
recalculates the new alarm setpoints. A tank may also be
converted from Outage to Innage by the same process

The Innage option button is the default value for new tanks
and measures the actual fluid in the tank, displaying the
Level measurement values from low to high. When the
Innage option is selected, the following applies:

Alarm settings under the Alarm tab are recalculated to
reflect your Innage selection:

High-High - must be greater than High and activates when
the tank level is equal to or greater than the setpoint.

High - must be greater than Low but less than High-High
and activates when the tank level is equal to or greater than
the setpoint.

Low - must be greater than Low-Low but less than High and
activates when the tank level is equal to or less than the
setpoint.

Low-Low - must be less than Low and activates when the
tank level is equal to or less than the setpoint.

Volume calculations - are based on the Strap table

Administrator Manual



Creating and editing tank points

Edit Tank Data dialog box - Strap/Water Table tab

OUTAGE The Outage option button measures the actual free space in
the tank displaying the Level measurement value from high
to low. When the Outage option is selected, the following
applies:

Alarm settings (In the Alarm tab) are recalculated to reflect
your Outage selection:

High-High - must be less than High and activates when the
tank level is equal to or less than the setpoint.

High - must be less than Low but greater than High-High
and activates when the tank level is equal to or less than the
setpoint.

Low - must be less than Low-Low but greater than High and
activates when the tank level is equal to or greater than the
setpoint.

Low-Low - must be greater than Low and activates when
tank level is equal to or greater than the setpoint.

Volume calculations - are based on the Strap table with the
exception of Water Volume and Bottom Volume for Outage.
These volumes are calculated as if the Strap table was an
Innage table

Strap, Water and Hydro Definition Modes
FuelsManager can be configured to calculate gross volume by one of two different
methods:

« Combined product and water tables

» Separated product and water tables

These selections control how the product and water tables overlap and how
FuelsManager should interpret the volumes at the point where the two overlap.
For more details, see the Product & Water Strapping Tables section of the Tank
Calculations chapter.

Leak Detection

If your system has the Leak Detection feature installed, a Leak Detection tab
appears on the Edit Tank Point dialog box. For details on these configuration
parameters, please refer to the Leak Detection section of this manual.
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Left - Database menu
select the Source
Assignments
command

Right - Database |10
Connections dialog
box, for descriptions
refer to the table
opposite
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Assigning data sources

Database 10 Connections El

Current Datahase System Connection Types
= WSIZEMORE Database. ¥ Mone [V Manual ¥ Calc [V Comm
archiveManager Selected Point Type v OFC

@ Tank  C mput O Output  ( Triggered Refresh

Database Point Connection Type Selectsd System | Server | Server Tac A

TankFarm.Tank 1 Tank Level Manusl

TankFarm.Tank 1 Tank Temperature .. Manual

TankFarm.Tank 1 Tank Dersity Cale

TankFarm.Tank 1 Tank Water Level Manual

TankFarm.Tank 1 Tank SB5W Manual

TankFarm.Tank 1 Tank Volume Gross ... Calc

TankFarm.Tank 1 Tank Volume Net Calc

TankFarm.Tank 1.Tank Yolume Remaini.. Calc
TankFarm Tank 1 Tank Yolume Availab . Calo
TankFarm.Tank 1. Tank Standard Densi... Manual

TankFarm Tank 1 Tank Mass Calc.
TankFarm.Tank 1. Tank Solids Level Manual
TankFarm Tank 1 Tank Flow Calc

TankFarm.Tank 1 Tank Weter Yalume ... Calc
TankFarm.Tank 1 Tank Gauge Postion .. None
TankFarm.Tank 1 Tank Density Temper... None
TankFarm.Tank 1 Tank Solids Yolume .. Calc v

< >

}

FuelsManager provides access to all data point assignments in one dialog box to
simplify management of Points in a database.

Database IO Connections dialog box

CURRENT The Current Database System displays the name of the

DATABASE system that hosts the currently selected database.

SYSTEM

DATABASE Clicking Database displays the Select FMDataManager

BUTTON Subsystem dialog box to allow selection of another system'’s
database

SELECTED This option buttons allows filtering of the point types appear

POINT TYPES in the Database Point list

« Tank Points - displays all tank points in the Current
Database System

« Input Points - displays all input points in the Current
Database System

< Output Points - displays all output points in the Current
Database System

« Triggered Points - displays all triggered points in the
Current Database System
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Assigning data sources

Database IO Connections dialog

assignments

assignments

Step-by-Step
¢ Open FuelsManager Configuration

box

CONNECTION This option buttons allows filtering of the types of
TYPES connections displayed on the Database Point list.
* None - displays all unassigned connections

e Manual - displays all manual data source assignments
e Calc - displays all calculated data source assignments
e Comm - displays all CommManager data source

e OPC - displays all OPC Server data source

SELECT The Select Source button allows a data source to be

SOURCE assigned to a database point. Clicking on this button

BUTTON displays the Select Data Source dialog box, and is only
enabled when a Database Point has been selected.

REFRESH The Refresh button the Database Point to be renewed
based on the current options selected in the Selected Point
Type and Connection Types options.

Opening the Database 10 Connections dialog box

* From the Database menu select the Source Assignments command
e The Database |0 Connections dialog box appears

» Select and then double click any database point shown

e The Select Data Source dialog box appears

Select Data Source - Water Yolume E|
Source Type Selection
Current Type  Calculated
Clear hdanual | Comm Cale QR
Bitfield Properties
Start Bit umber of Bits: Start Data Source Bit:
Data Type
Translgtion; |=hlone= | ...| Source Units: Undefined S

Diata Source
System

Device/Point Descrigtion

Ok Cancel
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Note! For a description of the
Database 10 Connections refer to
the table below.

Note! The Select Data Source
dialog may also be opened directly
from the Input, Output, Trigger or
Tank Point edit dialog.

Select Data Source
dialog box
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Note! For details on Data Source
types, see Point Attributes section.
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Dialog Group

Source Type
Selection

Bitfield Properites
(Only available the
point is configured
to process bitfield

data)

Data Type

Data Source

Button/Field

Current Type

Start Bit

Number of Bits

Start Data
Source Bit

Translation

Source Units

System

Device/Point
Description

Description

Displays the current Data Source type for
this database point. Possible options--
Clear, Manual, Comm, Calc, Local, OPC

Defines the first bit position in the
database point that will be sent to the
assigned /O point

Defines the number of bits, starting with
the Start bit, that will be sent to the I/O
point

Defines the first bit position in the
assigned I/O point that the bits defined by
the start bit and number of bits will be
written to

Translation or scaling table to be applied
to this database point

Engineering units that the received data
value will be expressed in

System name that this point is assigned
to

Description of the device or I/O point that
this database point is connected to

Select Data Source dialog box - commands and settings

CURRENT
TYPES

UN-ASSIGNED /

CLEAR
MANUAL

COMM

This field displays the current data source type.

Data Source is undefined, the data will be tagged as un-
initialized. The Clear button un-assigns the data source.

The Manual button assigns the data source such that the

operator will manually enter the value.

Data is to be received from the designated CommManager
Input or outputted for output points. The Comm button opens
the Communications Interface Configuration dialog box,
allowing the user to connect the value of the point to external
devices. Refer to the previous Data Source description
section and the particular Communications Driver manual for
procedures.
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Assigning data sources

CALC

LOCAL

OPC

Select Data Source dialog box - commands and settings

Data is to be updated by internal database calculation. The
Calc button assigns the data source such that FuelsManager
will calculate the data value for this point.

Data is to be received from another FMDataManager Point.
The Local button opens the Database Edit dialog box,
allowing the user to select another FuelsManager database
point to be used as the data source for the point. This option
is only available for the Tank Point - Ambient Temperature
process variable.

Data is to be updated from the assigned OPC Server.

Presently, output to an OPC server is not supported. The
OPC button opens the OPC Server Configuration dialog
box, allowing the user to select an OPC Server tag to be

used as the data source for the point.
Note! Varec is a OPC Foundation Member. For additional information on OPC
visit - http://www.opcfoundation.org or contact a Varec representative.

Clearing data source

ADMO03GVAE1005

Step-by-Step

¢ Open the Data Source dialog box for the point you want to clear. See
Opening the Database 10 Connections dialog box steps

* Check the Current Type field. If the field displays the message “Not
Assigned,” then the data source is already clear and no action is needed

« If the Current Type field displays a different message, then click Clear. The
“Not Assigned” message appears

¢ Click OK to close the Select Data Source dialog

Selecting a Manual data source

Step-by-Step
* Open the Data Source dialog box for the point you set. See Opening the
Database IO Connections dialog box steps

¢ Click Manual. The Current Type changes to “Manual Entry”
¢ Click OK to close the Select Data Source dialog
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Selecting a Comm data source
Selecta

Communication ro— =
Interface dialog Select A Communication Interface sl

System Mame:  WSIZEMORE Select System

Interface Descrigtion Interface Type Port Locked
INTERFACE 004 Madbus Master UNASSIGNED Unlocked
INTERFACE 007 “arec 5130 RTU UNASSIGNED Unlocked

| Cancel ‘

Step-by-Step

¢ Open the Data Source dialog box for the point you want to clear. See

Note! The exact process for Opening the Database |0 Connections dialog box steps

selecting the device and I/O point ¢ Click Comm. The Select a Communication Interface dialog box appears and

is specific to the interface selected lists all available Interfaces

¢ Select the Comm interface that you want to assign and select the device
and 1/0O point from the selected interface.

¢ Click OK to close the Select Data Source dialog

134 Administrator Manual



Assigning data sources

Selecting an OPC data source

OPC Server Source Select

System  [WSIZEMORE
Selected OPC Server _Fndress+Hauser.DataManager.1
Scan Time | 1000 mEec (100 - 10000)

et
adet,

= Meters # || Alarm & Ack Data
[+ W-300 Bl s Status
= M-400 3 Process Yalue
FloweRate
Temp
Density -

Ok | Cancel

Step-by-Step

within that OPC source

¢ Click OK to close the Select Data Source dialog

Selecting a Local data source

Step-by-Step

¢ Click Local, the Database Edit dialog box opens

¢ Click OK to close the Select Data Source dialog
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¢ Open the Data Source dialog box for the point you want to assign. See
Opening the Database 10 Connections dialog box steps

¢ Click OPC. The OPC Server Source Select dialog box appears
* From the list, select the OPC server. The list below will display the points

« Click the + to open levels of the database and navigate to the specific data

source point and select the point when it appears in the lower-right list
¢ Click OK to close the OPC Server Source Select dialog

¢ Open the Data Source dialog box for the point you want to clear. See
Opening the Database 10 Connections dialog box steps

« Browse to the database point you want to assign and click Select

OPC Server Source
Select dialog

Note! The local data source
selection is only available for the
Tank Point Ambient Temperature
parameter
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Engineering Units Conversion

The Source Units defined on the Select Data Source dialog box instructs
FuelsManager what engineering units the data value being received from the I/O
points are expressed in. So, if FuelsManager receives a value of 30.5 and the
Source Units are set to feet, FuelsManager knows to treat this as 30.5 feet.

Engineering unit conversions can be associated with any database point via the

Select Data Source dialog box.

If the engineering units for the FuelsManager database point do not match those
defined for the 1/0 paint (Source Units), it will automatically be converted the
engineering units defined for the FuelsManager database point.

If Source Units are not defined, FuelsManager assumes that the data received
from the 1/0 point is in the same units as the FuelsManager database point and no

unit conversion is performed.

The following example shows data received by FuelsManager, the same
functionality applied to data transmitted by FuelsManager.

Fuelsh anager
Database Point

Data Source
Definition Dialog

Source Units = rmm

Tank! Level
Level Units = feat "‘

Source Units and

not match, sovalue of
1200 mim is corverted to

3.937 feet

Fuelstanager
Database Point

Tankl.Level

1200feet is read.

Database Point units do

Level Units = feet —

Source Units are not

Data Source
Ciefinition Dialog

Source Units =

' undefined

defied s0 no conversion is
performed and a walue of

Level Gauge

Lewel =
1200mm

Walue of 1200 st from
Level Gauge

Level Gauge

Lewvel =
1200mim

Yalue of 1200 sant from
Level Gauge
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Configuring translation tables

Configuring translation tables

Translation tables define how data received / transmitted by FuelsManager is
scaled or converted to the data required by the device with which FuelsManager is
communicating. FuelsManager provides two types of translation tables:

* Lookup Tables — a simple table defining mapping of one set of values to
another set of values
« Scaling Functions — used to apply a mathematical formula to the value in
order to scale a particular range of values to a different range of values
FuelsManager allows the configuration of user defined names for translation
tables. Once a Translation table is defined it can be used as many times as need
by multiple databases points. This functionality allows the engineer to define all
the required translations once and then simply assign them to the points as
needed.

Translation tables can be associated with Input, Output and Triggered points. In
addition they can be applied to individual Tank Point process values via the Select
Data Source accessed from the Process Data tab.

Lookup Tables

A lookup table defines a one to one mapping of one set of values to an alternate
set of values. This mapping can be numeric to numeric, or coded variable / string
value to numeric.

Numeric to Numeric

From To
10 1
20 2
30 3

Coded Variable to Numeric

From To

Stop 100
Start 101
Pause 102

Lookup tables can be applied to data being received by FuelsManager and data
being transmitted by FuelsManager.

For data received the From column defines the data being received and the To
column defines the value that will be written in to the FuelsManager database.
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For data transmitted the From column defines the value in the FuelsManager
database and the To column defines the value that will written to the

communications interface.

In either case, transmit or receive, if a value is not defined in the lookup table no

conversion is applied.

FuelsManager

Translation Table

Database Point (Lookup) PLC
Valve 101 Procees gtrg;;n: 1T[]%
Yalue = Start - Start= 101 - alue = 101
Pause = 102 LT "
Database point is of type e
coded variable and setto colded :a:g?le Start' to
the value ‘Start el
FuelsManager Translation Table
Database Point (Lookup) PLC
Valve 101 Procees |1:60m: IO
Value =3 20 =2 i Value = 30
3 =3
Lookup Table converts
PLC'svalue of 30 towalue PLC sendsvalie of 30
of 3
FuelsManager Translation Table
Database Point (Lookup) PLC
Walve 101 .Process '1:60”]_ IO
Welue = 70 I el Walue = 30
an =3

Walue of 70is not in the
Lookup Table sono
conversion take place .

FLC sends value of 70
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Configuring translation tables

Scaling Functions

A scaling function defines mathematical formula that is applied to the value before
it is received or transmitted by FuelsManager. The following formulas are
supported.

c Y=A*X+B

* Y =(X-A)/(B-A)

¢ Y =[(X/A)* (B-C)] + C

* Y =[(X/A) ] (B-A)] * (D-C) +C
In these formulas the variable Y represents the result of the scaling and X is the
value before scaling. The constants A, B, C and D are configured by the user.

The following example shows data transmitted by FuelsManager, the same
functionality applied to data received by FuelsManager.

Fuelshanager Translation Table
Databaze Point (Scaling) PLC

Mty Hum ber.Process TR
Value =346 0202 Vabe= 1682
Datablase points current B= 100 ?‘:E!c:lgz-;fzsrzglﬁnoan
LELEIESSE walue of 189.2being writen
tothe PLC

Poirt's Minimum =0 .
Poirt's b asimum = 100 Scaled range of value in
PLC would be
Minimum = 100
M aximum =300
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Note! In the above example only 3
bits in the FuelsManager database
value are define. However,
FuelsManager will write the entire
word to the PLC. This means that
any data stored in bit 0 through 4 in
the PLC word will be overwritten by
zeros when bits 5, 6 and 7 are
written. It is the engineer’s
responsibility to ensure that writing
bitfields does not cause

unexpected operations in the PLC.
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Configuring bit field data sources

The concept of Bitfields allows the user to configure how individual bits within an
integer value are manipulated. To enable bitfield processing the user selects the
Bitfield Data option on the Input, Output or Triggered edit point dialogs; this option
is only available for integer type data formats, including:

e Char

* Byte

« Short

* Word

e Long

« DWORD

When the Bitfield Data option is enabled for a particular point the Start Bit, Number
of Bits and Start Data Source Bit parameters on the Select Source dialog are
enabled.

The Start Bit value defines the first bit position in the FuelsManager database
point that should be processed.

The Number of Bits value defines how many bits in the FuelsManager database
point should be processed, starting with the Start Bit.

The Start Data Source Bit value defines the first bit position in the I/O point that the
start bit (and subsequent number of bits) should be written to.

The following example shows data transmitted by FuelsManager, the same
functionality applied to data received by FuelsManager.

Fuelsianager PLC
Database Point

Value =

MyMurmber.Proce s
00000101

Walue = 0101000

o 123 4 58 7

2 3 4 5 6 7
(0T o7 0o[ oo T] IEIIEIIEIIEIIEI [077]

Start Bit =1

Number ofbits=3 k&

Start Data Source Bit= 5

Points with the Bitfield Data option enabled allow up to 32 independent data
source assignments. This allows the combination of multiple bits into a single
integer or the writing of single bits, from multiple integers, into a single PLC
register.

Again the following example shows data transmitted by FuelsManager, the same
functionality applied to data received by FuelsManager.
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Configuring bit field data sources

Fuelstanager e
Database P oints

0tz 34587

MyMumber? |0f1fof1jofofofo Al Fuelsh anager database
Start Bit=1

points ar e assigned to the
same PLC 1O point
Mumber of bits= 3 4"—-‘

Stant Data Source Bit=5

Yalue=
00000101

012 244506 7

(T [O[ o[ T[T]0]1]
MyMurroert 4 4
0134 456 7
MyNurmoer2 [TTO] T O T 0[] 0] wnozz 44
WyMurrberd
Start Bit =1 —
Mumber of bits= 2 é }

Start Data Source Bi=0

012 2 448067

Wyhumbers [T 1 o[ o] 1[1]0]
Start Bt= 0

Murrber of bits=3 4 4
Start Data Source Bit=2
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Importing and exporting points

Files consisting of Input, Output, Triggered, and Tank point information can be
imported and exported. FuelsManager also enables the user to import manual
values, calculated values, forced values, strap tables, and source assignments.
This feature has been provided so that the user can create an Input, Output
Triggered, or Tank point using external applications such as Excel or Notepad. Not
only can this method save time involved in initial configuration, but it can also be
used as a backup utility or a method for making bulk changes to the configuration.

Creating a *.csv file involves entering the column headers and entering the
associated point parameters. These files can only exist as comma delimited files
(*.csv).

The parameters found in the file vary based on the type of data exported. The file

types are described in the following table:

ASSIGNMENTS

Import / Export Data Type dialog box

INPUT POINTS  Files contain all the attributes associated with an Input point
OUTPUT Files contain all the attributes associated with an Output
POINTS point

TRIGGER Files contain all the attributes associated with a Triggered
POINTS point

TANK POINTS Files contain all the attributes associated with a Tank point
STRAP TABLES Files contain tank and strap table file names

SOURCE Files contain the Database tag, variable, data source type,

database system, interfaces, device, and connected I/O
communication point entries. For example:
Tank-1.Low-Stop,VALUE,NONE
Tank-1.Gauge,LEVEL,COMM,\GRAY1,TSU 1,Tank 1,Level,
Tank-1.Gauge, TEMP,COMM\\GRAY1,TSU 1,Tank
1,Temperature,

Tank-1.Gauge,DENSITY,CALC
Tank-1.Gauge,LVL_H20,MANUAL

MANUAL Files contain the Database tag, variable, and value entries.

VALUES The value is an assigned command, for example - STOP
Tankfarm.Tank.A301,BSW,0
Tankfarm.Tank.A301,STD_DENS,67.10898

FORCED Files contain Database tag, variable, and value entries. The

VALUES value is a forced value. For example
Area42.Tank37,LEVEL,220

CALC VALUES Files contain Database tag, variable, and value entries. The

value is the calculated value. Uncalculated points contain the
* Uninitialized * parameter. for Example
Tank-2.Gauge,FLOW,* Uninitialized *
Tank-3.Gauge,DENSITY,75.87801
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Importing and exporting points

The Input, Output, Triggered, and Tank point data types add points to the
database. The other data types are reference values assigned to the existing
points in the database. For example, the Manual Values data type file assigns
manual values. The import function finds that particular database point and
variable, and then assigns the manual value.

To import a point file

Step-by-Step

< In the Database Edit dialog box, click Import. The Import/Export Data Type
dialog box appears. This dialog box lists the types of data that can be
imported and exported

¢ Select the desired data type and click OK
¢ The appropriate Import File dialog box appears
e Select the desired file and click OK.

« A dialog box appears briefly indicating that the selected file is being
imported

To export a point file

Step-by-Step

¢ In the Database Edit dialog box, click Export

* The Import/Export Data Type dialog box appears
« Enter a file name and select the directory

e Click OK

« Adialog box appears briefly indicating that the selected data type is being
exported to the selected file
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Note! Before performing the tasks
to import or export points, the
default value (i.e. 123,456,789) in
the Digit Grouping field needs to
be changed to (123456789) on the
Customize Regional Options -
Numbers tab. After completing the
Export and Import functions,
change the Digit Grouping field
back to its default value (i.e.
123,456,789)
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Copying and renaming points
Database Points can be renamed or copied at any database level.

Point Copy/Rename

. Point Copy/Rename X
dialog B, E'

Source Paints

|Tank Farm | Tank | Tank 4

Destination Points

| Tark Farm | Tark [ Tank 5

Options

v Copy Description Help

v Copy Alarms
v Copy Tank Strap fvater Table

Copy

Step-by-Step

« From the Database Edit dialog box, select the desired database point level

¢ Click Copy (or Rename). The Point Copy/Rename dialog box appears, with
appropriate options to copy or rename. (The items in the Options section are
not available when Rename is selected.)

« In this dialog box, the user enters the Source points used to copy or rename
the Destination points. Each edit box corresponds to a database level. For
example, if the user were editing a two-level database point, the leftmost
edit box would be unavailable

« Enter the Source Points

e The user can rename points using a combination of methods by entering an
asterisk (*) in the appropriate edit box(es). For example, the user can type
BARGE in the Level 2 edit and then enter asterisks (*) in the remaining edit
boxes. This combination instructs the database to rename the Level 2 of the
destination points, but to leave the remaining levels unchanged

« If the entire point needs to be renamed, the user then enters the existing
point in the Source Points edit boxes and the new name in the Destination
Points edit boxes. In the above example, the Tank Farm.Tank.Tank 4 point is
renamed Tank Farm.Tank.Tank 5. The user could have also entered an
asterisk in the Destination Point’s third edit box instead of typing in GAUGE
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« Enter the Destination Points. The user can also use asterisks. These points
will be renamed according to the defined Source points

» Click Copy (or Rename, if renaming). A message is displayed warning the
user that any Graphics or Reports that reference the point(s) that are about
to be renamed may now be invalid

« If the point(s) are renamed successfully the Database Copy/Rename Status
dialog box will indicate a status of OK, otherwise it will indicate the reason
why the rename failed. When renaming multiple points the Database Copy/
Rename Status dialog box will indicate which points were successfully
renamed and which failed

¢ Click OK. Changes or new points appear in database

Point Copy /Rename dialog box

SOURCE POINTS  These fields define the FuelsManager database point to
be used as the source for the copy / rename action.
Wildcard characters allow the user to copy an entire
database level at once.

DESTINATION These fields define the FuelsManager database point to

POINTS be created by the copy / rename action. Wildcard
characters allow the user to copy an entire database level
at once.

COPY Copy the description of the source point to the destination

DESCRIPTION point.

COPY ALARMS Copy the alarms associated with the source point to the

destination point.

COPY TANK STRAP Copy the tank strapping table of the source point to the
TABLE destination point.

COPY PRODUCT Copy the product assigned to the source point to the
destination point.
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Note! Make sure that the
CommManager is not in Shutdown
mode. Otherwise, the user will not
be able to access the configuration
and maintenance dialog boxes.
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Communications interface configuration

The Server architecture module CommManager is responsible for exchanging
data between the FMDataManager module and external field devices such as tank
gauges and remote terminal units.

To be able to access the Communications menu, the user must have appropriate
privileges (refer to the Security). In most configurations, operators do not have
access to communication interface configuration.

The communications interfaces and associated devices of the CommManager are
configured and maintained from the Communications menu found in the
Configuration application.

Configuration can include creating an interface, selecting a port, creating a device,
and establishing connections from the database points to the designated field
devices. The procedures for creating interfaces and devices vary depending on
the type of device you are using.

An interface is utilized to transfer data into or out of a system. An interface is like a
communication channel, such as a serial port or network card. Some examples
include the Varec 8130 RTU, Modbus Master, Modbus Slave, and Varec TSU.

Communications Interface Configuration dialog box

INTERFACE Displays the interface description entered when the
DESCRIPTION interface was created

INTERFACE TYPE Displays the interface type (Varec 8130 RTU, Modbus
Master, Modbus Slave, and Varec TSU)

PORT Displays the selected hardware port used by the
interface. It may be a serial port or another hardware
communications channel

LOCKED Indicates if the interface is available for configuration
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Creating a new interface

The types of interfaces that can be created are dependent on the drivers installed
on the system. Once drivers have been installed, a new interface can be created.

Step-by-Step

Configuration command

already installed will appear for selection
¢ Click OK
e The Port Type dialog box appears

Terminal Server Port or Dial Up Modem

the available settings

recently created configuration listed

System Mame:  WSIZEMORE Select System

RunMode:  acTivE

Interface Status

Interface Description

Interface Type

Port

Communication Interface Maintenance @

Status

INTERF ACE 004
INTERF ACE 005

Moadbuz Master
Warec 8130 RTU

Change Interface Mode

UMASSIGMED
COM1

Open Maintenance Dialog

Dane |

Help |

STANDEY
STANDEY
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* From the Configuration application, Communications menu, select the

¢ From the Communication Interface Configuration dialog box select New
* The Choose The Type of Device dialog box appears
« Select the type of device you want to create. Only devices with the drivers

» Select the port type that the device is connected to, Local Serial Port, LAT
* The port type selected will determine what dialog box will appear next and

 Edit the port configuration necessary for the device you are creating
» Select OK once the device has been configured
* The Communication Interface Configuration screen will appear with the

Communication
Interface Configuration
dialog box
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Left - Choose the type
of device

Right - Select the port
type

Communication Port
Configuration dialog
box

Choose The Type Of Device @ Port Type E]

Local Serial Port
LAT Terminal Server Port
Dial Up Modem

Allen Bradley DHIDH+
Ertiz Host Interface
Modbus hMaster
Modbus Slave

M7 InterFace

Warec 8130 RTU
Warec TSU Model 6520

OK | Cancel

Local serial port and Dial-up modem

The local serial port is used when using any of the serial communications from the
local system. The dial up modem is used when using a modem for
communication.

The configuration of the local serial port and dial up modem involves the
definitions of the baud rate, data bits, stop bits, parity bit, handshaking and the port
identification.

Communication Port Configuration - RS232/485 Serial

System Mame:  WSIZEMORE

Interface Desc:  INTERFACE 001 m i
Baud Rate Data Bits Stop Bits Parity Handshaking -
38400 . = t (s 1 Bit= & Cdd i+ pane
& " 156t (" Ewen s
(" T Bits " 2 Bits {* Mone (" RTSICTS
(" 3 Bits £

O | Cancel | Help |

LAT Terminal Server Port
Local Area Transfer (LAT) systems support is for legacy systems running on NT
systems only with the 900DSL communication server and the 8130 RTU.

Communications port configuration

The communications port configuration is specific to the type of hardware the
system utilizes to communicate with field devices. In the case of a serial port
interface, parameters such as baud rate and number of data bits are available for
configuration. An interface must have a valid configuration for a hardware port
before communications with a field device can occur.

The dialog box used to configure a port is first displayed during initial
configuration. The port can be edited by selecting the Port button inside the
Device Configuration dialog box.
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The port list box displays the selected communication ports from the list of
available ports not assigned to other interfaces. There will always be an
UNASSIGNED entry in the list. The UNASSIGNED selection disables all other
controls in the dialog box until a valid port is chosen.

An interface may be configured with its hardware port UNASSIGNED, but the
interface may not be activated until a port is chosen. If the device is currently
ACTIVE it will be set to STANDBY. Once a valid port is chosen other
communications parameters may be set. Choices will be restricted to those which
are supported by the device.

Locked interfaces and devices
A Lock status is set when a user is configuring an interface or device.

If another user is configuring the same interface from another FuelsManager
system, configuration access to this interface will not be allowed. A message will
be displayed noting which user has the interface locked and from which system
this user is working. If the interface is unlocked, configuration can proceed
normally.

Anytime a user clicks Done at the end of a configuration process, the action saves
the configuration, updates the run-time interface and resets the configuration lock
of the interface. When an interface is locked during configuration, the run-time
operation of that interface is not interrupted and continues until the user
configuring the interface clicks Done.

At that time, the run-time operation of the interface is interrupted just long enough
to modify its configuration, and then normal operations resume. This time period
varies from one device to the next.

Device configuration
Device configuration varies widely between different types of devices. The user
needs to consult the device user’s documentation for further instruction.

If an interface has a valid port configuration as well as a valid device configuration,
the interface can be placed in an active mode so that communication with the field
device can occur. If the device was not configured when the interface was

created, the device can be subsequently configured through the Communications

Configuration dialog box.

Step-by-Step

» Select Devices in the Communications Interface Configuration dialog box

* The device specific configuration dialog appears

« Enter configuration parameters for the particular device. There may be
multiple dialog boxes that need to be completed for the configuration

« Click OK in the Device Configuration dialog box after all configurations have
been made for the device

¢ Click OK in the interface type configuration dialog box once all devices have
been defined.
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Note! The time period should be
insignificant enough that the user
will not notice any interruption of
data to or from the interface.
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RTU8130 Interface
Configuration dialog
box

1/0 Point Connections
dialog box
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130 RTU Interface Configuration @

System Name:

Interface Desc:

Delarys
Between Palls :

03 Seconds
Configured RTLs

Mame

MSIZEMORE

Port

Port 1| COM1
Port 2| UMASSIGHED

Address  Configuration

‘ Mew RTU ‘ T |

Run IEWRTU

I/O Point connections

1/0 point connections designate the link between the DataManager database point
and the field device. Each device has its own set of predefined CommManager 1/O
points depending on that device type. For data to pass between the
CommManager and the FMDataManager, the CommManager 1/O points must be
connected to FMDataManager point variables. One or more databases can be
interconnected with the CommManager over a network.

I/0 Point Connections - 5130 RTU Device
About

System Mams ‘E\VACH

Imertacs Desc: anmp\ elrterface

RTU Name ;.  |Meww Device vI

TypeNumber Parameter IMputiCuput - Description Source Database §fPoint 1D 1 Yariablz
RTU Communication Status Imternzl Comm . Status Init ] t_ﬂ
RTU Systern Stetus Irternal RTU Status Int ] 1.
CLE.O0 SysTime IFtermEl Systetn Time RTU ] f_
CLk 00 timezane Irternsl System Time RTU 1] |
10,0010t atuz1 Inpant 11D Comfiguration RTU X o
10,00 105 atus2 Impout 1% Configuration RTU ] I
1000 105t atus3 Mgt 12 Configuration RTU v F
10 .00 105t atus4 ImpLt 1D Comfiguration RTU ¥ r__
MM=53.01 Elapze Imput Mi=53.01 RTU 1] r___
MhiS53 01 Command ImpLt MWS53.01 RTU il i bt
« | »
ALESIO | Clear ... | Mgy | Edit Delete | Done |

Restrictions to 1/0O points
Some devices do not allow the connection of I/O points to DataManager point
variables of an incompatible type. As a result, restrictions may apply when
selecting a database point depending on the engineering units and data format
(for example, Float, DWORD, etc.)
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Types of I/O points
Device drivers can support three types of 1/O points:

Internal An internal point only exists in the device driver software, and
typically provides information about the status of the
communications between FuelsManager and the device

Input Input points collect data from the field device and can be
connected to FuelsManager point variables in order to read
data from the field

Output Output points read data from FuelsManager point variables
and can be connected to I/O points to write values to field
devices
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Communication
Interface Maintenance
dialog box
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Maintenance

The user can perform maintenance and diagnostics on the interfaces and
corresponding devices. In the Communication Interface Maintenance dialog box,
the user can change an interface’s mode as well as open the device dialog boxes

of that interface to display diagnostic information.

Step-by-Step
e Select Communications in the Configuration dialog box
* Select Maintenance

Communication Interface Maintenance @
Select System

System Mame:  NSIZEMORE
RunMode:  acTivE

Interface Status
Interface Description

INTERFACE 004
INTERFACE 005

Interface Type Port Status

Madbus Master UNASSIGMED  STAMDEY
Warec 8130 RTU COM1 STAMNDEY

Change Interface Mode Open Maintenance Dialog

Done Help

Change interface mode

Each individual interface has a current status, which is either STANDBY or
ACTIVE.

The CommManager does not communicate to the field devices when an interface
is in STANDBY. The port is then available to other non-FuelsManager programs.

When an interface is ACTIVE, the communications port becomes active and
unavailable. Communications then become operational. The data is transferred to
and from the database as defined by the device 1/O point configurations.

Step-by-Step
» Select the Interface description in the dialog box window for the interface
you wish to modify

» Select Run button to change the device from STANDBY to ACTIVE
¢ Select Standby button to change the device from ACTIVE to STANDBY
 Click Done to finish
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Device maintenance

Device maintenance is accessible by selecting the Device button in the
Communications Interface Maintenance dialog box. It allows the user to view
diagnostic information about the selected device. Diagnostic capabilities vary from
device to device.

Device Maintenance - 8130 RTU Device

System Name : 0
Interface Desc:  INTERFACE 001

Irterface Status
Fun Mode :  STANDEY

Port 1
Address (000 Desgcription : O s Mode:
Current Retry 555 Last Scan Time 000000 himes Time Between Scans : 0L him:sms
Port 2
Address 1 C Description ;AR ace:
Current Retry 955 Last Scan Time 00 hmes Time Between Scans : 0000 S himsms

Commandds Displays

RTUName | '] [

Cammunications

Done

Port Stats

a
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ArchiveManager

ArchiveManager is a FuelsManager subsystem that extracts information from
FMDataManager and stores it to an alternate data source, which is usually a third
party ODBC compliant relational database.

This section describes how to configure ArchiveManager to archive points and
associated variables to a relational database management system (RDMS) with
an ODBC interface (MS SQL, Access, etc.). This chapter also explains how to
start and shutdown ArchiveManager.
Opening ArchiveManager
You can access the ArchiveManager Configuration dialog box from the Database
menu in the FuelsManager Configuration application.

Step-by-Step

¢ Click Database from the Configuration dialog box menu bar

« Select ArchiveManager. The Archive Manager Configuration dialog box
appears

ArchiveManager configuration

Before ArchiveManager can begin transferring data, you must first configure the
system to archive the correct data, in the correct format, on your planned
schedule.This includes:

» Selecting a real-time Database(s)--the DataManager from which
ArchiveManager will extract data
« Connecting to a data source (ODBC-compliant RDBMS)
» Entering the Start Time, Interval, and Historical Period
« Selecting FMDataManager variables to be stored
When you finish configuring ArchiveManager, you must click OK to enable the

new settings.
ArchiveManager Archive Manager Configuration gj
Configuration dialog
box Realtime Database: WTESTWSE Select..

Historical Detabase: FM System Access (Microsoft SAL Server) Disconnect

Start Time (HH:Mw): oono I~ Archive Input and Output Points

Interwal (in Minutes) 10 I Specify Archived Poirts

Historical Period (in Days) | B0 I Automatic End-of-Morth Backup

Tank Point Yariables Type Wickh Precision
Bottom Pressurs P1 17 Al
Cathodic: Protection Byte 3 0 3 Q
Date Installed Date 25 0

Density Maximum Double 17 3

Density Minimum Double 17 8 Elit...
Density Units: Units: 23 o

Density Double 17 3

Description Desc 30 a

Flevas b asim wm Peinla 47 A el

Ok Cancel
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Selecting a real-time database

Step-by-Step

« From the Archive Manager Configuration dialog box, click Select. The
Select FMDataManager Subsystem dialog box appears

¢ Select the database systems you want ArchiveManager to transfer from. To
select more than one, press <Ctrl> and click on multiple DataManagers. Or
click Select All to select all options in the window

* Click OK after you make your selections. The system returns you to the
Archive Manager Configuration dialog box. Your database selection
appears in the Real-time Database display field

Note! You must have permission

Select DataManager Subsystem @ :)OI' ?ﬁg%sift;ht?;ﬁgg:afgﬁ:e systems,

Add System: Select

[1 Aokl

FMDataManager

Datahanagers Subsystem dialog box

WSIZEMORE

Select All
Clesr

Adding or connecting to an archival data source

Before ArchiveManager can begin transferring data, you must first connect to an
archival data source. Without the archival data source, the system will not have a
destination to store the data.

Step-by-Step
e From the Archive Manager Configuration dialog box, click Connect. The
Select Data Source dialog box appears

¢ Click the Machine Data Source tab
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The default FuelsManager installation creates a machine Data Source called
FMSystem Access--This is Preconfigured to point to the ODBC data source
selected during installation; a Microsoft SQL or Access database

Select Dat.a Source Select Data Source @@
dialog box

File Data Source  Machine Data Souree |
Data Source Name Type Description ”~
Diamand Oracle Database System
ECDCMusic System
Excel Files User
Fi Movement Log System
Fi System Access System
FowPra Files - Yword User
Historical Reports System
iTanks Archive System F
T el ity

b
New

& Machine Data Source is specific to this machine, and cannot be shared
"User'" data sources are specific to a user on this machine. "System'' data
sources can be used by all users on this machine. or by a spstem-wide service

K. Cancel | Hep |

« Select a Data Source from the list of existing options or click New to add a
new data source to the list

« Enter the login information. The information entered depends on the ODBC
data source selected. There may be additional configuration dialog boxes to
be completed. For further information, refer to Windows ODBC Help

» Click OK. The system returns you to the Archive Manager Configuration
dialog box showing the Data Source you selected in the Historical Database
display field. The system also changed the Connect button to Disconnect

Configuration dialog

box

Real-time Database WEIZEMORE Select. .
Historical Database: FM System &ccess (Microsoft SQL Server) Disconnect
Start Time (HH:MM): 00:00 [ Archive Input and Output Points:
Interval (in Minutes) 10 I Specify Archived Points
Historical Period (in Days) | 60 I Automatic End-of-Monith Backup

Tank Puirt Variables Type Width Precision

Double 17 3 Ml
o >

Date Installsd Date 25 o

Density Maxdimum Double 17 3

Density Minimum Double 17 3 Ecii...

Density Units Units: 23 o

Density Double 17 3

Description Desc 30 i

Flrns M n Nevkla 17T S ol

ok Cancel I

Disconnecting from an archival data source

To disconnect ArchiveManager from an archival data source, click Disconnect.
The system disconnects from the archival data source and clears the Historical
Database display field.
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Setting the ArchiveManager schedule
The ArchiveManager writes data on a schedule, based on your entries in the Start

Time and Interval fields in the ArchiveManager Configuration dialog box.

Step-by-Step

¢ In the Start Time field, enter the number of minutes past the hour that you
want to synchronize the archive data to

¢ In the Interval field, enter the number of minutes you want to leave between
data transfers. The minimum interval is 10 minutes

« In the Historical Period field, enter the numbers of days you want from 1
through 9999 days. This is the time period for the archive in days. Any
record older than this time period will be overwritten by newer data

¢ On startup, ArchiveManager takes the start time, the interval, and the
current time, compares these values and determines when the archive
should be updated

In the following example ArchiveManager, writes the first archive at 10:15 and
then every ten minutes there after.

Start Time — 00:15 / Interval — 10 minutes /

Current Time — 10:08
Archive input and output points
Click on this option to configure ArchiveManager to write input and output points.
Otherwise, the system only writes Tank Points.

Specify archived points

This option lets you specify points to be written from the real-time database to the
ODBC data source. If this option is selected along with the Archive Input and
Output Points option, you can specify both tank and input/output points.
Otherwise, you can only specify tank points.

If... then...

Archive Input and Output Points and all tanks for every FMDataManager are
Specify Archived Points are not archived

selected

Archive Input and Output Points is all tanks and the Input and Output points
selected and Specify Archived Points for all selected DataManagers are
is not selected archived

Archive Input and Output Points is only tank points selected in the Points to
not selected and Specify Archived be Archived dialog are archived
Points is selected

Archive Input and Output Points and every selected tank input point, and tank
Specify Archived Points are selected output point that has been selected in the
Points to be Archived dialog
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Points to b%élrggl\[;(e)g Points to be Archived @

WSIZEMORE Meters M-300 Temp 0K
Cancel

Delete

Step-by-Step
« If the Specify Archived Points check box is not checked, click on it. The
system activates the Points button

¢ Click Points. The Points to be Archived dialog box appears

¢ Click Add to access the database and select the point to be archived
« Continue adding points as needed

» Click OK to update the Points to be Archived configuration

ArchiveManager — EOM Backup

The EOM Backup option is only available if the selected archival data source is a
Microsoft SQL Server based database. If another data source is selected the
option will be disabled.

If selected the EOM backup option backs up the entire contents of the archive
description tables and the last month of data from the archive data tables. The
data is backed up to files located in the SQL Server backup directory (typically -
C:\Program Files\Microsoft SQL Server\MSSQL\BACKUP).

This option will create two files named as follows: <tablename>.<date>.dat

Point Variables

ArchiveManager lists the current point variables in the Tank Point Variables list in
the ArchiveManager Configuration dialog box. You can add, edit, and delete the
point variables with the Add, Edit, and Delete buttons.
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Adding point variables to ArchiveManager
Step-by-Step
* From the Archive Manager Configuration dialog box, click Add. The Select

Point Variable dialog box appears
 Click on the point variable you want to add. The selection is highlighted

e Click OK. The system adds the variable you selected and returns to the
Archive Manager Configuration dialog box

Select Point Yariable @

Type

Wariahle

Tank Point

=

- Bottom Sediment and Yater

Advizory Units - Transfer Advisory SP Units
Air Density - Air Density

Alarm & Ack Density
Alarm & Ack Digital
Alarm & Ack Flow
Alarm & Ack Gauge
Alarm & Ack Level

Select | Cancel Help

- Density Alarm & Acknowvledgement

- Digital Alarm & Acknovledgement

- Flowe Alarm & Acknowledgement

- Gauge Alarm & Acknowledgement

- Level Alarm & Acknowledgement b 4

Wariable:

Type:

Wiclth:

Editing point variables

Step-by-Step
 Click on the point variable you want to change. The selection is highlighted
¢ Click Edit. The Edit Variable dialog box appears

¢ Click Variables. The Select Point Variable dialog box appears

¢ Select a point variable and click Select. The system returns you to the Edit
Variables dialog box, showing the Point you selected

« Change the width and precision of the variable by entering them in the
current entries

¢ When you finish modifying the variable, click OK. The system saves your
changes and returns you to the Archive Manager Configuration dialog box

Edil variable 3]

FaBS

Dauble

17 Precision: |3
OK | Cancel J

Variables...
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Select Point Variable
dialog box

Note! When adding numeric
variables to Archive Manager, you
should also add the variables min/
max units and engineering units.
Failure to do so will prevent
FuelsManager from displaying
historical trend plots for the
variable and will make the data
archived less useful to external
systems.

Edit Variable dialog
box
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Deleting point variables
Step-by-Step
« In the Tank Point Variables display window in the Archive Manager
Configuration dialog box, click on the variable entry you want to delete. The
selection is highlighted
¢ Click Delete. The system deletes the entry from the Tank Point Variables

window

Once a variable has been added to the ArchiveManager configuration and the
user has confirmed the addition by clicking OK on the ArchiveManager
Configuration dialog box, it cannot be deleted.

Records

ArchiveManager creates two records for each type of point selected, one for data,
and the other for the description. Data Records are updated at the selected
interval and are subject to the Historical Period field and contain process data.
Description Records are only updated on change and are not subject to the
Historical Period field and contain configuration information. Refer to the following
tables for a complete list.
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Tank point records
Data Record

Point Tag

Product Code

System Name

Tank Level

Tank Level Status
Temperature
Temperature Status
Density

Density Status

Gross Volume

Gross Volume Status
Net Volume

Net Volume Status
Remaining Volume Net
Remaining Volume Net Status
Available Volume Net
Available Volume Net Status
Flow

Flow Status

Water Level

Water Level Status
Tank Status

Tank Status Status
Data Time Stamp

Description file Time Stamp
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Description Record

Point Tag

Description

System Name

Level Units

Temperature Units

Flow Units

Density Units

Volume Units

Minimum Level Range
Maximum Level Range
Minimum Temperature Range
Maximum Temperature Range
Minimum Density Range
Maximum Density Range
Minimum Volume Range
Maximum Volume Range
Minimum Flow Range
Maximum Flow Range

Time Zone

Time Stamp
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Input point records
Data Record

Point Tag

Description

System Name

Alarm Status

Process Value
Process Value Status
Ticks

Point Time

Units

Time Stamps
Description Time Stamp
Output point records
Data Record

Point Tag

Description

System Name

Alarm Status

Output

Output Status
Process Value
Process Value Status
Ticks

Point Time

Units

Time Stamp

Description Time Stamp

Description Record

Point Tag

Description

System Name

Units

Minimum Process Value Range
Maximum Process Value Range
Type

Time Stamp

Description Record

Point Tag

Description

System Name

Units

Minimum Process Value Range
Maximum Process Value Range
Type

Time Stamp
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Note! The Draw feature is only
available in the FuelsManager
Professional Edition. The Standard
Edition will not allow access to this
feature. For additional information
about upgrading to the
Professional Edition and above,
please contact your Varec
representative.

Custom Site Overview
Graphic created using
Draw application

168

Draw application

The FuelsManager Draw application is used to develop or edit process graphic
displays and symbols displayed in the Operate program. Draw is used to create
graphic objects, to define displays, dynamic condition codes and symbols.

Draw enables the user to create custom graphic screens in addition to editing the
tank detail graphics included in the FuelsManager package.

Make sure that the DatabaseManager is not in SHUTDOWN mode. Otherwise,
the user will not be able to access the database dialog boxes used to define
values. Refer to the Setting Subsystem Run Modes section of the Administrative
Operations chapter for instructions on setting the DatabaseManager mode.
Opening Draw

Step-by-Step

* From the FuelsManager Configuration application, select the Draw Graphics

command from the User Interface menu
e The Draw application window appears

I Fuanks Managor - Draw Filo: C:WProgram Files\FoelManage i MProjort\Graphics\Sie0vn rviow, GRI
Fim Fct Add Altritades Mader  Opbione  Help

Receipt
Tanks

Shipmient
Tanks

Exiting Draw
Step-by-Step
¢ Select Exit Draw from the File Menu

An introduction to creating graphics

When creating a new graphic or symbol there are many options available to the
user. To offer a general understanding of Draw’s capabilities, a basic procedure is
provided. The following procedure offers a rough outline of what steps (not
necessarily in order) to take in creating a graphic.
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» Create a sketch of how the graphic looks. Include in this sketch a list of
database points and corresponding variables that will be represented in the
graphic. Note which points have defined alarms and note the data point
types.

» Create any new symbols (if not available in the Symbol index) that will be
used in the new graphic by selecting New Symbol.

« Save and then generate the new symbol. The generated symbol appears in
the Symbol index. The symbol can then be added to the graphic.

« Create the new graphic by adding labels, values, bar graphs (for a data point)
or/and symbols (for example, valve). Place Conditions on any selected
object, if needed. Expand the contents of the graphic by placing one or more
buttons that access other screens like other graphics or a Tank Detail
window.

» Adding geometric shapes such as lines and rectangles can also enhance the
graphic.

» Save and then generate the new graphic. Generating the graphic places the
graphic in the Graphic Index. Once placed in the Graphic Index, the graphic
becomes available for display in the Operate program.

 In Operate, open the graphic under Operate’s Display menu. All real-time
values are then displayed in the graphic. An example graphic in Operate is
seen on the previous page.

How a graphic is used in the Operate application

The previous example shows what a Site Overview graphic looks like. This
graphic is a representation of a group of tanks. All of the contents were created
using lines, rectangles, bitmaps, bar graphs, values, and labels.

In this example, each tank name has an associated button (append) which, when
clicked on, displays a Tank Detail window. Tank levels are indicated by dynamic
bar graphs representing the associated data point variables. Each valve indicates
current status with standard color codes.

Command buttons may be added to each tank or valve that would open a
standard FuelsManager Operator Command dialog box. Operator Commands are
defined for selected points in database edit. If defined, a dialog box is displayed
allowing the operator to enter a value or issue a command. In this example, the
operator can issue valve open/close commands. The pipeline objects are
animated such that they change color to indicate flow within the particular
segment.

Draw window

This section describes the basic Draw window and components. This window
consists of a drawing space, menu bar, and a toolbar.

The Drawing space
The drawing space is the area where drawn objects are created and displayed.

When you start Draw, the drawing space is empty. You have the option to use a
grid to position objects or to draw with precision.

The Draw toolbar
A toolbar is displayed at the bottom of the window. The toolbar has been provided

for easy access to the drawing tools. It also displays the current pen/brush color
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Note! Only one graphic or symbol

may be opened at a time.
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and background/text color, as well as a message box describing the function of
the selected tool.

Pen and Brush  Message

[ |
Select Operation
> 1.23 et “
NEEEEENEBEEDTE L e

Text and Background Coordinate Displays
Drawing tool icons
These tools are also displayed as menu options in the Add menu. The
functionality and procedures of each tool are described in Using the Draw Tools.

Pen & brush box
This box displays the default or current choice of pen (line) and brush fill).

Message window
Whenever a tool is selected, the Message Window provides a brief description of

the selected task. When no action is in progress (no tool has been selected), the
Message Window displays “Select Operation.”

Text & background box
This box displays your current text and text background color as well as the bar

graph color. The background refers to an opaque box and appears behind the
text.

Defaults settings

Draw allows you to set or change various default settings of any object. These
defaults apply to text font, size and color; text background mode and color; pen
color, thickness and appearance; and brush style and color. These defaults can be
set in the Attributes menu.

Step-by-Step
« From the Attributes menu select the appropriate command to change the
default setting
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Setting the default font

Step-by-Step

¢ From the Attributes menu select Text Font

¢ The Select Text Font dialog box appears

¢ Select the desired font, size, and attributes

» This default applies to any text created such as labels and values

Setting the default text color

Step-by-Step

* From the Attributes menu select Text Color

e The Set Default Text Color dialog box appears

« Selecting Palette from the Set Default Text Color dialog box displays all the
colors available

e This default applies to any text created such as labels and values

Setting the default background mode

Step-by-Step

* From the Attributes menu select Background Mode to display a cascading
menu

* A check mark appears next to the current default mode

* Notice how the Text Color & Background Box display changes when you
choose transparent

Setting the default background color

Step-by-Step

* From the Attributes menu select Background Color to display the Set
Default Background Color dialog box

« Selecting Palette from the Set Default Background Color dialog box displays
all the colors available for the background color

* Notice the change in color in the Text Color & Background Box

Setting the default pen attributes
Step-by-Step
* From the Attributes menu select Pen Attributes
* Assign a palette color
* Select a line type - invisible, dashed or dotted
¢ Change the line width
e The change is displayed in the Pen & Brush Box
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Note! The Text Color &

Background Box displays your new
choice of color. This color remains

the same until the default is
changed.
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Setting the default brush attributes

Step-by-Step

* From the Attributes menu select Brush Attributes

« The brush may be any available palette color or may be hollow to allow
objects with just a border

< In addition, the brush may be hatched (horizontal, vertical or diagonal) or
patterned

* The change is displayed in the Pen & Brush Box

Display grid

The Display Grid enables the user to display a grid to position objects on the
display screen. The appearance of the grid is controlled from the Grid Spacing
dialog box.

Step-by-Step
¢ From the Options menu select the Display Grid command
¢ The Grid Spacing dialog box appears

Grid Spacing dialog

box Grid Spacing

[ Sawve Optionz on Exit

Horizortsl: [20  oftset [10
vertical:  [20  offset |10
tajor Diw ’5_

Grid Colors

Grict Lines Grid
Major Divisions hiajor

Center Line Center wancel

Display grid check box
Selecting the Display Grid option turns on the display of grid lines on the Draw

main screen. When selected, a check mark appears next to the Display Grid menu
option under the View menu. Clearing the check box removes the grid lines from
the Draw main screen and removes the check from the Display Grid menu option.

Save options on exit checkbox
Selecting the Save Options on Exit option sets the current options as the Draw

default settings. When you close Draw, the system will keep the Grid Spacing
settings and use them when you open the program again. Clearing the Save
Options on Exit option sets the system to revert to the original default Grid Spacing
settings when you close Draw.

Horizontal and vertical
Enter the number of points you want between the horizontal/Vertical grid lines.

Horizontal and vertical offset
Enter the number of pixels you want to move the entire grid. You can only enter a

number less than the current Horizontal/vertical setting. To move the grid to the left
or up, enter a negative number in the field.
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Major Div

Major Div lets you type the number of vertical and horizontal lines that separate
the major division lines. The major division lines start with the two vertical and
horizontal center lines. For example, if you enter 5 in the Major Div field, every fifth
vertical and horizontal line will appear as a major division line.

Grid

Clicking Grid opens the Select Operation dialog box so you can select which
system color you want to use for the basic grid lines.

Major

Clicking Major opens the Select Operation dialog box so you can select which
system color you want to use for the major Division lines.

Center
Clicking Center opens the Select Operation dialog box so you can select which
system color you want to use for the horizontal and vertical center lines.

Show appends

FuelsManager buttons (Appends) can be created as invisible buttons. In this
manner they can be placed behind bitmaps or symbols representing tank objects
or field devices. The user appears to be clicking on the graphical object but in fact
is clicking on the invisible button. In Draw it is possible to show these invisible
buttons by choosing the Show Appends command from the Options menu. When
you select this option, all created buttons in the current file are automatically
displayed. A check mark appears beside the option. To deactivate, select the
option to erase the check mark.

Displaying mouse coordinates

This option is helpful in sizing objects equally or aligning objects. The X and Y
coordinates displayed change as you move the cursor in the Drawing Space

Step-by-Step
» Select the Show Mouse Coordinates command from the Options menu
¢ A coordinate display appears in the right hand portion of the Draw toolbar

« To deactivate the displayed select Show Mouse Coordinates command from
the Options menu again

Displaying object coordinates

* Select the Show Object Number command from the Options menu

« A coordinate display and Object Number appears in the right hand portion of
the Draw toolbar

« The “X="displays the horizontal coordinate (or X coordinate) of the selected
object

e The “Y="displays the vertical coordinate (or Y coordinate) of the selected
object

* The “H=" displays the height of the selected object

e The "W=" displays the width of the selected object
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Creating user defined colors

If the users need additional colors, they have the ability to create user-defined
colors.

User Defined Colors

Step-by-Step

Select User Defined Colors from the Options menu

A warning message appears that changing user-defined colors can affect all
graphics

Click OK

The User Defined Colors dialog box appears.

The dialog box lists the numbers 56 through 63 that are available to the user

In the Customized Palette Color box, the current color is displayed for the
selected number radio button

To change the current color, the user can create a new color by selecting
and moving the red, green and blue scroll bars

All changes are displayed in the palette

When finished, click OK. The user-defined colors are saved and now appear
in the color palette

dialog box User Defined Colors @

Select User Defined Color [ 56 - 63)

(vs6 (57 (58 €59 60 C 61 B2 (63

Select RGE Yalues (0-255) Customized Palette
Color
1] 255
RED 4 x| o

GREEN 4 ﬁ 0
HEEE ﬂJ ﬂ g Cancel

o 255

OK
o 255

i

Graphics or symbols

Before you begin creating a graphic, make yourself familiar with the following
commands or functionality.
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Undo To undo the last operation, select Edit and click Undo
Last
Delete If you need to erase an object, click the Edit button and

select the object. Click Delete from the Edit menu

Object color Before drawing an object, you may want to set a default

color or style. This process eliminates having to select
the object and modify the attributes from the Edit menu
item. Refer to the Setting Defaults section

Changing tools The existing tool does not change until another button is

selected
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Opening an existing graphic or symbol
Step-by-Step

This dialog box contains the saved Symbol files (.SYM) and Graphic files
(.GRF)

e Select the desired file from the list box and click OK

» The graphic or symbol appears on the screen

Open Graphic File

File: Name :

Directory ;e\ Afmprojectygraphics

File Mame : File Type :

ReceiptT anks. GRF

Shipment T anks. GRF 3

SiteOverview. GRF (* Graphic
" Symbol

| Cancel

Creating a new graphic or symbol
Step-by-Step
¢ Select either New Graphic or New Symbol from the New sub-menu in the
File menu

Geometric tools

The standard geometric tools provided by Draw include the line, rectangle
(square), polygon, ellipse (circle) and arc. The tools are available in the toolbar
and in the Add menu.

Drawing aline
The Line tool draws straight lines at any angle.

Step-by-Step
¢ Select the Line tool (or select Add and click Line). Click on area to define
start point

« Drag the cursor and release at desired length

ADMO03GVAE1005

» Select Open from the File menu to display the Open Graphic File dialog box.

Open Graphic File
dialog box

Note! Holding down the SHIFT
key while drawing forces
orthogonal movement of the
line.
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Drawing a polyline
The Polyline tool draws multiple connected lines grouped as a single object.

Step-by-Step

» Select the Polyline tool (or select Add and click Polyline)

¢ Click on area to define first point

* Move the cross-hair cursor to the next point and click again

* As you move and click, the polyline appears. Clicking the right mouse button
deletes the last line segment

Note! Holding down the SHIFT key while drawing forces orthogonal movement of the line (vertical,
horizontal or at 45 degrees from previous point)
* Repeat above step for each additional point

« After the last point, press the ENTER key to complete the polyline

Drawing a rectangle
The Rectangle tool draws rectangles and squares.

Step-by-Step

¢ Select the Rectangle tool (or select Add and click Rectangle). Click on area
to define the first corner

» Drag the cursor and release the mouse button at desired size

Note! To draw a square, follow the procedure for drawing a rectangle, but hold down the Ctrl key while
you drag the cursor

Drawing a polygon
Use the Polygon tool to draw polygons (multi-sided closed objects). The user can
create polygons with up to 25 points (24 clicks).

Step-by-Step
« Select the Polygon tool (or select Add and click Polygon). Click on area to
define first point

¢ Move the cross-hair cursor to the next point and click again.

* Repeat this step for each additional point of the polygon. Holding the SHIFT
key while drawing forces orthogonal movement of the line from the previous
point

* Press Enter to connect the last point and the first point

Drawing an ellipse
The Ellipse tool draws ellipses and circles.

Step-by-Step

» Select the Ellipse tool (or select Add and click Ellipse)

¢ Click on area to define center point and hold down the mouse button
« Drag the cursor in a diagonal direction to create the ellipse

¢ Release the mouse button at desired size and shape

Note! To draw a circle, follow the procedure for drawing an ellipse, except hold down the Ctrl key while
you drag the cursor
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Drawing an arc
The Arc tool draws arcs and chords (filled arcs).

Step-by-Step
¢ Select the Arc tool (or select Add and click Arc/Chord). Click on area to
define center point and hold down the mouse button

« Drag the cursor to make an ellipse for the arc and then release the mouse
button at desired size and shape

« Position the cursor on the ellipse where you want the arc to start and hold
down the mouse button. The Message Window directs you to “Define Arc
End Point”. Drag cursor to point on ellipse where you want the arc to end
and release the mouse button

Label tool

A Label is used to place text inside the graphic. Labels may be left, center or right
justified and may include an optional background rectangle. Also, you have a
choice of fonts and various sizes.

Step-by-Step

e Select the Label tool (or select Add and click Label)
¢ Click on area of insertion

¢ The Label Attributes dialog box appears

Label Attributes E|

Label Text: ||

Current Font Edit

Text Color

\Fortt: arial 7 Palette ...
Size: 13

Backaround Color
Options u] Palette ...
fv Bold
I talic

[ BackGr Rectangle

Cancel
-

[ Tranzparent

« Enter the Label name, format appearance of the label or set up the label
alignment

» Click Edit to format the font appearance of the label
¢ Center Text in Rectangle only applies when Back Ground Rectangle is used

¢ Select a text and text background rectangle color by clicking on Palette
button. The edit box displays the number assigned to each color in the
palette

¢ Click OK. A label appears in selected area

Inserting a database value
The Value tool allows you to display data from a database. When the graphic is
opened in the Operate program, the value of the database point is displayed.
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Label Attributes dialog
box

1.23
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Note! The default font attributes Creating a Value involves selecting a point (for example, Tank 10 from Tank Farm
also apply to the Value object. 20), a point parameter (i.e. temperature, tank level), and a system database

Step-by-Step
¢ Select the Value tool (or select Add and click Value)
¢ Click on area where the value will be inserted

¢ Select a point to define from the Database Edit dialog box to be represented
by the value. Click Select. The Select Database Point dialog box appears

¢ The Select Database Point dialog box confirms the variable selection. If the
selection is incorrect select the appropriate button to edit the selection

Value Attributes dialog T ®
box
Databaze Point Data
Database:  WSIZEMORE
Paint: TankFarm.Tank 4. Tank
“ariable:  Leak Rate Minimum - Tank Minimum Leak Rate Scaling
Type: Double Units:
Forit Style: Color Selection Data Format
Fiehd Wickth: bid
Arial, 13 point pr——
Precision: 2
i Text
Fort = [~ Convert Linits
¥ Bald
- o Background... Align
LI & Lett 4
I™ Use Bkg Rectangle =  Conter
r " Right
Ok Cancel

Click OK to save the value

The Value Attributes dialog box appears

¢ Set the value appearance, formatting and the positioning of the value
¢ Once complete, click OK

* The value appears in the selected area

Inserting a bar graph
ma The Bar tool is used to draw vertical, horizontal or deviation bar graphs based on a
numerical point’s range.

Step-by-Step
« Select the Bar tool (or select Add and click Bar). Click on area to define the
corner and hold down the mouse button.

« Drag the cursor to end position and release the mouse button.

« Select the appropriate database, point, and corresponding variable by
clicking the Database, Point or Variable buttons.

¢ Click OK. The Dynamic Bar Attributes dialog box appears.

« Edit the data source, or define the attributes of the bar graph such as color
and style in the Dynamic Bar Attributes dialog box.

178 Administrator Manual



Draw application

Dynamic Bar Attributes @

Databaze Point Data

Database:  MSIZEMORE

Point: TankFarm.Tank 3.Tank

Wariahle:  Level - Tank Level

Backaround Color

Blkg Colar ... -

OK ‘

Torpe; Double
Bar Attributes Border Attributes
Brush... - Pen... Tl Width: 2
Bar Style “alue Range
" Hotizontal v Usze Variable Limits
+ ‘ertical
Maximum |
[~ Reverse Direction
hdini :
[~ Devistion Bar Al

Cancel

Limits check mark
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» Select Brush to select the color, pattern, and style of the bar fill. Select Pen
to select the color, size, and style of the outline. Select Color to select the
background color of the bar graph. Select either the Horizontal or Vertical
option and corresponding Reverse Dir and Deviation option

¢ Select Use Variable Limits to have the bar graph object automatically track
the minimum and maximum scaling limits of the database point it is linked
to. If you wish to set the bar graph's minimum and maximum limits
independently of the associated database point, clear the Use Variable

Dynamic Bar Attributes
dialog box

Note! To bring the bar graph
forward over a symbol, click Pull to
Front from the Edit menu.
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Symbol index
o, The Symbol tool adds a symbol from the Symbol Index. The Symbol Index

displays all standard and user-defined symbols.

Placing a symbol in a graphic
Step-by-Step
¢ Select the Symbol tool (or select Add and click Symbol). Click on area to
define corner

» Drag the cursor to size the symbol and release the mouse button
¢ The Select Symbol Index Entry dialog box appears

¢ Select a symbol and click OK

e The symbol appears

Creating a symbol

Step-by-Step

» Select New Symbol from the File menu item

« Construct the symbol using the geometric tools as well as other symbols

« Save the symbol by selecting Save As from the File menu. Enter the symbol
name including the SYM file extension. Once the symbol is saved, you must
generate the file

¢ Select Generate Run Files from the File menu. If an entry does not exist in
the Symbol Index (in the Master menu item), a dialog box appears asking if
you want to create one

» Click Yes. The Edit Symbol Index dialog box appears. Type in a description
of the symbol in the Description text box

» Click OK to display the Select Symbol Index Entry dialog box

e The symbol can now be placed in a graphic

Inserting a button
[ The Append tool allows the user to place a button on the graphic. In Operate, the

button can display a graphic, help file, Operator Command, Report, or Tank Detail.

Step-by-Step

» Select the Append tool (or select Add and click Append). Click on area to
define corner and hold down mouse button

« Drag the cursor to define the size of the append and release the mouse
button

e The Append Attributes dialog box appears

 In this dialog box the user selects a type of button and defines the attributes
for that button

 If you want the append to be displayed as a visible button in your graphic,
click on the check box and then select one of the seven choices of color

* The following procedures describe how to create the different types of
appends
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Append Attributes Dialog @

Databasze Point Data

Database:  database system

Paint: proint tag

“ariable: et name

Type: wvar type

Type Style

9 1011121314 [H
N ECEEEC

& Command v Button is Visible
" Graphic
" Report File Mame

" Help

" Detail

| Cancel ‘

Command append
This option button displays an Operator Command dialog box. From the dialog

box, the operator can issue a command or type in a new value.

Step-by-Step

¢ Select the Command option button in the Append Type group box

¢ Click Select in the Database group box

¢ The Select Database Point dialog box appears

¢ Select the appropriate database, point, and corresponding variable by
clicking the Database, Point or Variable buttons. Refer to the Values section
for more information

¢ Click OK. This button displays an Operator Command dialog box in the
Operate program

¢ The commands available via this button are defined by the modifier
assigned to the database point selected
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Append Attributes
dialog box
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Graphic append
This option button displays another graphic. A list of graphics can also be found

under the Graphic Index option in the Master menu item.

Step-by-Step

» Select the Graphic option button in the Append Type group box
¢ Click File in the File Name group box
e The Select Graphic Index Entry dialog box appears

» Select a file from the list and click OK to return to the Append Attributes
dialog box. The name is displayed in the File Name box at the bottom of the
Append Attributes dialog box

Report append
This option button displays a report.

Step-by-Step

» Select the Report option button in the Append Type group box
¢ Click File in the File Name group box
¢ The Select Report Index Entry dialog box appears

» Select a file from the list and click OK to return to the Append Attributes
dialog box. The name is displayed in the File Name box at the bottom of the

Append Attributes dialog box

Help append
This option button displays instructions to direct the operator to perform a specific

task. Two types of Help files are supported: Text Help and Windows Help Format.

Step-by-Step

¢ Select the Help option button in the Append Type Group

¢ Click File in the Graphic File Name group box. The Select Help File dialog
box appears

* The Select Help File dialog box allows the selection of an associated help
file for the Help Append

¢ Select a file from the list and click OK to return to the Append Attributes
dialog box. The name is displayed in the File Name box at the bottom of the
Append Attributes dialog box

Detail append
This option button is used when more information relating to a tank needs to be

displayed. The button displays the Tank Detail of the selected point.

Step-by-Step

» Select the Detail option button in the Append Type group box
¢ Click Select in the Database group box

e The Select Database Point dialog box appears

» Select the appropriate database, point, and corresponding variable by
clicking the Database, Point or Variable buttons. Refer to the Values section
for more information

* Click OK
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Inserting a bitmap

The Bitmap tool is used to insert a *.BMP file. Bitmaps can be used to represent
equipment such as tanks, pumps, valves, and pipeline segments; to include
images such as company logos and emblems; or to include digital photographs
such as plant overviews.

Step-by-Step

» Select the Bitmap tool (or select Add and click Bitmap). Click on area of
insert to define corner

» Drag the cursor to define an area within which the symbol will be located
and release the mouse button

* The Select BMP File dialog box appears

¢ Click on the desired file and click OK. The bitmap is displayed. The user is
able to size the bitmap by clicking and dragging on the graphic

Select BMP File 3

Filetame

Path:  cih.fmproject'graphics

File:

cone_izo_blBMP ~
Filter-Haorz bmp

Filter-Yert bmp

Fh_iconwG_b brmp

FM_0OG_b bimp

Fuel=Manager_bk bmp )
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Note! FuelsManager includes
various Bitmaps that were used to
create the predefined Tank Detail
and Tank Group displays. These
are located in the Detail folder and
Graphics folder respectively.
Additional bitmaps can be located
in the \Templates folder on your
FuelsManager CD.

Note! Custom Bitmaps must first
be added to your project directory.
Insert the bitmap in the directory
used to store all graphic and
symbol files. Most configurations
store the graphics in the
FMProject\Graphics subdirectory.

Select BMP File dialog
box
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Edit Dynamic . i -
Conditions dialog Edit Dynamic Conditions

Description : | TG S

“ariahle Type : Condition Tygpe

Cancel

= - 5 - F

Edit Condition Clear Edits
Select ...
Conditions 3 Entries

&g, Running then 2
ed. Stopped then 1

elze. thend

IR

The user can use Draw’s Dynamic Conditions, Attribute Conditions, and Object
Conditions to update the graphic based on changes in data to appropriately
represent site events, alarms, and other activity.

Defining a Dynamic Condition
Dynamic Conditions define the components of a condition. You can add up to 20
codes that represent the conditions that will be represented in the conditional
graphic.
Step-by-Step
¢ Select Condition Index from the Master menu to open the Select Global
Dynamic Conditions dialog

¢ Click New to open the Edit Dynamic Conditions dialog

¢ Type a Description for the first condition

» Select the Variable Type.

¢ Select the Condition Type

* The Display Styles availability are dependent on the Variable Type selected.

¢ Click the Select button to open the Build Condition Code dialog. The
available Code types is based on the Variable Type selected earlier
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Build Condition Code
. v dialog
Build Condition Code g|

Codes ... Select Condition Caode
Zelect Test Walue

Palette ... Select Calar 1

PlEE

Palette ... Select Colar 2

Qb ‘ Cancel

To select the Condition Code, click the Codes button and select from the list
* To select a Test Value, click the Variable button and select it from the list

* To select a color for the condition, click the Palette button next to Color 1
and select the color you want to represent the condition. If you want the
object to blink, repeat this step with Select Color 2

Click OK to return to the Edit Dynamic Conditions dialog box

Click Append to add your selections to the Conditions list

¢ Continue appending conditions until your Dynamic Condition is complete
On the Edit Dynamic Conditions dialog box, click OK

Assigning a condition

Dynamic Conditions can be assigned to a specific graphic or symbol so that it
represents those conditions. You can assign the Dynamic Conditions to an
object’s Pen & Background color, Brush color, and whether the object is Visible or
not.

Step-by-Step
« Select the object or symbol you wan to assign the Dynamic Condition to

* From the Edit menu, select Conditions to open the Define Object
Conditional Data dialog, or press <Ctrl+K>

¢ Select the checkbox to one of the available features (Pen Color,
Background Color, Brush Color, or Object Visibility)

¢ Click the corresponding Edit button to open the Select Global Dynamic
Conditions dialog, select the condition you want to attach, and click OK

* You can also define new conditions and edit existing ones
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Define Object
Conditional Data dialog

.D-a-tabase :

WSIZEMCRE

Pairt :

[Tark Farm.Tank Tark 4
“ariahle :

Mass - Product Mass
Type:

Doukle

[v Pen Color

dfasdf

v Background Color
dfasdf

[v Brush Color
dfasdf

v Ohject visibility
ddgghbh

Define Object Conditional Data

Cancel

Edit ...

E

E

Edit ...

o

]

it

i

it
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Customizing your tank detail

The Tank Detail not only displays tank point information, but also is used to
perform tank transfers and tank calculations.

You have the option of using one of the defaults provided with your system, or
creating one or more user-defined Tank Details. One of the FuelsManager default
Tank Detalils is typically used as a template. The user is able to rearrange the
contents, delete sections, and create new values, labels, appends and other
objects. The user can use any of Draw’s drawing tools to redesign the Tank Detail.

The only difference between creating a Tank Detail and creating any other graphic
is how the Value tool is used. See Editing a Value below for more details.

The process of creating a custom Tank Detail is summarized below: Note! Multiple Tank Detail
. . i templates can be created, the user
« The display is opened in Draw. The user enters labels, values, and other can define which template will be
objects used on a tank-by-tank basis refer
. . i . to the Configuring Database
* Once completed, the display is saved and generated like any other graphic chapter.

» The default Tank Detail is then defined by entering the file name in the
Registry Editor

» The default Tank Detail can be overridden on a tank-by-tank basis by entering
the file name in the Detail field of the Edit Tank Data dialog box
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Note! DO NOT SAVE over the
default file. Save the file under a
different file name by selecting
Save As.

Value Attributes dialog
box

188

Creating a tank detalil

Step-by-Step

« Select File and click Detail Mode. If a graphic is presently opened, Draw will
ask if you want to save the file. A check mark appears next to the Detalil
Mode menu option

» Select File and click Open. The Open Graphic File dialog box appears

« Select the desired graphic (*.grf) from the File Name list box. Make sure that
the Graphic option button is selected

e The Tank Detail graphic appears in the Draw window

Editing a value

Tank Details can be edited in one of two modes, Use Parameter mode and Use
Template mode. You can switch between these modes via the Draw menu, File
sub-menu, Detail Data command.

Use parameters mode
In this mode only tank point variables can be added to the Tank Detail. This is the
default mode

Step-by-Step
¢ From the File menu click Detail Data, from the sub-menu select the Use
Parameters option

* Click on the Hand selector icon in the toolbar and then select the desired
value

¢ Select Attributes from the Edit menu
¢ The Value Attributes dialog box appears

» Click Select next to the Variable entry. The Select Point Variable dialog box
appears. The tank parameter can be selected in this dialog box

* Choose the tank parameter and click Select

Yalue Attributes @

Datakase Poirt Data

Wariable:  Level - Tank Level

Type: Double Units:

Forit Style Color Selection Data Format

Field width: |12
Avrial, 16 point

| Sample Tet |
Precision 2
2 Text..
el [~ Convert Units t
Iv Bold
] Background... Align
I halic 4

-
v Usze Bky Rectanale

Pen =
| Center Bkg Rect. = 4 o

Ok Cancel
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Use template mode
In this mode the user can select any input, output, or triggered point that is at the

same database level as the tank point
i.e. Assuming a database structure of:

« Area31.Tankl.TankPoint(tankpoint)
* Area31.Tankl.ValveStatus(input)

* Area31.Tankl.PumpStatus.(input)
» Area31.Motor.BearingTemp(input)

The input points Area31.Tank1.ValveStatus and Area31.Tank1l.PumpStatus can
be added to a tank detail via the Use Template mode. The input point
Area31.Motor.BearingTemp cannot be added to the tank detail.

Step-by-Step
* From the File menu, click Detail Data, from the sub-menu select the Use
Template option

* Click on the Hand selector icon in the toolbar and then select the desired
value.

» Select the Attributes command from the Edit menu
e The Value Attributes dialog box appears

¢ Click Select next to the Variable entry

* The Template Configuration dialog box appears

¢ In the Tag Name edit box, enter the Level 0 database name Input or Output
point as it appears in the system database. In our previous example, you
would enter Valve Status or Pump Status

¢ In addition to the Tag Name, the user also selects either the Input or Output
point type, selects which parameter should be displayed (i.e., Process
Value, Engineering Units, etc.), and selects the data format of the parameter

e Click OK

Template Configuration Dialog

Tag Mame:

Poirt Type

{* Input (™ Output b il

“ariable... Alarm Status

Alarm

il

v Display Quality Data

ik | Cancel
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Note! The Tag Name field in the
Template Configuration dialog box
is case sensitive, you must enter
the Level 0 tag name exactly as it
appears in the database.

Template Configuration
dialog box
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Editing objects

Editing objects involves moving, copying, and deleting selected objects as well as
modifying the attributes of the selected object. These attributes include color,
style, fill, pen, and condition. An additional modifiable attribute is the database
point variable selection. Conditions and Symbols can also be edited or deleted.
Most of the editing options are found under the Edit menu. This section describes
the different techniques used to edit a graphic

Editing techniques
Before an object in the graphic or symbol can be changed or modified, the object
must be selected.

Step-by-Step
¢ Click the Hand selector icon from the Draw toolbar
¢ Select the object

¢ An object selection can be cancelled after the object has been selected -
Click anywhere on an empty spot in the screen (the handles disappear) or
press ESC.

¢ Choose an command from the Edit menu to modify the object

Deleting an object
You can delete objects by selecting the Delete command in the Edit menu or by

pressing SHIFT+DEL.
Next & previous

The Next and Previous commands allow the user to change the selected object
based on its layered position i.e. selecting overlapped objects.

* Next (PgUp) allows you to select an object from the back (or bottom) to the
front (or top).

» Previous (PgDn) allows you to select an object from the front (or top) of the
layers to the back (or bottom).

Attributes
All objects found under the Add menu item can be edited using the same initial

procedure.
Step-by-Step
¢ Select the object

» Select Attributes from the Edit menu item (or press Ctrl+A). The dialog box
pertaining to the selected object appears. This dialog box is the same one
that appears when first creating the object

* Make the desired changes and click OK when you have finished
* Your changes will then be displayed on the screen

Push to back & pull to front
Use the Push to Back and Pull to Front commands to change an object’s relation

to another in your display. If one object appears in front (or on top) of another on
the screen, you can modify that arrangement so the objects “switch places” in
relation to each other.

Administrator Manual



Visual Dynamic Tools

If you wanted to “push” an object from the front (or on top) to the back (or behind)
another object, choose the Push to Back command from the Edit menu, or press
Ctrl+P. The Pull to Front (Ctrl+F) command works in the opposite direction.

Copying single objects
The Copy command allows you to duplicate objects on the screen.

Step-by-Step

e Select the object and then select Copy from the Edit menu (or press Ctrl+C)

» Click on the copied object and drag the cursor to another area of the display
screen. When you hold down the mouse button, the cursor becomes a four-
sided arrow. This indicates that you can move the object in any direction.
When you release the mouse button, a copy of the object appears at the
location to where you dragged the cursor

Moving, deleting, and copying multiple objects

The Window option enables you to select and edit multiple objects. This option
creates an “edit window” by drawing a square marquee around a group of objects.
This window allows the user to edit (move, copy or delete) all the objects in the
window as a single unit. Selecting the Move and Copy Window options can
perform two of these actions.

Step-by-Step

e Select Window from the Edit menu item (or press Ctrl+W). A check mark
appears beside the option

» Select the first corner of the window and drag the cursor around the group of
objects you want to edit

« To change the size of the window, move the cursor to the border of the
window. Note that the cursor becomes a two-headed arrow. Drag the arrow
to make the window the desired size. Release the mouse button

« To move the window without moving its contents, click anywhere on the
window. The cursor will become a four-headed arrow and you can drag the
window to any desired location on the display

¢ Select the Edit menu and click Move Window (Alt+M), Copy Window
(Alt+C), or Delete (Shift+Del)

« If the Move Window option was chosen, move the window to a new location

« If the Copy Window option was chosen, move the duplicated window to a
new location

« Select Window from the Edit menu item to disable the Multiple Select option

Undo last
If you want to undo the last action performed, click Undo Last from the Edit menu
item.

Redrawing the screen

During the editing process, extraneous pixels may remain on the screen. Redraw
removes those pixels and gives you a “clean” display screen (all objects are
redrawn).
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Note! You should not delete
graphic or symbol files from the
project folder using Windows
Explorer. Doing so will remove the
File but the symbol and condition

indexes will not reflect the deletion.

Instead, use the Purge option
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Resizing objects

A selected object is marked by small squares called handles. Lines have three
handles one at each end and one at the center. Labels and Values have one
handle. The Label handle is located on the upper border of the label, on the left,
center or right, depending upon the label’s text alignment.

A Value’s handle is always located on the left. Arc handles include the arc start
and end points, as well as handles at the corners and sides of the rectangle
bordering the original ellipse drawn to create the arc. All other objects are marked
with handles at the corners and sides of the object’s bordering rectangle.

The geometric shapes can be sized by grabbing these handles. When resizing
symbols, the symbols remain in proportion.

Managing files

This section explains how to manage graphic and symbol files. Managing files
includes deleting, saving and generating files.

Saving files

The Save As command saves a file for the first time. This option is also used to
save the opened file under a different name. The Save command saves changes
to an existing file. Save As is particularly useful when you have created a complex
display that you want to use again with minor modifications.

Purging files

The Purge option enables you to delete unwanted symbols and graphic files from
your system. When you purge a file, the Symbol and Condition Indexes are
updated accordingly.

Merging files

Draw allows you to merge previously created files with the file in which you are
currently working.

Step-by-Step

¢ Click Merge File from the File menu item. Point and click on the location
where you want the merged file to appear

« Drag the mouse to create a box where the merged file appears. The Merge
Graphic File dialog box appears

« Type the name of the file you wish to merge, or select one from the File list
box

« Click OK to complete the operation and return to the current display screen
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Generating files

After a graphic or symbol has been saved, it is necessary to then generate the file.
Generating a symbol makes it available for placement in a graphic, and
generating a graphic makes it available to the Operate program.

Step-by-Step

» Select Generate Run Files from the File menu item

« The system displays a message box advising you that it is verifying the point
dynamics of your graphic. This means that the FuelsManager system is
checking all dynamic data records to verify the validity of all point names
and variables used in your graphic

« If there is not already an entry in the Graphic Index (in the Master menu
item) for your graphic, a dialog box appears asking if you want to create one

* Click Yes

e The Edit Graphic Index dialog box appears

« Type in a description of the graphic in the Description text box. If you click
on the Preload on Start option box, Operate loads the graphic into memory
on startup rather than accessing it from disk when the display is requested,
this can improve performance when switching between graphics on slower
systems

» Click OK to display the Select Graphic Index Entry dialog box. The graphic
that has been generated as a run file is now listed in the Master Index. Now
the graphic will be available to the Operate program

Generating multiple files
Draw provides an automated method for generating run files.

Step-by-Step

» Select Batch Run Files from the File menu item. Select either graphics or
symbols. The Batch Compile dialog box appears for either graphics or
symbols. The Altered Files list box displays all files that have been modified
since the last compilation.

« Select the files for generation. To select all the files in the list box, click
Select All. Clicking Unselect All deselects the files.

« Follow one of the below procedures.
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Note! Any time changes are made
to a graphic or symbol, it has to be

regenerated.
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Note! This generation process
does not prompt the user if the

graphic is not in the Graphic Index.

You must use the Master menu to
add graphics to the index.
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Using “Do Selected” command

Step-by-Step
¢ Click the Do Selected command. A dialog box appears asking you to
confirm your request to compile all selected files.

¢ Click OK to proceed with the compilation of the files you have selected.

Using “Make” command

Step-by-Step

» Click Make command. A dialog box appears asking you to confirm your
request to compile all altered files.

» Click OK. This option generates all files that have changed since last
generated. This option is useful if you are unsure of which files have been

modified.

Using “Build All” command

Step-by-Step

e The Build All option is useful for either initial project development or if the
system database has been modified. System database modification often
requires re-verification of database references.

¢ Click Build All. A dialog box appears asking you to confirm your request to
compile all files.

« Click OK. This option unconditionally compiles all files for a project, even if
they have not changed since the last generation.

Viewing file groups
The Master menu provides the user ability to view all created graphics, symbols,

and conditions. From each menu option, the contents can be deleted and the
name can be changed. These indexes are described below:

The graphic index

The Graphic Index defines all of the generated graphics that can be displayed in
the Operate program. Once you create a graphic, you can assign it to one of three
states:

* Pre-loaded: Graphic is loaded by Operate into your computer’s memory on
system startup.

* Not Pre-loaded: Graphic is not loaded into memory on startup but only when
selected.

* Not in Index: Graphic does not appear in the index.

The symbol index
The Symbol Index defines all of the symbols available to graphics.
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Select Symbol Index Entry &l
Symbol Descrigtion Fille Mame: Used By: DSAType:  Dynamics
Contral Yalve Legend Contralvalve a Word 4
Floweter Legend SD_Flowheter a Float 4
Pump Legend SD_Pumplegend 2
SD_valve SD_valve 38 Coded 1
‘alve Legend SD_valveLegend 2

The condition index
The Condition Index lists all of the global dynamic conditions available to
graphics. In this dialog box, the user can also create new conditions.

Select Global Dynamic Conditions El
Condition Description © Data Type Test Codes:  Used:

] Coded Color g
PipeSegmentStatus Coded Wisibility 2 &0
PumpStatus Coded Color 3 3

Elit . e 5[ cancel Ok
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Select Symbol Index
Entry dialog box

Select Global Dynamic
Condition
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Keyboard shortcuts for draw tools

Keyboard Shortcut
Shift+Del
Pg Dn

Pg Up

Ctrl+C

Ctrl+A
Ctrl+K

Ctrl+P

Ctrl+F

Ctrl+W

Alt+M

Alt+C
F12

Function
Deletes the selected object

Moves the selection to an object that lies beneath the
current object

Moves the selection to an object that lies in front of the
current object

Creates a copy of the selected object and places the
copy directly on top of the original

Displays the Attributes dialog box for the selected object

Displays the Conditions dialog box for the selected
object

Sends the selected object to the back of the drawing
space. All objects that were behind the selected object
will then be in front of it

Brings the selected object to the front of the drawing
space. All objects that were in front of the selected
object will then be behind it

Lets you select multiple objects that you can move or
copy with the Move Window and Copy Window menu
items

Lets you move objects selected using the Window
command (Ctrl+W)

Lets you copy

Displays the Draw online help system.
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Note! The Report feature is only
available in the FuelsManager
Professional Edition or the
FuelsManager Server Edition. The
FuelsManager Standard Edition
will not allow access to this feature.
For additional information about
upgrading to the FuelsManager
Professional Edition or the
FuelsManager Server Edition,
please contact your Varec
representative.

Note! All of FuelsManager’'s
standard reports are Summary
reports.
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Report

The Report application lets you create and edit reports as well as specify print
times and print intervals. Once created, the reports can be opened in the Operate
program. The active report prints at its scheduled time, even if the Operate
program is not opened.

In Operate, opened reports displaying real-time data from the database you
selected can be printed on-demand or schedule them to print automatically.

You can create two types of reports:
« The Summary report - displays the only Tank point information found in one or
more databases

» The Dynamic report - displays all types of points: Tank, Input, Output, and
Triggered points as defined by the report creator
Make sure the DataManager is not in SHUTDOWN mode. The user will not be
able to access the database dialog boxes used to define values if the
DataManager is in SHUTDOWN mode. The DataManager must be in STANDBY
or ACTIVE mode.

Opening Report
Step-by-Step
* From FuelsManager Configuration, User Interface menu select the Create
Reports command

e The Report Editor dialog box appears
Exiting Report

Step-by-Step
* From the Report Editor dialog box, click File

¢ Select Exit

Pre-defined standard reports

FuelsManager has provided several defined reports used to display standard tank
information that reflect common facility needs. These can be edited to conform to
the facility or used as a guideline.

These reports include the Inactive Tank, Active Tank, Operating Tank, and Current
Tank Inventory reports. These standard reports are listed and described below:.

Standard Report Description

Inactive Tank Report Displays information about all inactive tanks in the

system.

Active Tank Report Displays information about all active tanks in the

system.

Operating Tank Report Lists all tanks known to the system.
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Standard Report Description

Current Tank Inventory Groups the data by product. Also displays level,

Report temperature, gross volume, net volume and
remaining volume data. Totals for gross volume, net
volume, and remaining volume are given for each
product.

W Funkanager Report Editor- File: C:\Program Files\Fuelsionagenf MProjectRe partsicur rinveatary, £t
Fim Ft Vew Fomst Table Fage Hep

TANK | PRODUCT LEVEL TEMP
EXAMPLE.DATABASE.POINT.TAG |UNDEFINED PRODNAME U PR BECRL

Tools and objects for reports

A report can contain tables, data (values) used to represent real-time data points,
and labels used and identify the values. Additional items that can be found in a
report include column and row totals and averages. These components are
described below.

Tables

FuelsManager provides the capability to display information in a Tabular format.
The user can create tables as well as edit and delete tables. Some editing
techniques include sizing the table, defining the number of rows and columns,
inserting/deleting columns, and moving the table.

Labels
A Label is text used to identify values.

Creating label attributes includes entering the label name, selecting the
appearance, and positioning the label. The user can select the label size, font,
and style.
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An example Operating
Tank Report as it would
appear in the Report
program
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Summary Report
Setup dialog box

Values

A Value represents real-time data connected to a database. Creating values
include selecting a database and corresponding points and variables. This
procedure used to create values is the same procedure used in the Draw
application.

Summary Report Setup @
Murmber Of Columns (2-19): a v Outline Takle
Independert Yariakle Select Database System
(+ &l Tanks

i+ Tank Poirts ™ Active Tanks Detabase ..

" Inactive Tanks

Column Taotals et Table Sorting Crder

* Mo Column Totals
— i [ Group Entries by System

L

~
[ Group Entries By Product

(™ Total Everything in Column

O | Cancel

In addition to selecting a database, point, and point parameter, other attributes
include font appearance, positioning, field width, precision, and engineering units.
These attributes are set in the Database Value Attributes dialog box displayed
during value creation.

The user has the ability to customize or automatically set the field display. Field

Width is the number of characters allowed for the value. Precision is the allotted
number of decimal places if the value is numerical. The user can also convert to
new engineering units, if necessary.

The attributes also include font appearance and positioning. The user can select
the value size, font, and style. The table Snap option is enabled for aligning the
value if the Snap to table option (under the table menu) is checked.

Variables are parameters of a point such as time, temperature, and density. A
single point can have multiple variables. For example, a point is defined as Tank
Farm A. Tank 22. Tank Point. The variables associated with the Tank Point may be
temperature,% sediment, and tank level.

The variables available for Input and Output points are different from those
available for Tank points. Some examples of Tank point variables include
temperature, level, and density. Input and Output point variables may include an
alarm status or process value.

For a complete listing of point parameters, refer to the Glossary.
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Column/row totals and averages

The user is able to display column/row totals or averages in a report. Values in a
column can be totaled all together or individually for each product or database

system.

Summary reports

A Summary report acts like a spreadsheet. The first column lists all the Tank
points (active, inactive, or both) and corresponding databases. These points can
be grouped by tank product or by database system. The remaining columns list

point variables, such as level and density. You can select what variables the report

displays.

Object Functions in summary reports

Object
TABLE

# OF ROWS IN
TABLE

LABELS

VALUE

COLUMN/ROW
TOTALS AND
AVERAGES

ADMO03GVAE1005

Summary Report Functionality

Exactly one table is required.

The FuelsManager database sets the number of rows.
User cannot enter a number.

Can only be inserted in the first row as report column
headers.

The first value entered in the table establishes, or tags,
the databases to which the Tank points will be derived.
Each subsequent value created represents the selected
variables of one or more Tank points such as temperature
and density.

Only column totals and column averages can be
displayed
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Summary Report
Setup dialog box
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Creating a new summary report

Step-by-Step

Independent Yariable

{+ Tank Points

Column Totals

{

e

Al Tanks
" Active Tanks

" Inactive Tanks

&+ Mo Column Totals

(™ Total Everything in Column

]

« Within the Report Editor dialog box, from the file menu, select New, and
then select the Summary Report command from the sub-menu

e The Summary Report Setup dialog box appears. In the Summary Report
Setup dialog box, the user sets the specifications of the Summary report.
The components of the dialog box are described below

Summary Report Setup @

Hurmber Of Columne (2-197 | 5§

v Outline Table

Select Database System

Databasze...

Set Table Sorting Order
[ Group Entries by System

[ Group Entries By Product

Cancel |

In the Number of
Columns

The Independent
Variable

Select Database
System

Set table Sorting
Order

Summary report Setup dialog box

Type in a number from 2 to 19. This option is also available
when creating a table.

This option designates which tanks are to be displayed in
the report--All Tanks, Active Tanks (Tank Mode is not
stopped), or Inactive Tanks (Tank Mode is stopped).

Click Database to select which databases are to be included
in the report. One or more databases can be selected.

In the Set table Sorting Order section, the user selects an
option to group Tank point entries. The entries can be
grouped alphabetically and numerically by database
systems, by products or both. If both the system and
products are selected, the points are grouped by system
with products nested inside each system.
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Step-by-Step
or...

dialog box; otherwise

» Click OK

Tabular Format E|

Erter required number of roves and columns

Rowes ’_ Columns ’E_

(1-40) (2-19)

e
e

W &uta Sizing

OK | Cancel |

Summary report Setup dialog box

Column Totals In the Column Totals section, the user selects how to
display column totals of each numerical point variable. The
default setting is no totals. If one or both of the table Sorting/
Grouping buttons are chosen, the user has the option of
displaying the total for each product or database system. If
a total option is selected, three rows appear in the table. If
the “No Column Totals” option is selected, only two rows
appear in the table.

Outline table Selecting the Draw Outline table checkbox displays a table
outline when the report is printed or viewed in Operate.

Creating a table in a summary report
Since a Summary report is of a spreadsheet format, only one table is required.

« If you are not in table creation mode, select Edit, click Add, and click table
¢ Click where you want the table to be placed to display the Tabular Format

¢ This dialog box lets the user set the number of rows and columns in the
table, as well as the dimensions of the table cells.

¢ Type in the number of columns as well as the dimensions of the table cells,
select auto sizing or type in inches the cell width and height.

Table Format dialog box

ADMO03GVAE1005

ROWS Either a 2 or 3 appears for a Summary report. The first row is
reserved for labels, the second for values, and the optional
third for column totals. This number can only be changed in
the Summary Report Setup dialog box.

Note! The Select Database
System dialog box appears upon
exiting the Summary Setup dialog
box if databases were not
selected. After the database or
databases are selected, the user is
automatically placed in table
creation mode.

Table Format dialog
box
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Label Attributes dialog
box
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AUTOSIZING

Table Format dialog box
COLUMNS

The user can type the number of columns, with a maximum
of 19. The table appears from margin-to-margin if the
autosizing option is selected.

This option was also defined in the Summary Report Setup
dialog box. The defined number appears in the edit box;
change only if needed.

Deselect this option if you want to enter the table cell
dimensions manually, when checked, all cells will be equal in
width and stretched from margin to margin. The allowable
space can not exceed the page width minus the margins.

Creating labels in a summary report
Labels can only be added to the first row of a Summary Report.

Step-by-Step

* Select Edit, click Add, and click Label

» Click on the cell where you want the label to be placed. Only the cells in the
first row can be selected for a summary report

» The Label Attributes dialog box appears. In this dialog box, the user enters
the label name. An Edit button is available to format the appearance of the
label. The table Snap option buttons aligns the label within a cell

» Enter the text in the Label Text edit box

« Click Edit to format the font appearance of the label. These changes can be
made before or after the text has been entered in the Label Text edit box

« Align the label by selecting the appropriate option button. This option only
applies to labels placed in the table with the Snap to table option selected (in

the table pull-down menu)
¢ Click OK. A label appears in the selected area

Label Attributes
Label Text : |
Fort Options
Font: Courier Mew I~ Bold
Size: 10 EuL Ll
Table Snap
o+ Lefl
" Centet
e Cancel

Creating values in a summary report
When creating a value for a Summary report, the first step is to establish the
Independent Variable for which all the database points will be derived. The user

then selects the point variables to be placed in the remaining columns. In runtime,

the points and corresponding database are listed in the first column. The
remaining columns contain variables such as level and temperature.
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Refer to the Summary Report Summary dialog box (displayed from the Report
Menu) to review the defined specifications, if necessary. Refer to the Values
section for an elaborate description.

Pairit :

Wariahle
Paoint Tag - Point Mame
Type :

Teo
Engineering Units Format Table Snap
Faort: Courier Mew Field wicth - | 54 =
Size: 10 = L Precision : ’_ e
Converted To . ~ Cert
I~ Bold c S
7 i " Right
[ talic d
et ¢ R

Step-by-Step

Select Edit, click Add, and click Value

Click on the first column cell in the second row

The Database Value Attributes dialog box appears

The Database Value Attributes dialog box allows the user to set the
appearance, field width, and positioning of the Independent Variable. The
Independent Variable, or tag, cannot be changed from this dialog box. The
databases were selected earlier in the Summary Report Setup dialog box.
In runtime, the database points assume the Independent Variable’s
appearance attributes

Click OK when complete. “Example Database Point Tag” appears in the
selected cell. (This step only occurs once per report)

Click on the next column cell in the second row. The Select Point Variable
dialog box appears

Choose the desired point variable and then click Select. The Select
Engineering Units dialog box appears if the point variable is numerical. At
this time, the engineering units to be displayed are undefined. (To view a
complete list of engineering units, refer to the Shared Systems Resources
documentation)

Select the corresponding engineering unit. Click Select. The Database
Value Attributes dialog box appears

Select the attributes of the point and then select OK. The value appears in
the selected cell

DataBase Yalue Attributes @

Datahaze

OK Cancel
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Database Value
Attributes dialog box
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Select Point Variable
dialog box

Select Point Yariable @

Type Tank Point

“arighle  Point Tag

Minor Correction - Minor Correction Type ~
Movement Holdoff - Movement Holdoff Time [
MovementiD - |0 of controlling Movement

et Flowe - et Flow

et Flowe Time - Met Flowy Time

Mo Flowy Haldoff - Mo Flowy Holdotf Time

Crverfill Protection - Orverfill Pratection

- Paint Mame

Select ‘ Cancel | Help ‘

After the Independent Variable has been defined, the remaining columns can be
filled with Tank point variables such as temperature, level, and volume.

Atfter all values have been entered, the user has the option of displaying column
totals. If not, the next step is to save and generate the report for viewing in the
Operate program. Refer to the Saving Reports section. If any editing needs to be
done, refer to the Editing Reports section.

Creating column totals

The user can display grand column totals, or totals for each product or database
system. If only two rows are displayed in the table, return to the Summary Report
Setup dialog box to select a column totals option. This dialog box is found under
the Report menu.

Step-by-Step
» Select Edit, click Add, and click Summary

¢ Click on cell where you want the total to be placed. The Row/Column
Summary dialog box appears. Clicking Edit allows you to modify the column
total appearance

¢ Click OK. A number appears in the selected cell
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Row/Columin Sumimaty i
—Summary Type — Tatalibwg.

& Column Summsry

Ry SUMmars

& Calculste Total

 Calcuste Sverane

—Format

Precizian: 2
W Autc

Wich [77

— Table Snap
* Left
" Center

" Right

Fort.  Courier kew

Slzg 10

[~ Bald
Ecit |

[ talic

Enter the numker of table cells to I_
be included in this surmmation:

o]

cancel |

Dynamic reports

A Dynamic report is more flexible than a Summary report. You can select points
and corresponding variables from any active database and add them to the report.
You are also not restricted to a certain format. You can use as many tables as you
like or no tables at all. Unlike Summary reports that list all the points found in a
selected database, Dynamic reports can contain any number of individual
database points. You can also display multiple column/row totals and averages.
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Row/Column Summary
dialog box
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Object Functionality of dynamic reports

OBJECT Functionality in Dynamic Reports

TABLE No tables, one table, or multiple tables can be created
# OF ROWS IN Defines the numbers of rows to be included in a table
TABLE

LABELS Can be inserted outside or inside a table

VALUE User can select an individual point (Tank, Input, or

Output) of any active database. Only one database can
be selected at a time

COLUMN/ROW Can display column totals, column averages, Averages
TOTALS AND as well as row totals and total averages.
Can also contain multiple averages/totals

Creating a new dynamic report

By default, the Report program is placed automatically in the Dynamic Report
mode. Make sure that the Dynamic Report option is selected.

Step-by-Step

* From the Report Editor dialog box, select File

» Select New, and then select Dynamic Report option

¢ At this point, the user has the freedom to create the contents of the Dynamic
report. Listed below are procedures used to create tables, labels, values,
column/row totals (and averages), and pages. As mentioned earlier, the
user has the option of using one or more tables to display database point
data
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Creating tables in a dynamic report

Step-by-Step

« If you are not in table creation mode, select Edit, click Add, and click table
or...

¢ Click where you want the table to be placed to display the Table Format
dialog box; otherwise

¢ In the Tabular Format dialog box, the user is able to set the number of rows
and columns in the table as well as the dimensions of the table cells. These
options vary between types of reports; the differences are noted below.

¢ Type in the number of rows and columns as well as the dimensions of the
table cells or select Auto sizing

e Click OK

Creating labels in a dynamic report

Step-by-Step

* Select Edit, click Add, and click Label

¢ Click where you want the label to be displayed. This can be within a table or
no

« The Label Attributes dialog box appears

< In the Label Attributes dialog box, the user enters the label name. An Edit
button is available to format the appearance of the label. The table Snap
option buttons aligns the label within a cell

< Enter the text in the Label Text edit box

¢ Click Edit to format the font appearance of the label. These changes can be
made before or after the text has been entered into the label text edit box

< Align the label by selecting the appropriate option button. This option only
applies to labels placed in the table with the Snap to table option selected (in
the table pull-down menu)

¢ Click OK. A label appears in selected area

ADMO03GVAE1005

209



FuelsManager Defense

Creating values in a dynamic report

When creating a value for a Dynamic report, only individual points are used. The
process involves selecting a default database, selecting the point, and then
selecting the corresponding point variable. All types of points can be used in a
Dynamic Report Input, Output, Triggered, and Tank points.

Step-by-Step

Select Edit, click Add, and click Value

Click where you want the value to be displayed. This can be within a table or
not

Select a point from the Database Edit dialog box to be represented by the
value

Click Select. The Select Database Point dialog box appears

Make appropriate selections and click OK. The Select Engineering Units
dialog box appears if the point variable is numerical. For a complete list of
engineering units, refer to the Glossary

The Database Value Attributes dialog box appears

Click OK when the appearance, formatting, and positioning of the value
have been completed. The value appears in the selected area or cell

Creating totals and averages

Atfter all values have been inserted, you have the option of displaying totals or
averages at the bottom of a column or at the end of a row. The user is able to
insert multiple column averages and totals; however, total or averages cannot be
used outside of a table.

210

Step-by-Step

Select Edit, click Add, and click Summary

Click on the cell where you want the total to be displayed. The insertion can
exist in any cell at the end of a row, column, or any cell in-between as long
as there are cells to total or average. The Row/Column Summary dialog box
appears

Click either the Column Summary or the Row Summary option button to
select a row or a column summary. Click either Calculate Total or Calculate
Average option button

Type the number of cells to include in the summation or average. This
number includes the cells to the left in a row or the number of cells above
the insertion point. Entering this number allows for more than one total
average to display. The number excludes the cell containing the total or
average

Click OK

A value appears in the selected cell
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Adding pages
This option applies exclusively to Dynamic reports since the number of pages in a
Summary report is undefined.

Step-by-Step

» Select Page from the menu bar and click one of the following options:
Append or Insert Page Before Current Page

¢ Select Append to add a page to the end of the report

« Select Insert Page Before Current Page to add a page before the current
page

Once a page has been added, more tables, values, and summaries can be placed
onto the page just created.

Deleting pages
The user can delete a page in Dynamic reports. All data that is on the page will be
removed completely.

Step-by-Step
¢ Select the page that is to be deleted
¢ Select Page from the menu bar and click on Delete Current Page

Maneuvering through pages
The Page menu applies only to Dynamic reports. This option allows the user to
add pages to the report and to maneuver through the report pages.

Step-by-Step

» Select Page from the menu bar and click on Next, Previous, First or Last
¢ Select Next (or press <Page Up>) to maneuver to next page

» Select Previous (or press <Page Down>) to maneuver to previous page
¢ Select First (or press <Home>) to maneuver to first page

¢ Select Last (or press <End>) to maneuver to last page

Formatting reports

Summary and Dynamic reports can have the default font, report layout, headers,
and footers defined.
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Setting the default font

Step-by-Step

e Select Format and click Font. The Select Text Font dialog box appears
« Select the type of font, size, and attributes for the default font setting

¢ Click OK when completed

Select Text Font dialog

box Select Text Font E|
Fart Fort Size
7 Arial Size  Standard

" Times Mew Roman 10 Size0 =3 ~
E -

(+ Courier Mew

Aftributes
Size 10

[~ Bold
I~ talic

OK | Cancel

Setting the report layout

Step-by-Step

¢ Select Format and click Report Layout to display the Report Layout dialog
box

¢ Set the margins in inches. The report header and footer will adhere to the
top and bottom margins if they are defined

¢ The Paper Type option allows the user to select either a legal (81/2 x 14
inches) or letter (81/2 x 11 inches) setting

Report Layout dialo -
bO)? Y 9 Report Layout E|

Margins (in inches)
Left [25] Right 0.2t
Top 050 Bottom 050

Crigntation Paber Tore:

(+ Portrait Letter 6.5 11 b

i Land=cape

OK | Cancel |

Setting the headers and footers

The report header and footer appear on every report page inside the set margins.
The Edit Font button sets the header font appearance. The footer font assumes
the header’s attributes, but the font size remains at a fixed 10-point size. These
attributes are applied before or after the header is entered.
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The date and time appear in the bottom left corner of the first page. The page
number, “Page #”, appears in the bottom right corner. Its font attributes are the
same as the header and footer fonts but at a fixed 10-point size.

Step-by-Step
¢ Select Format and click Headers and Footers

¢ Select Edit Font to change the font for the header and footer. The header
and footer can have different font types

¢ Select OK when completed entering all information

Report Header Footer

Report Header-Footer. Format E| Format dialog box
{* Header ||
" Footer |
Bize 10
Font:  Courier Mew: [~ Buold
Size: 10 I talic
Ok | Cancel | Ediit Fort... |

Setting print times and report status
In the Printer list box, the user assigns a default printer to the selected report. The
selected printer can only be changed in the Report Editor dialog box.

Step-by-Step

» Select Format and click Report Details

¢ Select the print status, printer, and type in the time and file name

« To configure a report to print periodically, enter the number of minutes
between print times in the print interval field. In addition, enter the number of
minutes past the hour that you want the print interval to synchronize to in the
Print Time field

« To configure a report to print at a particular time of day, enter the required
time in the Print Time field

« If the print time is midnight, type in “24:00” instead of “00:00”

* The Print Status section allows the user to set the initial print status. The
Inactive option keeps the report from printing. In Operate, the operator is
able to enable an inactive report. An Active report will print at its designated
time once the file is saved and generated. The report does not have to be
opened in the Operate program, nor does the Operate program have to be
active, in order for it to print at its scheduled time

¢ Select OK when completed
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Report Details dialog
box

214

Report Details @

Print Status Print Time:
" Active Print Interval (in Minutes): o
Lzt Print Time: (HH:MM): 00:00
Prirter: | t i J
File: Mame: | "
[~ Print Ta File

Editing reports

FuelsManager enables the user to edit reports of both categories - Dynamic and
Summary. Any item that was created in the reports can be edited such as labels,
values, and tables as well as report formats and print times.

After a report is edited and the changes are saved, it is necessary to regenerate
the report so the changes appear when printed or displayed in the Operate
program.
Opening an existing report

Step-by-Step

¢ Select File from the Report Editor menu bar and click Open

» Select the desired report

e Click OK. The report is displayed in the Report window

Editing FuelsManager standard reports

Since all of FuelsManager’s Standard reports are Summary reports, the editing
procedures used are the same. Editing a standard or Summary report includes
changing the attributes of the Independent Variable, creating new point variables,
editing tables, labels, and column totals.
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Editing report objects

These procedures apply to both Summary and Dynamic reports. Follow the Note! You cannot move a table to
appropriate procedure. another page or outside the
margins.

e <Ctrl + S> or Select from the Edit menu option to be placed in edit mode

. CIi_ck on thg object to be edited, the border of the object becomes dashed Note! A label created in a table
to indicate it has been selected cannbt be moved outside the table

e <Ctrl +A> or Attribute from the Edit menu. A dialog specific to the selected ina Summary report.
object appears. This dialog is the same as the one used to create the
object; refer to the previous sections that detail the creation process

» To delete an object, select Delete from the Edit menu or <Ctrl + Del>

« To move an object, click and hold the mouse button while dragging it to the
new location

« To resize a cell in a table, position the cursor over the line (horizontal or
vertical). The cursor changes to a double-headed arrow. Click and drag the
line to the new position

Note! You cannot move a line past
the positions of adjacent lines.

Managing report files

Once you save a report, the next step is to generate the report so it can be
available for printing and display in the Operate program. Generating a report
converts it into a format that can be understood by ReportManager and Operate.

Saving reports

All report files are located in the Report subdirectory of your project directory.
Generated report files contain the *.RRT file extension and saved report files
contain the *.RPT file extension.

Step-by-Step

» Select File and click Save As

e The Save Report dialog box appears

¢ Type in the Filename plus the “.RPT” report extension
¢ Click OK
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Saving an existing report
Step-by-Step
e Select File and click Save

Generating reports

Step-by-Step

¢ Select File on the menu bar and click Generate Run Files. A message box
appears briefly on the screen. If the report has not been generated, the
Generate Report Run Files and the Search of Report Index dialog boxes
appear

 Click Yes

e The Edit Report Index appears

« Type in the description name. This name is used as the description when
opened in the Operate program

* Click OK. The Select Report Index Entry dialog box appears. Click OK

Generating multiple files

Report provides an automated method for generating run files. One of three
methods of batch generation is provided below.

Step-by-Step
¢ Select Batch Run Files from the File menu item
¢ The Batch Compile dialog box appears

« The Altered Files list box displays all files that have been modified since the
last compilation

» Select the files for generation. To select all the files in the list box, click
Select All. Clicking Unselect All deselects the files

* Follow one of the below procedures
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“Do Selected” option to automate run file generation

Step-by-Step

¢ Click Do Selected. A dialog box appears asking you to confirm your request
to compile all selected files

¢ Click OK to proceed with the compilation of the files you have selected

“Make” option to automate run file generation
Step-by-Step
¢ Click Make. A dialog box appears asking you to confirm your request to
compile all altered files
» Click OK. This option generates all files that have changed since last
generated. This option is useful if you are unsure of which files have been
modified

“Build All” option to automate run file generation _
The Build All option is useful for either initial project development or if the system

database has been modified. System database modification often requires re-
verification of database references.

Step-by-Step
¢ Click Build All. A dialog box appears asking you to confirm your request to
compile all files

« Click OK. This option unconditionally compiles all files for a project, even if
they have not changed since the last generation

Deleting reports

Deleting generated reports
This action deletes the report from the Report Index. Once deleted, it cannot be

viewed or printed in the Operate program.

Step-by-Step

¢ Select File and click Report Index

» Select the desired report to be deleted
¢ Click Delete

Deleting saved reports
This action totally deletes the report. This process cannot be reversed once the RPT file is deleted.

Step-by-Step
e Open explorer in Windows

« Select the drive that contains the FuelsManager directory and then locate
the Reports directory

¢ Delete the report with the .RPT and .RRT file extensions
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Note! The “Build All” generation
process does not prompt the user
if the report is not in the report
Index. You must use the Master
menu to add reports to the index.
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Note! FuelsManager Historical
Reports are created using
Seagate’s Crystal Reports
software package, and access
data from the FuelsManager
Archive Database (See
ArchiveManager). If order to
modify the existing Standard
Historical Reports or to create new
reports, you must purchase and
install Crystal Reports, version 7.0
or greater. Crystal Reports is not
included in the FuelsManager
product.
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Historical reports
Historical reports are created using Seagate Crystal Reports. In order to modify or
create new historical reports, it is necessary to purchase Seagate Crystal Reports.
There are nine default report types that can be utilized for the Operate program.

e Current Tank Inventory Report

« Tank Inventory Repeat by Date

« Active Tank Report

* Inactive Tank Report

« Last Full Day Tank Change Report

« 7-Day Tank Change Report

* Last Full Week Tank Change Report

* Last Full Month Tank Change Report

« Month to Date Tank Change Report

By default, FuelsManager installs the Crystal Report Print Engine (the files
necessary to preview and print Crystal Reports). This means it is not necessary to
install Crystal Reports on your FuelsManager machine in order to view and print
reports. It is only necessary to edit existing or create new reports.

In order for new reports to be available in the Operate program, they must be
placed in the FMProject\Reports\Historical Folder.

Historical reports run against the FuelsManager Archive database (see Archiving
Information section). If the necessary data has not been archived, the report will
be incomplete. For example, running a last full month report before the archive
database has accumulated a month (or more) of data will result in an incomplete
report.

All the default FuelsManager historical reports access the archived information
through an ODBC data source called “Historical Reports.” This data source must
point to the FuelsManager archive database. This can be confirmed and, if
necessary, edited with the Windows Administrative Tools, Data Sources (ODBC)
applet.
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Note! Movement is only available
with the FuelsManager
Professional edition.
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The Movement System lets you setup and monitor Product Movements and
produces archive information on the Movement. A Movement involves transferring
product from one or more Sources to one or more Destinations.

The FuelsManager Product Movement system is divided into two parts, the
definition of possible movement paths (creating a movement) and the operation of
the actual product movement (operating a movement instance).

The creation of possible movement paths is performed from the Configuration
program and documented in this section, while the operation of movement
instances is performed from the Operate program and documented in the User
Guide for the Operate program
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Movement types

The following table shows the different types of Movements:

Movement Types From (Sources) To (Destinations)
Blend One or More Tanks One Tank

Charge One Tank One Unit

Receipt One Unit One or More

Tanks

Run-Down One Unit One Tank
Shipment One or More Tanks One Unit

Transfer One Tank One Tank

Water Drain One Tank One Unit

To assist in setting up complex movements, movements can be chained together
to produce combined movements

The following are illustrations of the Movement Types.

Blend

From Tank(s) ' To Single Tank

One or More Tanks

Charge
To Unit
Typically Ship, Barge,
Truck or Pipeline
From Single Tank
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Receipt

From Unit
Typically Ship, Barge,
Truck or Pipeline

—

Run-down

From Unit
Typically Ship, Barge,
Truck or Pipeline

To Tank(s)
One or More Tanks

Y

Shipment

From Tank(s)
One or More Tanks

To Single Tank

To Unit
Typically Ship, Barge,
Truck or Pipeline

N

Administrator Manual



Movement types

Transfer

Tank to Tank Transfer

Water-drain

From Single Tank '

To Unit
Typically Drain or
Slops tank
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Xfr modes

The transfer (or Xfr) mode refers to the measuring denomination you are using to
measure the product movement: Level, Mass, or differential Volume or Mass.

These examples illustrate the different types of xfr modes.

Transfer by Level

Transfer by Volume
or Mass

Enter the amount
of volume / mass
to be transfer
from the tank.

Transfer by
Differential Volume or
Mass

4 ICurrent Level

-+ J Required End Level

<+ I Current Volume / Mass

-+ JRequirad End Volume / Mass
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Definitions

This guide uses the following terms when explaining how to configure the
Movement System.

Movement summary

Unit — The movement system allows the creation of Source/Destination
designations called units, examples could be Pipeline XYZ, Truck Rack 123,
Pumphouse A2B. Units allow the operator to use meaningful names for plant
items being utilized for product movements. A unit has no measuring device so it
has no way of monitoring product movement, users cannot enter movement
setpoints for a unit and movements involving units will not calculate discrepancies.

Meter Node — A location in a product movement instance where a reading from a
physical meter is possible. You can associate FuelsManager input and output
database points with meter nodes and have the meter data automatically
collected or manually entered.

Receipt via
Meter Node To Tank(s)
One or More Tanks
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Shipment via

To Tank(s) Meter Node
One or More Tanks
Closeout is defined as one of the following:
Stopping of the movement (either manually OR due to non-
zero flow)

If the movement is active at the system specified closeout
time (default midnight)

Opening Value is defined as one of the following:
If a close out has occurred, the opening value is the value of
the particular variable at the last closeout time.
If the movement has been started but a closeout has not
occurred yet, the opening value is the value of the particular
variable when the movement started.

Closeout Value only exists after a closeout event has occurred. If the
movement remains active, and further closeout events occur
the closeout value will be updated.

Start Value is the value of the particular variable when the movement
was initiated.

The following are possible movement states along with their meanings:

Inactive the movement has been setup but has not been initiated by
the operator.

Active the movement has been initiated by the operator and is not
configured to use Start on Non-Zero Flow.

Disabled the movement cannot be initiated because one or more of
the tanks involved in the movement are currently in use by
another movement and this movement cannot be combined.

Halted the movement has been paused by the operator.

Failed during the start-up of the movement a failure occurred, the
movement is neither active nor inactive. The operator must
use the Reset menu option to clear this state.
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Starting The movement has been initiated by the operator but the
movement has been configured to Start on Non-Zero Flow
and no flow has been detected yet.

Stopping The movement has been configured to Stop on Non-Zero
Flow and zero flow has not existed for a time greater than
the Zero Flow Hold Off Value.

Combined is a combination of movements that involve one or more

Movement common tanks, the following combinations are NOT allowed:

* A combination that involves the same node pair twice.

Transfer Tank 1

Blend Tank 1

Charge Tank 1
Shipment Tank 2
Tank 1

Tank 2
Tank 3
Tank 2

Unit XYZ
Unit XYZ

« A combination that results in a circular transfer of product.

Transfer Tank 1 Tank 2
Transfer Tank 2 Tank 3
Transfer Tank 3 Tank 1
Discrepancy is the difference between the total amount transferred from all
the From tanks and the total amount received at all the To
tanks.
Totals is only available for Shipment and Receipt movements and is

the sum of amount transferred.
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Movement history

The movement history allows the operator to view all product movements, totals,
and discrepancies on a daily basis. Operators can open multiple movement
history windows and visually compare movement data from different days.

The movement history is a Microsoft Access MS SQL database and may be
accessed offline in order to create custom reports using 3rd party reporting tools.

The movement system writes records to the movement history at the following
times:

< If amovement is stopped, either manually by the operator or automatically on
non-zero flow (if the Stop on Non-Zero Flow option is selected).

« If a movement is active at the system close out time. The default close out
time is midnight but can be configured to be any single time during the day.
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Defining Movement Paths

In FuelsManager, setting up movement paths involves the following procedures:

1. Defining Nodes
2. Defining Sources and Destinations
3. Defining Groups (Optional)

Each procedure is described in order in this section.

Before you start

Before you start configuring Movements, make sure that the database is not in
SHUTDOWN mode. Otherwise, the user is not able to access the configuration
dialogs.

The database mode can be altered from the System Menu of the Configuration
program. Select System and click Startup Options. The dialog containing the
startup modes is displayed.

Accessing the movement configuration
Step by Step
¢ Open the FuelsManager configuration program
» Select Movement from the menu bar

Movements dialog
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Movements E|
SOUrce Destination
= |
Tank 1
= R |
[ Tark 3
= [ Tark 1 Add Sources
[ Tark s
=i Tark 11 Add Destinations
= REWRE!
= [ Tark 12 4]
[ Tark 13
= Tark a7 Q
[ r-a00
T = et T
[ m-a01
= i Tank 20 M
[ Mg
Check Products—
Histary Closing Time
(HH:MM) | oocoo
History Period
(Days)  |ap

This dialog box lists all the Sources and associated Destinations found in the
system. Each Source and corresponding Destination constitutes a valid
movement path. The user is able to add and save Sources and Destinations from
a series of configuration dialogs. Selected Sources and Destinations can also be
deleted.

The configurations defined by this dialog control the movement line-ups available
for selection by the operator from the FuelsManager Operator interface.

If the Check Products check box is selected the system checks for product
mismatch.

The History Closing Time field lets you enter a time of day that the system logs in
the Movement data to the movement database. Two scenarios that may arise are:

» Scenario 1 consists of a movement that is still activate. The system writes the
amount transferred for that day into the Movement History database and tags
the movement as Active

» Scenario 2 consists of a movement that is completed in this time frame. The
system writes the total amount transferred during the entire movement to the
Movement History database

The Historical Period field allows you to enter the numbers of days worth of data

you want to be maintained in the movement history (1 through 999 days). The
system overwrites data that has exceeded this History Period with new data.
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Defining nodes
All available Source and Destination elements are called nodes. You can add

nodes anytime during the configuration process. There are three types of nodes:

Tanks, Units, and Meters. Tank nodes represent the facility’s tanks, Unit nodes
represent a vehicle or other temporary storage container, and Meter Nodes
represent a flow meter through which the product is being moved.

Adding a Tank Node
Step by Step

« From the Movements dialog box, click Nodes. The Nodes dialog box
appears. This dialog box lists all the nodes available for selection. The
defined nodes are listed by name and type. From this dialog box you can
add, delete, or modify nodes in the movement system

Modes E|

IMaime Type
hd-300 Meter A A
h-400 hMeter
-0 Meter )
Tank 1 Tank _
Tank 10 Tank
Tank 11 Tank Al
Tank 12 Tank
Tank 13 Tank |
Tanl 14 Tanl v

| Cloze |

e Click Add. The Node Type dialog box appears

Tank
Unit
Ieter

Ok | Cancel

» Select Tank and click OK. The Tanks dialog box appears. This dialog box
includes all database points that have not already been selected as nodes
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Node Type dialog
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Tanks dialog for
Movements

Note! Each node name must be
unique for the selected default
node name based on the point
name level. In the example given,
all level 0 points are named
‘Tankpoint' - this would NOT result
in a unique node name, a better
tank point name level selection
would be Level 1.

Note! Each Node name must be
unique.

Node Name dialog
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Tanks g|

Default Mode Mame Bazed on Point Mame Level |0—ﬂ

TankFarm Tank 18 Tank
TankFarm Tank 18 Tank
TankFarm Tank 20 Tank

| Cancel |

* Select the database level on which the node name will be based from the
Default Node Name Based on Point Name Level selection

¢ Select one or more database points and click Select. Use the <Ctrl> or
<Shift> key to select multiple nodes. The system returns you to the Nodes
dialog box

¢ Click Save. The system saves the nodes you added

¢ Click Close. The system returns you to the Movement dialog box

Adding a Unit Node

« From the Movements dialog box, click Nodes. The Nodes dialog box
appears. This dialog lists all the nodes available for selection. The defined
nodes are listed by name and type. From this dialog box you can add,
delete, or modify nodes in the movement system

¢ Click Add. The Node Type dialog box appears

¢ Select Unit, the Unit can be any Destination or Source node such as a pier,
barge, or pipeline

¢ Click OK. The Node Name dialog box appears

Mode Name

Cancel

I _ x|
_concel|

« Type in the Unit Node name and click OK
¢ Click Save. The system saves the unit node to the Movement system
¢ Click Close. The system returns you to the Movements dialog box
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Adding a Meter Node
Step by Step
* From the Movements dialog box, click Nodes. The Nodes dialog box
appears. This dialog box lists all the nodes available for selection. The

defined nodes are listed by name and type. From this dialog box you can
add, delete, or modify nodes in the movement system

¢ Click Add. The Node Type dialog box appears
» Select Meter and click OK The Meter Node dialog box appears

Meter Node E

Mame: [v Rezetable
Wolume Rollover:
Mazs Rollover:

Data Sources:

Variable | 110 Point Selec| Clear
Gross Vaolume
Met volume |
Iass
Flava
Reset

Cancel

* Type the Name of the meter node

* Make the necessary settings for the meter node. Clear the Resetable
checkbox if you do not want the meter to be resetable

» Define what the maximum volume and mass the meter is capable of
counting to before rolling over to zero. Type these amounts in the Volume
Rollover and Mass Rollover fields. These parameters are only available if
the meter node is not resetable

¢ In the Data Sources grid, assign the meter node to its FuelsManager
database points by clicking the corresponding button in the Select column

« To clear meter node database point assignments, click the button in the
clear column, adjacent to the assignment you want to clear

« Use standard point selection processes to select database points
« After assigning the points, Click OK on the Meter Nodes dialog box

¢ Click Save on the Nodes dialog box. The system saves the meter node to
the movement system

¢ Click Close. The system returns you to the Movements dialog box

ADMO03GVAE1005

Meter Node dialog

Note! The reset data source is
typically connected to a
FuelsManager output point, which
is used to send a command to a
PLC/RTU to cause the flow meter
accumulator to be reset.

Note! Meter nodes should be
assigned to FuelsManager Input
type points. Connections are only
allowed to input points of data type
double. In addition, the input point
must be configured with
engineering units that match the
meter node variable being
connected (Volume units for
Gross/Net Volume).
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Nodes dialog
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Defining Sources and Destinations

To configure the Movement System, you need to specify which nodes you are
using as movement sources and you must add destinations to the sources. A
source can contain multiple destinations.

Step by Step

« From the Movements dialog box, click Add Sources. The Nodes dialog box
appears. This dialog box lists all nodes that you have not assigned as a
source and lets you select one or more of those nodes

¢ Select one or more nodes and click Select. Use the <Ctrl> or <Shift> key to
select multiple nodes. Click Select

* Select the Source from the list box

Hodes El

Mame Tvpe
td-300 heter A Addd
hd-400 Meter
hd-401 Meter y
Tank 1 Tank
Tank 10 Tank
Tank 11 Tank
Tank 12 Tank
Tank 13 Tank
Tarml 14 Tanl b
‘ Close |

¢ Click Add Destinations. The Nodes dialog box appears. This dialog box lists
all nodes except the selected source and lets you select one or more nodes

» Select one or more nodes. Use the <Ctrl> or <Shift> key to select multiple
nodes

¢ Click Select. The user is returned to the Movements dialog box. The
contents are arranged in a tree-like format. View the Destinations of a
Source by double-clicking on the desired Source

¢ Click Save. The system saves the defined Sources with Destinations
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Defining groups
Groups may be used to correlate multiple Movements. You can add groups
anytime during the configuration process. Clicking the Groups button allows you
to view all previously defined Groups or create new ones.
Inserting a group
Step by Step
¢ From the Movements dialog box, click Groups. The Movement Groups
dialog box appears

Movement Groups
dialog

Movement Groups

Group 1
Fone 1
Fone 2
Fone 3

Inzert

Delete

Ok

Cancel

fle o

* Click Insert. Type in the new Group name
¢ Click OK. The system returns you to the Movement dialog box

Note! Each Group name must
Deleting a Group be unique.
To delete a group from the movement system, perform the following steps:

¢ From the Movements dialog box, click Groups. The Movement Groups
dialog box appears. This dialog box lists all the groups

¢ Select the group to be deleted

* Click Delete. The selected group is erased from the list

» Click OK to save changes. The system returns you to the Movement dialog
box
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Note! This feature is used mostly
when users want to enter a name
other than the default level name
available during Tank

Node configuration.

Note! Each Node name must be
unique.

Node Name dialog

Note! Only those nodes that have
not been assigned as a source or
destination can be deleted. If you
have chosen a node assigned as a
source or destination the Delete
button will not be enabled.
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Editing Movement Paths

This section describes how to edit defined Movements. Sources and Destinations
can only be added or deleted. Nodes, the basic component of Sources and
Destinations, can be deleted or modified.

Modifying Nodes

Step by Step:

* From the Movements dialog box, click Nodes. The Nodes dialog box
appears. This dialog box lists all nodes and lets you select one or more
nodes

¢ Click on the desired node. The Node is highlighted and the Modify button is
enabled

¢ Click Modify. The Node Name dialog box appears

¢ Type in the new name and click OK

e The system returns you to the Nodes dialog box, highlighting the new node
name in alphabetical order. The Save button becomes enabled

¢ Click Save. The system saves your changes

Hode Name

Cancel

I x|
_canca |

Deleting Nodes

Step by Step
« From the Movements dialog box, click Nodes. The Nodes dialog box
appears. This dialog box lists all the nodes
« Click one or more nodes. Use the <Ctrl> or <Shift> key to select multiple
nodes
¢ Click Delete. The selected node or nodes are erased from the list
¢ Click Save to save changes
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Deleting Sources and Destinations
Step by Step

¢ Select Movements from the Configuration menu bar. The Movements dialog
box appears. This dialog box lists the defined Sources and associated
Destinations. Each Source and corresponding Destinations constitutes
possible movement line-ups. The contents are arranged in a tree-like format

Movements dialog,
showing sources and

Movements @l destinations
Source Destination
=[] 300 Groups
B Tank 1
b Tark 2
E Tank 3
T E ek Add Sources
=l Tank s
=l Tank 11 Add Destinations
=l Tank 13
= [l Tank 12
[ Tank 13
= [ Tank 17
I m-400
= [ Tank 19 Expoit...
I m-a01
= E Tank 20 Import...
I m-a01
Check Products
Histary Closing Time
(HE:MM) | oo:00
History Period
(Days) |30
Close
Note! A Source can not be deleted
until its corresponding Destinations
« Select the desired Source or Destination. The Delete button becomes are deleted.
enabled

¢ Click Delete. The system deletes the selection from the list
¢ Click Save to save changes
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Note! All nodes must exist in the
workstation before you import
movements. If you are transferring
all elements of the movement
system (tank nodes, unit nodes,
meter nodes, movements, and
groups), import the tank, unit, and
meter nodes before the
movements.
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Exporting & Importing Movement Elements

You can export movements from FuelsManager to a file, and import that file to
another FuelsManager with the Movement Import/Export feature. You import and
export the tank nodes, unit nodes, meter nodes, movements, and groups
separately.

Exporting Tank, Unit, and Meter Nodes; Movements; or
Groups

You must export tank, unit, and meter nodes or movements separately. However,
you use the same process for each of them.

Step by Step
¢ From the Movements dialog box, click Export. The Import/Export File Types
dialog box appears
e Select either Tanks, Units, Meters, Movements, or Groups and click OK. A
dialog box appears, asking for the filename and location for the export
¢ Select the directory for the export, enter the file name, and click Save. The
system saves the selected movement information to the file

Importing Tank, Unit, and Meter Nodes; Movements; or

Groups
You must import tank, unit, and meter nodes or movements separately. However,
you use the same process for each of them.

Step by Step

» Select Movements from the Configuration menu bar. The Movements dialog
box appears

* From the Movements dialog box, click Import. The Import/Export File Types
dialog box appears

e Select either Tanks, Units, Meters, Movements, or Groups and click OK

¢ Select the directory for the export, enter the import file name, and click
Open. The system imports the Tank nodes, Unit nodes, Movements, or
Groups from the file
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Note! Leak Detection is only
available with FuelsManager
Professional Edition. The Standard
Edition will not allow access to this
feature. For additional information
about upgrading to the
Professional Edition and above,
please contact your Varec
representative.
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Leak Detection is designed to monitor tank farms and pipelines for leak conditions
and alert you to a potential environmental hazard.

Using the Remote Terminal Unit, the Leak Detection system communicates with
various leak detection systems, such as interstitial monitoring, vapor monitoring
and pipeline leak detection systems, while bringing all information back to one
central computer for monitoring and reporting ease and convenience.

« Monitoring Level, Temperature, Water Level and Density from field
instruments or operator entry

» Performing analysis of sensor data, looking for conditions that might indicate
aleak

« Comparing instruments readings and calculations against alarm limits

« Annunciating, processing and logging alarms

» Providing Reports
Configuration of the FuelsManager Leak Detection feature is performed from the
Configuration user interface and is documented in this section. The procedure for

running a leak test and creating a leak report is accessed via the Operator user
interface and is documented in the User Guide for the Operate program.

Leak Detection interfaces directly to FuelsManager’s Archive database, reading
data from ArchiveManager’s database file, applying filtering algorithms,
calculating various statistics, applying qualifying logic and writing the results of the
calculations to FuelsManager database points. Alarm Processes running within
DataManager can monitor the resultant calculations. Any data source can serve
as the source of data for Leak Detection’s calculations. This includes data
manually entered, data calculated by DataManager or an Application DLL, or data
received via CommManager or an OPC server.

FuelsManager Leak Detection feature is able to detect a leak at rates as low as
0.2 gallons per hour. The ability to detect leaks at these rates depends upon the
physical characteristics of the tank (size, shape, above/below ground, materials
used in construction, etc.), the types of instruments available to measure the
properties of the product in the tank, the resolution & stability of the instruments,
and how the tank is used.

Leak Detection has two basic methods for detecting tank leaks:
e Volumetric
* Mass

Volumetric Analysis

Volumetric leak detection involves measuring the level and temperature,
calculating the Net Standard Volume, analyzing the tank data during periods of
inactivity, and searching for losses.

Detection of leaks in bulk storage tanks using volumetric changes depends upon a
number of factors, including the dimensions of the tank, and the Net Standard
Volume derived from the level & temperature.

The resolution, stability and accuracy of the level & temperature instruments play
a major role on how effective this method is. An accurate gauge with high
resolution yields the best results for static measurement. The accuracy of the tank
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strapping table will also affect the accuracy of the volume calculation. Errors in the
strapping table could appear as leaks.

Some factors have more influence than others, depending upon the application. In
large tanks (over 50,000 gallons), the resolution of the level measurement is the
limiting factor. For example, for a 1,000,000-gallon cylindrical tank, 40 feet in
height, a sixteenth of an inch (1/16") equates to almost 150 gallons. This means
that a long time period is needed to effectively detect a leak. Another limiting
factor is the resolution and stability of the temperature sensor. Changes in both
the product and the tank shell temperature will affect the volume of the product in
the tank.

Currently, Leak Detection is approved with three different level probes for
volumetric leak detection:

B EHTET Volume Leak Rate/Test Time
& Model

MTS DDA 0-75,000 gallons .2 gal/hr; 24 hour test
L&J 8100 0-75,000 gallons .2 gal/hr; 24 hour test
Barton 0-75,000 gallons .2 gal/hr, 24 hour test
Instruments

Mass Analysis

Mass based leak detection is based upon measuring the pressure of the product
and applying the conservation of mass principle. In bulk storage tanks, the Total
Observed Volume will fluctuate with changes in the temperature of the product.
The mass of the product in the tank is a constant, so changes in the temperature
of the product have no effect on the total mass in the tank.

Currently, Leak Detection is approved with one probe for mass-based leak
detection:

Manufacturer Volume Leak Rate/Test Time

Barton Instruments  0-3,000,000 gallons 3.0 gal/hr; 48 hour test
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Note! A tank typically requires 24
hours to become stable for
adequate Static analysis.
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Tank Analysis Types

The analysis type selected by the operator determines the method used to search
for a leak. When configuring a tank, the following analysis types can be set:

« Static

» Continuous

* Real-Time
Static Analysis _ )
A Static analysis type requires the tank to be shut down (out-of-service) and stable
for 24-48 hours, depending on the gauge type. Typically, a total of 24 hours of
valid data or quite time is needed to perform a relevant static tank analysis. After
analyzing valid data from ArchiveManger over a minimum 24 hour time period, the
system can report valid leak rates.

Continuous Analysis

Continuous analysis allows the operator to keep the tank in use while performing
an analysis. The system automatically identifies valid down times from
ArchiveManager during regular operation and builds the results. Continuous
analysis does analyze tanks in real-time, like Static Analysis, Continuous Analysis
are manual operations initiated by the user.

Real-Time Analysis

Real-Time analysis allows for an automatic continuous analysis of tanks. An
operator will not have to interact with the Leak Detection system to perform an
analysis. Unlike Static and Continuous types, Real-Time Analysis works
constantly to analyze the leak rate. Tests are performed automatically every day at
12:00 am. Leak Detection can, if configured, trigger an alarm if the analysis
detects a leak that is out of range. Also, an alarm is triggered if Leak Detection
detects that there is not enough quiet time data in the current month, from the tank
to produce a valid Leak Test Report.
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Security

Security
In order for Leak Detection to be accessible, the following permissions must be Note! For more detailed
granted: instructions on Security, please

refer to the FuelsManager Security
« Configure Leak Detection: allows users to configure leak tests for tank points section of this manual

* Run LeakManager Test: allows operators to execute leak tests

Security [EJ

Actions  Yiew  WaM

= ﬁ Security Iame ] A~
= G Categories s, Acknowledoe Local Alarms
=i§2 Groups Al Acknowledge Remote Alarms
+ % Operatt [, Slobal Silence sudible
3 pL Adm:;?;zt;r g’; Configure Historical Trends
B @ Forisaiia g’; Configure Reattime Trends
[A s Frirt Display
4% Tag [, | configure Macros
" & NeswGroupT i Execute Macros
G Users [Asl | 44d Database Points
doiy] At [, |Esit Database Pairts

i Copy Database Poirts
[Aal,|Rename Database Poirts
[, iDelete Databass Points
i ImpartExpart

[Aa, |Brovwse Database

g, Setup Movements

g, | configure Start Defiritions
[Al,|Execute Start Definitions
g’; Configure Movement iew:
gE Configure Leakhanager
A, |Fun Leakhanager Tests
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ArchiveManager

The ArchiveManager database is analyzed to calculate leak rates. It is necessary
to configure ArchiveManager to write all required data to the archive database:

» ArchiveManager needs to be configured to include the following additional
tank point variables:

Cathodic Protection Standard Density
Date Installed Tank Gauge Type
Density Tank Height
Hydro Pressure Units Tank Level

Hydro Pressure Volume  Tank Material

Bottom Pressure P1 Tank Radius

Leak Rate Tank Volume

Leak Rate Units Temperature

Lining Material Unrounded Volume Net
Overfill Protection Water Level

Spill Protection

In addition, the following ArchiveManager Configuration changes must be made:
e The precision of the Tank Level should be increased to allow Leak Detection
to calculate small volume changes
« ArchiveManager’s sample Interval should be set to 5 minutes
« ArchiveManager’s Historical Period should be set to 60 or 90 days

For details on how to add the necessary additional tank point variables, and
configure the precision and historical period, see the Archiving information section
of this manual.

The following section details how to override the ArchiveManager minimum
sample interval of 10 minutes and set the sample interval to 5 minutes.
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To set the default minimum to 5 minutes

To set the default minimum to 5 minutes

¢ Click the Windows Start button and select Run. The Run dialog box appears
¢ Type regedt32. The Registry Editor appears

e Select HKEY_LOCAL_MACHINE, the FuelsManager key, and the
ArchiveManager subkey

« Double-click the MinUpdateTime value, set the value to 5 and click OK.
* Close the Registry Editor

75 HEEY_LOCAL_MACHIHE on Local Machines

-5 HARDWARE ExporiCPainis - B TRADIRD D]
50 Sam MirlpdataTime A
=0 SECURIT SpeciExporFains | REG_DWORD : 0
51 SOFTWARE

G 3Com

8 Adote

- 00 Auode sk

|00 Blue Sk Sofware
G0 Badand

0 Classss

- O Cliarits

- (0 Coggine Syatermns ne.
8 Cornl

-0 Dezcrintion

- FhiLag

- =3 Fuelshdanager =
05 Datahdanmgar
2 Detail
0 Operate

ol

MTERSOLY
ommega Coponaion
odak

ariem Sobwara

=1 HEEY_LOCAL_MACHIMNE 1 Confguranon | AEG BIMAFY: 04 00 00 00 30 00 31 Q0.
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Setting Sample Interval to 5 Minutes

Archive Manager Configuration

E3
Realtime Database: i Select. ..
Historical Database: FM System Access (Microsoft SEL Server) Disconnect
Start Time (HH:MM: [oooo [T Archive Input and Output Poirts
Interyal rin Minutes: 10 [V Specify Archived Poirts Poirts. ..
Historicel Period (nDays) [60 [ Automstic End-of-Month Biackup
Tank Pairt YWariables Type Wickth Precizion

Doukle
Biyte
Date Installed Date 23
Density Maximum Double 17
Density Minimum Doukle 17
Density Units Units 23
Density Doukle 17

Description Desc 30
Flrmns hdascivm mm Meokla A7

Cancel

A

clit

0 e P P e

I

Step-by-Step

¢ From the FuelsManager Configuration application, click the Database menu
and click ArchiveManager. The Archive Manager Configuration dialog box
appears

¢ Change the Interval entry to 5 and click OK. The system closes the Archive

Manager Configuration dialog box and updates ArchiveManager with the
new settings

246 Administrator Manual



Edit Tank Data

Edit Tank Data

All leak relevant data must be configured in the Edit Tank Point Data dialog for
each tank when a leak analysis is performed. The minimum leak rate value,
maximum leak rate value and leak rate units for the tank are configured on the
General page of the dialog.

Edit Tank Data, - > WSIZEMORE YTank Farm. Tank. Tank 4

Note! The fields described in this

General ]Volume] Process Dala] Alarms] Wessel 1 ] Wessel 2] WM ] Strap / \Water Tabla] Leak Detection} section for the Edit Tank Data
dialog only apply to those related
Desciption | TagCalegoy [Defak +| to Leak Detection. For descriptions
of other fields on the Edit Tank
Detail I~ Display Quality D ata Data dialog, refer to the Databases
section of this manual.
Variahle Type | Minimum | Maximum | Engineering Units |
Level jo-00-00] 40-00-00  ftinchi Bth
Temperature -300.00 300.00 Degrees Fahrenhet
“olume 0.00 10,000.00 (U5, Gallon
Mass 0.0 10,000,000.00 : Pound
Density 0.00 100.00 Degrees APl
Standard Density 0.00 100.00 :Degrees AP
Flow -1,000.00 1,000.00 U5, Gallon f min
Pressure Units 0.00 30.00 : pound/zg in (P30
Lewvel Change Rate -10.00 10.00 feet per minute
Mazs Flow -3,000.00 3,000.00 : pounds per hour
“aporiGas Densty 0.00 100.00 ‘pounds [ cu. foot
Leak Rate -10.00 10,00 LS. Gallon [ haur

Edit Tank Data dialog -
m General page

Leak Detection Variables Assignment Options

Leak Rate Minimum values, Maximum values and Engineering Units
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Edit Tank Data dialog -
Process Data page

Process Data

The Leak Rate value can be set to a communication source assignment, an OPC
Data Source can be calculated from ArchiveManager data.

Edit Tank Data -> WSIZEMORE \Tank Farm. Tank. Tank 4

General] Yolume Frocess Data ]Alarmsl Veszel 1 ] \u"esselﬂ Wi ] Strap / Water Table | Leak Detection]
Variable | Source b
Level Mot Assigned
Temperature i Mot Assigned
R S i i
water Level hanual Entry
BT Manual Ertry )
Yolume Gross Calculated
“olume Met Calculated
Walume Remaining Met Calculated
Walume Available Met Calculated
Standard Density i Manual Ertry
B P ey
Solids Level Marial Ertry
Flosy Calculated
Water Volume Calculated
Gauge Position Mt Assigned
Dél.ﬁs'rty.TemperatLlre Mot Assignedd
Solids Volume Calculated
Transfer Mode ; hanual Entry s
Cancel

LeakManager Variables Assignment Options

Leak Rate Calculated, Manual Entry, Communication Device
and OPC
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Alarms

The leak rate alarm is used to trigger real-time alarms associated with calculated
real-time leak rate. The leak data alarm is used to trigger a real-time alarm when
there is not enough quiet time in the tank to produce a valid Leak Test Report.

Edit Tank Data -> WSIZEMORE XTank Farm. Tank. Tank 4

General] Volume] Process Data  Alams | Vessel 1 ] VesselZ] WM ] Strap .-"WaterTabIe} Leak Deteclion]

Gauge Alarm Tank Gauge &larm/Event Category | Default -
Alarm state | High-igh |  High Low | Low-low | Holdoff |
Level Enabled f5-00-00] 34-00-00 §-00-00 2-00-00 0-00-00
Tempersture  [Mone
Density Morne
Flanwe Mone
Level Rate Mone
“apor Press  [Mone
Movement Disatied 0-00-00 0.00
Reverse Flow | Disabled 0.00
1 Flawy Disatied 0.00
Test Made Disatied
ET& Disabled
Leak Rate Enabled 9.50
Leak Data Enabled
Mir > 34-00-00  Max <= 40-00-00  Engr Units = ftin-16th

ok | Cancel
Alarms Description
Leak Rate Allows an Enable/Disable State and allows the entry of High

absolute values. The Leak Rate alarm is triggered if the
absolute values of the Leak Rate exceed the defined High
absolute limits

Leak Data Allows an Enable/Disable State. This alarm, when enabled,
will alert every day at 12:00 AM to notify the operator that
there is not enough valid data or quiet time data from the
configured tank to produce a valid Leak Test Report
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Note! Leak Detection alarms are
only functional for Real-Time leak
analysis

Tank Data dialog -
Alarm page

249



FuelsManager Defense

Note! Leak Detection data from
the Vessel 1 page will appear on
the Leak Test Reports

Edit Tank Data dialog -
Vessel 1 page

250

Vessel 1

e Tank Volume

« Tank Height

e Tank Radius

e Tank Material

* Lining Material

« Date Installed

« Cathodic Protection
« Oveffill Protection
« Spill Protection

Edit Tank Data -> WSIZEMORE \Tank Farm.Tank.Tank 4

The Vessel 1 page allows the user to enter additional data about the tank, such as
its construction material, inspection date and dimensional data. This data is not
used in any calculations and is only presented as informational data on the Leak
Test Report. The following fields on the Vessel 1 page are important for
informational data:

General] Volume] Frocess Data] Blams  Vessell lVesseI 2] WM ] Strap / Water Table] Leak Detection]
Characteristics - Dptional Protection Tank Shell Comection
Cathiodic Pratection I || [ Enable
Landedtizint W bt Overfil Pratection [~ || [ 1y
Floating Height W flin-16th Spill Pratection [ AreaCoef ]7
Fioof Mazs W (] B augig Selup
Foof Type |No Tank Roof j & Tradtional ¢ Hydrostatic ¢ Hybnid
T ank. Geometry |Vert_ Cylinder j = Prezsure Transmitter Setup
e ]ﬁDD— gal (US] m e Df|f8 et PS5l He|ight ft-in-16th
Tank Height [00000 ftin-6th C Midde | i
Tank Radius [00000 16t Batiom | J
Shell Thickness [00000  fhin16th
Nivinia blatoria ’7 Iinimum Lesel ft-in-16th
Date Installed | 10/21/2004 = Densty Deadband il
Tank baterial |Mild Steel LJ 1n li msSect
ExpCosf ,m Elesvation ft
Install Temp.lﬂi 'F Latitude I_ l_ l_ D-M-5
Lewel OffSet ft-irr-16th
’TI Cancel
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Vessel 2

The type of gauge/probe used on the tank is configured from the Vessel 2 page.
The user has the option to chose from all current FuelsManager supported
gauges from the Gauge Type drop-list.

Edit Tank Data dialog -
Vessel 2 page

Edit Tank Data -= WSIZEMORE ‘\Tank Farm. Tank. Tank 4

General] Volume] Frocess Data] Alarms] Vessel 1 Wessel2 ]W’&M ] Strap / \Water Table | Leak Detection

Transfer Limits

" High-High
M awimur Fill |4 ft-in-16th " High
(™ User Defined
" Low-Low
Mirimur Empty [=0000 findgth  ©* Low
™ User Defined
; Gauge
Gauge Type |Undefined j

M odifier Undefined

! LPG Float Characteristics

Float Masz i g
Float Density “BP
Float Diamneter | ! ft-in-16th

oK | Cancel
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Note! The Leak Detection page
will not appear if the Leak
Detection feature is not installed or
the user does not have the
Configure Leak Detection security
permission

Edit Tank Data dialog -
Leak Detection page
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Leak Detection

The Leak Detection page allows the user to configure Real-Time analysis on
configured tanks. Also, automatic printing of a Real-Time Leak Test Report at the
defined print time and day before end of the month can be configured.

Edit Tank Data -> WSIZEMORE ‘Tank Farm.Tank. Tank 4

Recurrence

Gemela\l Volumel Process Data} Alarms} Vessel 1 } Vessel2| i } Shrap / water Table Leak Detection ‘

Froperties
Tank Analysis Method: | Uiounded Net B
Tark Analysis Type: |HeaI-Time j
Auta Printing

V¥ Use Automatic Printing

Piint Time; |120048M ==

Mumber days before end of month; |0

Cancel

Field

Tank Analysis
Method

Tank Analysis
Type

Use Automatic
Printing

Print Time
Number of days

before end-of-
month

Description

Drop-list of leak analysis methods that are valid for the tank
gauge selected from the Vessel 2 page. The methods
include: Net Volume, Unrounded Net Volume, and Barton
Series

This field is typically for real-time tank analysis. The types
supported include Static, Continuous, and Real-Time

Allows the user to enable and disable automatic printing. This
field is only functional if Real-Time is the current selection in
the Tank Analysis Type drop-list

Allows the selection for the time of day the Real-Time Leak
Test Report will be printed. This field is only functional if Use
Automatic Printing is selected

Allows the setting of the printing interval for the Real-Time
Leak Test Report in relation to the last day of the month. This
field is only functional if Use Automatic Printing is selected
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Tank Analysis Methods

There are three possible tank analysis methods that can be used in
FuelsManager. All three methods compare test readings at different times to
calculate leak analyses.

Tank Analysis

Method Description

Net Volume The Net Volume method collects net volume readings from
the tank when performing tests. This method uses up to four
decimal places in its VCF calculations, which is an API
standard

Unrounded Net  The Unrounded Net Volume method collects net volume

Volume readings from the tank when performing tests. This method
uses up to 15 decimal places in its VCF calculations, which
provides a more accurate reading

Barton Series The Barton Series method collects pressure readings from
the tank when performing tests. FuelsManager retrieves the
pressure from a device that must be mapped to the Vapor
Press P3 process variable

Note! For more information on
Process Variables, see the
Database and Glossary sections of
this manual
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Upgrading versions prior to v4.3

If you are upgrading a system that is currently version 4.0, 4.1, or 4.2 of
FuelsManager, you will need to update the database system to the 6.0 version. To
do this, you need to run the FMSystemUpdate utility.

If you are upgrading from version 4.3, you do not have to run the FM System
Update utility.

The FuelsManager System Update utility will not update any version before
version 4.0.

Before Updating Your Database
Before running the FuelsManager System Update Utility, do the following:

* Update your version of the FuelsManager Defense software to the latest
version

¢ Shut down FMSystemManager and do not restart it until after you have
completed the update

* Make a backup copy of your existing FMProject database file

« If you have not already done so, copy the FMProject database you want to
upgrade into the current FMProject folder.

« Important! Copy the FuelsManager.act file from your old ...\FuelsManager
folder to the new ...\FuelsManager folder. If you do not do this, the update
utility will not be able to update any of your user, user groups, or security
permissions data

Items not updated

The FuelsManager System Update utility will not update previous versions of
communications driver configurations. In order to upgrade this part of your
configuration, you should export all the source assignments prior to starting the
upgrade; upgrade your database using the FMSystemUpdate utility; recreate your
communications configuration; then re-import the source assignments.

Alternately, you can update the software version-by-version, as described in the
Troubleshooting section.
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Upgrading versions prior to v4.3

Running the Utility

Step 1: Open the Utility from the Start Menu.

Click Start and select Programs, FuelsManager, FMTools, and click
FMSystemUpdate. This opens the FuelsManager System Update Utility. The
FMSystemUpdate window appears.

The utility recognizes

- = versions 4.0, 4.1,
wa FMSysUpdate E| and 4.2,

Suztem Data File Wersion 4.0

This means that the utility recognizes the file version on your machine and can
update your system.

Step 2. Click Run
Click Run to begin the update process.

Step 3. Back up Files in Project
Before running the process, the system prompts you to back up your files in the

project.
Backing up these files only makes copies of the files that change during the
update--not the entire project. Click Yes to back up these files and continue.

Step 4. Finish Update
After backing up the project files, the system will automatically start the update.

The window logs the updates:
« Updating System Data
e Updating Product Data
¢ Updating Alarm Group Data
» Updating DataManager and Movement Data
» Updating Graphics Data
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Update Complete
If the update is successful the last line of the log will display “Update Complete.”

This means that the update was successfully performed and your system is now
running the 6.0 database.

Update Failed
If the utility is unable to complete the update, the last line of the log will display

“Update Failed.”
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Error messages and troubleshooting

Error messages
Missing System File Update is Not Available

You may get this message in the FMSystemUpdate window. Invalid file message
s will keep the utility from
v FMSysUpdate El updating.

This message means that either the utility does not recognize the system file as a
version that it can update or that there are files missing. If your version is not 4.0,
4.1, or 4.2, the utility cannot update your database system. If this is so, the Run
button is disabled.

System Data File Version 4.3
If the utility recognizes the version as 4.3 (System Data File Version 4.3), then the

system is already updated and you do not need to run this utility. In this case, the
Run button is also disabled.

Unsupported Graphic Revision in File: 3401.SYM

You will get this message if you created your graphics and symbols in a version
previous to 4.0. This will not keep the update from successfully running. But you
should make sure that your graphics and symbols are displaying correctly; and if
not, manually correct them.

Database is Corrupt
You may get a “Database is Corrupt” message. This can reflect a couple

situations:
« Any of your data files may be from a version previous to 4.0.

» Your data files are not consistent; you may have a 4.0 movement database
and a 4.2 product database.
Whatever the reason is, the last update statement in the FMSystemUpdate
window tells you where the corruption was found. For example, it may list the
Movement Data database (MoveData.dat and MoveSchedule.dat).
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Troubleshooting
» A possible solution to the Database is Corrupt error is to rename any

database files that the update utility finds as corrupt. For example, in the
screen above, rename the MoveData.dat to MoveDataold.dat and rename
MoveSchedule.dat to MoveScheduleold.dat. By doing this, the utility will skip
these renamed files--they are not updated automatically. After running the
utility you need to manually update these data.

You can also try updating the software version-by-version--4.0 to 4.1, then to
4.2, 4.3, and then 6.0. This will update the databases as you go along,
negating the need to use the FM System Update utility.

As a last resort you can install FuelsManager Defense V6.0 to a different
CPU. This will require you to export all your tank points, resources, and strap
tables from the old system and import them into the new one.
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After Updating the Database

Rename Your Database as the Local Machine Name
If necessary, you can start FMSystemManager and run FMSystemConfig to
rename the database to the local machine.

Checking Your System

After you upgrade your database system to 6.0 with the utility, open Configuration
and verify that your groups, users, system permissions, and tag permissions are
still working properly. Since some of the security rights definitions have changed,
they may not match perfectly.

The update utility created a back-up copy of the old files that were changed.
These files are located in the “Copy of FMProject” directory. This is not a complete
back-up of your entire database, and includes only the files that were changed in
the upgrade.

Rebuild Graphics and Reports
You will have to rebuild the following:

« Symbols

e Graphics

 Detail Mode Symbols
 Detail Mode Graphics
* Rebuild Reports

Back up FMProject
After doing all this you should and back up your new FMProject.
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In this section, you will learn how to configure, maintain, and operate the
Automated Data Output section. This feature is used to periodically write the
contents of several tank point variables to an output file.

Automated Data Output basic functions include:

» Reading specified variables, up to a total of 98, from all tank points in the
FuelsManager database at specified intervals, or when a specific Process
Value is triggered

« Writing these values to output CSV, HTML, and XML files
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Program Location

The Automated Data Output service starts automatically whenever Windows is
started; however, it can be configured at any time from the Start, Programs,
FuelsManager, Automated Data Output.

The configuration process includes specifying which tank point variables should
be logged, and what events initiate the log process. Up to 98 tank point variables
can be logged simultaneously, though usually substantially fewer are needed.
Also, there are three different types of “triggers” that can be defined to initiate the

log process.

Snapshot file

Periodic File

HTML File

XML File
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A Snapshot file is a CSV file, written when a particular point value
takes place, and is designed as a “snapshot” of the data at the
moment in time at which the trigger was tripped. This file can be
written whenever a specific FuelsManager database value is met,
whenever a specific file exists, or at two individual static trigger times.
« Trigger Point: A trigger point and a trigger value can be entered.
Automated Data Output will wait for that specific database point
value to equal the trigger value and will then write the snapshot
file
« Trigger Time 1/2: Two trigger times can be specified directly.
These times indicate exactly when the snapshot file should be
written. This option is very useful for things like daily inventory
reports or statements

« Trigger File: This option triggers a snapshot file whenever a
specific file is detected. The file is then deleted as soon as the
operation is complete, to reset the trigger

The Periodic file is a CSV file, written at regular intervals, as specified
in the Periodic Interval field. There is a check-box option to export the
column headers with the data, as well as an option to include a custom
“Version” column.

The HTML file is a hypertext markup language (HTML) file, and it is
written periodically, according to the Periodic Interval field. There is an
option to include another HTML file as a header, so that company
logos, etc., can be included on the output. This option can be used to
publish data directly to a local or web server on a periodic basis.

The XML file is an extensible Markup Language (XML ) file, and it is
written periodically, according to the Periodic Interval field. It can be
used alongside or instead of the HTML file.
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Automated Data
Output configuration
dialog

Note! If a tank point variable is not
configured (See the Database
section of this manual), the
resulting data written by
Automated Data Output may be
invalid
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Automated Data Output Configuration Dialog

ﬂ Automatic Data Output

Available Tank Variables:

Tank Variables to be logged:

Ambient temp for ctsh A 4
AP Corection Emor EHLED
Available Mass
Awailable Vol [Gross)
Available Yolume [Net] << Remave <<
Bit12
Bottom Sediment & \Water
Bottom Sediment & YW ater Time Detault
Caleulation Error
Combined Bottom Yolume [H20 + Solids] Precision:
Current Transferred Yalurne B
Database Configuration Emor
Qenswly . = w
Mave Up Move Down
Snapshot File Parameters
Trigger Point: Trigger Yalue: ResetValue: Trigger Time 1: Trigger Time 2
[ [ - s = ¢ fiens 2
Snapshot File: Trigger File:
| gl | g
Periadic File Parameters i i Snaphot/Periodic File Options
File: poita i) Wersion [ Export Quality Info
| &8 |‘I | I™ Export Header
HTHML Files
File: Header File
| o | ol
#ML Files
File:
| g
Ok Cancel I Help Test

Tank Variables to be
logged

>> Add >>

<< Remove <<

Available Tank Variables This list includes all possible tank point variables

This field lists all of the tank point variables that are
currently selected to be logged

This button adds the currently selected variable in the
“Available Tank Variables” list box, on the left, to the
“Tank Variables to be logged” list box, on the right.
That variable will then be removed from the “Available
Tank Variables” list box

This button removes the currently selected variable
from the “Tank Variables to be logged” list box, on the
right. That variable will then reappear in the “Available
Tank Variables” list box, on the left
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Default

Precision

Trigger Point, Trigger
Value

Reset Value

Trigger Time 1, Trigger
Time 2
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This button deletes all variables from the “Tank
Variables to be logged” list box, and then adds the
Automated Data Output default set of variables to that
list box. This default list is generally accepted as the
most commonly used set of variables, and includes
the following:

¢ System Name

» Point Tag

e System Date and Time
* Product Code

e Level

« Temperature

« Standard Density

* Gross Volume

* Net Standard Volume
* Available Volume (Net)
* Remaining Volume (Net)
* Flow Rate

The precision of the data in the output files can be
entered here. The Precision field defines the number
of decimal places you want in the values logged. If
you enter 0, no decimal places will be logged

A FuelsManager point can be entered and you can
set the trigger value. The Trigger Point that you use
must be an Input point, and must be set to a Manual
Data Source. When the trigger point equals the
trigger value, Automated Data Output will write the
snapshot file. This method can be used to manually
initiate the log process when needed, or to cause the
log process to initiate automatically whenever a
particular event takes place

After the Trigger Value is reached and a snapshot file
is created, Automated Data Output sets the Trigger
Point value to the Reset Value

Two distinct trigger times can set so that the log
process runs once or twice every 24 hours. To set a
trigger time, check the box to the left of the time field
you want to set, and then enter the trigger time into
the appropriate field
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Trigger File

Snapshot File

Periodic File

Periodic Interval

Version

Export Quality Info

Export Header

HTML File

This field specifies an optional trigger on the
existence of a specific file. If a file (with the full path to
the file) is specified, then the log process is initiated
whenever the existence of this file is detected. This
file is subsequently deleted, to reset the trigger. The
button next to this field opens a browse window to
make it easier to specify the trigger file

A Snapshot file is an CSV file, written when any of the
above Trigger events take place, and is designed as a
“snapshot” of the data at the moment in time at which
the trigger was tripped. This file can be used to create
a daily inventory report at a specific time, or to log the
state of all tanks when a particular event or disk file is
detected. The button next to this field opens a browse
window to make it easier to define the desired output
file

The Periodic file is an CSV file, written at regular
intervals, as specified in the Periodic Interval field.
There are options to export the column headers with
the data, as well as an option to include a custom
“Version” column

The Periodic Interval is the amount of time, in
minutes, between updates to the Periodic File. The
Periodic File is overwritten each time this period
expires, and the counter begins when Automated
Data Output starts, which corresponds with when
Windows starts

If a value is specified in the Version field, it is included
in the periodic file as an additional column of data.
This affects both the Snapshot File Parameters and
the Periodic File Parameters

If this box is checked, the file will contain the current
status of the selected variables (overrage, underrage,
forced, manual, etc.). This affects both the Snapshot
File Parameters and the Periodic File Parameters

If this box is checked, then the field names are
included at the top of each column of the CSV file. If
this file is not checked, then the data is written without
a header. This affects both the Snapshot File
Parameters and the Periodic File Parameters

The HTML file is a hypertext (HTML) file, and it is also
written periodically, according to the Periodic Interval
field. This option can be used to publish data directly
to a local or web server on a periodic basis
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HTML Header File

OK

Cancel

Test
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This field is used to specify another HTML file as a
header for the output HTML file. This option can be
used to include company logos or other information at
the top of the web page

Clicking on this button saves any changes that have
been made and closes the Automated Data Output
configuration dialog

Clicking on this button discards any changes that
have been made and closes the Automated Data
Output configuration dialog

Clicking this button causes all specified output files to
be written immediately. This is very useful for verifying
tank variables, header files, and other options before
saving the configuration data
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Configuring Automated Data Output

This section describes how to configure Automated Data Output to export the
desired variables to the proper output files.

Initial Setup

Refer to the Dialog Descriptions section for field explanations on the configuration
dialog box used in this procedure.

Start the configuration program by selecting Start, Programs, Automated
Data Output, Automated Data Output

Select the variables to be logged from the Available Tank Variables field and
click the >> Add >> button. You can select all the variables to be logged at
once and add them simultaneously, or add them one-at-a-time.
Alternatively, you can click the Default button and add to or remove from the
default set of tank variables. Keep in mind that the order in which the
variables are displayed in the Tank Variables to be logged field is also the
order in which the variables will be written to the output file

If you want to use a database point value to trigger the file creation, define
that point in the Trigger Point and Trigger Value fields. Then enter the Reset
Value to the value you want to reset the point to after the snapshot file is
created

If you want to create snapshot files at specific times of day, check the
box(es) next to the appropriate Trigger Time fields and enter your time(s)
there. Keep in mind these fields are entered using 24-hour time. You can
enter up to two Trigger Times

Specify the snapshot file that you want Automated Data Output to write to by
entering in the full path and file name into the Snapshot File field.

If you want to create a snapshot file using a trigger file (when a file exists),
enter that file's path and filename in the Trigger File field

If you want Automated Data Output to create a Periodic File, enter the path
and filename you want to create in the Periodic File field. Set the Periodic
Interval field, keeping in mind that this value is also used to set the interval
for the HTML file. Also set any desired Period File Options

If you want Automated Data Output to create an HTML file, enter the full
path and filename in the HTML File field, as well as an HTML Header File if
you want to include a logo in the browser above your HTML file

If you want Automated Data Output to create an XML file, enter the full path
and filename of the file you want to create in the XML Files

If needed, click the Test button and review the output files

Click the Ok button to save the configuration and close the dialog.
Automated Data Output configuration is now complete. Since Automated
Data Output is running as a Windows service, the files ‘Snapshot.csv’,
‘Test.csv', and ‘Test.htmlI’ will be automatically produced as a specified,
regardless of whether the Automated Data Output Configuration application
is open
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Sample output files
For reference purposes, sample output files are included below.

Snapshot.CSV:

EZ Miciosoft Excel - Snapshot.CSY =
| Fle Edit View Insert Format Tools Data Window Help =181
DSHagl¥ | iaad - &= &4 3 il -0,
| vl roFBru|EEEEs %, FAEEL-D-A
Al =] = System Name
A B | C D EX| F G H i
1 [System Mame IPoint Tag System Date and Time Product Code Level Temperature Standard Density | Gross Volume |Net?
2 |MASTERS  TankFarm.Areal.Tankl 142472000 11:08 <No Product> 30 60.123 0.9 46675
9 |MASTERS  TankFarm.Areal Tank2 172472000 11:08 <No Product> 15 75 40 28115.234
4
| 5 |
B
| 7 |
| 8
g
10
11
12
KEl
14
[« [» [¥i}\Snapshot (R} _ ’If
Ready 1] [ [ | I
Test.HTML:

7 FuelsManager Data Logger - Micrasoft Intemet Explorer

| Ele Edt View Fovoites Took Help
S ] - & =
Back Fanmard Stop Refresh Home Search  Favortes  History Mail Prirt Edit Discuss RealGuids
Agehess [#] CATEMPATssthimd
| SystemName | Point Tag [ System Date and Time | Product Code |
[ MASTERS [ TankFarm.Areal.Tankl [ 01/24/00 11:10:03 [ No Product [
[ MASTERS [ TankFarm.Areal.Tank? [ 01/24/00 11:10:03 [ No Product [
d e ————
|&] Done =2

Testxml.xml:
The following is a sample of an xml file result if you use the default tank variables
for one tank.

<?xml version="1.0" encoding="UTF-8" ?>
- <FMLogXML Version="1.0.0">
- <Header>
- <ThisDocumentldentifier>
<Documentldentifier>c:\Program Files\FuelsManager\FMProject\testxml.xml</
Documentldentifier>
</ThisDocumentldentifier>
- <ThisDocumentDateTime>
<DateTime DateTimeQualifier="0n">20030328T1513</DateTime>
</ThisDocumentDateTime>
</Header>
- <ProcessVariableBody>
- <ProcessVariableProperties>
<LanguageCode Domain="">EN</LanguageCode>
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</ProcessVariableProperties>
- <ProcessVariableDetails>
- <ProcessVariableLineltem>
<LineNumber>0000000</LineNumber>
- <ProcessVariablelnformation>
- <ProcessVariable>
System Name
<ProcessVariableValue Value="BMS1" />
</ProcessVariable>
</ProcessVariableInformation>
<LineNumber>0000001</LineNumber>
<ProcessVariableInformation>
<ProcessVariable>
Point Tag
<ProcessVariableValue Value="Test.Tank.1" />
</ProcessVariable>
</ProcessVariableInformation>
<LineNumber>0000002</LineNumber>
<ProcessVariableInformation>
<ProcessVariable>
System Date and Time
<ProcessVariableValue Value="03/28/03 15:13:48" />
</ProcessVariable>
</ProcessVariableInformation>
<LineNumber>0000003</LineNumber>
<ProcessVariableInformation>
<ProcessVariable>
Product Code
<ProcessVariableValue Value="No Product" />
</ProcessVariable>
</ProcessVariableInformation>
<LineNumber>0000004</LineNumber>
<ProcessVariableInformation>
<ProcessVariable>
Level
<ProcessVariableValue Value="11-00-00" />
</ProcessVariable>
</ProcessVariableInformation>
<LineNumber>0000005</LineNumber>
<ProcessVariableInformation>
<ProcessVariable>
Temperature
<ProcessVariableValue Value="77.60" />
</ProcessVariable>
</ProcessVariableInformation>
<LineNumber>0000006</LineNumber>
- <ProcessVariableIlnformation>
- <ProcessVariable>
</FMLogXML>

Administrator Manual



Calculation Methods




FuelsManager Defense

274

Volume correction methods

This section describes the correction methods and tank calculations used in the
FuelsManager program. Since the volume of the product in a tank varies with the
temperature and density, the user must use a correction method to correct for
variations in temperature and density of the product.

Data rounding

Selecting any of the correction methods designated 'Japan’ allows the user to
configure the following special data rounding methods.

Volume Correction Factor (VCF)
¢ None
« 0.00001
« 0.0000001
Level
This includes both Product and Water Level
* None
* Nearest Integer (i.e. 123.5 millimeters is truncated to 123 millimeters.)
Temperature
This includes Product and Gas Temperature
* None
* 0.25 Degrees
- 0.000 ~0.124 --- 0.00 °C
-0.125~0.374 ---0.25 °C
- 0.375 ~0.624 --- 0.50 °C
-0.625~0.874 --- 0.75 °C
-0.875~1.124 --- 1.00 °C
¢ 0.5 Degrees
-0.00 ~0.29 - 0.0 °C
-0.30~0.79 - 0.5°C
-0.80~1.29--1.0°C
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Volume correction techniques

Custody transfers and billing are used based on volumes at a given temperature,
or Standard Temperature. FuelsManager provides the following temperature
correction techniques. All correction techniques are based on internationally
recognized standards developed by the American Petroleum Institute (API),
American Society for Testing and Materials (ASTM), Institute of Petroleum (IP),
Japanese Institute of Standards (JIS), Gosstandart of Russia (GOST), and
Chinese National Standards (GB/T).

The goal of a correction technique is to calculate a Volume Correction factor
(VCF) and to use this factor to calculate standard volumes from measured
volumes. The VCF is defined as:

« Correction for temperature for a liquid

» Compensates for the effect of temperatures on a liquid

« Corrects a volume at an observed temperature to a standard temperature

Petroleum tables.

Temp

Type Method Product Table Entry Range Range
6A/5A Generalized Crude API gravity @ 60°F in API 0-40 0-300°F
Oil 40.1-50.0 0-250°F
50.1-100.0 0-200°F
6B/5B Generalized API gravity @ 60°F in API 0-40 0-300°F
API °F Products 40.1-50.0 0-250°F
50.1-85.0 0-200°F
6C Individual & Thermal Expansion Coefficient 270-510 0-300°F
API °F 1980 Special in Alpha x 10° 510.5-530 0-250°F
Applications 530.5-930 0-200°F
6D Generalized API Gravity @ 60°F in API 0-50 0-150°F
Lubricating Oils 50.1-100 0-125°F
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Type Method

54A/53A

54B/53B

54C

54D

API °C 54A/53A
30°C

API°C 1980 54B/53B
30°C

54C

Japan JIS 30°C

2249°C 1980

54D
30°C

60A

60B

60D

Japan JIS Table
2256 °C 1967 2(54)

276

Product

Generalized Crude
Qil

Generalized
Products

Individual &
Special
Applications

Generalized
Lubricating Oils

Generalized Crude
Qil

Generalized
Products

Individual &
Special
Applications

Generalized
Lubricating Oils

Generalized Crude
Qil

Generalized
Products

Generalized
Lubricating Oils

Generalized
Products

Table Entry

Density @ 15°C in kg/m?®

Density @ 15°C in kg/m®

Thermal Expansion Coefficient
in Alpha x 10°

Density @ 15°C in kg/m®

Density @ 30°C in kg/m?®

Density @ 30°C in kg/m®

Thermal Expansion Coefficient
in Alpha x 108

Density @ 30°C in kg/m®

Density @ 20°C in kg/m®

Density @ 20°C in kg/m®

Density @ 20°C in kg/m?®

Density in g/cm?3

Range

610.5-778.5
779-824
824.5-1075

653-778.5
779-824
824.5-1075

486-918
919-954

800-824
824.1-1164

610.5-778.5
779-824
824.5-1075

653-778.5
779-824
824.5-1075

486-918
919-954

800-824
824.1-1164

610.5-778.5
779-82
824.5-1075

653-778.5
779-824
824.1-1075

800-824
824.1-1164

0.500-1.200

Temp
Range

-18- 95°C
-18-125°C
-18-150°C

-18- 90°C
-18-125°C
-18-150°C

-18-150°C
-18-125

-18-125°C
-18-150°C

-18- 95°C
-18-125°C
-18-150°C
-18- 90°C
-18-125°C
-18-150°C
-18-150°C
-18-125°C

-18-125°C
-18-150°C
-18- 95°C
-18-125°C
-18-150°C
-18- 90°C
-18-125°C
-18-150°C
-18-125°C
-18-150°C

Not Specified
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Type

Japan ASTM
D1250 °C

China GB/T

Russia GOST

ADMO03GVAE1005

Method

Table 55

54A (6X)

54B (6X)

60A/59A

60B/59B

600/59D

20°C-85

Product
Generalized
Products
Generalized Crude
Qil

Generalized
Products

Generalized Crude
oil

Generalized
Products

Generalized
Lubricating Oils

Oil & Oil Products

Table Entry
Density in g/cm?3

Density in kg/m3

Density in kg/m3

Density @ 20°C in kg/m?®

Density @ 20°C in kg/m?3

Density @ 20°C in kg/m®

Density in g/cm3

Range

0.6274-
1.0754

610.5-778.5
779-824
824.5-1075

653-778.5
779-824
824.5-1075

653-778.5
779-824
824-1075

653-778.5
779-824
824-1075

800-824
824.1-1164

0.560-1.060

Temp
Range

Not Specified

-18- 95°C
-18-125°C
-18-150°C

-18- 90°C
-18-125°C
-18-150°C
-18- 90°C
-18-125°C
-18-150°C
-18- 90°C
-18-125°C
-18-150°C
-18- 90°C
-18-150°C

-25- 114°C
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Chemical tables

Correction Type Table Entry

ASTM D1555 °F
ASTM D1555 °F 1980

VCF @ 60°F

ASTM D1555M °C
ASTM D1555M °C
1980

Japan ASTM D1555
°C

VCF @ 15°C

Japan Chemical °C

278

Product

300°F/148.9°C Aromatic
350°F/176.7°C Aromatic

Benzene
Cumene
Cyclo-hexane
Ethyl-benzene
Mixed Xylene
0-Xylene
p-Xylene
Styrene

Toluene

300°F/148.9°C Aromatic
350°F/176.7°C Aromatic

Benzene
Cumene
Cyclo-hexane
Ethyl-benzene
Mixed Xylene
o-Xylene
p-Xylene
Styrene

Toluene

Chemical Applications

Chemical Applications

VCF Range

0.9741-1.0296
0.9756-1.0266
0.9597-1.0130
0.9670-1.0297
0.9597-1.0132
0.9660-1.0306
0.9671-1.0293
0.9683-1.0288
0.9496-1.0027
0.9675-1.0242
0.9647-1.0383
0.9729-1.0278
0.9745-1.0262
0.9583-1.0123
0.9660-1.0293
0.9585-1.0126
0.9646-1.0300
0.9661-1.0289
0.9673-1.0285
0.9492-1.0025
0.9664-1.0237
0.9634-1.0376

Thermal Expansion
Coefficient in Alpha

x 10°

Thermal Expansion
Coefficientin Alpha

x 10°

Temp Range
5-110°F
5-110°F
40-120°F
5-120°F
40-120°F
5-120°F
5-120°F
5-120°F
55-150°F
15-120°F
-5-120°F
-15-44°C
-15-44°C
4.5-49.5°C
-15-49.5°C
4.5-49.5°C
-15-49.5°C
-15-49.5°C
-15-49.5°C
12-65.5°C
-90.5-49.5°C
-20.5-49.5°C

Not Specified

Not Specified
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Liquid Hydrocarbon Gas Table

Type
API°F

API°F
1980

LPG°C
LPG°C
1980

Method

24E/23E

LPG

Asphalt Tables

Type
Asphalt

Method

ASTM D4311-04 °C

ASTM D4311-04 °F

ASTM-IP Table 7

ADMO03GVAE1005

Product

Light Hydrocarbon

Liquid Petroleum
Gases

Product

Asphalt

Asphalt

Asphalt

Table Entry

Density @ 60°F in
Specific Gravity

Density @ 15°C in
kg/m3

Table Entry

Density @ 15°C in
kg/m?3

Density @ 60°F in
API

Density @ 60°F in
API

Range

0.350-0.688

Not Specified

Range

850- Unspecified

0-34.9

0- 100

Temp Range
-50-200°F

-110.0- 60°C

Temp Range

-25- 275°C

0- 500°F

0- 500°F
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Polynomial

This technique is used for specialized products that do not fall within one of the
correction tables already identified. A table of density versus temperature data can
be converted to a polynomial using the least square method of curve fitting. Using
the least square method results in a set of polynomial coefficients. FuelsManager
accommodates a fourth order polynomial to obtain a VCF.

The VCF polynomial equation is as follows:

VCF = KO + K1 (Dtemp) + K2 (DTemp2) + K3 (DTemp3) + K4 (DTemp4)

Where:

VCF = Volume correction factor = % Std Density
StdTemp = Standard Temperature

DTemp = Current temperature - StdTemp

KO-K4 = Coefficients of polynomial
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Traditional tank calculations

Traditional tank sensors return the level and temperature of the tank. From these
two values plus the tank configuration, a series of calculations is performed by the

FuelsManager.

Strap Table Volume (TOV)

The strap volume is obtained from the tank strapping table for the measured tank
level. FuelsManager calculates the volume for a given level based on the tank

shape as shown below.

Cylindrical tanks
LevelRatio = (Level - LowLevel)/(HighLevel - LowLevel)

TOV = (LowVolume + ((HighVolume - LowVolume) x LevelRatio))
Where:

Level = Current Tank Liquid Level

LowLevel = Strapping point level in table immediately below Level
HighLevel = Strapping point level in table immediately above Level
LowVolume = Strapping point volume in table for LowLevel point
HighVolume = Strapping point Volume in table for HighLevel point
Horizontal tanks

LevelRatiol = [((Level-HighLevel) x (Level-HighestLevel))/
((LowLevel-HighLevel) x (LowLevel-HighestLevel))]

CalcVolumel = (LowVolume x LevelRatiol)

LevelRatio2 = [((Level-LowLevel) x (Level-HighestLevel))/
((HighLevel-LowLevel) x (HighLevel-HighestLevel))]

CalcVolume2 = (HighVolume x LevelRatio2)

LevelRatio3 = [((Level-LowLevel) x (Level-HighLevel))/
((HighestLevel-LowLevel) x (HighestLevel-HighLevel))]
CalcVolume3 = (HighestVolume x LevelRatio3)

TOV = (CalcVolumel + CalcVolume2 + CalcVolume3)

Where:
Level = Current Tank Liquid Level
LowLevel = Strapping point level in table immediately below Level

HighLevel = Strapping point level in table immediately above Level
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HighestLevel = Strapping point level in table immediately above HighLevel
LowVolume = Strapping point volume in table for LowLevel point
HighVolume = Strapping point Volume in table for HighLevel point
HighestVolume = Strapping point Volume in table for HighestLevel point

Spherical tanks

Topl = LowestVolume x (Level-LowLevel) x (Level-HighLevel) x (Level-
HighestLevel)

Top2 = LowVolume x (Level-LowestLevel) x (Level-HighLevel) x (Level-
HighestLevel)

Top3 = HighVolume x (Level-LowestLevel) x (Level-LowLevel) x (Level-
HighestLevel)

Top4 = HighestVolume x (Level-LowestLevel) x (Level-LowLevel) x (Level-
HighLevel)

Bottom1 = (LowestLevel-LowLevel) x (LowestLevel-HighLevel) x
(LowestLevel-HighestLevel)

Bottom?2 = (LowLevel-LowestLevel) x (LowLevel-HighLevel) x (LowLevel-
HighestLevel)

Bottom3 = (HighLevel-LowestLevel) x (HighLevel-LowLevel) x (HighLevel-
HighestLevel)

Bottom4 = (HighestLevel-LowestLevel) x (HighestLevel-LowLevel) x
(HighestLevel-HighLevel)

TOV = (Topl/Bottom1 + Top2/Bottom2 + Top3/Bottom3 + Top4/Bottom4)
Where:

Level = Current Tank Liquid Level

LowLevel = Strapping point level in table immediately below Level
HighLevel = Strapping point level in table immediately above Level
HighestLevel = Strapping point level in table immediately above HighLevel
LowestLevel = Strapping point level in table immediately below LowLevel
LowVolume = Strapping point volume in table for LowLevel point
HighVolume = Strapping point Volume in table for HighLevel point
HighestVolume = Strapping point Volume in table for HighestLevel point

LowestVolume = Strapping point Volume in table for LowestLevel point
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Polynomial spherical tank
TOV =P-(Lx'+L0")3+Qn-(Lx'+L0"?+Rn-(Lx'+L0")+Sn+VR'

Where:

Ln-1=Lxw < Ln and nis an integer between 1 =n<9
Lwx' =Lwx/1000

VR' = VR/1000

Lx = measured liquid level (mm)

LO = correction volume (mm)

Ln = levels at the registered pointers (mm)
P = constant (£X. XXXXXXXXX)

Qn = constant (EXXX. XXXXXXX)

Rn = constant (£XXXX. XXXXXX)

Sn = constant (EXXXXXXX. XXX)

VR : correction volume (L)
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Note! Use the import option to
save time by importing previously
defined product or water tables.

284

Product and Water Strapping Tables

It is typical for inventory management customers to have two separate strapping
tables, one for product and one for water bottom. These tables can be either
related to one another or totally independent. This application note details the
calculation methods used by Endress+Hauser Systems & Gauging’s
FuelsManager Inventory Management system when configured to use separate
water and product tables.

In order to configure Inventory Management to use separate water and product
tables, simply use the Strap/Water table tab of the Edit Tank Data dialog to either
manually enter a water table or import a previously defined water table.

Edit Tank Data -» WSIZEMORE Mtankfarm.tank. tank4

General] \-"olumel Process Data] Alarms] Vesszel 1 ] Wessel 2] Wit Strap /W ater Table
water | ft-in-16th | gal (US) |
i 00
5 BEELELED] 1500 " Strap (o wiater (" Hydro Def.
Density IBD.DD AP
Temperature IED-DD F
Strap Table Type
(s o
Strap / \water T able Mode
(+  Cambined " Separated
MHumber Of Table Entries: 2
Add : Expont | Import |
ak | Cancel

When using product and water tables, Configuration can be used to set the water
and strapping table method for either integrated Product and Water tables or
Separated Product and Water tables. Under Strap/Water Table Mode, select either
Combined or Separated.

Integrated Product and Water Tables (Combined)
The key concept in the integrated product and water table mode of operation is

that the top point of the water table is assumed to coincide with the bottom point of
the product table.
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In the integrated

product and water

table mode, The

product table begins
B —— were the water table
ends

A
Product Table
\
Water ::— Water Table
Example 1
Water level lower than the top point in the water table:
Example 1 shows how
the product and water
volumes are calculated
when the water level is
20ft less than the water
table
Product Table
5ft
— 1t 0ft Product /
__ g 2ftWater 4
Water Table
o v
Product Table Water Table
Product Level Product Vol Water Level Water Vol
0 0 0 0
1ft 1000 gal 1ft 1000 gal
2ft 2000 gal 2ft 2000 gal
51t 5000 gal
20 ft 20,000 gal

* Measured product level = +5ft
* Measured water level = +1ft
From the product table, the product volume = 5000 gal
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Example 2 shows how
the product and water
volumes are calculated
when the water level is
higher than the top
point in the water table

286

Inventory Management recognizes that the measured product level is below that
of the bottom point in the product table, so it uses the top of the water table to
extend the range:

e From the water table +1ft [+2ft (top) minus +1ft (measured water level)] =
1000 gal
 Total product volume for +5ft of product and +1ft of water = 6000 gal
From the water table +1ft of water = 1000 gal

Example 2
Water level higher than the top point in the water table:

——= 20ft

Product Table

5ft
— 1ft

0ft Product / I
2ft Water

— 1ft I
Water Water lTabIe
oft Y
Product Table Water Table
Product Level Product Vol Water Level Water Vol
0 0 0 0
1ft 1000 gal 1ft 1000 gal
2ft 2000 gal 2ft 2000 gal
5 ft 5000 gal
20 ft 20,000 gal

* Measured product level = +5ft

* Measured water level = +3ft
From the product table the product volume = 5000 gal
Inventory Management recognizes that the measured water level is above that of
the top point in the water table, so it uses the bottom of the product table to extend
the range:

* From the water table +2ft of water = 2000 gal

* From the product table +1ft of water = 1000 gal

« Total water volume for + 3ft of water = 3000 gal
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Subtracting the 1ft of water volume from the product volume (5000 — 1000 gal)
equals: Product volume = 4000 gal

Example 3
Water level equals the top point in the water table:

——— 20ft

Product Table
5ft

— ™ oft Product /
1t 2ft Water
Water Table

v

This example shows how the product and water volumes are calculated when the
water level is equal to the top point in the water table.

Water

Oft

Product Table Water Table
Product Level Product Vol Water Level Water Vol
0 0 0 0
1ft 1000 gal 1ft 1000 gal
2 ft 2000 gal 2 ft 2000 gal
51t 5000 gal
20 ft 20,000 gal

Separate Product and Water Tables (Separated)
When configured to use the separate product and water table mode, Inventory
Management assumes no correlation between the water and product tables.

Since this mode of operation provides no correlation between the product and
water tables, it is assumed that the tables start at the same point and overlap in
the lower part of the tank.
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Example 3 shows how
the product and water

volumes are calculated
when the water level is
equal to the top pointin
the water table
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Separated strapping
and water tables
example

Product Table

r

Water Table
oft vy

« Water volume = Measured water level lookup in water table
e Product volume = Measured product level lookup in product table

Floating
Roof Adjustment (FRA)

Tanks with floating roofs require a correction to offset the effect of the
displacement of the floating roof.

Default
This correction is calculated in the following manner.

If no floating roof or level is <= Roof Landed Height:
FRA=0

No Correction Required.

If floating roof is not included in the strap table:

FRA = Roof Mass/ProductDensity

If floating roof is included in the strap table:

FRA = (RoofMass/StrapDensity) — (RoofMass/ProductDensity)

Japanese correction methods
If the user selects any of the correction methods designated 'Japan’ the floating
roof correction is calculated in the following manner:

If the 4th digit after decimal point of density is Zero such as p15 = X.XXX0
FRA = FRW / p15
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Where:

FRW: Floating Roof Weight

If the 4th digit after decimal point of density is other than ZERO

such as p15 # X.XXX0 (4th digit after decimal is 1~9).

If p15=X.XXNX then, the density will divided by Low and High.

Low density is p15L =X.XXNO and High density is p15H = X.XXNO + 0.001
FRAL = FRW / p15L (Rounding 4th digit after decimal point)

FRAH = FRW / p15H (Rounding 4th digit after decimal point)

Note! In the Critical Zone,
Between Roof Landed Height and

- Roof Floating Height,
FRA =FRAL - (FRAL —FRAH )M FuelsManager applies the full
p15H - p15L amount of the FRA.

Bottom Sediment Water (BS&W)

Product samples are periodically taken to determine its quality and purity.
Analyzing these samples results in a purity measurement referred to as
percentage bottom sediment and water (%BS&W). The operator usually manually
enters this value. The %BS&W value differs from the Water volume and Solids
volume values in that, the %BS&W impurities are suspended in the product, the
water and solids volumes have settled and rest at the bottom of the tank.

Volume of Sediment and Water (VSW)

This is the volume associated with the percentage of impurities suspended in the
product (%BSW) and is calculated as follows:

VSW = (TOV - FW) x (%BSW/100.0)
Where:

VSW = Volume of Sediment and Water

TOV = Total Observed Volume

%BSW = Percentage of Bottom, Sediment and Water
Free water

This is the amount of water in the bottom of the tank and Tank Bottom Solids (if
any). This is calculated as follows:

FW = H20VOL + SOLVOL
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Where:

FW = Combined Water and Solids volume
H20VOL = Water Volume

SOLVOL = Solids Volume

Correction volume

This is the un-measurable volume associated with line segments and manifolds
connected to the tank. The operator usually manually enters this value.

Volume Correction Factor (VCF)

This is the correction factor calculated via one of the methods defined in the
table(s) above. The value is used to correct the gross volume for the effects of
temperature.

Tank Shell Correction (CTSh)

Volume correction for the temperature of the shell. Compensates for the effect of
ambient and liquid temperature effects on the shell of the tank.

CTSh is calculated as follows:

CTSh =1 + ExpCoef x ATs + AreaCoef x (ATs x ATS)

Where:
ATs = Ts-Ref Temp (60°F)
ExpCoef =

MILD STEEL = 12.4 x 106

STAINLESS STEEL = 9.6 x 10

ALUMINUM = 13.0 x 106
AreaCoef = 4.0 x 10°°

For Non-Insulated Tanks:

Ts = [(7xTl) + Ta] / 8

Where:
Tl = Tank Liquid Temperature

Ta = Ambient Temperature
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For insulated tanks:

Ta = Tl = Liquid temperature

Setting the Tank Material to "Other" allows the user to manually enter the ExpCoef
and the AreaCoef.

Gross Observed Volume (GOV)

The strap volume value needs to be corrected in order to arrive at the Gross
Observed volume data. The exact calculation used is dependent on the how the
tank point was configured. The following correction methods are available:

Default
The following formula is used to calculate Gross Volume:

GOV = [(TOV-FW) x CTSh] +/- FRA + CORRVOL
Where:

TOV =  Strap Volume at the current tank level

FwW =  Free water + Tank Bottom Solids (if any)

CTSh =  Tank Shell Correction

FRA =  Floating Roof Adjustment

CORRVOL = Un-measurable volume associated with tank pipe work
Pre 1980

If a volume correction method with the 1980 designation is selected. The following
formula is used to calculate Gross Volume:

GOV = TOV +/- FRA + CORRVOL

Where:

TOV = Strap Volume at the current tank level

FRA = Floating Roof Adjustment

CORRVOL = Un-measurable volume associated with tank pipe work

Japanese correction methods
If a volume correction method with the 'Japan’ designation is selected. The

following additional options are available:

GOV = (TOV-FW) +/- FRA - (1.0 — %BSW/100.0) + CORRVOL
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Where:

TOV =  Strap Volume at the current tank level

FW =  Free water + Tank Bottom Solids (if any)

FRA = Floating Roof Adjustment

%BSW =  Percentage of bottoms, sediment and water impurities.
CORRVOL = Un-measurable volume associated with tank pipe work

The value of FW in the gross volume

Water not subtracted S
calculation is always zero

Water Subtracted from The FW value is subtracted from the TOV as
Gross Volume defined above

The FW is zero in the gross volume calculation,
it is subtracted from the Net Volume (see
below)

Water Subtracted from
Net Volume

The value of %BSW in the gross volume

VSW not subtracted S
calculation is always zero

VSW Subtracted from The %BSW value is subtracted from the TOV
Gross Volume as defined above

The %BSW is zero in the gross volume
calculation, it is subtracted from the Net Volume
(see below)

VSW Subtracted from Net
Volume

Roof Type = Kaiji-Kentei-  The FRA value is zero, it is applied to the Net
Kyoukai Volume calculation (see below)

Roof Type = Shin-Nihon-  The FRA value is zero, it is applied to the Net
Kentei-Kyoukai 1, 2 or 3 Volume calculation (see below)

Net Standard Volume (NSV)

Default
Net volume (net standard volume) is defined as Gross observed volume corrected

for %BS&W and temperature. The following equation is used to calculate net
volume:

NSV = [(GOV x (1.0-%BS&W/100.0)) x VCF]

Where:
NSV = Net Standard Volume
FRA =  Floating Roof Adjustment
%BSW =  Percentage of bottoms, sediment and water impurities

Administrator Manual



Traditional tank calculations

NSV
VCF
Pre 1980

Net Standard Volume

Volume Correction Factor

If a volume correction method with the 1980 designation is selected. The following
formula is used to calculate Gross Volume:

NSV = [(GOV - FW) x (1.0-%BS&W/100.0)) x VCF]
Where:

NSV = Net Standard Volume

FwW = Free water + Tank Bottom Solids (if any)

FRA = Floating Roof Adjustment

%BSW = Percentage of bottoms, sediment and water impurities
VCF = Volume Correction Factor

Japanese correction methods
If a volume correction method with the 'Japan’ designation is selected. The
following additional options are available:

Water not subtracted

Water Subtracted from
Net Volume

Water Subtracted from
Gross Volume

VSW not subtracted
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NSV = [(GOV - FW) x (1.0-%BS&W/100.0)) x VCF]

Where:

NSV = Net Standard Volume

GOV =  Gross Observed Volume

FwW =  Free water + Tank Bottom Solids (if any)

%BSW =  Percentage of bottoms, sediment and water impurities
VCF =  Volume Correction Factor

The value of FW in the net volume calculation is
always zero

The FW value is subtracted from the TOV as
defined above

The FW is zero in the net volume calculation, it
is subtracted from the Gross Volume (see
above)

The value of %BSW in the net volume
calculation is always zero
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The value of FW in the net volume calculation is

Water not subtracted
always zero

VSW Subtracted from The %BSW value is subtracted from the TOV as
Net Volume defined above

The %BSW is zero in the Net volume
calculation, it is subtracted from the Gross
Volume (see above).

VSW Subtracted from
Gross Volume

In addition, if a correction method with the 'Japan’ designation was selected, the
following Net volume calculation will be applied.

Kaiji-Kentei-Kyoukai
Floating Roof Tank Net volume of “Kaiji-Kentei-Kyoukai” (Japanese authorization
organization) uses the following equation.

NSV=(TOV-FW) x CTSh x VCF x (1.0 — BS&W/100.0)- FRA
Where:

NSV = Net Standard Volume

TOV =  Strap Volume at the current tank level

FW =  Free Water

CTSh =  Tank Shell Correction.

VCF =  Volume Correction Factor

%BSW =  Percentage of bottoms, sediment and water impurities
FRA =  Floating Roof Adjustment

Shin-Nihon-Kentei-Kyoukai 1
Floating Roof Tank Net volume of Shin-Nihon-Kentei-Kyoukai 1 (Japanese
authorization organization) uses the following equation.

S I 1 1 . ]f BS&W
NSV =4(TOV-FW xCTSh—| ———— XFRA px VCFx|1=5"
[( ) (\"('Fxp15 BSCJ ( AUU]

Where:

NSV = Net Standard Volume

TOV =  Strap Volume at the current tank level
FW =  Free Water

CTSh =  Tank Shell Correction

pl5 = Product Density

BSG = Strap Density
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NSV = Net Standard Volume

VCF = Volume Correction Factor

%BS =  Percentage of bottoms, sediment and water impurities
W

FRA =  Floating Roof Adjustment

Shin-Nihon-Kentei-Kyoukai 2
Floating Roof Tank Net volume of “Shin-Nihon-Kentei-Kyoukai 2" (Japanese
authorization organization) uses the following equation.

NSV =(TOV = FW)x CTShx VCFx (1.0 = BS & W, 100 '{pT15 = ﬁwx FRA

Where:

NSV = Net Standard Volume

TOV =  Strap Volume at the current tank level

FwW = Free Water

CTSh =  Tank Shell Correction

pl5 =  Product Density

BSG =  Strap Density

VCF =  Volume Correction Factor

%BSW =  Percentage of bottoms, sediment and water impurities
FRA =  Floating Roof Adjustment

Shin-Nihon-Kentei-Kyoukai 3
Floating Roof Tank Net volume of “Shin-Nihon-Kentei-Kyoukai3” (Japanese
authorization organization) uses the following equation.

It does not apply the roof correction to the net volume calculation.

NSV = (TOV - FW) x CTSh x VCF x (1.0 - BS&W/100)
Where:

NSV = Net Standard Volume

TOV =  Strap Volume at the current tank level

FwW = Free Water

CTSh = Tank Shell Correction

VCF = Volume Correction Factor

%BSW = Percentage of bottoms, sediment and water impurities
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MASS

Default
Mass is defined as net standard volume corrected for density at the observed
temperature. The following equation is used to calculate Mass:

Mass = NSV x Standard Density

In tables where density is expressed in API, Density is calculated as:

Density (KG/M3) = 141.5 x 999.012/(API Gravity + 131.5)

Japanese correction methods
If a volume correction method with the 'Japan’ designation is selected. The

following additional options are available:
Weight in air
NW =NSV x (p15 - 0.0011)

Where:

NW = Net Weight

NSV = Net Standard Volume

pl5 =  15°C liquid density

0.0011 = atmosphere conversion coefficient

Weight in a pressurized tank
NW = NSV x p15 + GW

The GW is the Gas weight derived by following equation.

GW =(Vmax-VG)x GDX(1+ P%\

Where:

NW = Net Weight

NSV = Net Standard Volume

pl5 = 15°C liquid density

GW = Gas weight

GD = Gas density

P = Gas Pressure
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NW

Net Weight
GT = Gas Temperature

The Molar method
NW = NSV (p15 - 0.0011) + GW

The GW is the Gas Weight derived by following equation.

_ 273 L033+P M 1 1
CW = (Vmax-GOV) 572767 * 1oz <224 * p15 * 1000

x (p15-0.0011)

Where:

NW = Net Weight

NSV = Net Standard Volume
GW = Gas weight

GOV = Gross Observed Volume
Vmax = Total Tank Capacity

pl5 = 15°C liquid density

P = Gas Pressure

GT = Gas Temperature

M = Mole constant

Food oil method

NW=GOV x p15
Where:
NW =  Net Weight
GOV = Gross Observed Volume

pl5 15°C liquid density

Chinese Correction Method

If the GB/T Volume Correction Method is selected, the following additional mass
calculation options are available.

Sinopec Method: NW= (NSV x (p20-1.1)-G) x (1 -W)
PetroChina Method: NW = NSV x (1 -W) x (p20 - 0.0011)

ADMO03GVAE1005 297



FuelsManager Defense

Where

NSV = Net Standard Volume (Sinopec method NSV in liters,
PetroChina method NSV in M%)

W =  Water percentage (% BSW)

G =  Floating root mass (kg)

p20 = Density of product @ 20°C (Kg/m?)

NW is returned in kg for Sinopec method

NW is returned in metric tones for PetroChina method

Available volume/available mass

Available Volume is defined as the amount of net or gross volume available for
pumping out of a tank. It is calculated as “0” if one or more of the following
conditions are true:

Level <= Low level Alarm, Low-Low level Alarm, or User Defined
Level <= Water Volume

Level <= Minimum level as defined in the strap table

If these conditions are not met, the available volume calculation is defined as
using the following equations:

Net Available Volume:

NAV = Current Net Volume of Tank — [(((SVC-FW) x CTSh x ((100.0-
%BS&W)/100.0)) +/- FRA) x VCF]

Available Mass:

AM = NAV x Standard Density

Gross Available Volume:

GAV = Current Gross Volume of Tank — [((SVC-FW) x CTSh) +/- FRA]

Where:

SvC = Strap Volume at the Minimum Working level
FwW = Free water + Tank Bottom Solids (if any)
CTSh = Tank Shell Correction

FRA = Floating Roof Adjustment
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SvC

Strap Volume at the Minimum Working level
VCF = volume correction Factor

Remaining volume/remaining mass

Remaining volume is defined as the amount of net or gross volume that can be
pumped into a tank. It is calculated as “0” if none or more of the following
conditions are true:

Level >= High level Alarm, High-High level Alarm, or User Defined

Level >= Maximum level as defined in the strap table

If these conditions are not met, the remaining volume calculation is defined using
the following equations:

Net Remaining Volume:

NRV = [((SVC-FW) x CTSh x ((100.0-%BS&W)/100.0) +/- FRA) x VCF] —
Current Net Volume in Tank

Remaining Mass:

RM = NRV x Standard Density

Gross Remaining Volume:

GNV = [((SVC-FW) x CTSh) +/- FRA] — Current Gross Volume in Tank

Where:

SVvC = Strap Volume at the Maximum Working level
FwW = Free water + Tank Bottom Solids (if any)
CTSh = Tank Shell Correction

FRA = Floating Roof Adjustment

VCF =  volume correction Factor
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LPG quantity calculation from liquid density
Calculation of LPG quantity from liquid density at 15°C (LPG °C & LPG °C 1980)

Overall calculation scheme

1. Measure level, average liquid temperature, average vapor temperature,
average pressure in vapor space.

2. Input liquid density at 15°C.

Calculate VCF and hence liquid density at tank conditions.

Correct measured level for thermal effects and buoyancy. This depends upon
the nature of the gauge.

Convert corrected level to liquid volume.

Correct liquid volume for tank thermal expansion and pressure effects
Convert liquid volume to equivalent volume at 15°C.

Calculate liquid mass from liquid volume at 15°C and liquid density at 15°C.
Correct total tank volume, for thermal and pressure effects.

10. Calculate vapor volume at measured temperature from corrected total volume
and liquid corrected volume at tank conditions.

11. From liquid density, vapor temperature and vapor space pressure calculate
vapor density.

12. Calculate vapor mass from vapor volume and vapor density at measured
conditions.

13. Calculate total mass as liquid mass plus vapor mass.
14. Calculate weight from total mass and liquid density.
15. Display the required results

P w

© N O

Details for each step

Step 1

ThepLiquid temperature and vapor temperatures should both be weighted
averages to reflect the volume in each vertical section. In the liquid phase there
should be little temperature gradient and a single measurement should be
adequate. In the vapor phase a gradient may be more apparent and the average
of the vapor temperature at the surface and at the top of the tank should be used.

Measured values:

H gauge reading of liquid level in mm
TL average liquid temperature °C

TV average vapor temperature °C

P vapor space pressure in bar g.
Step 2

Density is to be input by the operator. This should be the liquid density at 15°C,
and should be in units of kg/m?3.

Input value
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DENL15 - liquid density at 15°C (kg/m®)

gf’;\?crijlgtion of VCF and hence liquid density at tank conditions may be calculated

as follows:

X = (DENL15 - 500)/25

Yl = 0.296-0.2395 x X + 0.2449167 x X2-0.105 x X3 +0.01658334 x X*

Y2 = 363.8 + 4.924927 x X +13.66258 x X?-6.375x X3+ 1.087503 x X*

TR = 288.2 /Y2

TT = (1-TR)A(1/3)

VO = 1-152816 x TT +1.43907 x TT2-0.81446 x TT3+0.190454 x TT*

VD = (-0.296123 + 0.386914 x TR - 0.427258 x TR? - 0.0480645 x TR3)/ (TR - 1.00001)
Vi = VO x(1-Y1 x VD)

TR = (TL +273.2)/ Y2

T = (1-TR)A(1/3)

VO = 1-152816 x TT +1.43907 x TT2-0.81446 x TTS+0.190454 x TT*

VD = (-0.296123 + 0.386914 x TR - 0.427258 x TR?-0.0480645 x TR®) /(TR - 1.00001)
V2 = VO x (1-Y1 x VD)

VCF =  V1/ V2

VCF should be rounded to 5 decimal places.
The density of liquid at liquid temperature is given by:
DENL = DEN15 x VCF

Step 4
The following formulae are used for making corrections to liquid level gauges:

(a) Float buoyancy correction. This is necessary to correct for changes in liquid
density between calibration and use. The correction is achieved as:

Ah; = 1273 x 106 x _nl(l _ 1)

?\P Py
Where:
Ah, = correction to the gauge readout
for float buoyancy in mm
m mass of float in grams
d diameter of float in mm
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Note! When a float gauge is used
H is the value after the buoyancy
correction has been carried out.

302

p1 density of liquid at the time of
calibration

p density of liquid at the time of
gauging

This correction is only applied to float gauges. It does not apply to non-contact
measurement devices.

Corrected height = measured height + Ah

(b)Thermal correction. This is necessary to account for the thermal expansion of
the tank or stilling well and the gauge wire. For a float gauge this will be carried out
in addition to the buoyancy correction.

The correction is:

Ah, = aW(15 - TV)(HT = H) - 0, (15 = TV)(HT = H) - o, (15 - TL)H

Where:

Ah, correction to gauge readout for thermal expansion

o, = coefficient of thermal expansion of gauge wire /°C

oy = coefficient of thermal expansion of gauge mounting
(tank or well) /°C

TV = average vapor temperature°C

TL = average liquid texnperature°C

HT = total height of mounting (tank or well) in mm

H = depth of liquid in mm

The use ot as the coetficient of thermal expansion of the tank or stilling well
depends upon the mounting of the gauge. When the gauge is mounted on the
tank, or on the well but this is not rigidly fixed to the tank base, the coefficient of
the tank is used. The well coefficient is only used when the gauge is mounted on
the well and this is rigidly fixed to the tank bottom. In this case movement of the
gauge, relative to the bottom of the tank, is governed by stilling well expansion and
contraction.

Typical values of thermal expansion coefficients are:
Aluminium 0.000023 /°C
Mild steel 0.000011 /°C
Stainless steel  0.000017 /°C

The corrected level (HC) is given by: HC = H+ AH; + AH,
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Step 5

TheF(J:onversion of corrected liquid level to liquid volume is carried out using stored
values of key level/volume data points for the tank, with Lagrange cubic
interpolation between. The calculation for liquid value (VL) is defined in Spherical
Tanks in the Strap Table Volume section, earlier in this chapter. For the LPG
calculation method the corrected level value HC is used in the conversion of level
to liquid volume.

Step 6
Liquid volume needs to be corrected for the thermal expansion of the tank shell.
The nature of the correction depends upon the type of tank.

Thermal correction C = F aT(TL - 15)
Where oT = coefficient of thermal expansion of tank /°C

For a vertical cylinder:
F=2
for a horizontal cylinder:
F=1+2(A-sin A)/(A-sin Acos A)
where HC = liquid depth (corrected)

R = cylinder radius

= ot _H_C)
A= cos (1 R

for a sphere:

F = HC2 R/(HC?r - HC3/3)
where H = liquid depth

R = cylinder radius

A pressure correction should be applied. This will take into account the vapor
space pressure and the hydrostatic head of liquid. The average pressure
throughout the sphere is assumed to be one half the total liquid level, converted to
a pressure, plus the vapor space pressure. The linear stress, is then calculated
and this used, with Youngs modulus, to calculate the increase in radius. The F
factor necessary for temperature correction is again used to convert change in
radius to change in liquid volume.

The units of Youngs modulus are generally known in bar. The units of length used
in the calculation of stress do not matter, but the pressure must be in bar, to match
the units of Youngs modulus. The following equations are based upon the use of
bar for Youngs modulus. Note the P is in bar g and HC is in mm. Calculate
average pressure as:

PAV = P + DENL x HC/2.04 x 107
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where PAV = Average vapor pressure (Bar)
P = Pressure in vapor space
DENL = Liquid density (kg/m?®)
H = Liquid Level (mm)

calculate external radius as:

ROUT =R + THICK
where ROUT = External radius
R = radius

THICK = Shell thickness

calculate stress as

s - PAV 2xR°xROUT’
2 ROUT®-R®
calculate increase in linear dimension factor as:

CORRP =1 + F x SIYOUNG

The value of S calculated is also used in correcting the total volume of the tank in
step 9.

Typical values for Youngs modulus are:

Carbon steel 2.1 x 10° bar

Stainless steel 1.9 x 10° bar

Corrected liquid volume

VLC = VL x CORRT x CORRP

Step 7
The corrected volume at liquid temperature is converted to a volume at 15°C using
the volume correction factor (VCF) calculated in Step 3 as:

VLC15 =VLC x VCF
Where VLC15 = Volume @ 15°C
VLC = Volume at liquid temperature

VCF = Volume Correction Factor
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Step 8
Liquid mass is calculated from liquid density at 15°C and corrected liquid volume
at 15°C. The units here are tonnes.

ML = VLC15 x DENL15 / 1000
Where ML = Liquid Mass

Step 9

Total tank volume is corrected for temperature and pressure using the overall
mean tank temperature. This is best calculated for the liquid volume, liquid
temperature and total volume and vapor temperature as:

TAV = (TL X VLC + (VT - VLC) x TV)/ VTC
TAV = Average overall tank temperature

TL = Temperature of liquid

TV = Temperature of vapor

VTC = Total tank volume

The correction is then carried out as:
CORRT2=1+3 x aT x (TAV - 15)

Where oT = Coefficient of thermal expansion of the tank /°C

The correction for pressure is applied as in step 6 except that 3 replaces F in the
calculation of the correction factor. S is the previously calculated value.

ie. CORRP2=1+3 x S/YOUNG
VTC = VT x CORRT2 x CORRP2

Where VTC = Volume of tank corrected for temperature and pressure

Step 10
Vapor volume is calculated from corrected liquid volume at tank conditions (Step

5) and total tank volume corrected to measured conditions (Step 9) as:
W=VTC-VLC
Where VV = Vapor volume

VTC = Total tank volume

VLC = Corrected liquid volume

Step 11
Vapor density may be calculated from liquid density, vapor temperature and vapor

space pressure as follows:
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calculate molecular weight from liquid density at 15°C as:

X = (DENL15 =500) / 33.3333

MW =43 + 4.4 x X + 1.35 x X? - 0.15 x X3
calculate critical temperature from liquid density at 15°C as:

TC=364+1333x X +85xX?-1.833xX3
calculate critical pressure from liquid density at 15°C as:

PC =43 =2.283 x X + 0.05 x X? - 0.0667 x X3

calculate reduced temperature from vapor temperature and critical temperature
as:

TR =(TV +273.2)/ TC

Where TR = Temperature of vapor

calculate reduced pressure from vapor space pressure and critical pressure as:
PR = (P + 1.013)/PC

Where P = pressure in vapor space
calculate W as:

W =0.214 - 0.034333 x X + 0.005 x X? - 0.0001667 x X3
calculate z by locating the smallest root of:

Z-Z+Zx(A-B-B9)-AxB

where:
A= [0.42747 x L2 x _TTF;J/TR

B =0.08564 x PR/TR

L=1+(0.48 + 1.574 x W - 0.176 x W?) x (1-SQR(TR))
This may be solved by Newton Raphson as follows:

Z=15
20 F=73-Z2 + Z x (A-B-B)-A x B

IF ABS(F) < 0.0001 THEN 70

F1=3xZ7% - 2xZ+ A-B-B?

Z=Z-FIF1

GOTO 20
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check range of Z
70 IFZ<020RZ>2THENZ=1
RETURN

This routine always appears to converge and to give Z in the range 0.2 to 1, which
is correct for typical LPG storage conditions.

Vapor density is calculated from molecular weight, vapor temperature, vapor
space pressure and Z factor as:

MW x (P + 1.013)
0.08314 x (TV + 2732) x Z

DENV =

The units of DENV are kg/m?.

Step 12
Vapor mass is calculated as the product of vapor volume and vapor density both

at tank conditions as:
MV =VV x DENV/1000

Note that MV is in tonnes to match the units of liquid mass

Step 13
Total mass is the sum of liquid mass and vapor mass:

MT = MV + ML
Where MT = Total mass
MV = Vapor mass

ML = Liquid mass

Step 14
Total weight is calculated from total mass and liquid density as:

WT = MT x (1-1.2/DENL15)/0.99985
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Sample LPG calculation
Stored Data

Calibration (7 points only) m®

mm
H(1) = 0 V(1)
H(2) = 2000 V(2)
H(3) = 2500 V(3)
H(4) = 3000 V(4)
H(5) = 3500 V(5)
H(6) = 4000 V(6)
H(7) = 6000 V(7)

Total tank volume VT = 114.211 m3

Coefficients of thermal expansion (mild steel):

Gauge wire oW = 0.000017
Gauge meeting oM =0.000017
Tank Shell oT =0.000017

Youngs modulus:

YOUNG 2.06 x 108 bar

Float data:
Mass (m) 1033.5
Diameter (d) 288

Density of (DENL1) 999.1
Liquid of

Time of

Calibration

308

mm?3

0
29.213
= 42.217

= 56.311
= 70.627
= 84.122
= 114.211

/°C
/°C
/°C

mm

kg/m3
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Sample LPG calculation

Tank data:
Radius R = 3000 mm
Tank Height HT = 6000 mm
Shell Thick THICK =18 mm
Input Data
Level H = 5062 mm
Liquid Temp TL =185 °C
Vapor Temp TV =213 °C
Vapor Pressure P =91 barg
Check Data
Liquid Density DENL 15°C =505.0
Step3 VCF=0.98982 — Volume Correction Factor
DENL=499.76 — Liquid Density @ liquid temperature
Step4 AH.=15.86 — Gauge correction for float buoyancy
AH,=0.3 — Gauge correction for thermal expansion
HC=5078.16 — Corrected gauge reading (level)
Step5 Interpolation uses points 4,5,6,7
VL=106.731 — Liquid value
Step6 CORRT =1.000137 — Thermal correction
VLC =106.837 — Liquid volume
CORRP =1.000856 — Pressure correction
Step 7 VCF = 0.98962

VLC15 =105.728
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Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

310

ML =53.39264 (tonnes) —  Liquid mass
CORRT2=1.000188 — Thermal correction
CORRP2=1.00112 — Pressure correction
VTC =114.3603 — Volume of tank corrected for temperature
VWV =75232 — Vapor Volume

MW =43.6899 — Molecular weight

TC =366.1846 — Critical temperature

PC =42.6585 — Critical pressure

TR =0.80424 — Reduced temperature

PR =0.23707 — Reduced pressure

W = 0.20896

Z =0.81354

DENV =22.18134 — Vapor density

MV =0.16687 — Vapor mass

MT = 53.5596 tonnes —  Total mass

mass to weight conversion fraction = 0.99777

WT = 53.4404 tonnes Total weight
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Hydrostatic & Hybrid Tank Calculations

FuelsManager provides calculations of tank levels and volumes based on
measurements at pressure of precise positions on the tank. These calculation
techniques fall into two main groups.

Hydrostatic Measurement of pressure at one or more points in the tank and
the subsequent calculation of the product density and tank
level. This type of measurement technique can be used without
a level gauge

Hybrid This technique combines the measurement of product density,
via pressure measurement of one or more points in the tank,
and the direct measurement of product level with a level gauge

FuelsManager provides configuration parameters for up to three pressure
instruments as shown below. The following shows the use of three pressure
instruments; however, FuelsManager allows for configuration with 1, 2, or 3
transmitters.

Level (L)
[ ee—
Top ]
Pressure (Py) H:
Middle Hm

Pressure Pm)

Temperature (T) —

Bottom
Pressure Py)

In addition, FuelsManager allows for the configuration of the exact position of the
tank, including the latitude and elevation above sea level. These parameters allow
for corrections due to the effects of local gravity and air density as defined below.
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Note! Alternatively, the user can
enter the local manually

312

(D,)Air Density= 353 x eXp[—EIevatlon/8434.41}

Air Temp + 273.16

Where Elevation is in meters

Air Tempisin °C

Local Gravity =
9.80616 — (0.025928 x A) + (6.9 x 10> x A%) — (3.086 x 10™° x Elevation)

Where A = cos(2x Position in Radians)

For convenience, FuelsManager allows for the entry of the tank position in deg/
min/sec of latitude.

The following is used to convert the position in deg/min/sec to the position in
radians.

Radians= (stT(])—l) x (Deg * %} * (3?66%)

The position of the pressure transmitter is critical to the hydrostatic and hybrid tank
calculations since the positions can be affected by the thermal expansion or
contraction of the tank. FuelsManager uses the following to correct the installed

height of each transmitter for the effects of temperature.

Corrected Height = Height x [1 + ExpCoeff x (Temp - Installed Temp)}
Where Height = H;, H,, or H,

ExpCoeff = Thermal coefficient of expansion for the material from
which the tank shell is constructed

Temp = Current product temperature

Installed Temp = Temperature when the pressure instrument was
installed

Both the Hydrostatic and Hybrid methods calculate product density based on the
pressure difference between instruments of known heights, as follows.
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Hybrid Calculation

P, —P,)—(G,x(D,-D,)) x AH
(D) Density = (P =Py G(L >|< (|_(_va) a)) ‘D,
Where Py, = Bottom Pressure

Pt = Top Pressure
G| = Local Gravity
Dy = Vapor Density
Da = Air Density

L = Product level

Hy, = Corrected height of bottom pressure instrument

The calculation for the height AH depends on whether FuelsManager is
configured to use a top pressure instrument or not.

If the top pressure is used: AH =H; - Hy
If the top pressure is not used: AH=0
Hydrostatic Calculations

Pp=P) = (G, x (D,)=Dy) X AH _
GL(Hp—Hyp) Y

(D) Density = ¢

Where P, = Bottom Pressure
P+ = Top Pressure
G, = Local Gravity
Dy = Vapor Density
Da = Air Density
Hy, = Corrected height of bottom pressure instrument

Hp, = Corrected height of middle pressure instrument

The calculation for the height AH depends on whether FuelsManager is
configured to use a middle pressure instrument or not.

If the middle pressure is used: AH =Hq, - Hy
If the middle pressure is notused: AH=0

For hydrostatic calculations it is also necessary to calculate the level value from
the measured pressures:

ADMO03GVAE1005

313



FuelsManager Defense

P,-P,
(L,)Level = Hb+[Pb—P Jx(Hm—Hb)
m

Where Hyp, = corrected height of the bottom pressure instrument
Hp, = corrected height of the middle pressure instrument
Py, = Bottom Pressure
P; = Top Pressure

P, = Middle Pressure

In addition, FuelsManager provides for the configuration of a level offset to allow
the user to calibrate the hydrostatically measured level, this is called the Level
Offset. The find level is calculated as follow.

Level = L4 +L,

Where L = Level Offset
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Typical Tank Calculation
Analytical and Measured Data

Level (ft-in-16) 12-3-12
Water Level (ft-in-16) 0-9-5
Solids Level (ft-in-16) 0-1-3
%BS&W 0
Product Temperature (°F) 75.6
Product Density (Ibs /US Gal) 6.8
Density Temperature (°F) 70.8
Standard Density 5 (Ibs / US Gal) 6.84
Ambient Temperature (°F) 56.2

Tank Point Configuration Parameters

Volume Correction Method API °F: Table 6B/5B

Floating Roof Type Roof Mass Not in Strap

Roof Mass (Ibs) 589

Tank Shell Material Mild Steel (Coeff of Expansion =
1.24 x 10

Tank Insulated No

Maximum Fill Volume (US Gal) 850,000.00

Minimum Empty Volume (US Gal) 150,000.00

ADMO03GVAE1005 315



FuelsManager Defense

Total Observed Volume 1
Water Volume 2

Solids Volume 3

Shell

Floating Roof Adjustment

Gross Observed Volume 4

Correction for Product
Temperature °

Correction for %BS&W

Net Standard Volume ©

Available Product (Gross)

Available Product (Net)

Remaining Product (Gross)

Remaining Product (Net)

316

Calculated or Derived Data

Correction for Temperature of

Symbol Action

TOV
H20VOL subtract

SOLVOL subtract

CTSh multiply

FRA subtract
GOV
VCF multiply

BS&W multiply

NSV

Notes

Values
Reported
(rounded)

435,218.32
189.35
34.12

434,994.85

1.00016

435,066.22

86.61765

434,979.60

0.99230

1.00000

431,630.26

285,265.11
283,068.57

414,849.73
411,655.39

Units

US Gals
US Gals
US Gals

US Gals

US Gals

US Gals

US Gals

US Gals

Values used in
calculations
(unrounded)

434,994.8500000000

1.0001640643225

435066.2171353560

86.61764706

434,979.5994882970

431630.2565722380

1 Quantity derived from tank strapping table using level value to enter table.
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Typical Tank Calculation

2 Quantity derived from tank strapping table (or separate water table) using
water level value to enter table.

3 Quantity derived from tank strapping table using solids level value to
enter table.

4 Gross volume uncorrected for temperature effects and floating roof
adjustment

5 From API Tables 5/6B

6 Net volume corrected to 60 °F
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Flow calculations
The following sections detail how FuelsManager performs Flow calculations.

Flow

0= Gov, ., —-Gov,
Tn+| - Tu
Where:
Q = Flow rate
GOVn+1- = Gross Volume change in the sampling cycle
GOVn
Tn+1, Tn = Sample times
Level rate
_ Level,,, — Level,
Tn+| - Tn
Where:
Q = =Flow rate
Leveln+1- = Level change in the sampling cycle
Leveln
Tn+1, Tn = Sample times
Mass flow
Q= WN.... —WN,
Tn+1 - Tn
Where:
Q = Flow rate
WNn+1- =  Weight change in the sampling cycle
WNn
Tn+1, Tn = Sample times
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Flow calculations

Net flow
0= VN,.. = VN,
Tn+'| - Tn
Where:
Q = Flow rate
VNn+1-VNn = Net volume change in the sampling cycle
Tn+1, Tn = Sample times
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The Weights and Measures (W&M) function (formerly described in document
number MIS-100100-01) provides sealing functionality in the 8130 RTU and
FuelsManager products. The system also includes data flow between the various
FuelsManager and RTU modules.

This information is included to assist the W&M testing authority, and to ensure the
system’s data integrity.
This function meets the requirements of Nederlands Meetinsituut (NMi) and

Physikalisch-Technische Bundesanstalt (PTB) Weights & Measures (W&M)
Agencies. Features included in W&M include the following:

» Sealing of program EXE'’s / DLL's and report / displays files by W&M official
such that if the files are changed in any way the system will not display data in
a W&M approved fashion

« Adisplay that lets W&M officials quickly check the installed program elements
against the program elements that were approved

* Indicators on all displays when a W&M official has sealed a particular tank
variable

« W&M approved displays, to include (at least)

'W&M Approved’ Legend of all Engineering units

indication status signs

Tank Name Level Product Temperature
Water Volume Product Std Density

TOV GSV Mass

Volume Correction
Methods

Standard Temperature
for Correction Methods

« Application of calibration seals for individual variables per tank
» Application of calibration seals to tank points in the 8130 RTU

« Ensure that unauthorized modification of system data (both propriety and
open databases) is detected and then not displayed as W&M approved
These requirements have been provided for in FuelsManager and the 8130 RTU
by Module Seal and Tag Seal features described in the following sections. These
features are combined with Microsoft Windows XP/2000 Security to insure the

integrity of the data.
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System Overview

System Overview

NMS 8130 RTU

%1 Protocol
8213

8203-5 /.

Rackbus Protocal

FuelsManager

8130 Protocol

[l Fil ModuleSeals

See 'Sealng the
Foint in RTL¥
8130" section for
details

NMS Point

Wan Official
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At Dbt

See 'Seafihg
FuelsManager
Moduies' section
for details

TankPoint

See 'Sealng

T ankFPoint
variables via
FuelsManager’
section for details

Interface

Crystal Reporls

M3 Access Database

See 'Display of

WEM Jnciication See ' Digplay of

on Graphics# WA inciiation
Reports' section on Graphics/
for details Reports' section

for details

End User

End User
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Point Type

Enraf 811

Enraf 818 STIC
Enraf 854

Enraf 867 STIC

324

E+H FMR 131 Micropilot

Sealing the Point in 8130 RTU

The 8130 RTU is configured via a tool called ViewRTU. ViewRTU can

communicate with the RTU either local (running on a laptop device) or remotely

running via FuelsManager’s interface connection.

The ViewRTU configuration tool allows the W&M official to apply a ‘software seal’

to a particular point. Once this seal is applied all parameters that affect the
integrity of the point’s data cannot be changed, without removing the seal.

Parameters that effect the data integrity are specific to the point type, table 1.1
(below) details this relationship.

Table 1.1

WMSeal

No

Yes

No

Yes

No

Parameters Sealed

Module

Chan

Clu

Addr

ID

TOI

ScanCmd
LevelUnits
TempUnits
LevelDeadband
TempDeadband

Module

Chan

Clu

Addr

ID

TOlI

ScanCmd
LevelUnits
TempUnits
LevelDeadband
TempDeadband

Parameter Description

External Module Address Channel for
Communications

CIU Address

Tank Gauge ID

Type of Instrument

Scan Commands for Instrument

F=ft; M=Meters; m=millimeters
F=Fahrenheit;

C=CelsiusChange of State (COS) Level
Deadband.

Change of State (COS) Temp Deadband.

External Module Address

Channel for Communications

CIU Address

Tank Gauge ID

Type of Instrument

Scan Commands for Instrument

F=ft; M=Meters; m=millimeters
F=Fahrenheit; C=CelsiusK=kg/m3; A=API;
L=Ibs/ft>

Change of State (COS) Level Deadband.
Change of State (COS) Temp Deadband.
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Point Type
Enraf 873

GSI Model 2000
ITT Barton 3500
L&J MCG1000
L&J MCG1500
L&J MCG2000
NMS53

SAAB L/2 Radar

Tank Side Monitor

ADMO03GVAE1005

WMSeal

Yes

No
No
No
No
No

Yes

Yes

Yes

Parameters Sealed

Module

Chan

Clu

Addr

ID

TOlI

ScanCmd
LevelUnits
TempUnits
LevelDeadband
TempDeadband

Module

Chan

Clu

Addr

ID

TOI

ScanCmd
LevelUnits
TempUnits
LevelDeadband
TempDeadband

Module

Chan

ID

LevelUnits
LevelConvert
LevelDeadband

Module
Chan

ID
BaudRate
ComParams
Modelevel
Deadband
Temp
Deadband

Parameter Description

External Module

Address

Channel for Communications
CIU Address

Tank Gauge ID

Type of Instrument

Scan Commands for Instrument
F=ft; M=Meters; m=millimeters
F=Fahrenheit; C=Celsius

Change of State (COS) Level Deadband.
Change of State (COS) Temp Deadband.

External Module Address

Channel for Communications

Tank Gauge ID

Gauge / Scanning Mode

F=ft; M=Meters; m=millimeters
F=Fahrenheit; C=Celsius

G=g/ml; A=API; L=Ibs/ft3

Change of State (COS) Level Deadband
Change of State (COS) Temp Deadband

External Module Address

Channel for Communications

Tank Gauge ID

m=millimeters; s=sixteenths

Convert Level to standard

Change of State (COS) Level Deadband

External Module Address
Channel for Communications
Tank Gauge ID

Baud Rate Data bits & Parity
Operating Mode

Change of State (COS) Level Deadband.

Change of State (COS) Temp Deadband
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Point Type WMSeal Parameters Sealed Parameter Description

Sakura Level Tranmitter  No

TankPoint No
TI-111 No
TI-121 No
TI-150 No
Tokyo Keiso FM9000 No
Veeder Root TLS-350 No
Whessoe Bus 2046 No
Whessoe Bus ITG No
Whessoe Varec 6500 No

Whessoe Varec ATT4000 No

Whessoe Varec MFT No
4100
WV1900 No

326 Administrator Manual



Sealing the Point in 8130 RTU

Applying the Software Seal

Parameters that will be
effected by the

application of a
H EDIT POINT @ software seal are

Point Help - N shown in an alternate
color

Current Point # Point Desc: NM553.00 : NM553 Prozervo Tank Gauge
LCONFIG

Tag Point Tag NM553.00 ~

Wk Seal Weights & Measures Seal Dizable s

Module External Module Address 2h5

Chan Ch | for C: icati 1}

1D Tank Gauge ID 0x00

Mode Gauge / Scanning Mode Ox0000

Levelllnits F=Ft:M=Meters:m=millimeters m

T emplnits F=Fahrenheit.C=Celsius

DensitylInits G=g/mL_A=API:L=lbs/ft3 G

LevelDeadband CO5 Level Deadband 0.0 w
DYNAMIC/COMMAND

Command Gauge Command Undefined ~

Group Dynamic Matrix Group 3

VPos Vertical Matrix Position 1]

HPos Horizontal M atrix Position 1]

WriteData Write Data Undefined

ReplyData Command Reply Data Undefined

CmdStatus Status of Last Command Undefined

Level Tank Level 0.0

Position Displacer Position 181}

Temp Tank Temperature 181} w

Minimize | Next | Examine | Download |
Connections | Previous | Exit | Upload |

Step-by-step

¢ Double-click the WMSeal parameter in the CONFIG section of the Edit Point
dialog

« If prompted for a password, then the WMSeal value is currently Disabled.
Enter the W&M password

« If prompted with an Update Seal dialog asking for confirmation, then the
WMSeal value is currently Enabled. Click Yes to confirm

< After entering the W&M password or clearing the seal, a Modify Value dialog
is appears

¢ Change the value of the WMSeal parameter
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W&M Password
prompt

Update seal
confirmation

ViewRTU spreadsheet
mode

ViewRTU Edit Point
Data

328

WM Password Prompt

Update Seal

Are you sure you want to cear seals?

Yes No

Once the point is sealed the parameters that could affect the data integrity are
disabled and cannot be modified without removing the seal. Any attempt to edit
one of these parameter results in a error message box informing the user that the
W&M Seal is Enabled for this point. All ViewRTU point displays indicate the
disabled status in the same manner.

B SPREADSHEET MODE

Point Edit Options

pJul | Tag | wwseal | Modue | chan | b | Mode [Levelunits|Tempunits[pen*
p|u| o |nMs53.00 Enable Ot Ot -
Sl >

Tag Point Tag NMS553.00
WMSeal Weights & Measures Seal Enable

W&M Checksums

In order for the W&M official to verify that the sealed point has not been tampered
with, the 8130 RTU calculates a WMChecksum for all points that have a WMSeal
parameter. This WMChecksum is calculated by performing a CRC16 on all the
point parameters that can affect the data integrity. Users can make changes to
other point parameters without affecting the WMChecksum value.

In order to allow the W&M official to easily view the WMChecksum values for all
the sealed points, ViewRTU includes a ‘View Weights & Measures List...” menu
option under the Options menu item. This opens a ‘Weights and Measures List’
dialog displaying all points in the 8130 RTU, their WMSeal statuses and the
WMChecksum value.

W&M Seal Communications

The status of the WMSeal parameter is communicated to FuelsManager via the
PntStatus parameter in the particular RTU point. The bit position of the WMSeal
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Sealing the Point in 8130 RTU

information is specific to the particular point type. FuelsManager automatically
knows which bit position contains the WMSeal information.

FuelsManager combines this WMSeal information from the 8130 RTU with its own
W&M Seal information in order to determine if the particular data value is W&M
approved.
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Sealing TankPoint variables in FuelsManager

The FuelsManager Tank Database includes Tag Seal Data for each tank. The Tag
Seal Data includes a seal for the Tank, a seal for each input Process Variable, and
an integer Seal ID that denotes the revision of Tank Seal Data. The Tank
Database is stored in file FM_TankPoint.dat in the FuelsManager project directory.
FM_TankPoint.dat is a proprietary database file and is only accessible through
FMDataManager.exe. Library Tnkenfg.dll is the Tank Configuration client
component of FuelsManager and includes the Edit Tank Data dialog.

Applying the Software Seals

Tank seals can be configured from the W&M tab of the Edit Tank dialog in
Configuration.

Edit tank data—W&M
tab

Edit Tank Data -> WSUTCLIFFEZ \Test.W&M.Tank

General ] Volume 1 Process Data I Alarms ] Veszel 1 ] Vessel 2 W&M | Strap / Water Table | Leak Detection 1

Calibration Seals

Temperature
I Density
Water Level

OO0 OO OO IO OO OO R KR E]

“BSW

Volume Gross
Volume Net

Volume Remaining Net
Volume Available Net
Standard Density
Mass

Solids Level

Flow

Water Volume
Gauge Position
Density Temperature
Solids Volume

Tank Status

VCF

Wolume

Roof Comection

Vol. Remaining Gross
Wl Availahle Gross

Seal ID 5 Update
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Changing a Seal State for a Process Variable
A checkbox indicates the state for the Tank Seal and each input Process Variable

Seal. A checkmark means that the state is sealed.

Step-by-step

¢ Make the change by checking or clearing the appropriate checkbox under
Calibration Seals. The Update Seals button becomes available. This
happens when any Seal State checkbox is changed

¢ Click Update Seals. A prompt appears to confirm the changes

¢ Click OK. If any Seal State changes are checked, a prompt appears to enter
the Weights & Measures password. Otherwise the prompt is simply for
confirmation

¢ Enter the password. The Weights & Measures password must be properly
entered to effect setting Tag Seals

WitM Password Prompt

Enter Password |

Update Seals

Are you sure you want to dear seals?

OK | Cancel |

Each time the Tank Seal Data is changed, the Seal ID is incremented. This Seal
ID will be recorded by the W&M official.

If someone learns the W&M password and makes changes to the Tag Seals, the
Seal ID will be incremented and no longer match the Seal ID recorded by the
W&M official. In this manner the W&M official is able to detect unauthorized
tampering with the Tag Seals.

When a Tank is sealed, the user cannot configure or edit any process variable
scaling, engineering unit, volume correction, vessel characteristic, vapor
characteristic, or strap table parameters.
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Update seals
confirmation
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In this example of a
sealed tank, W&M
keeps any users from
editing the sealed
information

In this example, Level,
Temperature and
Density are sealed,
and cannot be edited

332

Edit Tank Data -> \\SUTCLIFFE2 \Test. W&M.Tank

General } Volume } Process Data } Alarmg  Vessel1 WVessel 2] WEM I Strap / Water Table } Leak Detedian]

1~ Characteristics - Optional Protection — 11 Tank Shell Comection
Cathodic Protection [~ ||
e i e Ovefil Protection [~ || T Shell Ireusfic
Floating Height | ftin-16th Spill Protection [~ || AreaCosf
Roof Mass b -

-Gauging Setup

Roof Type 5 D (* Tradtional ¢ Hydrostatic ¢ Hybrid
Tank Geometry ]ﬁ |- Pressure Tranemitter Setup
Tark Volume [T~ gal (US) F OTSa PSI Hefgh_t ftin-16h
Tank Height [00000  Rin-18h T vidde | =
Tank Radius |0-00-00 ftin-16th Bottom ] ‘
Shell Thickness [00000 in-i6th L
it Metesial ’—— Minimum Level . R4n-16th
Date Installed | 5/28:2004 ~| I pensty Descbend i
Tank Matarial Jm‘ I~ Use Local Gravity Ji m/Sect
ExpCosf jm Elevation J— i3
netall Temp [0 F lativd= [T [0 [0 Dms
Level Off Set ftin-16th

Cancel

When an input Process Variable is sealed, configuration of the Process Variable
data source is disabled. This feature ensures that a user cannot connect the

sealed process variable to another 8130 RTU point.

Edit Tank Data -> \\SUTCLIFFE2 \Test. W&M.Tank

General | Volume  Process Dete | Alams | Vessel 1| Vessel 2| WaM | Strap / Water Table | Leak Detection
Variable ‘ Source o]
Level Manual Entry
Temperature : Manual Entry
Density Calculated
Water Level Manual Entry
%BSW Manusl Entry
Volume Gross Calculated 3
WVolume Net Calculated
Wolume Remaining Net Calculated
Volume Avaiable Net Calculated
Standard Density Manual Entry
mass T Calculated
Soigs Level Manual Entry
Flow Calculated
Water Voume Calculated
Gau ge Posiion Not Assigned
Density Temperature Not Azsigned
Solids Volume Calculated
Transfer Mode Manual Entrv &

To aid the W&M official in verifying which FuelsManager tank points have a seal
applied, and what the value of the Seal ID is, FuelsManager includes a Tag Seals

dialog.
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Tag Seals

Current System: WSUTCLIFFEZ

X

Sslect...

Tag

| sealD

|

Test Tank.Table23_24E Obs
TestTank.Table23 24E
Test WEM.Tank

oooooo0o0d
oooooonood
0ooooo000s

Seal ID Sum; oooooooooe

In this example, three
tanks have been
sealed or contain
sealed variables.

The Tag Seals dialog shows the Current System and all the Tanks contained in
the FuelsManager Tank Database for the current system that have either Tank or
Input Process Variables sealed. The Dialog shows the Tag, the Seal ID and the

sum of the Seal ID’s.
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Display of W&M Indicator on Graphics & Reports

The FuelsManager Operate program indicates any Weights & Measures Seal for
Tank Detail and Historical Report displays. The Weights & Measures Seal is
shown by the prefix [W&M] on the title bar of the display.

If a particular tank process variable has been sealed, FuelsManager displays or
prints values with the subscript “W&M.” This is determined by the Input Process
Variable Seal and, if applicable, an I/O Seal that is communicated from the
external device. An illustration of the “W&M” seal indication is provided below.

w] FuelsManager - Operate - [[W&M] Tank Detail : WSUTCLIFFE2\Test. W&M. Tank]

) Display Alarm Point Tools Movements Trend Window Help

Tank Point

Product GAS Gasoline

— Measured Values

Level Set
12/20/2004 3:38:36 PM

Temperature Set 51.6..
12/22/2004 11:53:-44 AM faes

Water Level Set 0-00-00 f-in-16th

12/22/2004 11:53:47 AM

Any FuelsManager user-defined reports will include W&M indicators. The system
checks the database for the Seal and displays the subscript if applicable. The
indicator appears at the footer of each report page.
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Sealing FuelsManager Modules

FuelsManager includes a Seals database. This database exists on each computer
in a FuelsManager network and is stored in the FMSecurity.dat file under the
FMProject directory. For each module in the database, the system stores the
Path, a CRC16 Checksum (determined at the time the module is sealed), and a
Seal State that indicates whether the module is or is not sealed. Access to the
Module Seals Database is provided through the FMSecurityServer interface of
FMSystemServer.exe.

W&M officials can administer Module Seals in FuelsManager from Security. The
Module Seals dialog shows all the modules contained in the Module Seals
database for the Current System. Modules can be added and removed.

The dialog shows the following for each module:
« Seal State » Path
« File Size » Time of Last Modification
« Version (if applicable) ¢ Current Checksum

¢ Stored Checksum

Items under the Actions menu provide for the addition and deletion of modules
from the database.

Module Seals dialog—
available in Security

Module Seals
Actions
Current System: WSUTCLIFFE2 Select...
Module Seals Size | Modified Lo
CAProgram Files\FuelkeManageriTnkCnfg.dll 348180 11/22/2004 2:2
C:\Program Files\FuelzManagerlDCSCOMM . dIl 36864 1102202004 210
C:\Program Files\FuelzManageriFMArchiveManager.exe 208896 1112212004 2:1!
C:\Program Files\FueleManager\FMCommManager.exe 90112 11/22/2004 2:1!
C:\Program Fileg\FuelzManager FMCONFIG.dll 720896 11/22/2004 2:1.
C:\Program Files\FuelzManagerFiMDataManager.exe 438272 11/22/2004 21!
C:\Program Fileg\FueleManager FiReportianager.exe 126976 11/22/2004 21
C:\Program Fileg\FuelzManager\FMSecurityClient.dll 135168 112202004 21
C:\Program File=s\FuelzManager\FMSY STEM dil 561152 11222004 Z:1.
C:\Program Filez\FuelzManagenFMSystemidanager exe 475524 112212004 210
C:\Prugram Files\FuelzManagerFMUSR exe 1011712 12202004 21
C:\Program Files\FuelsManager\FMUSRLIB.dll 241654 1122020048 210
< I ¥
Print... JpasL 5

A checkbox shows the Seal State for each module. A check indicates the module
is sealed, while an unchecked box indicates no current seal is applied.
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Changing a Seal State for a module

Step-by-step

¢ In Security, Click Module Seals from the W&M menu. The Module Seals
dialog appears

« Click the checkbox that corresponds to the module you want to change. The
Update Seals button becomes available

¢ Click Update Seals. A prompt appears to confirm the changes

« Click OK. If any Seal State changes are checked, a prompt appears to enter
the Weights & Measures password. Otherwise the prompt is simply for
confirmation

« Enter the password. The Weights & Measures password must be properly
entered to modify the Tag Seals

W&M Logic

The following is a summary of the logic used when checking the Weights &
Measures seals. Sealed modules that are changed in any way in the system will
not appear with the W&M approval indicator.

The module seals are read when the particular module is started and loaded. So
any changes in W&M seal indication will only be effective when the module is
restarted / reloaded.

« FMCommManager. - will mark data as sealed if both the driver library and
FMCommManager.exe modules are sealed. Specifically for the 8130 RTU the
files cmdc8130.dll and the cmds8130.dll, in addition to the RTU point, must
also be sealed.

« FMDataManager - will mark data as sealed if the FMDataManager.exe
module is sealed and the process variable is sealed for the respective Tag. If
the process variable is calculated, then the VolumeCorrection.dll library
module must be sealed. If the process variable is an input from
FMCommManager then the data must also be sealed by the driver.

* FMArchiveManager - will mark data in the archive as sealed if the
FMSystem.dll library, the DCSComm.dll library and FMArchiveManager.exe
modules are sealed and the data is sealed by FMDataManager.

* FMOperate will display data as sealed on graphics, tank details and real-time
trends if the FMSystem.dll library, the DCSComm.dll library and OperNT.exe
modules are sealed and the data is sealed by FMDataManager.

* FMOperate will display data as sealed on historical trends if the FMSystem.dll
library and OperNT.exe modules are sealed and the data is sealed in the
archive.

» FMOperate will display data as sealed in historical reports and historical
trends if the FMSystem.dll library and OperNT.exe modules are sealed, the
data is sealed in the archive and the Archive.mdb file is still owned by the
SYSTEM. In addition, for the historical reports, the Crystal report must have
been designed to display W&M seals using custom functions supplied in the
U2FM.dIl, which must also be sealed
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* RMClient will display data as sealed on reports if the FMSystem.dll library, the
DCSComm.dll library, and the RMClient.dll modules are sealed and the data
is sealed by FMDataManager.

* FMReportManager will print data as sealed on real-time reports if the
FMSystem.dll library, the DCSComm.dll library, and FMReportManager.exe
modules are sealed and the data is sealed by FMDataManager.

« TankGroup will display data as sealed on tank group displays if FMSystem.dl|
library and TankGroup.dll library modules are sealed and the data is sealed
by FMDataManager.
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Setting the W&M Password

In order to set the W&M password the user must know the existing W&M
password.

WaM Password m

Oid Password

New Password
Confirm New Password

The same W&M password is used for:

» Tag Seals in FuelsManager
¢ Module Seals in FuelsManager
* WMSeal enable in 8130 RTU

Step-by-step

* From Security, select Password from the W&M menu. The W&M Password
dialog appears

¢ Enter the Old Password

« Enter the new password twice—once in New Password, and again in
Confirm New Password

¢ Click Update
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Systems Seals

To ensure the integrity of the FuelsManager historical data, FuelsManager makes
use of Windows XP & 2000 folder, file and object-based security. All system data
stored in open format databases is configured with file security settings. The
System account has ownership, read, and write access, while all other accounts
have only read access.

FuelsManager services that write system data run under the System account
thereby providing write access to all users but only in accordance with the
FuelsManager Security configuration.

The FuelsManager application allows the W&M official to seal any open format
database, specifically the historical data stored in the Archive.MDB file (an MS
Access database). This sealing process is protected by the same W&M password
and integer seal ID mechanism used in the Module and Tag seals dialogs.

The process of sealing an Archive.MDB file sets the permissions on the file to:

» Everyone — Read / Execute

e System — Full Control
In addition, ownership of the file is set to System
In order for any user (administrator included) to make changes to the security of
the file they would need to take ownership of the file. If the archive is sealed
FuelsManager checks the ownership of the file whenever access to historical data

is required. If the ownership of the archive file is not System, then the data does
not appear as W&M approved.
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FuelsManager Defense

Glossary of terms

This section describes each of the available FuelsManager tank point, input point,
and output point parameters and their function. Tank point, input point, and output
point parameters are displayed in FuelsManager as an abbreviated parameter
name, up to twenty characters long, and a more complete descriptive name, up to
forty characters long. The two names for each parameter are listed below,
followed by a more detailed description.
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Tank Points - Process Data

Tank Points - Process Data

DESCRIPTION - POINT DESCRIPTION

This process variable is the name by which the tank is known to the user. This variable is entered when
configuring the tank point, but cannot be modified via Operate

PRODUCT - PRODUCT

This process variable is the type of product contained in the tank. This variable is entered when configuring the
tank point, but can be viewed or modified from Operate by a user with sufficient privileges. The product variable
contains a string that is the combination of the 20 character Product Code and the 30 character Product
Description

PRODUCT CODE - PRODUCT CODE

This variable is the product code part of the Product process variable
PRODUCT DESCRIPTION - PRODUCT DESCRIPTION

This variable is the product description part of the Product process variable
LEVEL - TANK LEVEL

This process variable is the current level of the tank; this variable is usually measured by automatic tank
gauging but can be manually entered by the operator

LEVEL TIME - TIME OF LAST LEVEL UPDATE

This process variable is the last time that the tank level was updated. This variable can be viewed from the
Operate interface but cannot be modified.

TEMPERATURE - TANK TEMPERATURE

This process variable is the current temperature of the tank; this variable is usually measured by automatic tank
gauging but can be manually entered by the operator

TEMPERATURE TIME - TIME OF LAST TEMP. UPDATE

This process variable is the last time that the tank temperature was updated. This variable can be viewed from
the Operate interface but cannot be modified

DENSITY - PRODUCT DENSITY

This process variable is the current observed density of the product at the current temperature, this variable can
be measured by automatic tank gauging, manually entered by the operator or calculated by FuelsManager from
the Std., Density and current temperature

DENSITY TIME - TIME OF LAST DENSITY UPDATE

This process variable is the last time that the Density value was updated. This variable can be viewed from the
Operate interface but cannot be modified

WATER LEVEL - WATER BOTTOM LEVEL
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Tank Points - Process Data

This process variable is the level of water in the tank, this variable can be measured by automatic tank gauging
or manually entered by the operator

WATER LEVEL TIME - TIME OF LAST WATER LEVEL

This process variable is the last time that the Water Level value was updated. This variable can be viewed from
the Operate interface but cannot be modified

%BSW - BOTTOM SEDIMENT AND WATER

This process variable is the percentage of impurities (bottoms, sediment and water) in the product, if required,
the operator usually manually enters this variable, however, the variable can be linked to automatic gauging
systems if required

%BSW TIME - TIME OF LAST BS&W UPDATE
This process variable is the last time that the tank %BSW was updated
VOLUME GROSS - GROSS TANK VOLUME

This process variable is the total measured volume of the product in the tank corrected for Water Level, % BSW,
and Roof Volume. FuelsManager normally calculates this from the tank gauge reading and the tank-strapping
table, however, the value can also be measured by automatic tank gauging systems or manually entered by the
operator

VOLUME TIME GROSS - TIME OF LAST GROSS VOL. UPDATE

This process variable is the last time that the tank gross volume was updated. This variable can be viewed from
the Operate interface but cannot be modified

VOLUME NET - CORRECTED TANK VOLUME

This process variable is the corrected volume of the product in the tank. FuelsManager normally calculates this
by multiplying the Gross Volume by the Volume Correction Factor, however, the value can also be measured by
automatic tank gauging systems or manually entered by the operator

VOLUME TIME NET - TIME OF LAST NET VOLUME UPDATE

This process variable is the last time that the tank net volume was updated. This variable can be viewed from
the Operate interface but cannot be modified

VOLUME REMAINING NET - NET REMAINING STORAGE

This process variable is the Net Volume of product that can be added to the tank. FuelsManager normally
calculates this by subtracting the current Net Std. Volume from the Net Std. Volume at the maximum working
level, however the value can also be measured by automatic tank gauging systems or manually entered by the
operator

VOLUME AVAILABLE NET - NET AVAILABLE PRODUCT

This process variable is the Net Volume of product that can safely be issued from the tank. FuelsManager
normally calculates this by subtracting the Net Std. Volume at the minimum working level from the current Net
Std. Volume. However this value can be measured by automatic tank gauging systems or manually entered by
the operator

STANDARD DENSITY - STANDARD DENSITY
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Tank Points - Process Data

This process variable is the current corrected density of the product at the standard temperature as defined by
the selected correction method. This variable can be measured by automatic tank gauging, manually entered by
the operator or calculated by FuelsManager from the observed density, current temperature and correction
method

MASS - PRODUCT MASS

This process variable is the mass of product. FuelsManager normally calculates this by multiplying the Net Std.
Volume by the Std. Density. However this value can be measured by automatic tank gauging systems or
manually entered by the operator

MASS TIME - TIME OF LAST MASS UPDATE

This process variable is the last time that the tank mass was updated. This variable can be viewed from the
Operate interface but cannot be modified

SOLIDS LEVEL - BOTTOM SOLIDS LEVEL

This process variable is the level of solids in the tank, the operator usually manually enters this variable,
however, the variable can be linked to automatic gauging systems if required

SOLIDS LEVEL TIME - SOLIDS LEVEL TIME

This process variable is the last time that the tank solids level was updated. This variable can be viewed from
the Operate interface but cannot be modified.

FLOW - TANK INPUT / OUPUT FLOW

This process variable is the flow of product into or out of the tank. FuelsManager normally calculates this
sampling the gross volume at user-defined intervals and averaging the change in volume over a user-defined
number of samples. However, this value can also be measured by automatic tank gauging systems or manually
entered by the operator

FLOW TIME - TIME OF LAST FLOW UPDATE

This process variable is the last time that the tank flow was updated. This variable can be viewed from the
Operate interface but cannot be modified.

WATER VOLUME - WATER BOTTOM VOLUME

This process variable is the volume of water in the tank. FuelsManager normally calculates this from the water
level value and the tank strapping table, however, the value can also be measured by automatic tank gauging
systems or manually entered by the operator

GAUGE POSITION - LEVEL GAUGE POSITION

This process variable is the current position of the tank level gauge measuring head. This variable is only
applicable to servo type tank gauges, where the measuring device can be positioned at points in the tank other
than the product level. This variable is usually measured by automatic tank gauging but can be manually entered
by the operator

GAUGE POSITION TIME - GAUGE POSITION TIME

This process variable is the last time that the tank gauge position was updated. This variable can be viewed
from the Operate interface but cannot be modified.
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Tank Points - Process Data

DENSITY TEMPERATURE- TEMPERATURE FOR MEASURED DENSITY

This process variable is the measured temperature at the time the density data was last updated. If entered
FuelsManager uses this data to convert the density data to corrected density. This variable is normally measured
by automatic tank gauging, but can be manually entered by the operator. Typically, tank gauges that support
density measurements provide this data. Otherwise, the laboratory may provide this data for manual entry

DENSITY TEMP. TIME - DENSITY TEMP. TIME

This process variable is the last time that the tank density temperature was updated. This variable can be
viewed from the Operate interface but cannot be modified

SOLIDS VOLUME - BOTTOM SOLIDS VOLUME

This process variable is the volume of solids in the tank. FuelsManager normally calculates this from the solids
level value and the tank strapping table, however, the value can also be measured by automatic tank gauging
systems or manually entered by the operator

VCF - VOLUME CORRECTION FACTOR

This process variable is the volume correction factor, used to correct gross volume for the effects of product
thermal expansion. FuelsManager normally calculates this from temperature, density, and selected correction
method, the variable can also be linked to automatic gauging systems or manually entered if required

VOLUME STRAP VOLUME

This process variable is the observed volume of the product in the tank as read from the tank strapping table.
FuelsManager normally calculates this from the tank gauge reading and the tank strapping table, however, the
value can also be measured by automatic tank gauging systems or manually entered

ROOF CORRECTION - ROOF VOLUME

This process variable is the volumetric effect of the tanks floating roof. If a floating roof type tank is defined,
FuelsManager normally calculates this from the roof weight and roof position. However, the value can also be
measured by automatic tank gauging systems or manually entered

VOLUME REMAINING GROSS - GROSS REMAINNG VOLUME

This process variable is the Gross Volume of product that can be added to the tank. FuelsManager normally
calculates this by subtracting the current Gross Volume from the Gross Volume at the maximum working level.
However, the value can also be measured by automatic tank gauging systems or manually entered by the
operator

VOLUME AVAILABLE GROSS - GROSS AVAILABLE VOLUME

This process variable is the Gross Volume of product that can safely be issued from the tank. FuelsManager
normally calculates this by subtracting the Gross Volume at the minimum working level from the current Gross
Volume. However, this value can be measured by automatic tank gauging systems or manually entered by the
operator

MASS REMAINING - REMAINING MASS

This process variable is the Mass of product that can be added to the tank. FuelsManager normally calculates
this by subtracting the current Mass from the Mass at the maximum working level. However, the value can also
be measured by automatic tank gauging systems or manually entered by the operator
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Tank Points - Process Data

MASS AVAILABLE - AVAILABLE MASS

This process variable is the Mass of product that can safely be issued from the tank. FuelsManager normally
calculates this by subtracting the Mass at the minimum working level from the current Mass. However, this value
can be measured by automatic tank gauging systems or manually entered by the operator

VOL STRAP - H20 - STRAP VOLUME MINUS WATER VOLUME

This process variable is the tank strapping volume minus the water volume. FuelsManager normally calculates
this by subtracting the current water volume from the current strapping volume. However, this value can be
measured by automatic tank gauging systems or manually entered by the operator

VOL STRAP - COR EXP - STRAP VOLUME MINUS CTSH

This process variable is the tank strapping volume minus the thermal expansion effect of the tank shell.
FuelsManager normally calculates this by subtracting the volumetric effect of the tank shell correction factor from
the current strapping volume. However, this value can be measured by automatic tank gauging systems or
manually entered by the operator

VOL NET - C&W - NET VOLUME MINIUS C&W CORRECTION

This process variable is the Net Std. volume minus the correction for sediment and water. FuelsManager
normally calculates this by subtracting the correction for sediment and water from the current Net Std. volume.
However, this value can be measured by automatic tank gauging systems or manually entered by the operator

TANK SHELL COR. FAC - TANK SHELL CORRECTION FACTOR

This process variable is the tank shell correction factor, used to correct gross volume for the effects of tank shell
thermal expansion. FuelsManager normally calculates this from product temperature, ambient temperature, shell
material, and type of tank shell, the variable can also be linked to automatic gauging systems or manually
entered if required

C&W COR. FAC - C&W CORRECTION FACTOR

This process variable is the correction for sediment and water, used to correct gross volume for the effects of
water and sediment in the bottom of the tank. FuelsManager normally calculates this from water level and solids
level variables, the variable can also be linked to automatic gauging systems or manually entered if required

BSW VOLUME - VOLUME FOR %BSW

This process variable is the volume base, sediment and water impurities in the tank. FuelsManager normally
calculates this from the %BSW value and the current gross volume. However, the value can also be measured
by automatic tank gauging systems or manually entered by the operator

TANK BOTTOM VOLUME - TOTAL BOTTOM VOLUME

This process variable is the combined water and solids volumes in the tank. FuelsManager normally calculates
this by adding the water volume to the solids volume values. However, the value can also be measured by
automatic tank gauging systems or manually entered by the operator

VAPOR TEMP. - VAPOR TEMPERATURE

This process variable is the temperature of the vapor space above the product in the tank. This variable is
usually measured by automatic tank gauging but can be manually entered by the operator. This data is normally
only applicable to tanks containing liquified hydrocarbons.
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TEMP VAPOR TIME - VAPOR TEMPERATURE TIME

This process variable is the last time that the tank level was updated. This variable can be viewed from the
Operate interface but cannot be modified.

LEVEL CHANGE RATE - RATE OF LEVEL CHANGE

This process variable is the rate of change of the level value due to movement of product into or out of the tank.
FuelsManager normally calculates this sampling the level at user-defined intervals and averaging the change in
level over a user-defined number of samples. However, this value can also be measured by automatic tank
gauging systems or manually entered by the operator

LEVEL RATE TIME - LEVEL RATE TIME

This process variable is the last time that the tank level change rate was updated. This variable can be viewed
from the Operate interface but cannot be modified.

GAUGE COMMAND - LEVEL GAUGE COMMAND

This process variable is used to issue commands to automatic tank gauges, the possible values depend in the
tank gauge modifier configured for the tank. This variable is normally entered by the operator, but can be linked
to automatic tank gauging systems to allow remote commands to the tank gauges

GAUGE STATUS - LEVEL GAUGE STATUS

This process variable represents the status of the automatic tank gauge. In order to use this variable the gauge
status variable must be linked to the status information data in the tank gauge. Possible statuses depend on the
tank gauge in use. This variable is normally linked to automatic tank gauging systems but can be entered by the
operator if required

GAUGE ALARMS - GAUGE ALARM FLAGS

This process variable represents the alarms present in the automatic tank gauge. In order to use this variable
the gauge alarms variable must be linked to the alarms information data in the tank gauge. This variable is
normally linked to automatic tank gauging systems but can be entered by the operator if required. Possible alarm
values depend on the tank gauge in use and can be configured by the user, the default gauge alarms are:

e 0x01-Scan Failure

¢ 0x02-Gauge I/O Fail

¢ 0x04-Device Alarm

¢ 0x08-Field Cfg Modified
¢ 0x10-Raise Failure

¢ 0x20-Lower Failure

¢ 0x40-Upload Failure

¢ 0x80-Download Failure
¢ 0x100-OverkFill
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GAUGE ALARMS BIT XX - GAUGE ALARMS

This process variable represents the individual elements of the Gauge Alarm Flags. Where gauge alarms bit 00
represents the state of the lowest bit of the gauge alarm flags and gauge alarms bit 15 represents the highest bit
of the gauge alarm flags. Possible values for each gauge alarms bit are Normal or the coded variable associated
with the particular bit. In the example above gauge alarms bit 00 - Normal or Scan Failure

TEMP TANK AMBIENT - AMBIENT TANK TEMPERATURE

This process variable is the ambient temperature of the air surrounding the tank. This variable is normally
entered by the operator, but can be linked to automatic tank gauging systems. In addition, this variable supports
linking to a 'local' FuelsManager database point, this allows multiple tanks to read one common ambient
temperature

VOLUME CORRECTION - TANK VOLUME CORRECTION

This process variable is the unmeasurable volume associated with line segments and manifolds connected to
the tank. This variable is normally entered by the operator, but can be linked to automatic tank gauging systems
to allow remote commands to the tank gauges

VOL. CORRECTION TIME - VOLUME CORRECTION TIME

This process variable is the last time that the tank volume correction was updated. This variable can be viewed
from the Operate interface but cannot be modified

VAPOR DENSITY - VAPOR DENSITY

This process variable is the density of the gas in the vapor space above the product in the tank. This variable is
normally entered by the operator, but can be linked to automatic tank gauging systems to allow remote
commands to the tank gauges. This data is normally only applicable to tanks containing liquified hydrocarbons or
tanks using hydrostatic or hybrid tank calculations

VAPOR DENSITY TIME - VAPOR DENSITY TIME

This process variable is the last time that the tank gas density was updated. This variable can be viewed from
the Operate interface but cannot be modified

VAPOR PRESS P3 - VAPOR PRESSURE P3

This process variable is the pressure of the vapor space above the product in the tank. This variable is usually
measured by automatic tank gauging but can be manually entered by the operator. This data is normally only
applicable to tanks containing liquified hydrocarbon or those using hydrostatic or hybrid tank calculations

VAPOR PRESSURE TIME - VAPOR PRESSURE TIME

This process variable is the last time the Vapor Pressure P3 was updated. This variable can be viewed from the
Operate interface but cannot be modified. This variable is usually measured by automatic tank gauging but can
be manually entered by the operator. This data is normally only applicable to tanks containing liquified
hydrocarbon or those using hydrostatic or hybrid tank calculations

MIDDLE PRESSURE P2 - HYDROSTATIC PRESSURE P2
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This process variable is the pressure measured at the same known height in the tank, typically at a point such
that it is normally below the product level. This variable is usually measured by automatic tank gauging but can
be manually entered by the operator. This data is normally only applicable to tanks containing liquified
hydrocarbon or those using hydrostatic or hybrid tank calculations

BOTTOM PRESSURE P1 - HYDROSTATIC PRESSURE P1

This process variable is the pressure measured at the bottom of the tank, typically of a point that is always below
the lowest possible product level. This variable is usually measured by automatic tank gauging but can be
manually entered by the operator. This data is normally only applicable to tanks containing liquified hydrocarbon
or those using hydrostatic or hybrid tank calculations

AIR DENSITY - AIR DENSITY

This process variable is the density of the air surrounding the tank. This variable is usually measured by
automatic tank gauging but can be manually entered by the operator. This data is normally only applicable to
tanks containing liquified hydrocarbon or those using hydrostatic or hybrid tank calculations

MASS FLOW - MASS FLOW

This process variable is the mass flow of product into or out of the tank. FuelsManager normally calculates this
sampling the mass at user-defined intervals and averaging the change in mass over a user-defined number of
samples. However, this value can also be measured by automatic tank gauging systems or manually entered by
the operator

MASS FLOW TIME - MASS FLOW TIME

This process variable is the last time that the tank mass flow was updated. This variable can be viewed from the
Operate interface but cannot be modified

NET FLOW - NET FLOW

This process variable is the net volumetric flow of product into or out of the tank. FuelsManager normally
calculates this sampling the net volume at user-defined intervals and averaging the change in net volume over a
user-defined number of samples. However, this value can also be measured by automatic tank gauging systems
or manually entered by the operator

NET FLOW TIME - NET FLOW TIME

This process variable is the last time that the tank Net flow was updated. This variable can be viewed from the
Operate interface but cannot be modified

VAPOR MASS — VAPOR MASS

This process variable is the mass of the vapor space above the product in the tank. FuelsManager normally
calculates this value. However, the value can also be measured by automatic tank gauging systems or manually
entered

VAPOR NET VOLUME - VAPOR NET VOLUME

This process variable is the net volume of vapor space above the product in the tank. FuelsManager normally
calculates this value. However, the value can also be measured by automatic tank gauging systems or manually
entered
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LIQUID MASS

This process variable is the mass of the liquid of the product in the tank. FuelsManager normally calculates this
value. However, the value can also be measured by automatic tank gauging systems or manually entered

TOTAL NET VOLUME

This process variable is the total net volume of the product in the tank. FuelsManager normally calculates this
value. However, the value can also be measured by automatic tank gauging systems or manually entered

FASTSCAN COMMAND

This process variable allows the operator to choose the timing of the communications for a particular gauge. The
possible values are enabled or disabled. When enabled the timing is dependent of the type of gauge

FASTSCAN STATUS

This process variable displays the current FASTSCAN status (gauge communications) either enabled or
disabled
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TRANSFER MODE - TANK TRANSFER MODE

This process variable is the mode by which the operator wants to transfer product to/ from tank, possible values
are inactive, by volume, by level, or by differential volume. This variable is used as part of the tank transfer
feature and as part of the Product Movement System (option). This variable is normally entered by the operator,
but can be linked to automatic tank gauging systems to allow remote setting of the transfer mode

TANK COMMAND - TANK MODE COMMAND OUTPUT

This process variable is the desired mode of operation of the tank, possible values are stop, fill, empty, run, test,
reset, or out of service. This variable is used by the tank point to enable tank mode alarms. For example, if the
tank mode is Stop (and the product movement alarms are enabled) and the level changes, then activate an
illegal movement alarm. This variable is normally entered by the operator, but can be linked to automatic tank
gauging systems to allow remote setting of the mode or can be calculated by FuelsManager based on the flow
process variable

TANK STATUS - CURRENT TANK MODE

This process variable reflects the selected mode of operation of the tank, possible values are stopped, filling,
emptying, running, testing, or disabled. This variable always reflects the selected tank mode regardless data
source selection

TRANSFER STATUS - TANK TRANSFER STATUS

This process variable reflects the current state of the tank transfer, possible values are Inactive, Trans SD
Setpoint, In Progress, Advisory or Complete. The value is intended to represent the various steps in the transfer
process. This variable always reflects the current state of the tank transfer regardless data source selection

TRANS SD SETPOINT - TRANSFER SHUTDOWN SETPOINT

This variable is the operator entered desired ending point of a tank transfer, it is automatically expressed in
either volume of level units depending on the transfer mode selected

TRANS ADV. SETPOINT - TRANSFER ADVISORY SETPOINT

This variable is the amount of time before a transfer is complete that an advisory alarm should be triggered. The
value can be from 0-120 minutes before the transfer reaches the Transfer Shutdown Setpoint

TRANSFER UNITS - TRANSFER SHUTDOWN SP UNITS

This variable is the units being used for the currently active transfer. The units are dependant on the transfer
mode selected (i.e. Xfr by Level - Tank Level Units; Xfr by Diff Vol - Tank Volume units)

TRANSFER VOLUME - CURRENT VOLUME TRANSFERRED

This variable is the amount of volume transferred into or out of a tank during the tank transfer, or the amount
transferred thus far if a transfer is active

TRANSFER TOTAL - CURRENT TRANSFERRED BASED ON MODE

This variable is the amount of volume / level / mass transferred into or out of a tank during the tank transfer, or
the amount transferred thus far if a transfer is active. Units are based on the selected transfer mode

352 Administrator Manual



Product Transfer Data

Product Transfer Data

TRANSFER MASS - CURRENT MASS TRANSFERRED

This variable is the amount of mass transferred into or out of a tank during the tank transfer, or the amount
transferred thus far if a transfer is active

TRANSFER TIME REMAIN - REMAINING TIME TO FILL OR EMPTY

This variable is the time left to complete an active transfer, based on the amount left to transfer, and the current
flow rate

TRANSFER START TIME - TIME AT WHICH TRANSFER BEGAN

This variable is the time at which a currently active transfer started. If no transfer is active this variable displays
the time that the last transfer was started

TRANSFER COMPLETE TIME - TRANSFER FINISH TIME
This variable is the time at which a last product transfer ended
TRANSFER LEVEL SETPOINT - TRANSFER LEVEL SETPOINT

This variable is the current level shutdown setpoint. If no transfer is active this variable displays the level
shutdown setpoint for the last transfer

TRANSFER VOL SETPOINT - TRANSFER FINAL VOLUME SP

This variable is the current volume shutdown setpoint. If no transfer is active this variable displays the volume
shutdown setpoint for the last transfer

TRANSFER DIFF VOL SP - TRANSFER DIFF. VOLUME SP

This variable is the current differential volume shutdown setpoint. If no transfer is active this variable displays
the differential volume shutdown setpoint for the last transfer

TRANSFER MASS SETPOINT - TRANSFER MASS SETPOINT

This variable is the current mass shutdown setpoint. If no transfer is active this variable displays the mass
shutdown setpoint for the last transfer

TRANSFER DIFF MASS SP - TRANSFER DIFF. MASS SP

This variable is the current differential mass shutdown setpoint. If no transfer is active this variable displays the
differential mass shutdown setpoint for the last transfer

TRANSFER REMAINING - TRANSFER REMAINING BASED ON MODE

This variable is the amount of product that remains to be transferred for the currently active transfer. Units are
based on the currently selected transfer mode

MASS TRANSFER REM - TRANSFER REMAINING MASS

This variable is the amount of product, expressed in mass units, that remains to be transferred for the currently
active transfer

ADMO03GVAE1005 353



FuelsManager Defense

Tank Alarms Data

Tank Alarms Data

LEVEL ALARM - COMPOSITE LEVEL ALARM STATUS

This variable is a composite value that displays a coded variable representing the highest priority level alarms
for the tank. Possible values are Normal, High-High Low, Low-Low. FuelsManager calculates this alarm based
on the current level and the alarms limits configured for the tank

LEVEL HIHI LIMIT - CURRENT HI_HI LEVEL LIMIT

This variable is the limit for a High-High level alarm. If the tank level exceeds the HiHi Alarm value, then a High-
High alarm is activated. This variable is entered when configuring the tank point, but can be modified from
Operate by a user with sufficient privileges

LEVEL HIGH LIMIT - CURRENT HIGH LEVEL LIMIT

This variable is the limit for a High level alarm. If the tank level exceeds the High Alarm value, then a High alarm
is activated. This variable is entered when configuring the tank point, but can be modified from Operate by a user
with sufficient privileges

LEVEL LOW LIMIT - CURRENT LOW LEVEL LIMIT

This variable is the limit for a Low level alarm. If the tank level falls below the Low Alarm value, then a Low alarm
is activated. This variable is entered when configuring the tank point, but can be modified from Operate by a user
with sufficient privileges

LEVEL LOLO LIMIT - CURRENT LO-LO LEVEL LIMIT

This variable is the limit for a Low-Low level alarm. If the tank level falls below the LoLo Alarm value, then a
Low-Low alarm is activated. This variable is entered when configuring the tank point, but can be modified from
Operate by a user with sufficient privileges

LEVEL LOLO LIMIT - CURRENT LO-LO LEVEL LIMIT

This variable is the limit for a Low-Low level alarm. If the tank level falls below the LoLo Alarm value, then a
Low-Low alarm is activated

LEVEL ALARM HOLDOFF

This variable is the sometimes known as deadband or hysteresis. It is the amount by which the alarm limit must
be cleared before the alarm is deactivated. For example, if the High level alarm setpoint is 10 and the level alarm
holdoff is 1, the level must return to a value of 9 before the High level alarm is deactivated. This variable is
entered when configuring the tank point and cannot be modified from Operate

ETA ALARMS

Estimated Time of Arrival alarms (ETA) are intended to give the operator a warning a preset time before the
relevant level alarm is reached. This type of alarm is commonly used in facilities where the tanks are always
filled or emptied to high or low levels. Since the filling or emptying of large tanks can take days, these are alarms
are used to alert the operator that a particular tank is approaching a level where some action needs to be taken.
By default, ETA alarms disabled, they can be enabled via the Alarms tab of the tank configuration dialog box
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LEVEL HIHI ETA - HIGH HIGH LEVEL ETA

This variable is the estimated time to arrive at the High-High level alarm setpoint based on the current flow rate.
The alarm is activated when the time remaining before reaching the High-High level setpoint is less than the
advisory limit defined by the Trans. Adv. Setpoint (see Product Transfer Data section)

LEVEL HIGH ETA - HIGH LEVEL ETA

This variable is the estimated time to arrive at the High level alarm setpoint based on the current flow rate. The
alarm is activated when the time remaining before reaching the High level setpoint is less than the advisory limit
defined by the Trans. Adv. Setpoint (see Product Transfer Data section)

LEVEL LOW ETA - LOW LEVEL ETA

This variable is the estimated time to arrive at the Low level alarm setpoint based on the current flow rate. The
alarm is activated when the time remaining before reaching the Low level setpoint is less than the advisory limit
defined by the Trans. Adv. Setpoint (see Product Transfer Data section)

LEVEL LOLO ETA - LOW LOW LEVEL ETA

This variable is the estimated time to arrive at the Low-Low level alarm setpoint based on the current flow rate.
The alarm is activated when the time remaining before reaching the Low-Low level setpoint is less than the
advisory limit defined by the Trans. Adv. Setpoint (see Product Transfer Data section)

TEMPERATURE ALARM - COMPOSITE TEMP. ALARM STATUS

This variable is a composite value that displays a coded variable representing the highest priority temperature
alarms for the tank. Possible values are Normal, High-High, High, Low, Low-Low. This alarm is calculated by
FuelsManager based on the current temperature and the alarms limits configured for the tank

TEMP HIHI LIMIT - CURRENT HI-HI TEMP LIMIT

This variable is the limit for a High-High temperature alarm. If the tank temperature exceeds the HiHi Alarm
value, then a High-High alarm is activated. This variable is entered when configuring the tank point, but can be
modified from Operate by a user with sufficient privileges

TEMP HIGH LIMIT - CURRENT HIGH TEMP LIMIT

This variable is the limit for a High temperature alarm. If the tank temperature exceeds the High Alarm value,
then a High alarm is activated. This variable is entered when configuring the tank point, but can be modified from
Operate by a user with sufficient privileges

TEMP LOW LIMIT - CURRENT LOW TEMP LIMIT

This variable is the limit for a Low temperature alarm. If the tank temperature falls below the Low Alarm value,
then a Low alarm is activated. This variable is entered when configuring the tank point, but can be modified from
Operate by a user with sufficient privileges

TEMP LOLO LIMIT - CURRENT LO-LO TEMP LIMIT

This variable is the limit for a Low-Low temperature alarm. If the tank temperature falls below the LoLo Alarm
value, then a Low-Low alarm is activated. This variable is entered when configuring the tank point, but can be
modified from Operate by a user with sufficient privileges
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TEMPERATURE ALARM HOLDOFF

This variable is the sometimes known as deadband or hysteresis. It is the amount by which the alarm limit must
be cleared before the alarm is deactivated. For example, if the High temperature alarm setpoint is 10 and the
temperature alarm holdoff is 1, the temperature must return to a value of 9 before the High temperature alarm is
deactivated. This variable is entered when configuring the tank point and cannot be modified from Operate

DENSITY ALARM - COMPOSITE DENISTY ALARM

This variable is a composite value that displays a coded variable representing the highest priority density alarms
for the tank. Possible values are Normal, High or Low. FuelsManager calculates this alarm based on the current
density and the alarms limit configured for the tank point

DENSITY HIGH LIMIT - CURRENT HIGH DENSITY LIMIT

This variable is the limit for a High density alarm. If the tank density exceeds the High Alarm value, then a High
alarm is activated. This variable is entered when configuring the tank point, but can be modified from Operate by
a user with sufficient privileges

DENSITY LOW LIMIT - CURRENT LOW DENSITY LIMIT

This variable is the limit for a Low density alarm. If the tank density falls below the Low Alarm value, then a Low
alarm is activated. This variable is entered when configuring the tank point, but can be modified from Operate by
a user with sufficient privileges

DENSITY ALARM HOLDOFF

This variable is the sometimes known as deadband or hysteresis. It is the amount by which the alarm limit must
be cleared before the alarm is deactivated. For example, if the High density alarm setpoint is 10 and the density
alarm holdoff is 1, the density must return to a value of 9 before the High density alarm is deactivated. This
variable is entered when configuring the tank point and cannot be modified from Operate

FLOW ALARM - COMPOSITE FLOW ALARM

This variable is a composite value that displays a coded variable representing the highest priority flow alarms for
the tank. Possible values are Normal, High or Low. FuelsManager calculates this alarm based on the current
flow and the alarm limits configured for the tank

FLOW HIGH LIMIT - CURRENT HIGH FLOW LIMIT

This variable is the limit for a High flow alarm. If the tank flow exceeds the High Alarm value, then a High alarm
is activated. Please note that FuelsManager compares the value of the flow variable regardless of it's sign,

meaning that a flow of -10000 gpm would trigger a high flow alarm if the High flow limit was 9999. This variable
is entered when configuring the tank point, but can be modified from Operate by a user with sufficient privileges

FLOW LOW LIMIT - CURRENT LOW FLOW LIMIT

This variable is the limit for a Low flow alarm. If the tank flow falls below the Low Alarm value, then a Low alarm
is activated. Please note that FuelsManager compares the value of the flow variable regardless of it's sign,

meaning that a flow of -10000 gpm would trigger a high flow alarm if the High flow limit was 9999. This variable
is entered when configuring the tank point, but can be modified from Operate by a user with sufficient privileges
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FLOW ALARM HOLDOFF

This variable is the sometimes known as deadband or hysteresis. It is the amount by which the alarm limit must
be cleared before the alarm is deactivated. For example, if the High flow alarm setpoint is 10 and the flow alarm
holdoff is 1, the flow must return to a value of 9 before the High flow alarm is deactivated. This variable is entered
when configuring the tank point and cannot be modified from Operate

LEVEL RATE ALARM - CHANGE IN LEVEL RATE ALARM

This variable is a composite value that displays a coded variable representing the highest priority level rate
alarms for the tank. Possible values are Normal, High or Low. FuelsManager calculates this alarm based on the
current level rate and the alarm limits configured for the tank

LEVEL RATE HIGH S.P - HIGH LEVEL RATE SETPOINT

This variable is the limit for a High level rate alarm. If the tank level rate exceeds the High Alarm value, then a
High alarm is activated. Please note that FuelsManager compares the value of the level rate variable regardless
of it's sign, meaning that a level rate of -10 in/min would trigger a high level rate alarm if the High level rate limit
was 9. This variable is entered when configuring the tank point, but can be modified from Operate by a user with
sufficient privileges

LEVEL RATE LOW S.P. - LOW LEVEL RATE SETPOINT

This variable is the limit for a Low level rate alarm. If the tank level rate falls below the Low Alarm value, then a
Low alarm is activated. Please note that FuelsManager compares the value of the level rate variable regardless
of it's sign, meaning that a level rate of -10 in/min would trigger a high level rate alarm if the High level rate limit
was 9. This variable is entered when configuring the tank point, but can be modified from Operate by a user with
sufficient privileges

LEVEL RATE ALARM HOLDOFF

This variable is the sometimes known as deadband or hysteresis. It is the amount by which the alarm limit must
be cleared before the alarm is deactivated. For example, if the High level rate alarm setpoint is 10 and the level
rate alarm holdoff is 1, the level rate must return to a value of 9 before the High level rate alarm is deactivated.
This variable is entered when configuring the tank point and cannot be modified from Operate

PRESS VAPOR ALARM - VAPOR PRESSURE ALARM

This variable is a composite value that displays a coded variable representing the highest priority pressure
alarms for the tank. Possible values are Normal, High or Low. FuelsManager calculates this alarm based on the
current vapor pressure and the alarm limits configured for the tank

PRESS HIGH SETPOINT - HIGH PRESSURE SETPOINT

This variable is the limit for a High pressure alarm. If the tank pressure exceeds the High Alarm value, then a
High alarm is activated. This variable is entered when configuring the tank point, but can be modified from
Operate by a user with sufficient privileges

PRESS LOW SEPOINT - LOW PRESSURE SETPOINT

This variable is the limit for a Low pressure alarm. If the tank pressure falls below the Low Alarm value, then a
Low alarm is activated. This variable is entered when configuring the tank point, but can be modified from
Operate by a user with sufficient privileges
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PRESSURE ALARM HOLDOFF

This variable is the sometimes known as deadband or hysteresis. It is the amount by which the alarm limit must
be cleared before the alarm is deactivated. For example, if the High pressure alarm setpoint is 10 and the
pressure alarm holdoff is 1, the pressure must return to a value of 9 before the High pressure alarm is
deactivated. This variable is entered when configuring the tank point and cannot be modified from Operate

MOVEMENT ALARM

This variable is used to detect illegal product movements. If the tank command mode is 'Stopped' and the level
moves, in either direction, by more than the Movement High limit a ‘"Movement Alarm' is activated. By default the
movement alarm is based on change in product level, by editing the registry value:
HKEY_LOCAL_MACHINE\SOFTWARE\FuelsManager\DataManager\ UseNetVolumeForMvmntAlarm such that
the value equals 1. The movement alarm behavior will be based on change in Net Std. Volume, thus eliminating
false alarm caused by product temperature changes. This variable is entered when configuring the tank point
and cannot be modified from Operate

MOVEMENT HOLDOFF - MOVEMENT HOLDOFF TIME

This variable is the amount of time (in seconds) by which the level (or Net Std. volume) must exceed the
Movement alarm high limit before an alarm is activated. This variable is entered when configuring the tank point,
but can be modified from Operate by a user with sufficient privileges

REVERSE FLOW ALARM

This variable is used to detect product movements in the opposite direction to the selected tank command
mode. If the tank command mode is 'Filling' and the level falls then a 'Reverse Flow Alarm' is activated

REVERSE FLOW HOLDOFF - REVERSE FLOW HOLDOFF TIME

This variable is the amount of time (in seconds) by which the reverse flow condition must exist before an alarm
is activated. This variable is entered when configuring the tank point, but can be modified from Operate by a user
with sufficient privileges

NO FLOW ALARM

This variable is used to detect that product movement has stopped unexpectedly. If the tank command mode is
'Filling' or 'Emptying' and the flow value is zero then a No Flow Alarm' is activated

NO FLOW HOLDOFF - NO FLOW HOLDOFF TIME

This variable is the amount of time (in minutes) by which the no flow condition must exist before an alarm is
activated. This variable is entered when configuring the tank point, but can be modified from Operate by a user
with sufficient privileges

TEST MODE ALARM

This variable is used to generate an alarm if the tank command mode is selected to be 'Test'. The tank mode
can be commanded to 'Test' mode, this is used by the operator in order to disable all level alarms, typically used
during tank gauge maintenance. Enabling the Test Mode alarm ensures that an operator alarm will be generated
when the test mode is selected, thereby ensuring the mode is not selected accidentally.

LEAK RATE

This variable shows the statistically calculated rate of leakage from a specific tank
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LEAK DATA

Allows an Enable/Disable State. This alarm, when enabled, will alert every day at 12:00 AM to notify the operator
that there is not enough valid data or quiet time data from the configured tank to produce a valid Leak Test
Report

DIGITAL ALARMS - STANDARD TANK ALARM FLAGS

This variable is the current standard digital alarm statuses associated with the Tank. Available status are:
0x1-DB Config Error
0x2-Tank Calc Error
0Ox4-Strap Error
0x8-API Corr Error
0x10-Critical Zone
0x20-Movement Alarm
0x40-Reverse Flow
0x80-No Flow
0x100-ETA HiHi Level
0x200-ETA High Level
0x400-ETA LoLo Level
0x800-ETA Low Level
0x2000-Testing
0x4000-Trans Adv SetPt
0x8000-Trans SD SetPt

TANK MODE ALARM - COMPOSITE TANK MODE ALARM

This variable is a composite value that displays a coded variable representing the highest priority tank mode
alarms for the tank. Possible values are Normal, Movement Alarm, No Flow, Reverse Flow or Testing.
FuelsManager calculates this alarm based on the current product movement of the tank and the currently
operator selected tank mode

ALARM APl CORRECTION - API CORRECTION ERROR

This variable is a coded variable value that displays a status of either Normal or API Corr Error if the Density or
Temperature is outside of the range for the selected volume correction method

ALARM CALCULATION - CALCULATION ERROR

This variable is a coded variable value that displays a status of either Normal or Tank Calc Error if
FuelsManager is unable to perform the tank volume calculation due to an internal error

ALARM CRITICAL ZONE - LEVEL IN CRITICAL ZONE

This variable is a coded variable value that displays a status of either Normal or Critical Zone if the current tank
level is between the Fully Floating and Fully Landed heights

ALARM DAtabASE CONF - DAtabASE CONFIGURATION ERROR

This variable is a coded variable value that displays a status of either Normal or DB Config Error if
FuelsManager is unable to perform operation for this tank due to an internal configuration error

ALARM ETA HIGH LEVEL - HIGH LEVEL ETA ALARM
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This variable is a coded variable value that displays a status of either Normal or ETA High Level if the ETA High
level alarm is active (see above for details of ETA alarms)

ALARM ETA HIHI LEVEL - HIGH HIGH LEVEL ETA ALARM

This variable is a coded variable value that displays a status of either Normal or ETA HiHi Level if the ETA High-
High level alarm is active (see above for details of ETA alarms)

ALARM ETA LOLO LEVEL - LOW LOW LEVEL ETA ALARM

This variable is a coded variable value that displays a status of either Normal or ETA LoLo Level if the ETA Low-
Low level alarm is active (see above for details of ETA alarms)

ALARM ETA LOW LEVEL - LOW LEVEL ETA ALARM

This variable is a coded variable value that displays a status of either Normal or ETA Low Level if the ETA Low
level alarm is active (see above for details of ETA alarms)

ALARM MOVEMENT - FLOW (LEVEL CHANGE)

This variable is a coded variable value that displays a status of either Normal or Movement Alarm if the
Movement Alarm is active (see above for details of the Movement Alarm)

ALARM NO FLOW - NO FLOW

This variable is a coded variable value that displays a status of either Normal or No Flow if the No Flow alarm is
active (see above for details of the No Flow Alarm)

ALARM REVERSE FLOW - REVERSE PRODUCT FLOW

This variable is a coded variable value that displays a status of either Normal or Reverse Flow if the Reverse
Flow alarm is active (see above for details of the Reverse Flow Alarm)

ALARM TANK IN TEST - TANK IN TEST MODE ALARM

This variable is a coded variable value that displays a status of either Normal or Testing if the tank mode has
been set to Test by the operator. (see above for details of the Test Mode alarm)

ALARM XFR ADVISORY - TRANSFER ADVISORY ALARM

This variable is a coded variable value that displays a status of either Normal or Trans Adv SetPt if the current
tank transfer has reached the Transfer Advisory setpoint

ALARM XFR SHUTDOWN - TRANSFER SHUTDOWN ALARM

This variable is a coded variable value that displays a status of either Normal or Trans SD SetPt if the current
tank transfer has reached the Transfer Shutdown setpoint
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VARIABLE TYPE

FuelsManager variables are divided into eleven types, for each type of variable the user can configure the range
of the data and the engineering units. The range and engineering units are configured via the General tab of the
tank configuration dialog box. The range information is used as the default minimum / maximum values for
display objects like bar graphs and trends, in addition to the minimum / maximum values for operator command
dialog boxes

LEVEL MININIUM - TANK MINIMUM LEVEL SCALING

This variable is the minimum range for the level, water level, solids level, and gauge position process variables.
This variable can be viewed from the Operate interface but cannot be modified

LEVEL MAXIMIUM - TANK MAXIMUM LEVEL SCALING

This variable is the maximum range for the level, water level, solids level, and gauge position process variables.
This variable can be viewed from the Operate interface but cannot be modified

LEVEL MININIUM EMPTY - MINIMUM TANK EMPTY LEVEL

This variable is the minimum level to which the tank can be safely drained. This variable is entered when
configuring the tank point, it can viewed but cannot be modified via Operate

LEVEL MAXIMUM FILL - MAXIMUM TANK FILL LEVEL

This variable is the maximum level to which the tank can be safely filled. This variable is entered when
configuring the tank point, it can be viewed but cannot be modified via Operate

LEVEL UNITS - LEVEL ENGINEERING UNITS

This variable is the engineering units for the level, water level, solids level, and gauge position process
variables. This variable can be viewed from the Operate interface but cannot be modified

TEMPERATURE MININIUM - TANK MINIMUM TEMP SCALING

This variable is the minimum range for the tank temperature, ambient temperature, and vapor temperature
process variables. This variable can be viewed from the Operate interface but cannot be modified

TEMPERATURE MAXIMIUM - TANK MAXIMUM TEMP SCALING

This variable is the maximum range for the tank temperature, ambient temperature and vapor temperature
process variables. This variable can be viewed from the Operate interface but cannot be modified

TEMPERATURE UNITS- TEMPERATURE ENGINEERING UNITS

This variable is the engineering units for the tank temperature, ambient temperature and vapor temperature
process variables. This variable can be viewed from the Operate interface but cannot be modified

VOLUME MININIUM - TANK MINIMUM VOLUME SCALING

This variable is the minimum range for all tank volume process variables. This variable can be viewed from the
Operate interface but cannot be modified
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VOLUME MAXIMIUM - TANK MAXIMUM VOLUME SCALING

This variable is the maximum range for all tank volume process variables. This variable can be viewed from the
Operate interface but cannot be modified

VOLUME UNITS - VOLUME ENGINEERING UNITS

This variable is the engineering units for all tank volume process variables. This variable can be viewed from the
Operate interface but cannot be modified

MASS MININIUM - TANK MINIMUM MASS SCALING

This variable is the minimum range for all tank mass process variables. This variable can be viewed from the
Operate interface but cannot be modified

MASS MAXIMIUM - TANK MAXIMUM MASS SCALING

This variable is the maximum range for all tank mass process variables. This variable can be viewed from the
Operate interface but cannot be modified

MASS UNITS - MASS ENGINEERING UNITS

This variable is the engineering units for all tank mass process variables. This variable can be viewed from the
Operate interface but cannot be modified

DENSITY MININIUM - TANK MINIMUM DENSITY SCALING

This variable is the minimum range for the tank observed density process variable. This variable can be viewed
from the Operate interface but cannot be modified

DENSITY MAXIMIUM - TANK MAXIMUM DENSITY SCALING

This variable is the maximum range for the tank observed density process variable. This variable can be viewed
from the Operate interface but cannot be modified

DENSITY UNITS - DENSITY ENGINEERING UNITS

This variable is the engineering units for the tank observed density process variable. This variable can be
viewed from the Operate interface but cannot be modified

DENSITY STD MININIUM - TANK MINIMUM STD DENSITY SCALING

This variable is the minimum range for the tank corrected density process variable. This variable can be viewed
from the Operate interface but cannot be modified

DENSITY STD MAXIMIUM - TANK MAXIMIUM STD DENSITY SCALING

This variable is the maximum range for the tank corrected density process variable. This variable can be viewed
from the Operate interface but cannot be modified

STD DENSITY UNITS - STANDARD DENSITY UNITS

This variable is the engineering units for the tank corrected density process variable. This variable can be
viewed from the Operate interface but cannot be modified
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FLOW MININIUM - TANK MINIMUM FLOW SCALING

This variable is the minimum range for the tank flow process variable. This variable can be viewed from the
Operate interface but cannot be modified

FLOW MAXIMIUM - TANK MAXIMUM FLOW SCALING

This variable is the maximum range for the tank flow process variable. This variable can be viewed from the
Operate interface but cannot be modified

FLOW UNITS - FLOW ENGINEERING UNITS

This variable is the engineering units for the tank flow process variable. This variable can be viewed from the
Operate interface but cannot be modified

PRESS. VAPOR MININIUM - TANK MINIMUM VAPOR PRESSURE SCALING

This variable is the minimum range for the tank vapor pressure process variable. This variable can be viewed
from the Operate interface but cannot be modified

PRESS. VAPOR MAXIMIUM - TANK MAXIMIUM VAPOR PRESSURE SCALING

This variable is the maximum range for the tank vapor pressure process variable. This variable can be viewed
from the Operate interface but cannot be modified

PRESS VAPOR UNITS - VAPOR PRESSURE UNITS

This variable is the engineering units for the tank vapor pressure process variable. This variable can be viewed
from the Operate interface but cannot be modified

LEVEL RATE MININIUM - TANK MINIMUM LEVELRATE SCALING

This variable is the minimum range for the tank level change rate process variable. This variable can be viewed
from the Operate interface but cannot be modified

LEVEL RATE MAXIMIUM - TANK MAXIMIUM LEVELRATE SCALING

This variable is the maximum range for the tank level change rate process variable. This variable can be viewed
from the Operate interface but cannot be modified

LEVEL RATE UNITS - RATE OF LEVEL CHANGE UNITS

This variable is the engineering units for the tank level change rate process variable. This variable can be
viewed from the Operate interface but cannot be modified

MASS FLOW MININIUM - TANK MINIMUM MASS FLOW SCALING

This variable is the minimum range for the tank mass flow process variable. This variable can be viewed from
the Operate interface but cannot be modified

MASS FLOW MAXIMIUM - TANK MAXIMUM MASS FLOW SCALING

This variable is the maximum range for the tank mass flow process variable. This variable can be viewed from
the Operate interface but cannot be modified
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MASS FLOW UNITS - MASS FLOW UNITS

This variable is the engineering units for the tank mass flow process variable. This variable can be viewed from
the Operate interface but cannot be modified

VAPOR DENSITY MININIUM - TANK MINIMUM GAS DENSITY

This variable is the minimum range for the tank gas density process variable. This variable can be viewed from
the Operate interface but cannot be modified

VAPOR DENSITY MAXIMIUM - TANK MAXIMUM GAS DENSITY

This variable is the maximum range for the tank gas density process variable. This variable can be viewed from
the Operate interface but cannot be modified

VAPOR DENSITY UNITS - GAS DENSITY UNITS

This variable is the engineering units for the tank gas density process variable. This variable can be viewed from
the Operate interface but cannot be modified

LEAK RATE MINIMUM - TANK MINIMUM LEAK RATE
This variable sets the minimum leak rate that is detectable when running leak detection tests
LEAK RATE MAXIMUM - TANK MAXIMUM LEAK RATE

This variable sets the maximum leak rate that is allowed when running leak detection tests. Any rate above this
will result in an alarm (if configured) and the printing of the word ‘FAILED’ on leak reports

LEAK RATE UNITS - LEAK RATE UNITS

This variable sets the volumetric engineering units that is used during leak detection
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DETAIL

This parameter defines which tank detail template is to be displayed for this particular tank. If this value is not
defined, FuelsManager will use the tank detail template defined in the registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\FuelsManager\Detail\Tank

CORRECTION TYPE

These two parameters define the volume correction method to be used in the calculation of Std. Density and Net
Std. Volume. The selection made in the first parameter constrains the available options in the second parameter.
For example, if the user selects API°C, the second parameter is constrained to American Petroleum Institute
tables that are valid for temperatures expressed in °C.

STD TEMPERATURE

This parameter defines the temperature to which the gross volume value will be corrected. The majority of the
correction types define the standard temperature, for these types this field is for display only

KO - K5

These parameters are only visible when the correction type 'polynomial’ is selected, these parameters define the
constants to be used in the polynomial calculation

ALPHA

This parameter is available when an American Petroleum Institute table of type C (table 54C or table 6C) or a
Japan Chemical table is selected. This parameter defines the thermal co-efficient of expansion to be used in the
volume correction method

VCF ROUNDING

This parameter is only available when a Japanese correction type is selected. The rounding options are None,
0.0001, and 0.000001 and are applied to the Volume Correction Factor before all calculations are performed

LEVEL ROUNDING

This parameter is only available when a Japanese correction type is selected. The rounding options are None
and Nearest Integer. Level rounding is applied to the product level before performing each volume calculation

TEMPERATURE ROUNDING

This parameter is only available when a Japanese correction type is selected. The rounding options are None,
0.25, and 0.5. Temperature rounding is applied to the product temperature before performing each volume
calculation

WATER SUBTRACTION

This parameter is only available when a Japanese correction type is selected. The water subtraction options are
None, Gross Volume, and Net Volume. This parameter defines the method of Water Volume compensation.
Water Volume is either; not subtracted; subtracted in the calculation of Gross Volume; or subtracted in the
calculation of Net Volume, respectively
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VSW SUBTRACTION

This parameter is only available when a Japanese correction type is selected. The VSW subtraction options are
None, Gross Volume, and Net Volume. VSW is defined as the Volume associated with the percent BSW
(Bottoms Sediment and Water). This parameter defines the method of VSW compensation. VSW is either; not
subtracted; subtracted in the calculation of Gross Volume; or subtracted in the calculation of Net Volume,
respectively.

NET MASS

This parameter is only available when a Japanese correction type is selected. The Net Mass options are Mass,
Weight, Weight in a Pressure Tank, Idemitsu, and Food Oil. This parameter defines the method of Weight
calculation

MOLE CONSTANT

This parameter is only available when Idemitsu is selected for the Net Mass calculation. This parameter defines
the Mole Constant value used in the Idemitsu weight calculation

SAMPLES

This parameter is used, along with the 'Sample Time' and 'Deadband' parameters, in the averaging calculation
of Flow, Level Rate, Mass Flow, and Net Flow. It defines the amount of samples to be included in the average.
The same Sample parameter is used for Flow, Level Rate, Mass Flow, and Net Flow calculations

SAMPLE TIME

This parameter is used, along with the 'Samples' and '‘Deadband’ parameters, in the averaging calculation of
Flow, Level Rate, Mass Flow, and Net Flow. It defines the amount of time, in seconds, between the samples in
the average. The same Sample Time parameter is used for the Flow, Level Rate, Mass Flow, and Net Flow
calculations

DEADBAND

This parameter is used, along with the 'Samples' and Sample Time' parameters, in the averaging calculation of
Flow, Level Rate, Mass Flow, and Net Flow. The sample value must be greater than the deadband value
otherwise a sample value of zero will be used. The deadband parameter can be set independently for the Flow,
Level Rate, Mass Flow, and Net Flow calculations

FILTER

This parameter is used, to enable the averaging calculation of Flow, Level Rate, Mass Flow, and Net Flow. If the
filter parameter is not set, FuelsManager calculates the instantaneous value for the Flow, Level Rate, Mass Flow,
and Net Flow values. Averaging can be set independently for the Flow, Level Rate, Mass Flow, and Net Flow
calculations

LANDED HEIGHT

This parameter defines the height at which the floating roof is fully landed on it legs. At this point the volumetric
effect of the floating roof is zero, since it is no longer floating. The area between the Landed Height and the
Floating Height is known as the ‘Critical Zone'. FuelsManager only uses this parameter if the Roof type, Roof
Mass not in Strap is selected, otherwise this parameter is ignored

FLOATING HEIGHT
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This parameter defines the height at which the floating roof is fully floating on the product. At this point, the full
volumetric effect of the floating roof is applied to the volume calculations. The area between the Landed Height
and the Floating Height is known as the 'Critical Zone'. FuelsManager only uses this parameter if the Roof type,
Roof Mass not in Strap is selected, otherwise this parameter is ignored

ROOF MASS

This parameter defines the weight of the floating roof, this value is used together with the Roof Type selection,
current density and strapping density to calculate the volumetric effect of the floating roof

ROOF TYPE

This parameter defines the type of floating roof, possible values are:
¢ No Tank Roof - no floating roof correction.

* Fixed Roof - no floating roof correction.

* Roof Mass in Strap - roof mass is accounted for in the tank strapping table. FuelsManager corrects the roof
volume to compensate for the difference between the current product density and the density of the product
when the tank strapping table was created.

* Roof Mass not in Strap - the roof mass has not been included in the tank strapping table. FuelsManager
applies the volumetric effect of the roof to the volume correction calculations, in addition to compensating for
the difference between the current product density and the density of the product when the tank strapping
table was created.

« Kaiji-Kentei-Kyyokai see the Tank Calculations chapter for more details. Only available if a ‘Japan'
Correction Type is selected on the Edit Tank Data Volume tab

¢ Sin-Nihon-Kentei-Kyyoukail see the Tank Calculations chapter for more details. Only available if a '‘Japan’
Correction Type is selected on the Edit Tank Data Volume tab

¢ Sin-Nihon-Kentei-Kyyoukai2 see the Tank Calculations chapter for more details. Only available if a ‘Japan’
Correction Type is selected on the Edit Tank Data Volume tab

¢ Sin-Nihon-Kentei-Kyyoukai3 see the Tank Calculations chapter for more details. Only available if a 'Japan’
Correction Type is selected on the Edit Tank Data Volume tab

TANK GEOMETRY

This parameter defines the shape of the tank. FuelsManager uses this value to determine how to interpolate
between strapping points, possible values are: Vert. Cylinder, Horizontal Cylinder — End Caps; Horizontal
Cylinder — Flat Ends; Standard Sphere; Polynomial Sphere; Underground — End Caps; and Underground — Flat
Ends. Selecting Polynomial Sphere causes the strapping table tab of the tank configuration dialog box to change
to ‘Polynomial Sphere’

TANK VOLUME

This parameter is used for LPG volume correction methods and defines the total internal volume of the spherical
tank

TANK HEIGHT

This parameter is used for LPG volume correction methods and defines the total height of the sphere at the
point at which the automatic tank gauge is installed

TANK RADIUS
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This parameter is used for LPG volume correction methods and defines the radius of the sphere

SHELL THICKNESS

This parameter is used for LPG volume correction methods and defines the thickness of the sphere's shell
LINING MATERIAL

This piece of data stores the material that the tank is coated with on the inside of the tank

DATE INSTALLED

This variable stores the date that the tank was brought into service

TANK MATERIAL

If this parameter defines the material from which the tank shell is constructed. Different materials have different
thermal coefficients of expansion and hence expand or contract at different rates. The selection of tank material
will effect the calculated tank shell correction factor

TANK SHELL CORRECTION - EXPCOEF

This parameter defines the material expansion coefficient used in the tank shell correction calculations. Manual
entry of this value is not allowed except when the Tank Material is set to 'Other’

INSTALL TEMP

This parameter stores the outside ambient temperature when the tank was brought into service

CATHODIC PROTECTION

This variable denotes that this tank is fitted with Cathodic protection--used for reporting and information only
OVERFILL PROTECTION

This variable denotes that this tank is fitted with Overfill protection--used for reporting and information only
SPILL PROTECTION

This variable denotes that this tank is fitted with Cathodic protection--used for reporting and information only
TANK SHELL CORRECTION - ENABLE CORRECTION

If this option is selected FuelsManager compensates the Net Std. volume for the thermal expansion effects of the
tank shell. If the option is not selected the Tank Shell Correction factor equals 1, hence no correction

TANK SHELL CORRECTION - SHELL INSULATION

If this option is selected FuelsManager uses the insulated tank correction equation when compensating the Net
Std. volume for the thermal expansion effects of the tank shell. If the option is not selected the non-insulated tank
correction equation is used

TANK SHELL CORRECTION - AREACOEF

This parameter defines the shell area expansion coefficient used in the tank shell correction calculations.
Manual entry of this value is not allowed except when the Tank Material is set to 'Other’

PRESSURE TRANSMITTER SETUP
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These parameters define the position of the top, middle, and bottom offsets for the respective pressure
transmitters in Hydrostatic/Hybrid calculations

MINIMUM LEVEL
This parameter defines the lowest level of which Hydrostatic Hybrid tank calculations can be performed
DENSITY DEADBAND

This parameter defines the minimum change in density that will cause the Hydrostatic/Hybrid tank calculation to
be executed

LOCAL GRAVITY

Enables the entry of the earth’s gravity in meters/sec? at the tank’s specific location used in Hydrostatic/Hybrid
calculations

ELEVATION

Defines the elevation above sea level at the tank’s specific location, used in Hydrostatic/Hybrid calculations
LATITUDE

Defines the Latitude (in deg, mins, sec) of the tank’s specific location, used in Hydrostatic/Hybrid calculations
LEVEL OFFSET

Defines the offset value to be applied to the level calculations as part of the Hydrostatic calculations
MAXIMUM FILL

This parameter defines the maximum safe level to which the tank can be filled (see Level Maximum Fill).
FuelsManager uses this value in the calculation of remaining and available volume(s). The maximum fill level
can be:

e User Defined - user can enter any value

¢ High - maximum fill level is the same as the high level alarm limi
¢ High-High - maximum fill level is the same as the high-high level alarm limit

Note! Selecting the 'User Defined' option also enables the Maximum Operating limit level alarm. This alarm
functions independently of the High and High-High alarms and is intended to give an additional stage of level
alarm monitoring

MINIMUM EMPTY

This parameter defines the minimum safe level to which the tank can be drained (see Level Minimum Empty).
FuelsManager uses this value in the calculation of remaining and available volume(s). The minimum empty level
can be:

» User Defined - user can enter any value.

¢ Low - minimum empty level is the same as the low level alarm limit

¢ Low-Low - minimum empty level is the same as the low-low level alarm limit

Note: Selecting the 'User Defined' option also enables the Minimum Operating limit level alarm. This alarm functions independently of the Low
and Low- alarms and is intended to give an additional stage of level alarm monitoring
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GAUGE TYPE

This parameter defines the type of automatic tank gauge used by this tank. FuelsManager uses this parameter
for display only. This parameter can be viewed from the Operate interface but cannot be modified

GAUGE TYPE - MODIFIER

This parameter defines the commands available to the operator for a particular automatic tank gauge. For
example,\. Raise / Lower

FLOAT MASS

This parameter is used for LPG volume correction methods where float type automatic tanks gauges are used. It
defines the mass of the float, FuelsManager uses this to compensate the level value reported by the tank gauge

FLOAT DENSITY

This parameter is used for LPG volume correction methods where float type automatic tanks gauges are used. It
defines the density of the float. FuelsManager uses this to compensate the level value reported by the tank
gauge

FLOAT DIAMETER

This parameter is used for LPG volume correction methods where float type automatic tanks gauges are used. It
defines the diameter of the float. FuelsManager uses this to compensate the level value reported by the tank
gauge

STRAPPING TEMPERATURE

This parameter defines the temperature at which the tank strapping table was made. FuelsManager uses this
parameter to correct for roof volume in tanks where the mass of the floating roof has been accounted for in the
strapping table but the current temperature differs from that at which the tank was strapped

STRAPPING DENSITY

This parameter defines the density at which the tank strapping table was made. FuelsManager uses this
parameter to correct for roof volume in tanks where the mass of the floating roof has been accounted for in the
strapping table but the current density differs from that at which the tank was strapped

STRAP TABLE TYPE

This parameter defines whether the strapping table starts at the minimum and increments to the maximum level
/ volume pair (innage) or starts at the maximum level / volume pair and decrements to the minimum (outage)

STRAP/WATER TABLE MODE

This parameter defines the mode of Strap and Water tables used--Combined or Separated. Combined uses a
single table for both water and strap calculations. Separated uses individual tables for strap and water
calculations

POLYNOMIAL SPHERE

This parameter enables the special Polynomial Sphere strapping table when selected in Tank Geometry. The
Polynomial Sphere strapping table uses a polynomial equation to calculate volume based on level
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DESCRIPTION - POINT DESCRIPTION

This process variable is the name by which the input point is known to the user. This variable is entered when
configuring the input point, but cannot be modified via Operate

PROCESS VALUE - PROCESS VARIABLE OR SETPOINT

This process variable is the current value of the input point. This variable is usually linked to automatic tank
gauging systems, PLC's or DCS systems, but can also be manually entered by the operator

ALARM STATUS - COMPOSITE ALARM STATUS

This variable is a composite value that displays a coded variable representing the highest priority alarm for the
input point. Possible values depend on the format of the alarm definition associated with the input point.
FuelsManager calculates this alarm based on the current process value and the alarm definition configured for
the input point. This variable can be viewed from the Operate interface but cannot be modified

UNITS - ENGINEERING UNITS

This variable is the engineering units of the input point's process variable. This variable is entered when
configuring the input point, but cannot be modified via Operate

TIME - TIME OF LAST VALUE UPDATE

This process variable is the last time that the input point's process value was updated. This variable can be
viewed from the Operate interface but cannot be modified

TICKS - MILLISECONDS OF LAST UPDATE

This process variable is the number of milliseconds that have elapsed since input point's process value was
updated. This variable can be viewed from the Operate interface but cannot be modified

MAXIMUM - MAXIMUM SCALING VALUE

This variable is the maximum range for the input point's process value. This variable is entered when configuring
the input point, but cannot be modified via Operate

MINIMUM - MINIMUM SCALING VALUE

This variable is the minimum range for the input point's process value. This variable is entered when configuring
the input point, but cannot be modified via Operate
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DESCRIPTION - POINT DESCRIPTION

This process variable is the name by which the output point is known to the user. This variable is entered when
configuring the output point, but cannot be modified via Operate

OUTPUT - OUTPUT POINT COMMAND

This process variable is the value of the last command issued via this output point. This variable is usually linked
to automatic tank gauging systems, PLC's or DCS systems, and is used to send operator commands to field
devices (i.e. Open / Close, Start / Stop)

PROCESS VALUE - PROCESS VARIABLE OR SETPOINT

This process variable is the current value of the output point. This variable is usually linked to automatic tank
gauging systems, PLC's or DCS systems, but can also be manually entered by the operator

ALARM STATUS - COMPOSITE ALARM STATUS

This variable is a composite value that displays a coded variable representing the highest priority alarm for the
output point. Possible values depend on the format of the alarm definition associated with the output point.
FuelsManager calculates this alarm based on the current process value and the alarm definition configured for
the output point. This variable can be viewed from the Operate interface but cannot be modified

UNITS - ENGINEERING UNITS

This variable is the engineering units of the output point's process variable. This variable is entered when
configuring the output point, but cannot be modified via Operate

TIME - TIME OF LAST VALUE UPDATE

This process variable is the last time that the output point's process value was updated. This variable can be
viewed from the Operate interface but cannot be modified

TICKS - MILLISECONDS OF LAST UPDATE

This process variable is the number of milliseconds that have elapsed since output point's process value was
updated. This variable can be viewed from the Operate interface but cannot be modified

MAXIMUM - MAXIMUM SCALING VALUE

This variable is the maximum range for the output point's process value. This variable is entered when
configuring the output point, but cannot be modified via Operate

MINIMUM - MINIMUM SCALING VALUE

This variable is the minimum range for the output point's process value. This variable is entered when
configuring the output point, but cannot be modified via Operate
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Output Points - Process Data

DESCRIPTION - POINT DESCRIPTION

This process variable is the name by which the output point is known to the user. This variable is entered when
configuring the output point, but cannot be modified via Operate

OUTPUT - OUTPUT POINT COMMAND

This process variable is the value of the last command issued via this output point. This variable is usually linked
to automatic tank gauging systems, PLC's or DCS systems, and is used to send operator commands to field
devices (i.e. Open / Close, Start / Stop)

PROCESS VALUE - PROCESS VARIABLE OR SETPOINT

This process variable is the current value of the output point. This variable is usually linked to automatic tank
gauging systems, PLC's or DCS systems, but can also be manually entered by the operator

ALARM STATUS - COMPOSITE ALARM STATUS

This variable is a composite value that displays a coded variable representing the highest priority alarm for the
output point. Possible values depend on the format of the alarm definition associated with the output point.
FuelsManager calculates this alarm based on the current process value and the alarm definition configured for
the output point. This variable can be viewed from the Operate interface but cannot be modified

UNITS - ENGINEERING UNITS

This variable is the engineering units of the output point's process variable. This variable is entered when
configuring the output point, but cannot be modified via Operate

TIME - TIME OF LAST VALUE UPDATE

This process variable is the last time that the output point's process value was updated. This variable can be
viewed from the Operate interface but cannot be modified

TICKS - MILLISECONDS OF LAST UPDATE

This process variable is the number of milliseconds that have elapsed since output point's process value was
updated. This variable can be viewed from the Operate interface but cannot be modified

MAXIMUM - MAXIMUM SCALING VALUE

This variable is the maximum range for the output point's process value. This variable is entered when
configuring the output point, but cannot be modified via Operate

MINIMUM - MINIMUM SCALING VALUE

This variable is the minimum range for the output point's process value. This variable is entered when
configuring the output point, but cannot be modified via Operate
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UNIT NAME

Square 16ths of an Inch
Square Centimeters
Square Feet

Square Inches

Square Kilometers

Square Meters

Square Miles
Square Millimeters

Square Yards

ABREW.

16th?

INDEX

34

31

36

35

33

32

38
30

37

Metric English
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UNIT TYPE UNIT NAME ABREV. INDEX Metric English
Density Degrees API ° API 191
Degrees Balling ° Balling 198
Degrees BRIX ° BRIX 194
Degrees Heavy Baume °Ba (h) 196
Degrees Light Baume °Ba (l) 195
Degrees Twaddell °Tw 197
Grams per Cubic Centimeter g/cm3 180
Grams per Cubic Liter g/L3 182
Grams per Cubic Milliliter g/mL3 181
Kilograms per Cubic Liter kg/L3 184
Kilograms per Cubic Meter kg/m3 183 v
Percent Plato % Plato 193
Pounds per Barrel (Liquid) Ib/bbl (lig) 190
Pounds per Barrel (Oil) Ib/bbl (oil) 189
Pounds per Cubic Foot Ib/ft3 186
Pounds per Cubic Inch Ib/in3 185
Pounds per Imperial Gallon Ib/gal (UK) 188
Pounds per U.S. Gallon Ib/gal (US) 187 v
Short Tons per Cubic Yard ton(s)/yd3 199
Specific Gravity sp gr 192
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UNIT NAME

Bushel

Cycles per Second

Parts per Million

Percent Humidity

Percent Oxygen

Percentage

pH Factor

Relative Humidity

Revolutions Per Minute
Centipoise

Cubic Feet per Pound
Percent Steam Quality
Percentage of Solids by Volume
Percentage of Solids by Weight
Proof Mass

Proof Volume

Amperes

Capacitance (Farad)
Conductance (mho)
Conductance (Micro-Siemens)
Conductance (Siemens)
Coulomb

Inductance (Henry)

Milliamps

Millivolts

Power Factor

Resistance (Ohms)

Volts

ABREV.

bushel
Hz

PPM
%H
%02

%

pH

RH
RPM
centp
ft3/lb
%quality
%sol-vol
%sol-wt
pr mass
pr vol

A

=

mho

uS

mA
mV
P.F.

ohm

INDEX

244
233
235
236
237
234
239
238
232
240
247
243
242
241
246
245
223
225
230
228
229
226
227
222
220
231
224
221

Metric English
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UNIT TYPE UNIT NAME ABREV. INDEX Metric English
Energy British Thermal Unit (IT) BTU 200
Calorie cal 201
Joule N 202 v
Kilowatt Hour KWH 204 v
Watt Hour WH 203
Length 16ths of an Inch 16th 024
Centimeters cm 021
Feet ft 026 v
Feet-in-16th ft-in-16 027
Feet-in-8th ft-in-8
Inches in 025
Kilometers km 023
Meters m 022 v
Mile (statute) mi 029
Millimeters mm 020
Yard yd 028
Mass English Tons ton (e) 065
Gram g 060
Kilogram kg 061 v
Long Tons ton (1) 067
Metric Tons ton (m) 062
Ounce oz 063
Pound Ib 064 v
Short Tons ton (s) 066
Pounds (thousands) Mlbs 068
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Mass Flow Rate Grams per Hour g/hr 145

Grams per Minute g/min 144

Grams per Second g/sec 143

Kilograms per day kg/day 149

Kilograms per Hour kg/hr 148

Kilograms per Minute kg/min 147

Kilograms per Second kg/sec 146 v

Long Tons per Day ton(l)/day 142

Long Tons per Hour ton(l)/hr 141

Long Tons per Minute ton(l)/min 140

Metric Tons per Day ton(m)/day 136

Metric Tons per Hour ton(m)/hour 135

Metric Tons per Minute ton(m)/min 134

M pounds per Day
M pounds per Hour
M pounds per Minute

M pounds per Second

Pounds per Day Ib/day 133
Pounds per Hour Ib/hr 132
Pounds per Minute Ib/min 131
Pounds per Second Ib/sec 130 v
Short Tons per Day ton(s)/day 139
Short Tons per Hour ton(s)/hr 138
Short Tons per Minute ton(s)/min 137
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UNIT NAME

BTU (IT) per Hour
BTU (IT) per Minute
BTU (IT) per Second
Calories per Minute

Horsepower

KiloVolt-Ampere
Kilowatt

Watt

Atmosphere

Bar

Feet of Water (@68°F)

Grams per Square Centimeter
Inches of Mercury (@ 0°C)
Inches of Water (@ 68°F)
Kilograms per Square Centimeter
Kilopascal

Millibar

Millimeters of Mercury (@ 0°C)
Millimeters of Water (@ 68 °F)

Pascal

Pounds per Square Foot

Pounds per Square Inch

Pounds per Square Inch -
Absolute

Pounds per Square Inch - Gage

Torr (@ 0°C)

ABREV.

BTU/hr
BTU/min
BTU/sec
cal/min

HP

kVA
kW
W

atm
bar

ft H20
g/cm2
in Hg
in H20
kg/cm2
kPa
mbar
mm Hg
mm H20
Pa

Ib/ft2
PSI

psia

psig
torr

INDEX Metric English
212

211

210

213

217 v

216
215
214 v

086
081
077
085
078
076
072
071
082
083
084
070 v

079
073 v

075

074
080
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UNIT TYPE UNIT NAME ABREV. INDEX Metric English
Temperature Degrees Centigrade °C 001 v
Degrees Fahrenheit °F 002 v
Degrees Kelvin Kelvin 003
Degrees Rankine °R 004
Time Days days 009
Hour hr 008
Milliseconds
Minute min 007
Seconds sec 006 v v
Weeks wks 010
Month mon 011
Years yrs 012
Velocity Centimeters per Second cm/sec 164
Feet per Minute ft/min 162
Feet per Second ft/sec 161 v
Inches per Second in/sec 160
Kilometers per Hour KPH 169
Knots KNOT 170
Meters per Hour m/hr 168
Meters per Minute m/min 166
Meters per Second m/sec 165 v
Miles per Hour MPH 167
Millimeters per Minute mm/min
Millimeters per Second mm/sec 163
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UNIT TYPE UNIT NAME ABREV. INDEX Metric English
Volume Barrels of Liquid bbl (Liq) 049
Barrels of Oil bbl (Oil) 048
Cubic Centimeter cc 040 v
Cubic Feet ft3 044 v
Cubic Inch in3 043
Cubic Meter m3 041
Cubic Yard yd3 045
Imperial Gallon gal (UK) 047
Liter L 042
Kiloliters ki 050
U.S. Gallon gal (US) 046
Volumetric Flow Barrels per Day (Liquid) BPD (Liq) 122
Rate Barrels per Day (Oil) BPD (Qil) 118
Barrels per Hour (Liquid) BPH (Liq) 121
Barrels per Hour (Oil) BPH (Oil) 117
Barrels per Minute (Liquid) BPM (Liq) 120
Barrels per Minute (Oil) BPM (Oil) 116
Cubic Centimeters per Hour cc/hr 091
Cubic Centimeters per Minute cc/ min 090
Cubic Feet per Day ft3/day 105
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UNIT NAME

Cubic Feet per Hour
Cubic Feet per Minute

Cubic Feet per Second

Cubic Inches per Hour
Cubic Inches per Minute
Cubic Meters per Day
Cubic Meters per Hour
Cubic Meters per Minute

Cubic Meters per Second

Cubic Yards per Hour

Cubic Yards per Minute
Gallons per Hour (US)
Gallons per Minute (US)
Gallons per Second (US)
Imperial Gallons Per Hour
Imperial Gallons per Minute
Imperial Gallons per Second
Kiloliters per Day

Kiloliters per Hour

Kiloliters per Minute
Kiloliters per Second

Liters per Hour

Liters per Minute

Liters per Second

Million Liters per Day

Million Gallons per Day (US)
Million Gallons per day (UK)

Millions of Barrels per Day
(Liquid)

Millions of Barrels per Day (Oil)

ABREV.

ft3/hr
ft3/min
ft3/sec

in3/hr
in3/min
m3/day
m3/hr
m3/min
m3/sec
yd3/hr
yd3/min
gph (US)
gpm (US)
gps (US)
gph (UK)
gpm (UK)
gps (UK)

L/hr
L/min

L/sec

MBPD (Liq)

MBPD (Oil)

INDEX
104
103
102

101
100

094
093
092

107
106
110
109
108
114
113
112

098
097
096

123

119

Metric English
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Point format

The storage formats available only to Input and Output points are listed below. All Tank points are of a fixed data

format.
STORAGE TYPE

Character
Byte
Short
Word
Coded
Long
Dword
Float
Double
Time & Date
Time

Date

User Defined String

ADMO03GVAE1005

FORMAT

8 Bit Signed

8 Bit Unsigned

6 Bit Signed

16 Bit Unsigned

16 Bit, Index to Coded Variable
32 Bit Signed

32 Bit Unsigned

4 Byte Floating Point

8 Byte Double Precision Floating Point
8 Byte Time & Date

8 Byte Time Only

8 Byte Date Only

16 Bit Index to User String

RANGE

-128 to 127

0 to 255

-32768 to 32767

0 to 65535

0 to 65535
-2,147,483,648 to 2,147,483,647
0 to 4,294,967,295
3.4 E +38 (7 digits)
1.7 E + 308 (15 digits)
NA

NA

NA

0 to 65535

383



Coded Variables

Coded Variables

This list contains all the standard coded variables that came with your FuelsManager system. The standard
FuelsManager variables and their corresponding codes are listed below:

1.

N N N N N N NN P B R B B B B R R R
N o 00 W N P O © 0N O o0 M w N P oo

January

. February
. March
. April

May

. June
. July
. August

. September

. October

. November

. December

. Sunday

. Monday

. Tuesday

. Wednesday

. Thursday

. Friday

. Saturday

. Normal

. Alarm

. DB Config Error
. Tank Calc Error
. Acknowledged

. Unacknowledged
<

>
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28.
29.
30.
31.
32.
33.
34.
35.
36.
37.
38.
39.
40.
41.
42.
43.
44.
45.
46.
47.
48.
49.
50.
51.
52.
53.
54.

Abort

Active

Adv Low
Adv High
Advisory Low
Advisory High
All

Auto
Automatic
Average
Both

Bottom
Cascade
Clear

Close
Closed
Closing

Cool
CoolDown
Days
Decrease
Decreasing
Default
Direct
Disable 1/0
Disable Input

Disable

55
56

57.
58.
59.
60.
61.
62.
63.
64.
65.
66.
67.
68.
69.
70.
71.
72.
73.
74.
75.
76.
77.
78.
79.
80.
81.

. Disabled

. Down

Early

Emer Shutdown
Enable I/O
Enable Input
Enable
Enabled
Error
Executing
Extend
Failure
Failed

False

Fault

Flow

Force
Forced
Halted

Halt

Heat & Cool
Heat

Strap Error
API Corr Error
High
High-High
Hold

82. Holiday

83. Hour

84. Hours

85.In

86. Inactive

87. Increase

88. Increasing
89. Indirect

90. Initialize

91. Kill

92. Late

93. Left

94. Load

95. Local

96. Locked

97. Lock

98. LOS

99. Loss of Signal
100.Critical Zone
101. Movement Alarm
102. Low

103. Low-Low
104. Lower

105. Lowering
106. Lowered
107. Man

108. Manual
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109. Minutes
110. Month
111. No Flow
112. No

113. Not Ready
114. O/R

115. Off Line
116. Off

117. On Line
118. On

119. Open
120. Opened
121. Opening
122. Out

123. Override
124. OverRange
125. Over
126. Parallel
127. Pressure
128. Primary
129. Raise
130. Raised
131. Raising
132. Ramp
133. Ready
134. Remote
135. Reset
136. Resume
137. Reverse

138. Right

139.
140.
141.
142.
143.
144.
145.
146.
147.
148.
149.
150.
151.
152.
153.
154.
155.
156.
157.
158.
159.
160.
161.
162.
163.
164.
165.
166.
167.
168.

Run

Running
Secondary
Seconds
Series
Shutdown
Start Sequence
Start

Starting

Stop Sequence
Stop
Stopping
Summer
Timeout
Timed Out
Top
Transitional
Transfer
Transfer In
Transfer Out
Transferring
Trip

Tripped

True

U/R
Unauthorized
UnderRange
Under
Unload
Unlocked

169.
170.
171.
172.
173.
174.
175.
176.
177.
178.
179.
180.
181.
182.
183.
184.
185.
186.
187.
188.
189.
190.
191.
192.
193.
194.
195.
196.
197.
198.

Unlock

Up

Vacuum

Valid

Warmup

Week

Winter

Xfr by Volume
Xfr by Level
Year

Yes

I/O Failed

I/O Disabled
Reverse Flow
Trans Adv SetPt
Trans SD SetPt
Scan Failure
Gauge I/O Fail
Device Alarm
Field Cfg Modif
Raise Failure
Lower Failure
Upload Failure
DnLoad Failure
Raise Head
Lower Head
Run Immed Prof
Follow Witr Lvl
Find Wtr Lvl

Find Datum

199.
200.
201.
202.
203.
204.
205.
206.
207.
208.
2009.
210.
211.
212.
213.
214.
215.
216.
217.
218.
2109.
220.
221.
222.
223.
224.
225.
226.
227.
228.

Stowed
Seeking Level
Doing Profile
Doing Dip
Finding Water
Following Water
Finding Datum
Following Level
Servo

NC

One Hour
Eight Hours
One Day

One Week
One Month
Last Value
Goto Zero
Goto Full Scale
Hand

Invalid
Midnight

Time of Day
Process

Fill

Filling

Empty
Emptying

Test

Testing

Stopped
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229. Xfr by Diff.Vol 252. L&J Slave 275. Enhanced 298. Port 1 Fail
230. In Progress 253. Enraf Master 276. Follow Level 299. Port 2 Fail
231. Advisory 254. Enraf Slave 277.LON 300. Print

232. Complete 255. GPP 278. MTS Master 301. Printer

233. Overfill 256. GPU 279. Measure 302. V1 Master
234. Minimum 257.CIU 280. Set Time 303. Rackbus Master
235. Maximum 258. Block 281. Start Leak Mode 304. Upper Int Level
236. RTU Master 259. Freeze 282. Stop Leak Mode 305. Mid Int Level
237. RTU Slave 260. Lock Test 283. ETA HiHi Level 306. Upper Density
238. TIWAY Master 261. Get ID 284. ETA High Level 307. Middle Density
239. TIWAY Slave 262. Set Gauge Data 285. ETA Low Level 308. Bottom Density
240. MODBUS Master 263. Get Stored Data 286. ETA LoLo Level 309. Rel Over Tens
241. MODBUS Slave 264. Rejected 287. DB Empty 310. Calibration Act
242. HART Master 265. Auto Configure 288. Not Programmed 311. Shipment

243. HART Slave 266. Redundant 289. DB Download 312. Receipt

244, Peer to Peer 267. Independent 290. Programming 313. Water Drain
245. Local Diag 268. Download 291. Leak Probe 314. Run Down
246. IMUX Master 269. Upload 292. Generic Gauge 315. Charge

247. IMUX Slave 270. Whessoe Bus 293. GPE Master 316. Blend

248. LRC 271. TSU Slave 294. Out of Service 317. Monitor

249. CRC 272. AB Slave 295. AC

250. Passive 273. AB Master 296. DC

251. L&J Master 274. Standard 297. Fifteen Minutes
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Modifiers

The standard FuelsManager modifiers are listed below. Modifiers are used when the coded variable data format
type is selected. The user can select a modifier from the available list or create a custom modifier.

MODIFIER NAME COMMAND  COMMAND  COMMAND  COMMAND  COMMAND  COMMAND 10\ 1 2
1 2 3 4 5 6

Active/Inactive Active Inactive
Enable/Disable  Enable Disable
Manual/Off/Auto  Manual Off Auto
Manual/Auto Manual Auto
On/Off On off
Open/Close Open Close
Raise/Lower Raise Lower
Run/Stop Run Stop
Start/Stop Start Stop
Start/Stop/Reset ~ Start Stop Reset
Trip/Reset Trip Reset
Up/Down Up Down
Fill Mode Inactive Xfr by Xfr by Xfr by Diff  Xfr by Xfr by Diff

Level Volume Vol Mass Mass
Tank Mode Stop Fill Empty Run Test Reset
ITG 60/70 Raise Head Lower Clear Run Follow Wtr  Find Wtr Find Datum

Head Immed Lvl Lvl

Prof

ITG 50 Raise Head Lower

Head
Tank Mode 2 Stop Fill Empty Run Test Reset Out of Service
NMS530 Follow Raise Stop Upper Int.  Upper Reset

Level Level Density
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Tank strapping table

The file format defined below is the format of strapping table files exported by FuelsManager.

874969854, (09/22/97 19:10:54)

Vol Test Tank 6B (fixed

roof),

27,46,64, (Level Units = ft/inch/16th, Volume Units = U.S.
Gallon, Mass Units = Pound)

0, (Roof Mass)

60, (Strap Temperature)

50, (Strap Density)

5 (Pin Height aka Critical Low)

7, (Critical Zone aka Critical High)

21, (21 of strapping entries)

0-00-00, 0.00, (Entry #1)

0-01-00, 2085.00, (Entry #2)

0-02-00, 4212.00, (Entry #3)

0-03-00, 6250.00, (Entry #4)

0-06-00, 12512.00, (Entry #5)

0-10-00, 20813.00, (Entry #6)

1-00-00, 25015.00, (Entry #7)

2-00-00, 50123.00, (Entry #8)

3-00-00, 75045.00, (Entry #9)

4-00-00, 100000.00, (Entry #10)

6-00-00, 150762.00, (Entry #11)

10-00-00, 250094.00, (Entry #12)

11-06-00, 287645.00, (Entry #13)

12-00-00, 300184.00, (Entry #14)

20-00-00, 500003.00, (Entry #15)

23-00-00, 575034.00, (Entry #16)

27-00-00, 675111.00, (Entry #17)

30-00-00, 750197.00, (Entry #18)

35-00-00, 875096.00, (Entry #19)
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36-00-00,900000.00, (Entry #20)
40-00-00, 1000000.00  (Entry #21)
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Index

A

Actions Menu, 33
ACTIVE, 154

Active Mode, 52

Active Tank, 198
Adding Pages, 211
Administrative Tools, 17
Administrator, 18

Alarm, 114

Creating, Deleting or
Renaming, 34

Defining Properties, 36

Edit Test, 81

Limit Enable, 77

Limits, 76

Other Types, 117

Properties, 36

Specialized, 117

Test Parameter, 79

Test Value, 80

Alarm Graphic
Assigning, 78
Alarm Graphic and Alarm
Help, 77
Alarm Process
Build, 78
Alarm Template, 77
Alarm Test
Build, 79
Alarm/Event
Category, 78

Alarms, 21, 70
Configuring alarms, 72
Leak Detection, 249
Pre-configured, 71

Analytical data
Tank Calculation, 315

Append
Command, 181
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Detail, 182
Graphic, 182
Help, 182
Report, 182

Archival Data Source
Adding or Connecting to
an, 159

Archive
Input and Output Points, 161
Specify Archive Points, 161

ArchiveManager, 27, 158, 244
schedule, 161
Setting the Schedule, 161

Asphalt Tables, 279
Attributes, 190
Auto Start Mode, 52

Automate Run File Generation
“Build All” Option, 217
“Do Selected” Option, 217

Automated Data Output, 264
Configuration dialog, 266
Configuring, 270
Sample output files, 271

Automatic mode, 16
Autorun, 8

B
Background Color, 171
Background Mode, 171

Backup
Project, 257

Bar Graph, 178
Batch Compile, 11
Batch Run Files, 10
Bitmap, 183

Blend
Movement Type, 221

Bottom Sediment Water

Correction Method, 289

Brush
Attributes, 172
Box, 170

Build All, 194
Button, 180

C
Calculated Value, 87

Calculations
Hybrid, 313
Hydrostatic, 313

Categories
alarm, 34
tag, 34

Center, 173

Charge
Movement Type, 221

Checksums
Weights and Measures, 328

Chemical tables, 278
Client, 14

Coded Variable
Creating, 62
Deleting, 62

Coded Variable to Numeric
Lookup Table, 137

Coded Variables, 61
Importing, 62

colors
User Defined, 174

Column Totals, 206

Comm data source
selecting, 134

CommManager, 26, 87
Functions, 26

communication drivers, 3
Communications
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Weights and Measures
Seals, 328
Communications Interface
Configuration, 148
Communications Menu, 148

Condition
Index, 195
Configuration, 28, 50
Exiting, 50
Working with, 50
Configuration Parameters
Tank Point, 315
Continuous AnalysisTank
analysis types, 242

continuous data, 20

coordinates
Displaying mouse
coordinates, 173
Copying Single Objects, 191
Correction Method
Assignment Options, 57

Correction Methods
Japanese, 288, 291, 293
Correction volume, 290
Creating
A Modifier, 63
Labels in a Summary
Report, 204
Reports, 11
Tables in a Dynamic
Report, 209
Totals and Averages, 210
Values in a Dynamic
Report, 210

Current Tank, 198

D

Data Access
OPC, 90

Data Format, 88
Data Rounding, 274
Data source, 86

392

archival, 159, 160
Assigning, 130
Clearing, 133
Data sources
bit field, 140
Database
Input and Output points, 64
Inserting a Value, 177
Multiple, 21
Real-Time, 21
Real-time, 159
Storage, 26
Time, 26

Database 10 Connections, 131

Database is Corrupt
message, 259

Database Point
Add Point, 94

Database Points
input and output points, 97

Database points
creating, 93

DataManager, 26
Functions, 26

Default, 288, 291, 292
Mass, 296

Default Font, 212

Definition Modes
Strap, 129

Definitions
Movement, 225

Destinations
Movement, 234

Detail
folder, 14

Detail Mode, 12
Device configuration, 151

devices
locked, 151

Dial Up Modem, 150

Dialog box
Add Point to Database, 96

Alarm Assignments, 76
Batch Compile, 10
Coded Variables
Configuration, 62
Communications Interface
Configuration, 148
Database Edit, 84, 93, 95
Database 10
Connections, 130
Device Configuration, 151
Edit Point, 105
Edit String, 60
Graphic Files, 64
Help Files Configuration, 65,
66
Import / Export Data
Type, 142
Modifiers Configuration, 63
Open Graphic File, 12
Point Copy /Rename, 145
Select Data Source, 132
Start Definitions, 66
Summary report Setup, 202
Table Format, 203

Directories
File, 54
FMTools, 54
subdirectories, 54
ViewRTU, 55

Directory
Program, 54

Disconnecting from an Archival
Data Source, 160

Display grid
Graphics, 172

Do Selected, 194

Draw, 29, 168
Buttons, 64
Exiting, 168
Graphics, 10, 12
Keyboard Shortcuts, 196
Label Tool, 177
Menu, 10
Toolbar, 169
Window, 169

Drawing
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Arc, 177
Ellipse, 176
Line, 175
Polygon, 176
Polyline, 176
Rectangle, 176
Space, 169
Tool Icons, 170

Dynamic Condition
Assigning, 185
Defining, 184

Dynamic Report
Creating Labels, 209

E

Edit Tank Data dialog box
Alarm tab, 117
Alarms tab, 114
General tab, 108
Polynomial Sphere tab, 125
Process Data tab, 112
Strap/Water Table tab, 127
Vessel tab, 119, 124
Volume tab, 109

Editing Techniques, 190
Engineering Units
Conversion, 136

Data, 361
Source Units, 136

EOM Backup
ArchiveManager, 162

Error messages
update utility, 259

Event, 70
Definition, 78
Log, 47
Logging, 22

Excel
Start Definitions, 66

Exporting
Movement data, 238

F
File directories, 55
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file directories, 54

file names
Help, 64

Flow, 318

Flow calculations
Tank Calculations, 318

FMDataManager, 25
FMSystemManager, 25

Font
Default, 171

Food Oil Method, 297

G

Generated Reports
Deleting, 217

Generating files, 193
Generating Multiple Files, 193

Global Alarm
Definition, 75
Export, 81
Import, 81

Global Alarms, 73
Creating and Modifying, 75
Sharing, 77

Graphic
Adding a File Name, 64
Creating, 175
creating, 168
file names, 63
folder, 14
Graphics or symbols, 174
Index, 64, 194
Opening, 175
Operate, 169

Grid, 173
Display, 172

Gross Observed Volume, 291

Group
Adding Users, 41
Creating Deleting and
Renaming, 40
Deleting a Movement
Group, 235

Groups, 38
Defining Movement
Groups, 235
H

Hardware Key, 2, 6
Headers and Footers, 212

Help
Text Help, 64
Windows Help, 64

Help File
Adding, 66

Horizontal, 172
Hybrid Tank Calculations, 311

Hydro
Definition Mode, 129

Hydrostatic Calculations, 311

I
I/O Points, 153
Importing

Movement Data, 238
Inactive Tank, 198
Independent System Files, 25

Index
Product Index, 56

Indicator
Weights and Measures, 334

Input Point, 85
Process Data, 371
Records, 166

Input Source
triggered point, 104
Input/Output Point
Variable Format, 98
input/output point
Details, 99
Input Sources, 100

Install
CD-ROM, 2
Install Wizard, 8
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Installing FuelsManager, 7
Modifying, 9
Upgrading from 4.3, 10

Interface
Communications interface
mode, 154
Locked interfaces, 151

interface
creating new
communications, 149

Inventory Management, 4
Inventory Reports, 198

J

Japanese Correction
Methods, 296

K
Kaiji-Kentei-Kyoukai, 294
Keyboard Template, 2

L
Label, 199
LAT Terminal Server Port, 150

Leak Detection, 71, 129, 240
Edit Tank Data dialog, 252

Level, 274
Rate, 318

Licensing Options, 4
liquid density
from LPG Quantity, 300
Liquid Hydrocarbon Gas
Table, 279

Local

Alarms, 75

Input, 87

selecting a local data

source, 135

Serial Port, 150
Logic

Weights and Measures, 336
Lookup Tables

394

translation table, 137

LPG calculation
Quantity, 300
Sample, 308

M

Maintenance, 154
Communications, 154

Major, 173

Major Div, 173

Make, 194

Managing files
Draw files, 192

Manual
Data Source, 87
data source, 133
Input, 87

mass
Available Mass, 298

Mass Analysis
Leak Detection, 241

Mass Flow, 318
Master System Files, 25

Measured Data
Tank Calculation, 315

Merging Files, 192
Message Window, 170

Meter Node
Adding, 233
Movement, 225

Microsoft Software
Development Kit, 65

Mode
Auto Start, 52
Current, 52

Modifier Assignment, 88
Modifiers, 63, 387

Module Seall
Weights and Measures, 322

Modules

Weights & Measures
Seals, 335
Movements, 225
Editing, 236
Movement Groups, 235
Movement Types, 221
Multiple Objects
Moving, Deleting, and
Copying, 191

N

Nederlands Meetinsituut
Weights and Measures, 322

Net Flow, 319
Networking, 13

New Product definitions
Creating a, 56

Next, 190

Node
Meter, 233
Tank, 231

Nodes
Defining, 231
Deleting, 236
Exporting, 238
Importing, 238
Modifying, 236
Unit, 232

Numeric to Numeric
Lookup Table, 137

O

Object
Deleting, 190
Displaying object
coordinates, 173
Resizing Objects, 192
Offset, 172
On-Line
Configuration, 21
Help, 22
OPC, 87,90
Matrikon OPC Tag Studio, 91
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Selecting an OPC data
source, 135

Server Source, 88

server support, 90

Open, 12
Open Graphic File, 12
OPERATE, 28
Operating Tank, 198
Operator

group rights, 40
Optional Drivers, 3

Output Destinations
Triggered point, 103

Output File
HTML File, 265
Periodic File, 265
Snapshot.CSV, 271
Test.HTML, 271
Testxml.xml, 271
XML File, 265

Output Point, 85
Process Data, 372, 373

P

Pages, 211
Deleting, 211

Parallel Key, 6
Parameters Mode, 188

Password
W&M Password, 338

Pen, 170

Pen Attributes
Default, 171

Permissions, 43

System, 42
Petroleum tables, 275
Physikalisch-Technische

Bundesanstalt
Weights and Measures, 322

Point
export a point file, 143
I/O Point connections, 152
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import a point file, 143
RTU Sealing, 324
Variables, 162

Point Format, 383

Point Variable, 163
Adding to
ArchiveManager, 163
Deleting, 164
editing, 163

points
copying, 144
importing and exporting, 142

Polynomial, 280
Polynomial Sphere, 125
Pre 1980, 291, 293
Previous, 190

Print Times, 213

Printer
Network, 15

Printers, 15

Process Data, 112
Leak Detection, 248

Process Variable
Weights and Measures, 331,
332

Product and Water Tables
Combined, 284
Separated, 287

Product Configuration, 56

Product Definition
Edit, 57
Importing/Exporting, 59

Product Transfer data, 352

Products
Defining, 56

Professional Edition, 4

Project
folder, 14

Purging Files, 192

R

Real-Time Analysis

Tank analysis types, 242
Receipt

Movement Type, 222

Records
ArchiveManager, 164

Redrawing, 191

Regenerating, 10
Graphics and Symbols, 10
Tank Details, 11

remote systems, 30
REPORT, 29
ReportManager, 15, 27

Reports, 198
Deleting, 217
Editing, 214
Exiting, 198
folder, 14
Formatting, 211
Layout, 212
Managing, 215
Opening, 214
Regenerating, 11
Saving, 216
Standard Pre-defined, 198
Status, 213

Resources, 56

Restrictions
|/O Points, 152

RTU
Weights and Measures, 322

Run modes
setting, 51

Run-Down
Movement Type, 222

S

Sample Interval
Setting, 246

Save Options
Graphics, 172
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Saving Files, 192
Scale limits, 86
Scaling, 361

Scaling Functions, 139
translation table, 137

Seal
Changing Seal State, 336
Process Variable W&M, 331

Seals
System Seals, 339
W&M Software Seals, 330

Security, 32
Leak Detection, 243

Selection
Alarm and Tag, 42

Server, 13

Server Tags
OPC, 91

Service, 16

Shin-Nihon-Kentei-
Kyoukai, 294, 295

Shipment
Movement Type, 222

Shutdown, 25
Shutdown Mode, 52
Source Points, 144

Sources
Movement, 234

Standard Density
Assignment Options, 57

Standard Edition, 4
STANDBY, 154
Standby Mode, 52

Start Definition
Creating, 67

Start-up, 25

Static Analysis
Tank analysis types, 242

Stopping FuelsManager, 17
Strapping, 127
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Strapping Tables
Definition Mode, 129
Product and Water, 284
Strap Table Volume

(TOV), 281

String
Creating, 60
Deleting or editing, 60
Importing, 61
Importing/Exporting
information, 61

Strings, 59

Summary Report
Creating a table, 203
Creating Values, 204
Object Functions, 201

Symbol, 10
Creating, 175, 180
Index, 180, 194
Opening, 175
Placing in a Graphic, 180

symbol
opening, 175

System
Architecture, 23
Defining system
resources, 56
Permission Descriptions, 43
Permissions, 42
Resources, 25
System Name, 30
System Selection, 51

SystemManager, 25

T
Table, 199

Tag
Category, 89
Creating, Deleting or
Renaming, 37
Permissions, 45
Tag permissions, 38

Tag Seal
Weights and Measures, 322

Tank

Alarms Data, 354
Configuration Data, 365
Creating Tank Details, 188
Cylindrical, 281
Horizontal, 281

Point, 85

Point Process Data, 343
Point Records, 165
Polynomial Spherical, 283
Spherical, 282

Weights and Measures, 322

Tank Analysis, 242

Tank Calculation
typical, 315

tank calculations
traditional, 281

Tank Data
Edit Movement, 247

tank detail, 20
Creating, 188
Customizing, 187

Tank Node
Adding, 231

Tank Nodes
Exporting, 238

Tank Points
Data Source, 113
General information, 107
Vessel Information, 118
Volume, 109

tank points, 107

Tank Shell Correction, 290
Tank Strapping Table, 388
Temperature, 274

Temperature Limits
Assignment Options, 58

Template Mode, 189
Test Conditions, 80
Text & Background, 170
Text Color, 171

Text Help File, 65

The Molar Method, 297

Administrator Manual



Tools
Alarms toolbar, 70
Visual Dynamic, 184

Transfer

Movement Type, 223
translation tables, 137
Trends, 22
Trigger File, 265
Trigger Point

Automated Data Output, 265

Triggered Point

Variable Format

information, 102

triggered points

Creating and editing, 101
Troubleshooting

Update Utility, 260
troubleshooting

Update Utility, 259

U
Undo Last, 191
Uninstalling FuelsManager, 9

Unit Node

Adding, 232

Exporting, 238
Units, 374

Engineering, 86
Update Complete, 258
Update Failed, 258

Upgrading
versions prior to 4.3, 256

USB Key, 6
USB key, 8

User

Creating deleting or
Renaming, 39

Defined, 71
Defining Properties, 40
Interface, 10
Multiple, 21
Privilege, 46
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user
Windows, 38

Users, 38
Creating and Editing, 38

V

Value, 188, 200
Version 4.3, 10
Vertical, 172

Vessel 1
Leak Detection, 250
Tank Points, 119

Vessel 2

Entering Information, 123

Leak Detection, 251
View Menu, 33

Volume
Available volume, 298
Remaining volume, 299

Volume Calculations, 21
Volume correction, 275

Volume Correction Factor, 290

Volume Correction Factor
(VCF), 274

Volume Correction
Methods, 274

Volume of Sediment and Water

Correction Method, 289

Volumetric Analysis
Leak Detection, 240

w

Water
Definition Mode, 129

Water Table, 127

Water-Drain
Movement Type, 223

Weight in a Pressurized
Tank, 296

Weight in Air, 296

Weights & measures, 126

Weights and Measures, 322
Checksums, 328

Windows

Help Format, 65
Terminology, i

Windows Server, 13

X

Xfr Modes
Movement Type, 224
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